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BOOK 1:
EXCEL FOR BEGINNERS



CHAPTER ONE

INTRODUCING EXCEL

Microsoft Excel 2022 is a spreadsheet app and the latest Excel software that
allows individuals to arrange, manage, and add data while utilizing
formulae. Additionally, the software is included in the Microsoft Office
suite, but it is also linked with more office applications.

As the majority of other Microsoft apps are, Excel can be assessed as a
cloud-based subscription via Office 365. With Excel, you can perform more
functions than you think, as an individual or organization.

The software was specifically made for Mac OS and Windows users. Both
users are capable of carrying out functions including creating pivot tables,
using graph tools, and forming easy arithmetic. Furthermore, Excel enables
us to use the AVERAGE and other functions that will guarantee success in
our workplace.

Workers looking to arrange and organize data can use a set of cells formed
into columns and rows to do so, and this can be made possible by using
Microsoft Excel 2022. Excel also uses histograms, charts, and line graphs to
display data.

UNDERSTANDING WHAT EXCEL IS USED FOR

Excel is a popularly used Microsoft Office application that companies and
individuals usually use to analyze and save numerical data. Furthermore, it
is a spreadsheet program where individuals and companies can record data
to create tables. With an MS Excel spreadsheet, it is simple to analyze data.
You can summarize data and save it in an orderly manner with the aid of
graphs and charts so that you can readily access it whenever you need it. It
becomes easy to save data, and you will save a lot of time as a result.

MS Excel also lets users arrange, format, and calculate data while using
formulas with a spreadsheet system. There are numerous formulae in MS
Excel. By utilizing them, you perform many operations on a huge quantity
of data at once, such as computing the sum, average, and so on. As a result,



MS Excel is used anytime users need to solve difficult mathematical issues
or apply basic mathematical functions to tables with a lot of data.

MS Excel has a plethora of functions that make your job a lot easier and
save you time. There are fantastic tools for sorting, filtering, and searching
that make your job even easier. You can do your task in much less time if
you combine these tools with tables, pivot tables, and other tools (NB:
Multiple components may be readily found in vast volumes of data to
assist in the resolution of a variety of issues and concerns).

Excel allows you to add more complexity to your data. (NB: This means
you can enhance the data bars, highlight any particular elements for
laying emphasis, and quickly make your data more attractive). If you have
data saved in MS Excel and you want to emphasize something significant,
you may do it using the numerous data presentation options provided in MS
Excel. You can even make the spreadsheets on which you've placed data
more appealing.

MS Excel is useful for budgeting. For example, if a doctor earns $50,000
per month, he will incur some expenses, and if he wants to know exactly
how much he is spending each month, he can easily do so using MS Excel.
He can enter his monthly income and expenses into excel tables, which will
allow him to see how much he is spending and, as a result, control his
spending.

Excel is among Microsoft Office suite, and it is compatible with additional
applications in the Microsoft Office suite. Like other Microsoft Office
products, users can purchase Microsoft Excel 2022 and previous models
through the cloud on a subscription basis via Office 365. In addition, this
software program uses a cell collection organized into columns and rows to
organize and separate data. It is capable of displaying data as charts, line
graphs, and histograms.

There are numerous advantages to using MS Excel, which is why it is used
by people worldwide for a variety of tasks. Not only does it save time, but it
also makes the job easier. It is almost capable of completing any task. For
example, you can perform mathematical calculations as well as create
graphs and charts to store data. It is simple for a businessperson to compute
and save data in it.



LOOKING AT WHAT’S NEW IN EXCEL 2022

Excel 2022 comes in with its new calendar template. Nobody wants to start
this year off with a ton of spreadsheets if we are being totally honest.
Luckily, this template only has one sheet and it’s the only sheet you need.

In the smart calendar sheet, you have a calendar. A cool feature of this
template is that when you hover over the interactable aspects of the
template, a guide pops out with information on how the tools are used.

This template is flexible because you can adjust out the year to your liking
whether you want to skip ahead to 2023 or relieve the good old days of
2019. The template adjusts the dates for you automatically. In the first day
label, you can decide what day you want to start your weeks with.

If you want to mark an entry as critical, you need to put an asterisk in front
of it so the data shows red. For normal events, you just input values
normally and for holidays, you input a forward slash. You get the whole set
from January to December and on the top left, you have a full-screen macro
button that hides the ribbon for a larger work area and a print selection
button that allows you to print the areas you have highlighted.

As always, in the intro sheet, you get the standard items like the content,
customization difficulty, explanation of the sheets, and instructions on how



to utilize this template.

UNDERSTANDING WORKBOOKS AND WORKSHEETS

The electronic counterpart of a paper ledger is a worksheet. It's a powerful
toolset for entering, analyzing, calculating, and manipulating data. A
worksheet may be used for simple calculations like addition and
subtraction, as well as more complex applications like statistics, audits, and
mortgage tables. Worksheets also make it simple to turn your data into
useful business reports.

A workbook is a file that contains a collection of worksheets. These
worksheets may include a variety of data, but they are generally connected
in some way. Each worksheet in a sales workbook, for instance, may
include sales data for a single division.

Workbooks may have an infinite number of worksheets, depending on the
size of the worksheet and the amount of memory available on your
computer. A workbook may also contain chart sheets, Visual Basic
modules, dialog box sheets, macro modules, and scenario report sheets in
addition to worksheets.

In Excel, a workbook is the same as a file, and a file is the same as a
workbook. At the top of the screen, we can see the file or workbook's name.

If it's a new file, it'll be called Book 1. To open a new workbook, go to File
> New > Blank Workbook. At least one worksheet is included in every
workbook. You can add more sheets if necessary by clicking on the Add
Sign (+) below the window.



We can remove sheets. We can relocate them. We can copy them. Columns
and rows make up every spreadsheet or simply sheet. You can get all the
options by right-clicking on the worksheet you want to act on.

Vertical columns are indicated by letters. The rows are laid down
horizontally. Numbers are used in identifying them.



There are about 16,384 columns and 1,048,576 rows at the bottom. There is
an address in every cell in an Excel spreadsheet. To summarize, a workbook
is a file, and a workbook is a file. We have a working sheet with over a
million rows and over 16,000 columns on each.

MOVING AROUND A WORKSHEETS

When you open a new workbook in Excel, the worksheet's "active cell" is
positioned in the top-left corner (in Cell A1). You must move about in your
worksheet to build it or make changes to it. You can move around your
worksheets in Excel in two ways; by using the Keyboard or the Mouse.

Navigating with your keyboard

By hitting the arrow keys and other direction keys on the keyboard, you
may navigate around the worksheet. When you move around in the
worksheet using the keyboard, the active cell moves with you. The contents
of the active cell are then added or edited. Below are the shortcuts you can
use;

Up arrow key Move up the next row (one row)
Left arrow key Move to the next cell on the left
Right arrow key Move to the next cell on the right
Down arrow key Move down the next row (one row)
Control key + End Moves to The cell that is located at the

junction of the column on the right and the
bottom-most utilized row.



Control key + arrow
key

Moves to the last row or column in the
worksheet

Page Up Moves up one screen page
Page Down Moves down one screen page
Control Key + Home Moves to Cell A1

Navigating with your Mouse

Using the wheel on your mouse, you can move around on your worksheet.
You can use it to scroll up and down to navigate through the worksheet.
You can add more sheets using the mouse by clicking on the add sign below
the screen. By clicking on a worksheet tab, it displays the sheet for you to
work on/with it.

To navigate quickly to a cell, check the left-hand side of the formula bar
and click on the Name box. Type in the cell address i.e. the column letter &
the row number. For example, type in A6, or B2, then press Enter.

USING THE RIBBON

The toolbar has been referred to as the ribbon. It organizes commands into
tabs depending on their functionality and shows them as icons in a strip.
Meanwhile, before we get started, there are certain things you can’t change
in Excel. They include:

●       Built-in commands cannot be changed or removed. (NB: You may,
however, conceal a whole group).

●       The ribbon cannot be resized. The only visual option is to conceal
(collapse) it fully.

●      Text size, font type, and color selections are available right away. You
may also use Excel schemes to change the backdrop of the ribbon



across all Office programs.

Customizing the Ribbon

You can customize the ribbon in your Excel. There are different techniques
you can use to get to the customization options.

●      Select File > Options > Customize Ribbon from the File menu.

●      Right-click on the ribbon and pick Customize the Ribbon

The window gives you lists of instructions to choose from. In contrast, the
one on the left provides all popular commands, the right side, lists the
ribbon's main tabs, groups, and commands.



Ribbon Tabs

This is where you make some changes to your worksheets. You can insert a
new tab, create a new group, add a command, changes the names and
positions of tabs, groups, and instructions.

Inserting a new tab

Go to the right-hand list and choose New Tab. The new tab and group are
created when you click the button (NB: A tab should always have a
minimum of one group. Otherwise, you won't add commands). Use the
Rename button to rename a tab or group.



Creating a new group

Choose the tab you want to add a group, then, select New Group.

Adding a command

Commands can be added only to custom groups. As a result, begin by
picking a custom group from the appropriate list. So, on the left side,
choose the command. Choose commands from the menu above to filter the
list. To add the command to the specified group, click Add >>. When
you're finished, click OK.

Changing the names of ribbon tabs, groups, and commands

The Rename button, as previously indicated, may be used to rename tabs,
groups, and commands. However, when it comes to built-in things, your
selections are restricted. Although you may change built-in tabs and groups,



none of the built-in commands can be renamed. Except for the File tab, that
is. Symbol selection, on the other hand, is not possible for built-in tabs and
groups.

Changing the position of tabs, groups, and instructions

You can rearrange the tabs, groups, and instructions on the ribbon in Excel.
You may take one of the following approaches:

●      On the right side, use the arrow buttons. Select the object you want to
move and then click the arrow that indicates the direction you want it
to go.

●      Make use of drag and drop. Move the mouse by clicking and holding
the mouse button on any object.

Contextual Tabs

When you create or update an object in Excel, such as a chart, table, or
diagram, contextual tabs appear. The contextual tabs provide you with the
choices and tools you need when working with these things, and they are
then cleared away when you click out of the object. To restore them, just
click on the item, and the tab will appear. It keeps your workspace free of
clutter.



Types of Command on the Ribbon

There are 5 main types of commands on the Excel ribbon. They are; Toggle
buttons, Drop-Down buttons, Tick Box, One-Click, and Split Buttons.

Toggle Buttons: With these buttons, you can adjust a cell. When you use
this button to a cell, Excel will let you know the button you have applied
(you will see the button highlighted with a particular color). Most times,
when you have applied different formats to your cells, this button helps you
to know the formats you have applied.

Drop-Down Buttons: These are those little arrows that are next to a
particular button. When you click on the arrow, it gives you an extra list of
applicable change options that you can use to make changes to a cell. For
example, when you click on the arrow next to the Fill Color button, you
will see a list of different colors that you can apply to the selected cell.



Tick Box: This box is more like the On/Off buttons. On these boxes, you
can check and uncheck different box options. For example, when you click
on the View tab, you will see some options there with the tick-box beside
them. As you can see in the image below;

One-Click: These are those commands on the ribbon that when you click
on them once, act immediately. Let’s look at the Text alignment option for
an example. Select a cell and click on it, it aligns the cell immediately.
Same with the Bold button, Italic button, or the Increase and Decrease
font size buttons.

Split Buttons: These are buttons that consist of the drop-down option and
one-click option i.e. you can click on the button to act immediately and you
can also click on the drop-down arrow next to the button to select from the
list of other options.

Accessing the Ribbon by using your Keyboard

You can easily access the ribbon using your keyboard. To do this, simply
press the “Alt key” on your keyboard. When you do this, you will see
different letters on the ribbon. Each of these letters will be displayed on a
particular tab on the ribbon. When these letters appear, press any of the
letters on your keyboard and it will open up the menu of the tab you
pressed.

USING SHORTCUT MENUS



Using keyboard shortcuts into your Excel routine is one method to speed
things up. Excel specialists seldom use a mouse since it takes more time
and is often imprecise. Many key combinations, or instructions, are already
incorporated into the application, allowing you to perform actions.
Depending on their function, all of the accessible shortcut keys may be
grouped into numerous categories.

Shortcuts for formatting data

Combinations of the Control key + Shift key with extra characters may be
differentiated as a distinct category of data formatting fast commands.

●       CONTROL KEY + W — This command will dismiss the current
worksheet immediately.

●      Save the working document by pressing CONTROL KEY + S.
●      Create a new working document by pressing CONTROL KEY + N.
●       CONTROL KEY + X – copy the contents of selected cells to the

clipboard.
●      Open a working document by pressing CONTROL KEY + O.
●       CONTROL KEY + V - this shortcut pastes data from the clipboard

into the previously selected cell.
●      CONTROL KEY + P – brings up a window with printing options.
●       CONTROL KEY + Z is a command that can be used to undo a

previous action.
●      F12 - this key saves the current working document as a new name.
●      CONTROL KEY + T - This key combination allows you to generate

a new worksheet from a single cell and a range of cells around it.
●       CONTROL KEY + 1 – Opens the cell formatting dialog box from

the table.

Data entry shortcuts
●      CONTROL KEY + D – this command copies the contents of the first

cell in the marked range and pastes it into all subsequent cells.
●       CONTROL KEY + Y – the command will, if feasible, repeat the

previous action.
●      Add the current date using CONTROL KEY + ;
●      If edit mode is open, ALT + enter inserts a new line within the cell.
●      Change the indicated cell using F2.



●      The Paste Special Docker is opened by pressing CONTROL KEY +
SHIFT + V.

Data View and Navigation
●      CONTROL KEY + G (Go to) – opens the "Go" window on the screen.
●      You may navigate to the next worksheet by pressing CONTROL KEY

+ PgDown.
●       CONTROL KEY + END - Go to the end cell of the current sheet

immediately.
●      The Find dialog box is opened by pressing CONTROL KEY + F.
●      Switch between workbooks by using CONTROL KEY + Tab.
●       Hide or reveal the ribbon with tools by pressing CONTROL KEY +

F1.

Data selection
●      SHIFT + Space – Selecting a whole line
●      CONTROL KEY + Space – Selecting a whole column
●      CONTROL KEY + A – Selecting the whole worksheet.

CUSTOMIZING YOUR QUICK ACCESS TOOLBAR

The Quick Access Toolbar is a resizable toolbar that includes a collection of
instructions that are not reliant on the current ribbon tab. You may add
buttons that indicate instructions to the Quick Access Toolbar.

Select the drop-down arrow on the Quick Access Toolbar, it shows a list of
commands that you can add to the toolbar. When you click on any of the
commands, it will display in the Quick Access Toolbar.



Move the Quick Access Toolbar: You can move it to two places; Below
the ribbon or Above the ribbon. To change the location of your quick access
toolbar (if it is currently above the ribbon), click on the drop-down arrow,
then select Show Below the Ribbon.

Follow the same steps above then select Show Above the Ribbon.



Not all commands are displayed in the lists. So, simply click on the drop-
down arrow and select More Commands and this will display a window
where you will see other commands options.

Click the arrow under the “Choose commands from” option. This will
display different command options.



Select an option and choose a command. Then click Add>>. You can also
remove a command by clicking on the << Remove button.

WORKING WITH DIALOG BOXES

The box that appears is known as a Dialog Box. It is a transient window
created by an application to collect user input. Dialog boxes are often used
in applications to ask the user for further information about menu options.

In Excel, when you click or make use of some commands in the ribbon, it
displays a box where you see other options for that command. Excel



features a lot of dialog boxes that you'll use a lot, such as Format Cells,
Spelling, Past, Find and Replace, etc. There are types of dialog boxes.

Typical Dialog Box: If this box appears on your screen, it doesn’t go away
by itself until you decide to close it. when it appears, perform your action,
then you click OK. If you want to dismiss the box, click on the Cancel
button. This will close the dialog box immediately and no action will take
place. The image below is a Typical dialog box.

Navigating Dialog Boxes: This box appears when you click on a command
that you want to use. You can easily see them from the list of commands on
the Insert Tab.



Tabbed Dialog Boxes: Many of the dialog boxes in Excel are Tabbed
dialog boxes. It has several commands on it. You make the changes you
want, and once you are done, click OK.

USING TASK PANES

In Excel, task panes are interface panels that display on the right side of the
window. It provides users with easy access to common features, data, and
instructions. Below is an example.

Open an excel sheet (It should have some details in it).



Now, let’s insert a picture. Click Insert > Pictures > Select the picture you
want, then click Insert. Once the picture has been displayed on the
worksheet, right-click on it and select Format Picture.

This will open up the Format Picture Task pane. You will see lots of options
you can select from in the Task Pane.

Click on an option. As you make the changes, you will see the picture
adjusting to the changes you have made.





CREATING YOUR FIRST EXCEL WORKBOOK

You'll get a welcome screen when you first launch Excel, where you can
select to access an already Excel spreadsheet or you create a new one. You
may create a fresh, blank worksheet or a ready-made workbook using a
template on Excel's welcome page. For the time being, click the "Blank
workbook" icon to create a new spreadsheet without any formatting or
data.

Getting Started on Your Worksheet

A worksheet is a grid of cells into which you may write data and formulae.
The grid occupies the majority of the Excel display. It's where you'll do
everything from inputting data to developing formulae to evaluating the
outcomes. The worksheet consists of rows and columns gridlines and is
labeled with numbers and alphabets.



Filling in the Month Names

Now, we are going to fill in some data. First, select Cell B2 and Cell C2 at
the same time. To do this, click on Cell B2, and why holding the left-click
button on your mouse, move the cursor over Cell C2. This will select both
cells. Now, on the Home tab, select Merge & Center from the ribbon
which will merge both cells into one cell.

Now, click on the merged cell and type in Sales Report. Now, activate cell
B3 and type in the word Month. Activate cell C3 and type in the word
Sales. Now, select cell C3. In the alignment group, select the Center
command.



Now, activate Cell B4 and type in JANUARY. Then, on the small square
box on the bottom right of Cell B4, click and drag down to 11 rows (B15).
Once you’ve done this, Excel will automatically complete the rest of the
months for you instead of making you type the months because it
recognized January.

Entering The Sales Data

Now, enter the following numbers (as you can see in the image below) into
C4 and C15 in the exact following format without dollar signs or commas.
Then, activate cell B16 and type in Total and then center it.



Summing the Values

The SUM function is used for summing values. we will apply it in cell C16.
Activate cell C16 and enter in the equal sign, sum, and left parenthesis.
Then select cell C4 to cell C15 and close the parenthesis. The contents
within cell C16 should be as follows: =sum(C4:C15).



Then, press ENTER, and this sums up the monthly sales.

Making Your Worksheet Look a bit Fancier

Select Cell B2 and C2. Click the down arrow on the fill color command on
the ribbon and select a color. This will color the title of the table.



Now, select cells B3, C3, and B16 which are the Month, Sales, and Total.
Repeat the same steps above but pick a lighter color. Repeat the same steps
for cells B4 to B15 which are the Months. Finally, select cell C16 and fill it
with a very light color to differentiate it from the rest of the Sales number.

Now, let’s add a border



Select cell B2 through cell B16 (the entire Sales report). Select the down
arrow of the border command and select All Borders. There are other
border options there as well.

Creating a Chart

Now, choose the cell you want to create a graph for. To do this, click and
drag your mouse across the cell. Once you’ve done this, click on the Insert
Tab on the ribbon. You will see the chart command menu on the Insert tab
options.

You can create different charts for your work. In this case, we will create a
bar chart. Click on Recommended Charts > All Charts. Then, select Bar.
Click OK.



This will immediately create a pie chart for your work.

Formatting the Numbers

Select the cell > click the down arrow on Number group and select any
number format option. you want. Click on More Number Formats for more



formatting options. On the image below, I formatted the numbers to
Currency (Dollar).

Printing your Worksheet

Excel sheets might have much information, and printing it all at once isn't
always practical. By identifying the desired region, navigating to the print
options, and selecting the 'print chosen area' option, you may print specific
areas of a spreadsheet. Printing selected sheets in a workbook may be done
similarly. "Print Areas" may also be utilized by people who want to fine-
tune their formatting before printing. There are different methods you can
use in printing your worksheet.

Printing from a Selection

Highlight the cell(s) you want to print. Click on File and choose Print.

On the Print Setting menu, hit the down arrow and select Print Selection.
Then, click on Print. This will print out only the selected area in your
spreadsheet.



Using a Print Area

Highlight the cell(s). Click on Page Layout. Click on Print Area, then
select Set Print Area.

The print area will be identified by the highlighted cells. You may continue
working while this area is stored for future printing.



�        The "Orientation" button allows you to move between landscape and
portrait mode.

�        On a printed page, the "Margins" button modifies the margins.
�        "Scale to Fit" determines how many pages your printed material will

occupy.
�        From the same dropdown menu, you may clear, overwrite, or add to

the print area.

Click on File and select Print. On the Print settings menu, select Print
Active Sheet. Then, click on Print.

Saving Workbook

When you save a workbook for the first time, Excel will ask you to name it.
Any modifications to the text, numbers, or formulae must be saved using
the Save procedure once the file has been given a name.

●      Go to File > Save New Workbook.
●      Choose File Save As.
●      A dialog window called Save As opens.
●      Select a location for the file.
●      Fill in the File Name: box with a name for your file.
●      Select "Save" from the drop-down menu.

When working with a spreadsheet, it's a good idea to save it periodically.
It's never pleasant to lose data. Using the shortcut key combination Control
key + S, you may save your worksheet fast.

 



CHAPTER TWO

ENTERING AND EDITING WORKSHEET DATA

Double-clicking the cell location or using the Formula Bar may alter the
data that has been put in it. You may have observed that the data you put
into a cell location showed in the Formula Bar as you wrote it. The Formula
Bar may be used to input data into cells as well as amend data that has
previously been entered.

For example, click on cell B16, and type in the word Tot. Activate cell B16,
then, on the formula bar, you will see the abbreviation, Tot.



So, click on it and complete the word to Total, then click on the checkmark
icon on the left. This will change the word to Total in cell B16.



Exploring Data Types

In Excel, there is the Numeric data type, Text data type, Date and Time data
type, and Formula data type.

Numeric values

The numerical data which are stored in Excel cells are used in building the
majority of formulae in Excel.  Numeric data is aligned to the right-hand
side. Numeric data may be divided into two categories.

Numeric Data: Numeric data is used to keep track of amounts. 500 bags of
cement, for example.

Date and Time: Date and Time values are stored using the Date and Time
data type. Technically, Excel saves Date and Time as numbers as well. Date
and time data, like numeric data, is aligned to the right-hand side. A date
value, a time value, or both may be stored using the data and time data type.
Depending on how you structure the Cell, the date and time value might
appear in a variety of forms.

Excel's numeric data type is used to record various amounts that may then
be utilized in mathematical operations using Excel formulae. Numeric



characters (0 to 9) may be used in Excel cells with numeric data types.
Aside from numeric characters (0–9), the special characters listed below
may be used for many purposes.

+ Positive symbol
- Negative symbol
() Negative symbol
% Percentage symbol
. Decimal symbol
, Decimal symbol
E Exponential

symbol

Text Entries

Text is any string of letters, digits, spaces, and characters. This is the most
popular data type. Text is the only data type in Excel that is oriented to the
left by default. It's mostly used to name table headings, descriptions, and
other things. Although text can as well be a number, it should not be
utilized in calculations. You may get a #VALUE! error if you endeavor to
execute any mathematical operation with text data in a Cell. Customer
names, customer numbers (using customer numbers in computations would
be meaningless), and addresses are examples of the popular usage of the
Text data type.

If the text data in an Excel Cell is bigger than the Cell width, the text data
will flow over into the empty right-side Cells. If a right-side empty Cell is
subsequently filled, Excel hides the spilled text before revealing the data in
the new full Cell. See below.



Formulas

A formula is a set of instructions that are entered into a cell to generate a
value. It must start with an equal symbol (=). A mathematical equation, cell
references, functions, or an operator might all be examples. An expression
is another name for a formula. Because MS Excel can build tables with a
large quantity of data, you use this function to add formulae to your table
and receive faster results. Following are some fundamental Excel functions
to get you started, assuming you can now input and function with your
favorite formulae.

SUM Formula: First and foremost, the SUM function in Excel is a must-
know formula. Values from several columns or rows are often combined.
=SUM is a simple selection that adds the column values (A2:A8). Example:
Summing up the values of a single row, =SUM(C4-C15).

MEDIAN Formula: The average number of shareholders in a certain
shareholding pool is an example of a simple average that the AVERAGE
function should bring to mind. Example: The formula =AVERAGE is used
to calculate an average (C2:C14). (SUM(C2:C14)/12) is likewise
comparable.

COUNT Formula: The COUNT function keeps track of how many cells in
a given range contain just numeric values. Example: COUNT is used to
count the numerical values in a column (C: C). To count rows, you must
change the range of the formula.

IF Formula: The IF function is often employed when you wish to sort your
data according to a set of rules. Other formulae and functions may be true,
for example, the value is true and false.

Example: =IF(C2D3, 'TRUE,' 'FALSE') – IF(C2D3, 'TRUE,' 'FALSE') –
IF(C2D3, ' This method checks the two numbers to see whether C3 is
smaller than D3. If the reasoning is right, the cell value should be TRUE;
otherwise, it should be FALSE.

COUNTA Formula: COUNTA counts all cells in a given range in the same
way as the COUNT function does. Regardless of cell type, all cells are
counted. It counts the same things as COUNT: dates, times, strings
(including logical values and errors), and empty strings or text.



Entering Text and Values into your Worksheets

Any cell may have either text or number. It might be difficult to input data
if you haven't been taught how, so follow the steps below to discover the
tips and tricks for efficiently entering data.

Entering Numbers and Text

To input numbers or texts, first of all, activate the cell by clicking on the
cell, then input the value and hit Enter key. After inputting the value,
activating the cell, you will notice that the value is shown in the cell
likewise in the Formula bar.

A cell may carry up to 32,000 characters, which is more than enough for a
normal chapter in a book. Despite a cell carrying a large number of
characters, you'll discover that it's impossible to show them all. The formula
bar may not fully display lengthy text. To expand the height of the Formula
bar and show additional text, click the bottom of the Formula bar and drag
it down.

When inputting values, especially numbers, you may use decimal points,
currency symbols, mathematics symbols, etc. excel considers a value to be
negative if it is preceded by a minus sign or it is enclosed in parenthesis.

Entering Dates and Times into your Worksheets

According to what you want to perform, there are numerous methods to add
dates in Excel. Do you wish to include today's date in a report or invoice,
for example? Perhaps you'd want to put a date in Excel that would regularly
refresh and always show the current date and time? Or maybe you'd like to



have your worksheet auto-fill weekdays or enter random dates? Let’s show
you how you can do that.

Entering date and time values

Choose the cell. Then, press Control key + Semi-Colon (;). This will add
the current date to that cell. To enter the time, select the cell, then press
Control + Shift + Semi-Colon (;) on your keyboard. This will add the
current time on that cell.

You can also enter date and time using some functions. To do this, simply
Activate the cell you want to add a date on, type in this function on the cell
=TODAY() and then press Enter. For the time, select the cell, type in this
function =NOW(), and press Enter.

MODIFYING CELL CONTENTS

Deleting the contents of a cell

There are various techniques for deleting data on a worksheet. This is a
useful command if you accidentally delete data from your worksheet. The
instructions below show you how to erase data from a cell or a range of
cells



●       Click on any cell you want to delete. Then, on your keyboard, press
the Delete key. This will delete the contents of the cell.

●       Select cell B3 to B16 by highlighting it. To do this, place the mouse
cursor over B3, click and drag down to B16. Then, on the Fill handle
of B16, click and drag it up to cell B3, then leave the mouse button.
All contents of B3 to B16 will be deleted.

Replacing the contents of a cell

To replace the contents, you can use the Undo button on the Quick Access
Toolbar. Click on it and the contents will be back. You can also press the
Control key + Z to do this.

Learning some handy data-entry techniques

The core of Excel is data input. If you can't rapidly and properly input data
into your spreadsheets, you won't be able to utilize the tools to analyze and
report on the data. When it comes to data input, Excel gets a lot of things



right, yet certain things aren't straightforward. Even the most seasoned
Excel users may sometimes choose more sophisticated procedures than are
required. See below.

●      If you wish to remain in the same cell but switch to a new line when
entering long text, you can't merely hit [Enter]. This just advances
you to another cell. Instead, use [Alt] + [Enter] to make a line break
or a new line in the same cell. This technique is often known as a new
line or line break.

●      Do you use product codes or other ids that start with one or more zeros
in your entries? When you input data like this, Excel thinks it's
numbered and removes the beginning zeros. Format your worksheet
cells as text rather than numbers to persuade Excel to allow you to
input values with leading zeros. There are two techniques to consider:

1. One: Type an apostrophe (') in front of each item to convert it to a text
format. However, if you have a lot of data, this is a time-consuming
method since you'll have to add the apostrophe to each record, not
just the ones with leading zeros. Your list will not order appropriately
if this is not done.

2. Format selected cells into the text to prepare for data input. Choose
the cells (or a whole column) where numbers will be kept as text.
Right-click, then select Format Cells, then in the Category box, select
Number Click Text and then OK to apply.

Automatically moving the selection after entering data

As you hit Enter, Excel slides the pointer down to another cell. That isn't
always the best course of action. It's aggravating when you're typing data
from one column to another. You may now hit the right arrow key instead of
hitting Enter, however, this will cause you to slow down. Although
pressing Tab is simpler than extending for the right arrow key, changing the
cursor movement as follows may be the simplest solution

Click on File. Click on Options. This will open up the Excel option menu.
On the left-hand side of the menu, click on Advanced. On the Editing
option, below the After Pressing Enter option, select the direction you



want from the down arrow. The direction options are Right, Left, Up, and
Down. When you are done, click OK.

Selecting a range of input cells before entering data

In Excel, working with a whole data set is a regular activity. You could wish
to transfer the data, apply a filter or a standard format, or convert it to a
table. There are several reasons to pick a data range, but doing so may need
to leap through a few selection hoops, particularly if you're dealing with a
wide range that covers multiple screens. Fortunately, selecting a whole data
range is simple and fast.

Use the Go To function to choose a data range as follows:

Any cell in the data range may be selected by clicking it. For example, you
might choose any cell from B2 through C15 to choose the data range
B2:C15.

[F5] is the shortcut key. Press it.

Click the Special button in the bottom-left corner of the Go To dialog.

Select Current Region from the pop-up menu that appears.

When you click OK, Excel will choose the current data range for you (the
current region).

Using CTRL + Enter to place information into multiple cells

In Excel, copying and pasting a single cell is simple. When it comes to
copying and pasting a group of cells, columns, or rows, you have several
options. Use the shortcut Control key + Enter key to activate. Pick a few
cells and type any term or value into any of them. Instead of hitting Enter,



hold down the Control key and hit Enter. You'll see that the name is copied
to all of the chosen cells.

Changing modes

In an Excel spreadsheet, there are four different sorts of cell editing modes.
"Ready," "Edit," "Enter," and "Point" are the four sorts of Cell modes. An
Excel cell's default mode is "Ready." Excel is ready to take data in any of its
worksheet Cells while it is in Ready mode.

The default "Ready" mode of its Active Cell is changed to "Edit" mode by
pressing the function key "F2" once. If you hit the function key "F2" again
when in "Edit" mode, the Cell mode will change to "Enter." The fourth
cell mode is called "Point." While creating or editing a formula, "Point"
cell mode enables you to explore a large Excel spreadsheet and choose the
required cells.

Entering decimal points automatically

If you need to input many numbers, each of which includes two decimal
numbers, as illustrated below, manually typing the decimal point will be a
waste of time. Now I'll show you how to quickly add a decimal point to a
number in Excel at a precise location.

To do this, click on File > Options. In the Options menu, select Advanced.
Under the Editing Option, check the box close to the Automatically insert
a decimal point option. Then, put in the decimal places in the Places
option.



After that, click Ok.

Using Autofill to enter a series of values

You may use the AutoFill command to automatically lengthen a predictable
sequence (for example, 10,20,30.... day, hours of the day). You may also use
AutoFill to propagate formulae - create the formula once, then use AutoFill
to spread it to the other cells.

So, select a cell and type the first day of the week; Sunday. Activate the cell
you typed in the day. Then, hover the cursor to the little box beside the cell.
When the pointer changes to an Add sign (+), click and drag down. Excel
will fill in the rest of the values i.e., the days of the week.



         

Using Autocomplete to automate data entry

When manually inputting data into a spreadsheet, the AutoFill option comes
in handy. This function is useful for a variety of things, but it's especially
useful for inputting data in a certain order, such as the digits 2, 4, 6, 8, and
so on, or non-numeric data like the days of the week or months of the year.
Just like we did in chapter one when we completed the months of the year
by dragging down the box beside the month cell. See the example below;



Activate Cell B4 and type in January. Then, you will see a tiny small box
beside the cell which is the Fill Handle.

Click on it and drag down to 11 rows on the bottom right of Cell B4 (B15).
Because Excel identified January, it will automatically fill the remainder of
the months for you rather than making you input them.

Forcing text to appear on a new line within a cell

By pressing the Alt key + Enter, you can insert a line break or start a new
line of text or create space between lines and paragraphs. On the cell you
want the line break to appear, double-click on it. to break the line, click the
desired position inside the cell you have chosen.

Using Autocorrect for shortcut data entry

Excel's AutoCorrect tool may be used to create shortcuts for frequently used
words or phrases. Entering lengthy stuff or individual name takes time and
often results in mistakes and inaccuracies. To fix this problem, use the
AutoCorrect tool to create shortcuts and modify them. Follow these
procedures below;

Click on File > Options. This will open up the Excel Options menu.



On the left-hand side of the menu, select Proofing. Then, click on
AutoCorrect Options.

This will open up the AutoCorrect option dialog box. On the Replace text
box, type in the shortcuts you want and what you want to replace them
with. Then, click Add. As you can see in the image below.

You must give each AutoCorrect item a distinct name after entering or
choosing it.

If you're going to name an AutoCorrect entry, don't use a popular term
unless you're going to change it.



Don't call an entry Mr., for example. Instead, use an underscore or another
symbol to distinguish it, such as *Mr. If you don't make the term unique,
Word will automatically insert the AutoCorrect entry anytime you enter it,
whether you want it or not. If you've picked a frequent term, reverting each
auto-correction will take too much time.

Note that your AutoCorrect list in Excel is shared with other Office
products. Any AutoCorrect entries you make in Word will function in Excel
and Outlook as well.

Entering numbers with fractions

When we use the slash ("/") symbol to separate two integers in Excel, the
values are converted to decimal format. We may use the Fractions option to
retain fractions for such values; first, choose the cell whose value we want
to convert fractional and then choose the Format Cells option from the
right-click menu list.

Click on the Number tab, pick Fraction from the category area, where we
have many criteria for fractioning up to one digit, two digits, or three digits
like halves, eighths, etc. Then select the Fraction Type you want.



Using a form for data entry

A data entry form can assist by data entry process more efficient and error-
free. You use it to put data into your worksheet. By default, there is no data
entry form option on the Excel Ribbon. So, you will have to add it to the
Quick Access Toolbar so you can access it easily. Follow the steps below to
add it;

Right-click on any option on the Quick Access Toolbar and select
Customize Quick Access Toolbar.

This will open up the Excel Options box. Click on the drop-down arrow on
the Choose commands from and select All Commands.



On the All command list, click on Form, then click on the Add button.
Then, OK.

You will see the Form Icon on the Quick Access Toolbar. So, you can easily
access it now. Simply click on the cell you want to input data from, then
click the Form-Icon.



The Data Entry Form is made up of different options. Below is a brief
explanation of what each option does.

●      New: This clears any existing data in the form and enables you to start
over with a new record.

●      Delete: You may use this to get rid of an existing record.
●      Restore: If you're updating an existing entry and haven't clicked New

or pressed Enter, you may restore the old data in the form.
●      Find Previous: This will locate the preceding entry.
●      Find Next: This will take you to the next page.
●      Criteria: You may use criteria to discover particular records.
●      Close: This will bring the form to a close.
●       Scroll Bar: The scroll bar may be used to navigate through the

records.

Let's take a look at all you can accomplish with an Excel Data Entry form.
●      Activate the cell for the data.



●       Click on the Form-Icon. This will open the data form box. Now type
in the data in the fields. Then, press the Enter key. You can also click
the New button.

Applying Number Formatting

It's a wise concept to utilize suitable number formats for your data if you're
dealing with a spreadsheet. Number formats specify what sort of data you're
utilizing in your spreadsheet, such as percentages (%), money ($), times,
dates, etc. Number formats not only make it simpler to read your
spreadsheet, but they also make it easier to utilize.

To apply a number format, choose the cell > On the Number group, click on
the arrow and select a number format. Click on More Number Formats for
more formatting options.



Using automatic number formatting

The AutoFormat option cannot be accessed from the ribbon, so you will
have to add it to the Quick Access Toolbar. Right-click on the Quick Access
Toolbar and select Customize Quick Access Toolbar.

Click on the down arrow on the Choose commands from and select All
Commands.

On the All Commands list, click on AutoFormat, then click Add. This will
add the AutoFormat Option on the Quick Access Toolbar.



This will add the AutoFormat Option on the Quick Access Toolbar.

To AutoFormat the numbers, simply highlight the whole data, hit the
AutoFormat icon. This will display the AutoFormat menu. Choose any
style, then click Ok.



Using shortcut keys to format numbers

There are shortcuts for formatting numbers on Excel. Control key + Shift
key + Number key. Simply choose the cell(s), then press the shortcut keys.
Below is a list of the shortcut keys and their function.

Control + Shift + ` = General Control + Shift + 5
= Percentage

Control + Shift + 1 = Number Control + Shift + 6
= Scientific

Control + Shift + 2 = Time Control + Shift + 7 =
Border

Control + Shift + 3 = Date

Formatting numbers by using the Format Cells dialog box

Pick the cell for formatting, right-click on it and select Format Cells. On
the Dialog box, you will see a list of options that you can select from.
Choose the one you want and click OK.



Add your own custom number formats.

You may wish to format a number in a custom manner, such as formatting
421020000 as $421.02 M, and then store this for future use. You can also
apply it to multiple cells.

To do this, follow the steps below.

Select the cell that has a number value in it, right-click on it, then click on
Format Cells.



Click on the Number tab, then click on Custom. On the box below the Type
option, type in the format code $#.##,," M"; then, click OK.



CHAPTER THREE

PERFORMING BASIC WORKSHEET OPERATIONS

Worksheets may be a fantastic tool for organizing your data. Rather than
jamming everything into one worksheet, the user may utilize several
worksheets inside a workbook.

Learning the Fundamentals of Excel Worksheet

Each file in Excel is referred to as a workbook, and each workbook may
include more than one worksheet. Consider an Excel workbook as a
notebook, with worksheets serving as pages inside the notebook. You may
see a specific sheet, add new sheets, delete sheets, and copy sheets just like
in a notepad.

Excel workbook files can contain more than one-sheets. These sheets can
be different from each other. It can be chart sheets (containing a chart) or
worksheets (which contain rows and columns). Take note that each
worksheet has a unique name; by default, a workbook opens with three
worksheets named Sheet1, Sheet2, and Sheet3. However, you may add,
remove, and rename these spreadsheets as desired.



Right-clicking on a worksheet brings up a menu containing some options
for making changes to your worksheet. You will see options like Insert,
Move or Copy, Rename, Delete, and others. You can also change the color
of the worksheet.



Working with Excel windows

A window is opened for each Excel workbook file that you open. A
window is the workbook's container in the operating system. You may open
as many Excel spreadsheets as you want concurrently. As with other
Windows programs, the Excel window's control buttons are situated in the
window's extreme right top corner.

Three window-control buttons are accessible. To minimize the Excel
application window, press the left button. The middle button
maximizes/restores the Excel software window. To dismiss the Excel
application window, click the right button.

The functionalities of the left and right buttons are always identical. They
are used to minimize and close the Excel software window. However, the
center button's operation is dependent on the present state of the Excel
window. If the current state of the Excel window is Maximized, the center
button is used to Restore the Excel window to its default state. When the
current state of the Excel window is Restored, the center button is utilized
to maximize the Excel window. You must comprehend three concepts
relating to window state: minimized, maximized, and restored.

Minimized state: A minimized Excel window is not visible on the
Operating System screen but is minimized to stay on the Windows
taskbar.
Maximized state: The term "maximized Excel window" refers to the
state of the Excel window when it has been maximized to fill the
whole screen of your Operating System.
Restored state: When an Excel window is restored to its original
size, it is said to be restored to its restored condition. When the
window state is restored, the size of the Excel window is less than
when it is maximized. You may resize the Excel window in this state.



Moving and Resizing Windows

When the Excel window is in the Restored state, drag the Windows pointer
to one of the window's sides or corners. As seen here, the Windows cursor
transforms into a double-headed arrow. Once you see the arrow, click and
drag the mouse. The window will begin to resize. Note that when you drag
the window, the resizing will affect the height and the width.

To move a window

When the Excel window is in a Restored state, move your mouse pointer to
the top of the Excel title bar. Then, click and drag the window to any
location on the screen you want.

Switching Windows

You must have at least two Excel workbooks open to switching windows.
Click on the View Tab, click on Switch Windows.

Choose the window to switch to.

Closing Windows

On the top right-hand side of the Excel window, click on the close button.



Activating a worksheet

To activate a worksheet, click on the small left arrow at the bottom left of
the workbook.

Then, right-click to see all sheets. This will bring up the Activate Sheet
menu. Click on the sheet you want to activate and then click Ok.



Adding a new worksheet to your workbook

You can do this in two ways. First, click the (+) sign below the workbook to
add the workbook. You can also right-click on the present worksheet below
the menu which should be Sheet 1, then click on Insert, click worksheet and
then click OK.



Deleting a worksheet

To do this, simply right-click on the name of the sheet you want to delete,
then select Delete.

Changing the name of a worksheet

Select the name of the sheet you want to rename by right-clicking on it.
when you do so, select Rename. Then, you can now rename the sheet by
typing the name on the sheet box.

Changing the tab color

On the sheet, you want to change the tab color, right-click on it. from the
list of options there, click on Tab Colour. Then select the color you want to
use.

Rearranging your worksheet

You can move or copy a worksheet to another location. Right-click on the
worksheet, choose Move or Copy. You can rearrange the worksheet to
another position on the same workbook and you can also rearrange the
worksheet to another worksheet.



1. To reposition a worksheet inside the same workbook, click the
worksheet's name.

2. To reposition a worksheet to a different workbook, choose the new
workbook from the “To Book” option and click the name of the
worksheet you want to move.

Note that your worksheet will vanish from the main workbook when you
move it to another workbook.

Hiding and unhiding a worksheet

Select the worksheet, right-click on it and select Hide. To unhide it, select
any worksheet from the list and right-click on it, then select Unhide.

CONTROLLING THE WORKSHEET VIEW

Zooming in or out for a better view

By using the Zoom slider in the Microsoft Excel status bar, you may zoom
in or out of an Excel worksheet. The status bar is located in the bottom right
corner of Microsoft Excel. Slide to the desired % zoom setting. To zoom in
and out in small steps, use the - or + buttons. The percentage number
associated with the zoom level is also shown in the status bar adjacent to
the zoom slider. When you click the percentage, a Zoom dialog box



appears, allowing you to choose from preset zoom levels or create your
own.

You can also make use of the ribbon. On the ribbon, click on View. On the
View tab, you will see the Zoom box with some options in it.

Viewing a worksheet in multiple windows

You need to have more than one window opened. So follow the steps below
to do so;

Click View tab.
From the options there, select New Window.
Click on the View tab again and select Arrange All. This will open
up a box for you to select how you want to arrange the windows.
Once you have selected it, click OK.

The worksheet will now appear on both windows.



Comparing sheets side by side

To do this, click on the View tab, you will see the View Side by Side
option, click on it.

Splitting the worksheet window into panes

To do this, you will make use of the Split Button on the View tab. So first of
all, choose the row or column that you will like to insert the split pane.
Then click on View on the ribbon, then click Split.

Keeping the titles in view by freezing panes



Freezing panes in Microsoft Excel implies that some rows and/or columns
will be constantly visible at the top of a worksheet while scrolling. Below
are the steps to do so.

Freeze Top Row

Select Freeze Panes on the View tab.
Select Freeze Top Row from the menu.

You will see a dark grey horizontal line on the top row.

Unfreeze the Panes
●      Select Freeze Panes from the Window group on the View tab.
●      Select Unfreeze Panes from the menu.

Freeze First Column
●      Select Freeze Panes on the View tab.
●      Select Freeze First Column
●      You will see a dark grey vertical line in the first column.

You can do this to the rows and cells as well using the same steps.

Monitoring cells with a watch Window



In Excel 2013, Microsoft added the Watch Window. It's a tool that displays
the value of a cell and its characteristics in another window, including the
workbook and worksheet titles, cell or range names, cell address, and
formulae. This window may be placed anywhere you like and even docked
like a toolbar.

To use the Watch Window tool simply click on Formulas on the ribbon,
then click Watch Window. This will bring up a box where you can add and
remove cells.

WORKING WITH ROWS AND COLUMNS

Inserting rows

Click on the heading of the row where you want to insert the new row.
Then, on the home tab in the ribbon, click Insert.

The newly inserted row will appear on top of the row you selected.



Inserting Column

Click on the heading of the column where you want to insert the new
column. Then, on the home tab in the ribbon, click Insert.

The newly inserted column will display at the left of the column you
selected



Note: A paintbrush icon appears next to newly added rows, columns, or
cells when you insert new rows, columns, or cells. This button enables you
to customize the formatting of these cells in Excel. Excel formats added
rows by default to match the formatting of the cells in the row above. Hover
your cursor over the icon, then click the drop-down arrow to see more
choices.

Deleting rows and columns



To delete a row, click on the row you want to delete, right-click and select
Delete. Also, to delete a column, click on the column you want to delete,
right-click and select Delete. Note that it is very important to know the
difference between removing a row or column and merely erasing its
contents. Right-click a heading, then pick Clear Contents from the drop-
down menu to delete the content from a row or column without causing
others to shift.

Changing column widths

To do this, simply place your mouse cursor over the column line in the
column heading. When you do this, the mouse cursor will change to a
double arrow.

Then, click and drag the mouse left or right depending on how you want it
to be. Then, release the mouse.



Changing row heights

Place your mouse cursor over the row line. The mouse cursor will turn to a
double arrow.

Then, click and drag the mouse up or down. Let go of the mouse.

Hiding rows and columns

Simply choose the column(s) or row(s). Then, right-click on it and select
Hide.

This action will hide the column. You will see a green line on the worksheet
after you have hidden the row/column. The green line shows where the
hidden column or row is.



To unhide the column or row, move your cursor in-between the two
columns where the hidden column was i.e. on the green line, then right-
click and click Unhide.



CHAPTER FOUR

WORKING WITH EXCEL RANGES AND TABLES

UNDERSTANDING CELLS AND RANGES

A cell range is a collection of cells that you choose to employ in functions
and operations. A cell range is a  set of chosen cells. This range is normally
symmetrical (square), but it may also be made up of individual cells. A cell
range may also be referenced in a formula.

A cell range is specified in a spreadsheet by the reference of the upper-left
cell (minimum value) and the reference of the lower right cell (highest
value). When different cells are eventually added to this selection, the range
is referred to as an irregular cell range. The minimum and maximum values
are supplied in Excel. A mathematical range, on the other hand, is a
collection of values between a maximum and lowest value.

Select Single Cell Range

The intersection of the row and column in Excel is referred to as a single
cell. When you click on any cell on the Excel sheet, you'll see a column
name and a row name.

Let's look at the picture below as an example. The intersection of column B
and row 3 is the cell chosen below. The cell may be interpreted as B3,
which is a mix of row and column names.

Selecting complete columns



When you select all column cells in Excel, the range is also described. You
may use either your mouse or your keyboard to pick all the cells in a
column, depending on your preference. The techniques for selecting all
column cells are shown below.

Mouse

●      Click the column cell name with the mouse.

Keyboard
●      Pick the column for the cell.
●      Press and hold the 'ctrl' key while pressing the ‘space' key.

Assume you wish to pick the cells in column C in the picture above. Simply
click on the C column name.

With the keyboard, go to column C. Then, while holding the ‘control key’
hit the ‘space' key on your keyboard.

Selecting complete rows

With the mouse, click the row letter of the cell.
With the keyboard, use the arrow keys to move to the cell.
Press the ‘shift' key and hit the ‘space' key to select a row.



To choose a row, as shown above, do so. You must click the row's name.
You may also use your keyboard shortcut to choose a row. Using the arrow
keys on your computer, go to any cell in row 6. Now, while holding down
the ‘shift' key, press the ‘space' bar on your keyboard.'

Selecting noncontiguous ranges

To choose noncontiguous ranges, follow the procedures outlined below:
●      Using the mouse, click on the start cell.
●      Press and hold the Control key on your keyboard.
●      Select the cells you wish to select by clicking on them.

Assume you wish to choose the range (A1:C4, C6, E3, E5) shown in the
figure above. Using the arrow keys on the keyboard, click or visit the initial
cell. Now press C4 while holding down the 'ctrl' key. With the Control key
held down, click C6, E3, and E5 cells again to select them.

Selecting multi-sheet ranges

It's a technique for picking many cells in a certain pattern, such as squares
or rectangles. This approach may be used to pick both tiny and big areas of



cells. Follow the procedures shown below to choose your pattern.
●      Use the mouse or keyboard to go to the first cell.
●      Press and hold the ‘Shift' key on your keyboard.
●      Select the last cell.

Assume you wish to choose the range (A1: D6), as shown in the figure
above. To begin, use your mouse or keyboard to go to cell A1. Now press
the ‘shift' key on your keyboard and click cell D6. As seen in the graphic
above, this will choose the needed cell range.

Selecting special types of cells

You may copy, move, remove, color, fill, and protect specific cells on a
sheet, such as cells holding Constants, Formulas, blank cells, and more. To
select particular cells, follow these steps:

●      Press Control key + G on your keyboard.
●      This opens up the Go to the dialog box. Click on Special.



●      Click OK after selecting one of the available buttons.

Selecting cells by searching

●      Press Control key + G on your keyboard.
●      Type in the cell and click Ok.

COPYING OR MOVING RANGES

There are different ways to copy and move ranges in Excel. In Excel,
copying and pasting a cell is simple. When it comes to copying and pasting
a collection of cells, columns, or rows, there are ways for it.

Copying by using Ribbon commands

Click on the cell range heading (row or column). Select Copy from the
home tab. To copy as a picture is possible also.



Copying by using shortcut keys

To copy a range of cells, use Control key + C simultaneously after choosing
the range of cells. Choose a range of cells in which you wish to paste it
again, and then click Control key + V to paste it. This is the most
convenient method for copying and pasting several cells at once.

Other shortcut keys are Control key + D and Control key + R. Control key
+ D is used for copying and pasting data downwards. It can also copy the
values of a full column. To do this, choose any range of cells that are in the
same column as the cell you want to replicate.

Now, press Control key + D. this action will copy the values downwards.



Control key + R also does the same action, but this time, it copies the
values to the right-hand side. This shortcut works well for rows. To do this,
simply click on the cell range, but this time you are not choosing from the
bottom up, choose the cells from the right.

After you have selected it, press the Control key + R.

You may also duplicate a single value to several cells using another
shortcut. Control key + Enter is the shortcut. To do so, pick a few cells on
your worksheet and type any term or value into any of them. After selecting
the cells, press Enter to put in a value in any of the cells.



Now, press the Control key + Enter.

Copying or moving by using drag-and-drop

For copying a set of values for columns, rows, or a range of cells, we will
make use of the Fill Handle option. To do so, enter some values in the
appropriate cells. Select the cells after inputting the data. The value is
surrounded by a green box.

In Excel, this green area is called the Fill Handle. Drag the fill handle down
to replicate these values for a range of cells by hitting the "+" symbol that
appears in the bottom right corner of the fill handle.

Once you stop dragging the handle, you will get the result, as you can see
below.



Copying to adjacent cells

So in our example below, there are data in range A1:C7.

Column D is empty and it will consist of the total score of the table. To do
this, we are to copy and paste the formula for that. Now, in Cell D2, enter in
this formula “=B2+C2”, then press Enter. As you can see in the image
below;



Then, using the fill handle, drag down and release to fill in the empty cells.

Now, we want to copy a range of cells to the adjacent side. So, select the
range of cells. In this example, we want to copy the Total Score column. To
do this, we will select the cell on the right-hand side which is Cell E. when
you select it, press Control key + R.

Using the Office Clipboard to paste

You may copy up to 24 things from Office documents or other applications
and paste them into another Office document using the Office Clipboard.
You can paste text from an email message, data from a workbook or
datasheet, and a graphic from a presentation into a document, for example.
You may organize the copied objects in the document as you wish using the
Office Clipboard.

When you utilize the Clipboard task window, you're not restricted to
copying the last thing you copied or cut. Many of the last pictures and text
you copied or cut are stored in the Clipboard task window. First, Open the
Office Clipboard. On the Home tab, click on the Clipboard dialog box
launcher.



Now to copy and paste, follow the steps below;

Open the file from which you'd want to copy things.
Select the first thing you wish to copy and click CTRL+C on your
keyboard.
Continue copying stuff from the same or other folders until you've
gathered all you desire. Up to 24 things may be stored on the Office
Clipboard. The initial item on the Office Clipboard gets destroyed
after you copy the twenty-fifth item.
Now, open the clipboard pane. On it, you will see all the things
you’ve copied. You can select each item to paste or you can paste all
of them. So, to paste one item, click on the item. to paste all items,
click on the Paste All box on the clipboard pane.



Pasting in special ways

When a conventional copy/paste isn't suitable, Excel's Paste Special
provides a variety of choices, such as pasting just certain portions of copied
cells or performing a mathematical function on the copied data.

All of the Paste Special options are shown in the image below:

Using the Paste Special Dialog box

This is an easy process. Select the cell or range of cells and right-click on
the area you wish to paste the item on the workbook and select Paste
Special. This will open up the Paste Special Dialog box where you have a
list of options on how you can paste the copied item.

Skipping blanks when pasting



So, we will make use of the Paste Special Skip Blanks Option to do this. As
you on the image below, range B1:B10 has some blank spaces in its cells.
So we are going to copy the range and skip those blanks. So, copy Cell B.

Now, select cell A1. Right-click on it and select Paste Special.

Check the box on Skip Blanks and click Ok.

USING NAMES TO WORK WITH RANGES

However, there are certain key requirements for naming named ranges in
Excel that you should be aware of before you begin:

a. There are no spaces allowed in names. Instead of using a space, you
might use an underscore character (such as Annual Total).

b. You may name the range with any combination of alphabets and
digits, but it must begin using a letter symbol. A number cannot begin
a name.

c. Except for underscores and periods, no other symbols are permitted.



d. Although names are restricted to 255 characters, it is best to make
them as brief as possible while still being relevant and clear.

Excel also keeps a few names in reserve for internal use. Although it is
possible to construct names that override Excel's internal names, this is
something you should avoid.

Creating range names in your workbooks

Choose the cell or range. Click the Formula tab on the ribbon. Navigate to
the Define Names section. Click the down arrow and select Name
manager.

Click on New. This opens up the New Name dialog box.

In the Name box, type a name (Excel can display the name if you selected a
data range with a heading line). In the area labeled Refers to, the active or



chosen cell or range address shows. To add the name to your spreadsheet
and exit the dialog box, double-check that the address provided is accurate.

Using the Name box to construct a name is a quicker option:

Choose the cell or range, then input the name. Press Enter. (If you input a
name and then click on the worksheet, Excel will not assign the name to the
chosen range.) You can't modify the range that a name refers to if it already
exists. Instead of selecting the range, attempting to do so choose it.

For instance:

If your formula contains named cells or ranges, you can either input the
name instead of the address or select a name from a table, then Excel
will automatically insert it. Names and Values are two specified names on
the worksheet.

Using the Create Names from Selection dialog box

You may rapidly generate names for numerous cells by using existing row
or column labels. Choose the cell range and labels. In the Defined Names
group of the Formulas tab, pick Create from Selection.



Select the place of the text and click OK.

ADDING COMMENTS TO CELLS

Let's say you've gotten an Excel document from someone and you'd want to
provide comments, make edits, or ask questions about the data. Writing a
comment to a specific cell in the worksheet is a simple way to do this.
Because it doesn't modify the data, a comment is typically the easiest
approach to add extra information to a cell.

This tool is also useful for explaining formulae to other users or describing
a specific value. You may use an image instead of words to describe
something in a comment. Follow the steps below to add comments to cells.

First, choose the cell you would like to add a comment on.
On the ribbon, click on the Review tab, then select New Comment.



This will display a small box on the screen. Type in your comment in the
box. When you are done, click on any cell.

The comment box will disappear. But you will notice a red mark on the
column you have just added a comment. That red mark indicated that the
cell contains a comment. When you hover your mouse cursor on the cell, it
will display the comment.

Shift key + F2 will perform the same action here.

Formatting comments

To format the comments, hover your mouse cursor to the cell to display the
comment box. Once it has been displayed, right-click on it and select



Format Comments. This will bring up the Format Comment dialog box.
After formatting, click Ok.

Changing a comment’s shape

By default, the shape of the comment box is a rectangle. You can decide to
change this shape. You will add a tool to the Quick Access Toolbar. So,
click the down arrow on the Quick Access Toolbar and select More
Commands.



On the Choose commands from option, hit the down arrow and select
Drawing Tools |Format Tab. From the list of commands below the
options, select Change Shape. Then, click Add and click Ok.

The shape icon will be added to the commands in the Quick Access
Toolbar.

At first, the shape icon won’t be accessible. So, you have to first work on
the comment box. Click on the comment box and move your cursor around
it until it switches to the four-headed arrow. Then, click.



The shape icon will be accessible now. So, click on it. This will display a
box that consists of different shapes. Select any shape.

Resizing comments

Most times, when you change the shape of the comment box, the text inside
will no longer fit into the comment box. You can solve this issue by resizing
the comment box. To do this, click on the comment box, then click on the
sizing angles around it (the small transparent boxes) and then drag it to the
size you want.



Hiding and showing comments

Simply click on the Review tab and select Show All Comments.

To hide the comments, click on Show All Comments the second time.

Editing comments

Right-click on the cell that has the comment on it and selects Edit
Comments.

This opens up the comment box. Now, you can click on it and start making
changes to it or you can right-click and select Format Comment to make
more edits.

Deleting comments



You may not want a comment to be on a cell again and you want to delete
it. Right-click on the cell, then select Delete Comments from the options.

Also, do this with the Review Tab. Select the Delete icon.

WORKING WITH TABLES

Microsoft Excel makes it simple to create tables and do computations. Its
working area consists of a series of cells that must be filled with
information. As a result, the information may be structured and utilized to
create graphs, charts, and summary reports.

Working with tables in Excel may seem hard at first look to a novice. It
varies significantly from Word's table creation concepts.

Understanding a table’s structure

A table in excel consists of many elements which are explained below;

The header row

Every table in Excel consists of a header row. The columns in a table have
filtering enabled in the header row. This is to enable you to filter your table
as well as sort it easily.

Calculated columns

You may build a calculated column by inserting formula in one cell in a
table column and having that formula automatically applied to all other
cells in that table column.

The total row

When you add a total row to a table, Excel provides an AutoSum drop-
down list from which you may choose among functions like SUM,
AVERAGE, and others. When you choose one of these choices, the table



will convert it to a SUBTOTAL function, which by default ignores rows
that have been concealed by a filter. You may adjust the SUBTOTAL
function parameters to include hidden rows in your computations.

Creating a table

Tables in Excel are useful for providing data collections structure. It
contains several useful features, such as data organization, headers, and
applied filters. Tables may be accessed via the Insert menu tab or the
shortcut key Control key + T. All we have to do now is choose the range of
cells we want to include in the table. The Design tab, which appears when
we pick the table, allows us to adjust table styles. Follow the steps below to
create a table.

Choose the cell or range you want to create the table on.

Click on the Home tab, then click on Format as Table. This will display a
menu that consists of some table styles. Choose any style you want.

When you click on the style you want, a dialog box will open. Check the
box on the My table as header (Checking this box makes the first row of the



range the header row) and click Ok.

Sorting a table

One of the most frequent data management tools is sorting. You may sort
your table in Excel by one or more columns, ascending or descending order,
or by performing a custom sort. First, click on the cell. Then, click on Sort
& Filter.

You will have different sorting options.

Sort A to Z: This is to sort in ascending order
Sort Z to A: This is to sort in descending order



Custom Sort: This is for applying various sort criteria in multiple
columns.

Click on Custom Sort, then click Add Level.

Then, enter in how you want it to be sorted. Once you are done, click Ok.

Filtering a table

Click on cell on your worksheet. On the ribbon, click on the Data tab, then
select Filter.

Now, click on the arrow on the column header.

Then, click on Number Filters. Select any filter option.



Filtering a table with slicers

Adding Slicer filters to your tables may dramatically boost the usability of
tables by allowing you to filter table data more quickly and simply. Choose
the table for filtering. Then, click on Insert Slicer. You can find the Insert
Slicer on the Design tab on the ribbon.

When you click on Insert Slicer, it opens up a dialog box. On it, you are to
check the boxes of the field in the table in which you want to filter with a
slicer.



Then, click Ok.

Tables are among Excel's most powerful features, but when you add
Slicer filters to them, you significantly increase their use by allowing you
and your team to swiftly filter tables without having to utilize the typical
drop-down filter environment.

Changing the table’s appearance

What's the first thing you'd want to do with an Excel table once you've
generated it? Make it appear just how you want it to!

To do this, simply select the table, click on the Home tab, then click on
Format as Table. This will display a menu that consists of some table
styles. Choose a style.





CHAPTER FIVE

FORMATTING WORKSHEETS

GETTING TO KNOW THE FORMATTING TOOLS

Using the formatting tools on the Home tab

When you're thinking about how to design a spreadsheet, it's helpful to
know what tools you have at your disposal. What tools alter the appearance
of a worksheet?

Italic, Underline, and Bold: These three tools are fundamental options.
You see them almost in any text editing tool.  Just highlight the text or
sentences and click on any of these tools.

Borders: Borders are useful for segmenting your data and separating it
from other portions in your worksheet. The border tool in Excel can create a
variety of borders, but it might be difficult to use at first. Begin by
highlighting the cells to which you wish to apply a border. Select one of the
built-in styles from the Borders dropdown menu.



Shading: Shading, commonly known as fill, is a color applied to the cell's
backdrop. To apply shading to a cell, click and highlight the cells you wish
to shade.

Then, on the Font tab of the Home ribbon, click the arrow next to the paint
bucket option. To apply a color to a cell, choose one of the several color
thumbnails. I'll also utilize the More Colors option to launch a full-featured
color choosing window regularly. The easiest way to make writing legible
is to use light tones.



You may use shading to emphasize important data once again. One
suggestion is to utilize a constant fill depending on the data of the cell, such
as blue for every "input" field where you manually enter data, as I indicated
previously.

Don't go overboard with the shading. When you apply too many of these to
your cells, it detracts from the information provided in the spreadsheet.

Alignment: How the contents of a cell are aligned to the edges is referred
to as alignment. Text may be aligned to the left, center, or right. In a cell,
content is left-aligned by default. When working with huge data sets, you
may wish to experiment with alignment to improve readability.

Text on the left border of a cell is a regular change I make, whereas numeric
quantities should be right-aligned. Also, when column headings are
centered at the top, they look fantastic.

The three alignment buttons on the Alignment tab of Excel's Home ribbon
may be used to change alignment. You may also modify whether the
content aligns towards the top, middle, or bottom of the cell by aligning it
vertically.

Using the Format Cells dialog box

When formatting a cell value from General to Number, Accounting,
Currency, etc., Format Cells is mostly used to do this. Format Cells allow us
to modify the formatting of a cell number without affecting the actual
number. We may modify the quantity, alignment, font style, Border style,
Fill options, and Protection in Format cells.

Also, use Control key + 1 to open it.  You can also use the Shift key + F10
as well as right-clicking on the cell you want to format and select Format
Cells. On the Format Cell box, you will see six tabs which are Number,
Font, Border, Fills, Protection, and Alignment.



Simply select the cell or range. Press the shortcut keys listed above, open
the box, and then click on any of the tabs depending on your format style.
Once you are done, click Ok.

Formatting your worksheets

Worksheets are often dismissed as dull, utilitarian tools. They are, without a
doubt, quite helpful for organizing data and doing computations. That
doesn't mean we can't add some flair to our spreadsheets with some Excel
styling.

When we format a worksheet correctly, it gives a second layer of
significance to it. Formatting isn't a haphazard process; it's a technique of
applying certain styles to indicate the kind of data in a cell.

Using fonts to format your worksheet



1.  Font — Changes the font of the currently selected cell (s). Fonts are
several methods of displaying the same letters.

2. Font Size – Controls the text size (the font). Font size is proportional to
the size of the number. In this box, you may write a custom size. You may
use the numbers 1 through 409 in Excel, including half sizes.

3. Change Font Size – Increases the font size.

4. Reduce Font – Reduces the font size.

5. Bold – Highlights the chosen cell(s). Control key +-B and Control key
+-2 are shortcut keys.

6. Italic – Italicizes the chosen cell(s). Control key +-I and Control key +-3
are shortcut keys.

7. Underline — Highlights the chosen cell(s). Control key +-U and Control
key +-4 are shortcut keys.

8. Borders – For the specified cell, add and remove borders (s). The down
arrow will bring up a large list of border options. Click More Borders... for
more border options.

9. Fill Color – Changes cell background color. The cells have "No Fill" by
default.

10. Font Color — Modifies the font color

11. Format Cells — This button brings up the dialog box.

Wrapping or Shrinking text to fit the cell



When text does not fit inside a cell and overflows to nearby cells, or even
when text extends to the next cell, this is one of the problems encountered
by Excel users.

Furthermore, when there is material in the neighboring column, Text is
sometimes cut-off. Because of the column's narrow width, all of the
contents of the cells are not visible in the image below, however, you may
always change the width. You'll also come across hyperlinks that don't fit in
the cell.

Purpose of Wrap Text

Wrap Text ensures that all of the texts in a cell remain inside the cell's
bounds, ensuring that all of the cell's contents are visible to readers. So, to
do this, simply

Click on the Cell(s) or Range. On the Home tab, on the Alignment group,
click on the Wrap Text option.



The breadth of the cell remains constant, but the cell is made taller than
previously to ensure that all contents are contained inside the body of cells.
As a consequence of this operation, the text in Excel will move down rather
than across.

Shrinking text

Consider the case when you don't want to raise the cell size horizontally or
vertically to fit the text inside the cell boundaries. You may utilize Excel's
'Shrink the text' option in such cases. To use this, the first thing you are to
do is to unwrap the text you have wrapped. Select the cell and click on
Wrap Text. 

Right-click on the cell or range.

Click on Format Cell. On the Alignment, tab selects the box Shrink to fit.



Do you notice how the type size of the contents in the cell changed? This
effect will not affect the cell boundaries; width and height of the cell.

Merging worksheet cells to create additional text space

Once you have opened your worksheet, choose the cells for merging.

Select Merge & Center on the Home tab. This will merge the cells and will
center the content. Click the down arrow on the Merge & Center option to
see other merging options.



Displaying text at an angle

Using an angle for your text, particularly for column and row headings,
maybe aesthetically pleasant. You may swiftly rotate the text in either a
clockwise or counterclockwise direction. Simply follow the steps below;

Click on the cell or range of cells.
Click on the down arrow near the ab (with an arrow below) symbol in
the alignment group.
Choose either Angle Counterclockwise or Angle Clockwise from
the top two choices.

Using colors and shading

First, select the cells, then press Control key + 1 to launch the Format Cells
dialog.

Click the Font tab. After choosing font color, click ok. In the image below,
I changed the color of the Total Score 2 column to blue.



To fill the cells with color, select the desired cells. Launch the format cells
dialog box. Click on the Fill tab and select a color, then click Ok. This
formatting draws attention to the column headings and the data in the total
score column.

Adding border lines

Highlight the cells. Click on the drop-down arrow.

So, select the kind of border you want to add and where you want to add it.



Using conditional formatting

In Excel, conditional formatting is used to emphasize data based on certain
conditions. It would be tough to see different patterns merely by looking at
your Excel worksheet. In Excel, conditional formatting allows you to
visualize data and make spreadsheets more understandable. It enables you
to add formatting to cell values such as colors, icons, and data bars based on
the cell values.

It makes it simple to scan your data and check for vital signs graphically.
With numerical data, conditional formatting works best. Simply choose a
column of data and make sure you're on the Home tab of Excel's ribbon to
get started. From the Conditional Formatting dropdown menu, you may
choose from a variety of styles. Each of the formats your cells in a different
way, but they all adjust to the cells you've highlighted.

Using graphical conditional formats

Data bars, color scales, and icon sets are the three conditional formatting
choices for displaying graphics. These sorts of conditional formatting might
help you see a range of numbers.

Using data bars

Horizontal bars are shown directly in the cell using the data bars conditional
format. The length of the bar is determined by the cell's value in
comparison to the other values in the range. To do this, simply select the



column or row. Click on Conditional formatting and select Data bars
which will display a list of different data bars for you to select from.

Pick one and the effect will be applied on your worksheet.

Surprisingly, the colors used for data bars are not theme colors if you pick
one of the 12 data bar types. The data bar colors do not change when you
alter the document theme. However, if you use the New Formatting Rule
dialog box to add the data bars, the colors you pick are theme colors.

Using color scales

Select the column or row. Click on Conditional formatting and select
Color Scales which will display a list of different color scales for you to
select from. Select one and it will be applied to your worksheet.



Using icon sets

Select the column or row. Click on Conditional formatting and select Icon
Sets which will display a list of different icon sets for you to select from.
Select one and it will be applied to your worksheet.

Creating formula-based rules

Formulas are a more powerful technique to apply conditional formatting
since they enable you to apply rules based on any reasoning. Excel comes
with a plethora of "presets" that makes it simple to establish new rules
without having to use formulae.

Although Excel comes with several "presets" for conditional formatting,
they are restricted. You may, however, construct rules using your unique
formulae. You may take over the situation that activates a rule and apply
precisely the reasoning you need by creating your formula. Formulas
provide you with the greatest amount of power and versatility.

To create formula-based rules, simply choose the cells. Then, on the Home
tab, click on Styles > Conditional Formatting > New Rule. This will open
up the new formatting rule dialog box. Click on the Use a formula to
determine which cells to format option, and then type in the formula.



The formula has to be logical. It must return either TRUR or FALSE. When
it is true, the conditional formatting will apply but when it is false, it will
not apply. Note that the formula must start with an equal to (=) sign.

Understanding relative and absolute references

There are several types of cell references in Excel formulas, some of which
we have listed below.

Absolute cell references: (Those preceded by a $ sign, such as $A$1) are
always consistent, regardless of where they are copied.

Relative cell references: (Those without the $ sign, such as A1) alter
depending on the relative location of the rows and column when replicated
over several cells.

Mixed cells references: This is the absolute column and relative row
($A1), or relative column and absolute row (A$1). These are mostly used in
conditional formatting rules to indicate that a column letter or row number
should be fixed when a rule is applied to all other cells in the chosen range.

In conditional formatting rules, cell references are tied to the specified
range's top-left most cell. Simply create a formula for the top-left cell when
establishing a new rule, and Excel would "replicate" your formula to all of
the other cells in the given range.



Relative references: Every cell references are a relative reference by
default. When you copy them on many cells, they will adjust depending on
the relative location of the columns and rows. Now, let’s create a formula
and copy it using relative references.

From the image below, we will create a formula that will multiply the
student’s score on the first day by the student’s score on the second day. So,
we will create the formula in cell E2. So first, select cell E2.

On the cell, we will put in the formula which will calculate it for us. The
formula here is =B2*C2.

After typing in the formula, press Enter. Now, drag the fill handle to the last
cell on the column. This will copy the formula to the cells with relative
references and fill in the rest of the column with the calculated answer.

When you double-click on the cells, you will see their formula. The relative
cell references will differ from each other (that depends on their rows).



Absolute references

Maybe you may not want your cell reference to change when it is copied to
other cells. In relative references, it changes, while absolute references
don’t change when it's copied. You use this to make your row or column
remain constant.

Conditional formatting formula examples

Assume you choose the range A1:B10 and want to apply formatting to any
cells in the range that are greater than the value in cell C1. Fill in the
following conditional formatting formula:

=A1>$C$1

The reference to cell C1 in this example is absolute; it will not be altered for
the cells in the chosen range. To put it another way, the conditional
formatting formula for cell A2 is as follows:

=A2>$C$1

The absolute cell reference is not changed, but the relative cell reference is.

After choosing the Use a Formula to Determine Which Cells to Format rule
type, each of these examples employs a formula written directly into the
New Formatting Rule dialog box. You get to choose the sort of conditional
formatting you want to use.

Identifying weekend days

Although Excel has a variety of conditional formatting rules for dates, it
does not allow you to identify dates that fall on a weekend. To get weekend
dates, use the following formula:



=OR(WEEKDAY(A1)=7,WEEKDAY(A1)=1)

This formula supposes that you've chosen a range and the active cell here is
cell A1

Highlighting a row based on a value

In my example below, I want to highlight the records that contain
everything about Bob.

So, I highlight the entire worksheet, select Conditional Formatting (Home
tab) and select New rules. Choose the “Use a formula to determine which
cells to format” option. On the box, below it, type in this formula =$C2=”
Bob”



e

Then, click on the Format option. Click on the Fill tab and choose a color
that you want it to be highlighted with. Then, click Ok.



This will be the result.

Explanation

Conditional Formatting examines each cell for the condition we've set,
which is =$C2=" Bob" in this case. As a result, it will check whether cell



C2 contains the name Bob or not while inspecting each cell in row A2. If it
does, that cell is highlighted; if it does not, it is not.

It's important to note that the dollar symbol ($) comes before the column
alphabet ($C1). By doing so, we've ensured that the column will always be
C. When cell A2 is tested for the formula, it will also check cell C2, and
when cell A3 is examined for the condition, it will also check cell C3. By
using conditional formatting, we can highlight the whole row.

Displaying alternate-row shading

Pick a range. Click on Conditional Formatting and select New Rule.

Click on “Use a formula to determine which cells to format”

Type =MOD(ROW(),2).

Click Format to choose a style. Click Ok.



How does it work?

The residual of a division is returned by the MOD function. The ROW()
method returns the number of rows in a table. For instance, MOD(7,2) = 1
for the seventh row since 7 divided by 2 equals 3 with a leftover of 1.
MOD(8,2) = 0 for the eighth row since 8 divided by 2 equals 4 with a
residual of 0. As a consequence, all odd rows will be darkened if they return
1 (TRUE).

Creating checkerboard shading

First, choose a range of cells and follow the steps above. On the formula
box, type in this formula =MOD(ROW(),2) =MOD(COLUMN(),2). Click
on Format and select a color. Click Ok.



Shading groups of rows

To shade rows in excel, formulas to be used will be based on CEILING,
ROWS, and ISEVEN. The formula for it is =ISEVEN(CEILING(ROW()
–offset, n)/n).

n stands for the number of rows in a group
offset stands for the number used to normalize the first row.
So to shade group pf rows, simply follow the steps above and on the
formula box, type in this formula =ISODD(CEILING(ROW)
-5,3)/3).

Working with Conditional formats

We'll go through the basics of building a new conditional formatting rule in
the example below. Although there are several forms of conditional
formatting, the core processes are the same for all of them. Let's have a look
at what we've got.

In the image below is a table that consists of the scores of a group of
students. Now, we will create a conditional formatting rule which will
highlight the test scores that are over 70. We will make it highlight it with
the green color. To do this, follow the steps below;

First, choose the cells you want to format. On the Home tab, click on
Conditional formatting. From the list of options there, click on the
Highlight Cells Rules, then select Greater Than.



Type in 70 and select the green color. Click Ok.

After you have clicked Ok, the rule will be created and you will see the
result on your worksheet.

To access the conditional formatting rule, which you have created, click on
Manage Rules on the conditional formatting menu. if the selection has
cells that have conditional formatting applied to it, the rule will display in
the Rules Manager window.

But if the current selection has no cells which have conditional formatting
applied to it, then, the rules will not display. So, to make it display, click on
the drop-down arrow on the “Show formatting rules for” option and select
“This Worksheet”. It will display all the rules and conditional formatting
you have applied to that worksheet.



You may use the following steps to develop an excel formula for
conditional formatting:

●       Select cells or columns to format. If you wish to apply formatting to
an entire row, however, you may pick numerous columns or the
whole table. More data may be added by transforming cells into
tables using the Insert tab and then choosing some empty rows below
one's data.

●      Select New Rule from the Conditional Formatting menu.

●       Select Use a formula tab to decide which cells to format under New
Formatting Rule.



●       The formula may then be typed in the appropriate area. Pick the
Format option to select a custom format.

●       The Font, Border, and Fill tabs may be switched to experiment with
choices such as font, style, and fill color. Under the More Colors
option, one may also choose a chosen color from the RGB or HSL
charts and then click Ok.

●      Once the preview section has shown the required format, select the Ok
button to save the rule. If the results aren't what you're looking for,
click Format and start modifying.

When changing a conditional formatting formula, always hit the F2 key,
then use the arrows to go to the desired location inside the formula. F2 is
pushed a second time while adding a cell, and then the cell is clicked.



USING NAMED STYLES FOR EASIER FORMATTING

Applying styles

First, choose the cell or range of cells. Below the Conditional Formatting
option, click on Cell Styles. On the menu that opens, select a style.

Modifying an existing style

Right-click on it and select Modify.



A box appears containing different modifying options. Click Format to see
the rest of the options.

Creating new styles

Choose the cell, click on Cell Styles. Pick New Cell Style.

Enter style name. Select Ok. The style will be saved.

Merging styles from other workbooks

Most times, when people create styles, they like to use them in other
workbooks. You can easily do that. First, launch the workbooks that have



cell styles. Also, launch the other workbook that you will like to merge the
style with.

Click on Cell Styles and click on Merge Styles. This opens up the Merge
Style dialog box. Choose the workbook and click Ok.

Controlling styles with templates

In your Excel Start folder, save the workbook as a template. After that, click
File, click New to select a template for the new workbook. Template files
may also hold additional named styles, which is a great method to keep
your workbooks looking consistent.

UNDERSTANDING DOCUMENT THEMES

Themes are built-in and customizable functionalities in Excel that allow
you to customize the look of your worksheet. In Excel, there are numerous
themes, each of which has 12 colors and two fonts (heading and body).  The
themes make it simple to coordinate colors, fonts, and visual formatting so
that they may be utilized and modified quickly.

A standard color theme may be chosen, a custom color theme can be
created, theme fonts can be changed, a specific theme can be converted to a
new theme, a custom theme can be saved for reuse, and numerous
adjustments to the preset themes can be made using Excel themes.

Applying a theme



Click the Page Layout tab. You will see the Theme option. Click the down
arrow on the Theme option. You will see different themes to apply to your
workbook.

Customizing a theme

To customize a theme, click the down arrow on any of the color, fonts, or
effects options and select Customize.



From the Create New window, make your theme using the options there.
You can add text background, Accents, Hyperlink, etc.



Once, you are done, click Ok.



CHAPTER SIX

UNDERSTANDING EXCEL FILES AND TEMPLATES

Users may build a new workbook from a blank document in Excel 2022.
They also have the option of creating a new worksheet from an existing
one. A new workbook comes with three worksheets by default. We may,
however, adjust the number of worksheets in a workbook to meet our needs.

Creating a new workbook

To create a new worksheet, simply launch Excel on your computer, click on
File and select New. Then, click on Blank workbook.

Opening an existing workbook

An existing workbook is a workbook that has been saved already and stored
in the computer or cloud. You can open it from your drive or online. To
open the file, click on File and select Open. Click Browse. A pop-up menu
will appear where you will search for the file. Select the file and click
Open.

Choosing your file display preferences

Click on File, then select Browser View Options. Click on the Show tab,
then on the down arrow and select Sheets.



Pick the worksheets from the list, press Ok.

Saving a workbook

Click on File > Save. Select a location where you want to save the
workbook. Type in the name for the workbook, then click Save.

Using AutoRecover

When Excel stops response or it shuts down, AutoRecover automatically
recovers the last saved work and will open the file. It will give you two
options to choose from which are: to maintain the changes in the documents
or dismiss them if we have already saved the data. This helps a lot because
it prevents us from losing important data.

It only retrieves files that have been saved. The workbook must have been
saved in the system or computer at least once.

Enabling AutoRecover in Excel

Select File, select Option. On the options menu, click on Save.
AutoRecovery options are on the right. 



By default, it is already enabled. If yours is not, enable It and click Ok.

Recovering versions of the current workbook

So first of all, launch the workbook which you want to recover. Select File
> Info > Manage Versions. On it, you will find the automatically saved
versions with the time beside it.

Recovering unsaved work

Click File > Open > Recent Workbooks. Scroll down, then click Recover
Unsaved Workbooks.



Click on the workbook for recovering.

Configuring Auto recover

By default, your files are backed up by Excel every ten minutes. You can
decide to change these settings. simply click on File > Options > Save >
Save Workbooks.

Password-Protecting a Workbook

Excel, however, provides three distinct levels of data protection. This
prevents data from being accessed or edited without a password. Follow the
steps below to protect your workbook.

Click on File > Info. Click on Protect Workbook. Then select Encrypt with
a password.



This will open up a password box. Enter in the password and click Ok. You
will be asked to confirm the password again. Click Ok. Once you are done,
you will see the Protect Workbook option as it has been highlighted stating
that a password is needed for the workbook.

Organizing your files

Microsoft Excel is a spreadsheet-based tool that employs functions and
formulae to help you manage figures and data. There are ways to discover a
solution to assist you to organize your worksheets.

1. Templates: You shouldn't spend time re-creating Worksheets from
start every time you need to evaluate data. Instead, Microsoft Excel
comes with a large number of user-created templates. Simply select
one of the numerous templates available in Excel by going to File >
New. Of course, selecting a template that exactly matches your data
analysis method may be tough.



2. Multiple Sheets: When dealing with anything complicated or with
much data, use multiple sheets for your works. Divide your data into
different worksheets and name each one appropriately. This will make
it simple to locate the information you want.

3. Highlighting the essential data: You always should emphasize the
most critical information while using any management application.
When working with Excel, this is particularly true if you have a full
team working on a single spreadsheet. One of the simplest ways to
achieve this is to construct a dashboard sheet that summarizes your
major data elements. Furthermore, you should always maintain your
vital information in a legible font and use conditional formatting to
provide heights and colors to important cells.

4. Sorting Data: Knowing how to categorize/sort your data is an
important element of data analysis. It makes no difference whether
you wish to order the names alphabetically or list the goods from
cheapest to most expensive. Sorting your data can aid you in better
understanding and visualization of your data. You may arrange your
data alphabetically, numerically, by built column list, formatting, an
icon set, or by time and date in Excel.

5. Hyperlink cells: A times, you will often spend time digging through
all of the worksheets for a specific bit of data. However, this does not
have to be the case. Rather, you may give your relevant cells names
and create hyperlinks between them in your sheets to help you
navigate the data. 



OTHER WORKBOOK INFO OPTIONS

When you click on File and select Info, you will see different options on the
Info menu. those options are explained below.

Protect Worksheet options

This option allows you to control the type of changes that people can make
to a workbook.

Check for issues options

This is to inspect your workbook, check accessibility, and check
compatibility.



Manage workbook option

This is to check in, check out, and recover unsaved changes on your
workbook.

Browser view options

This determines what users can see on your workbook when viewed on the
internet.

Compatibility mode section

This helps you to create documents that can be viewed by everyone. Since
Excel has been there for years, it has a variety of versions. As a result,
documents created in later versions might not be compatible with older
versions. It is dependent on the content of a document, which is a difficult
factor to consider. For instance, a feature developed in Excel 2021 will
almost certainly not work with Excel 2013. The majority of Excel users,
however, are unaware of this.



Microsoft implemented Compatibility Mode to Excel to address the
problem. Your workbook in compatibility mode will be readable in former
versions of Excel. Compatibility Mode guarantees that workbooks created
in recent editions may be viewed even if you're using an earlier version.
Some documents may show improperly or not open at all if you don't use
Compatibility Mode. When software upgrades affect the core of a program
over time, this is typical.

To save in compatibility mode, simply open the workbook, click File >
Save As >. Then, click on the down arrow on the Save As Type box. Select
the version you want.

Closing Workbooks

When a worksheet is open, and you want to close it but not the Excel
program, simply click on File > Close. Use Control key + W also. To close
every workbook that is open when you have more than one workbook open,
simply press down the Shift key as you select Close from the File menu.

Safeguarding your work



Nothing is more frustrating than working for hours on a complex Excel
spreadsheet only to have it destroyed due to a power outage, a hard drive
crash, or even a human mistake. Protecting oneself against these tragedies,
however, is not difficult.

We examined the AutoRecover option earlier in this chapter, which causes
Excel to store a backup copy of your workbook at regular intervals. It's a
fantastic concept, but it's far from the sole safeguard you should use. If a
file is critical, more precautions must be taken to protect its security. Your
work may be safeguarded using the following backup options:

●       Save copies of the documents on the same disk as a backup. As you
are saving your work, pick the Always Create a Backup option, this
is essentially what occurs. Although this option provides some
security if you make a mess of the spreadsheet, it is useless if your
whole hard drive collapses.

●      Keep a duplicate on a separate disk for backup. This assumes that your
computer has more than one hard disk. Because the chances of both
hard drives failing are slim, this technique provides greater protection
than the previous strategy.

●       Keeping a backup copy on the internet (cloud) is a good idea.
Assumes that your computer is linked to a server where you may
upload and download files. This procedure is relatively risk-free.
However, if the network server is in the same building as you, you are
in danger if the whole building burns down or is destroyed in some
other way.

Working with templates

Microsoft Excel templates are a valuable feature of the Excel experience
and a time-saving tool. Once you've produced a template, all it takes is a
few simple modifications to make it fit your current needs, and it can then
be utilized in a variety of circumstances and reused over and over again.
Excel templates may also assist you in producing consistent and appealing
papers that will wow your coworkers or superiors while also making you
appear your best.



Excel schedules, budget plans, receipts, inventory, and dashboards are all
examples of commonly used document types that benefit from templates.
What could be cooler than selecting a fully prepared worksheet with the
design and feel you desire and that you can quickly customize to fit your
needs?

Exploring Excel templates

To explore the Excel templates, click on File > New. You will see a search
box. On it, you can search for templates on the web.

Viewing templates

Choose File > New to bring up the available templates screen in Backstage
View, to see the Excel templates. You can templates maybe from your drive
or Microsoft Office Online. In the right panel, when you pick a template
thumbnail, you will get a preview.

Creating a workbook from a template

Click on File > New. On the search box, type in the template you want to
use or you click on any of the options below the search box which are the
suggested searches. You must be connected to the internet.



This will open a box, where you will see the information about the
template. Click Create.

The template will begin to download. Once it’s done, it will open up the
template in your worksheet.

Modifying a template

Open the Excel Template. Click File > Open > Browse. In the dialog box,
open the location where the template is saved. When saved in the default
save location, put this path in the Address box



C:\Users\%Username%\Documents\Custom Office Template. Press
Enter.

Click the file and select Open.

Creating a worksheet template

Create a blank workbook. Apply some data into it (if you want) then click
on File > Save > Browse. Select a location where you want to save the file.
On the Save as type box, click on the drop-down arrow and select Excel
Template.

Click on Save to save the worksheet. By default, this file will be saved in
the Template folder.



Editing your template

Click on File > Open > Browse. Click on Documents and select Custom
Office Templates folder.

Select your Template, then click Open. apply the edits you want to your
templates.

Resetting the default workbook

Click on File > Options. On the General tab, below When creating a new
workbook option, choose the options best suitable for you. When you are
done, click Ok.

Using custom workbook templates

It's simple to create your own Excel templates. You begin by creating a
workbook using the normal method, and the most difficult aspect is getting
it to appear exactly how you want it to. Because whatever formatting,
styles, text, and pictures you use in the workbook will appear in all
subsequent workbooks based on this template, it's worth spending some
time and effort in both the design and contents. You may save the following
settings in an Excel template:

●      The number of sheets and the kind of sheets
●      Formats and styles for cells
●      Each sheet's page layout and print regions
●       To make particular sheets, rows, columns, or cells invisible, use

hidden regions.



●      Protected zones to keep some cells from changing.
●       Text that should appear in all workbooks generated using the same

template, such as column labels or page headers
●       Formulas, hyperlinks, charts, photos, and other graphics are all

examples of graphics.
●       Drop-down lists, validation messages or warnings, and other data

validation features are available in Excel.
●       Options for calculations and window views, such as freezing the

header row
●      Custom forms using macros and ActiveX controls

Creating custom templates

After creating the workbook, click on File > Save as > select a location. In
the dialog box, enter the name of the template. On the Save as type box,
choose Excel Template (*.xltx). Select Excel Macro-Enabled Template
(*.xltm) if the workbook consists of Macro. As you select these templates,
the file extension in the file name field will change to the corresponding
extension.

Saving your custom templates

When saving your work as an Excel Template, the location will be changed
by Excel. It will be saved to the default templates folder (C:\Users\<User
Name>\AppData\Roaming\Microsoft\Templates). So, if you want
another location for the file, try to change the location after choosing Excel
Template (*.xltx) as a document type. Even though you choose another



location, the copy of the file will be stored in the default template folder.
So, click on Save to save your custom templates. 

 

 



CHAPTER SEVEN

PRINTING YOUR WORK

Doing Basic Printing

Print in Excel is for printing the data in the worksheet, but only to the width
that the printer option allows for chosen and available pages. The present
worksheet, active sheet, whole workbook, any chosen table, or any
specified range of worksheets may all be printed. To print your work,
simply open the worksheet, click on File > Print. On the Print setting
menu, click the arrow and pick Print Entire Workbook. Then, select how
many copies you want. Click Print.

Changing your Page View

This is an excellent way of knowing how your worksheet appears when
printed. On the page view, the functionalities of the normal view will be
there but this time you will have a few more tools like header, footer,
layouts, and more. This will help you complete your page perfectly.

Normal view

The standard view of your worksheet. How your worksheet looks when
you’ve not made any view edit on it.



Page layout view

Select the worksheet that you want to change the view. Click the View tab
on the ribbon, then select Page Layout View. Your workbook will be
displayed in the page layout view as you can see in the image below.

Page break preview

Select the worksheet. Click View, then Page Break View.



ADJUSTING COMMON PAGE SETUP SETTINGS

Choosing your printer

To print, your work, you need a printer. So, on the print page, click on the
drop-down arrow below the Printer section. You will see a list of printers,
select one from there. If you want to add a printer, click Add Printer.

Specifying what you want to print

When printing a workbook, you can decide what you want to print from
that particular workbook. When you go to the print setting menu and click
on the drop-down arrow, you will see a list of options in which you can
select how you want to print your workbook.

Below are the options you will see and what it means;

1. Print Entire Workbook: To print the whole workbook. If you have
many sheets, use this option to print them all.

2. Print Selection: For printing just the current selection in your
workbook. So, to print some portion of your worksheet, simply



highlight the areas, then select this option.

3. Print Active Sheets: To print just the active sheet i.e. the sheet that’s
being displayed on the screen. In the image below, the active sheet is
Sheet 1. So that is what you will print.

4. Print Selected Table: This option is to print the selected table on
your worksheet.

Changing page orientation

There are two types of page orientation in Excel which are Landscape
orientation and Portrait orientation. The Portrait orientation is mostly used
when you have more rows and lesser columns on your worksheet while
Landscape orientation is used when you have more columns and lesser rows
on the worksheet. You will find this page orientation on the Print setting
menu.

Specifying paper size



Click on Page Setup below the Print Setting option.

In the dialog box that opens, click on the drop-down arrow on the Paper
Size option. Pick the paper size for your workbook.

Printing multiple copies of your reports

If you want to print more copies, click on the arrow next to the Copies
option. Type in the number of copies you want and then click Print.

Adjusting the page margins

to change the page margins of your worksheet, click on the arrow on the
Normal Margin option. You will see different options for margins. Select
the one you want to use.



Understanding page breaks

As the name sounds, Page Breaks is used to break pages into different
forms. In Excel, it is used to reduce the length of a page to minimize data
misalignment when printing the work.

Inserting a page break

First, choose the row or column for the page break. Click Page Layout. On-
Page Setup, click Breaks and select Insert Page breaks.



This action will display a thick line on the worksheet to let you know where
the new page starts from.

Removing manual page breaks

To remove the page breaks, click on a cell that is below the cell you inserted
a page break, click on Breaks, then select Remove Breaks.

Printing row and column titles

Click the Page Layout tab, select Print Titles.

On the Rows to repeat at the top and Columns to repeat at the left box,
choose the row or column you wish to print. After that, click Ok.

Scaling printed output

Scaling is used to determine how you want to print the sheets. Click on the
Scaling arrow to see the list of options just as you can see in the image
below. You can decide to print the actual size of the sheets, fit the sheets on
one page, fit all columns on one page, or fit all rows on one page.



Printing cell gridlines

By default, the letters and numbers that function as row and column
headings do not print. Neither do the gridlines on the worksheet. If you
need to print them also while printing, then you can turn them on. So, on
the ribbon, click Page Layout, then select Print Titles. On the Page Setup
box, check the box next to Gridlines. If you also want to print the row and
column headings, check the box close to the option. Once you are done,
click Ok.

Using a background image

By default, when printing a worksheet, it only prints the cells which contain
the data. If there is any other content on the worksheet, it won’t be printed.
However, you can add a background to your excel printouts.  You can add a
background by clicking on Page Layout, then, select Background. The issue
with this step is that excel will not be able to print any backgrounds that
have been added this way.  So you can make use of shapes, images to work
this out. So, let’s insert a shape and use it as our background image.

Click Insert and on the illustrations group, select the Shape icon and click
on the arrow. Select any shape. Here, I choose a shape from the rectangles



shape group.

Then, draw how you want the shape to be on the worksheet. The Drawing
Tool tab will now be active. Click Shape fill. Select White. Then, click
Shape Outline. Then, select White as the outline color.

Now, on the shape, right-click. Chose Format Shape. This opens up the
Format Picture pane



On the pane, click on Fill. Then, choose the Picture or texture fill option.
Click on File. This opens a menu where you will select the picture you want
to use. Click on the picture and click Insert. Check the box next to the Tile
picture as a texture option. On the transparency slide, set it to 75%.

Now, click on the size and properties icon (the third icon on the Shape
Options). Click on Properties, check the box next to Move and size with
cells, and also the box next to Print Object. Then, click Close. 

Now, click File > Print. You will see the preview of the page with the
background image on it.

Adding a header or a footer to your reports

A document's header is a text or picture that appears at the top of
every page. A header may make your content stand out. Including a header
in your papers can save you time when it comes to creating templates since
it will display on every page.

A well-crafted header may pique your audience's interest right away. If you
want to be heard, you must first engage your reader. And having a terrific
header in your reports and/or articles is one of the most effective methods to
hook them.

Inserting a header

Open the Excel file. On the ribbon, click on the Insert Tab. Then, select
Header and Footer from the Text Group.

Your worksheet will be displayed in a Page Layout View. Now, on the box
above the worksheet, enter in the header. By default, you write your header
in the center box, but you can also write on the other boxes. Just click on
them and write.



Inserting a footer

A footer is more like a header but this time it is located at the bottom of the
page. It is as important as a header. You can add information like your
contact address, page number, homepage link, and so on your footer. To
insert footer, click on the Insert tab, select Header, and Footer, then go to
the Navigation group and select Go to Footer.

This will lead you to the footer below the page.

Understanding header and footer element codes

There are elements that you can apply to the header and footer of your page.
Some of the elements are File path, Picture, Page Number, Current Date,
File Name, Sheet Name, Current Time, and so on. To apply any of them,
click on the icon of the elements you want to use.



Let’s say you want to insert the current date on the header, just click on
Current Date, you will see this &[Date] written on the header.

Click on any area on the worksheet to see the current date written there.

Exploring other header and footer options

There are also other options you can make use of. On the Design tab, hit the
down arrow on the Header and Footer icons to see the list of headers or
footer options.

 

EXPLORING OTHER PRINT-RELATED TOPICS



Copying page setup settings across sheets

Say you've got a workbook containing many worksheets, but you wish
to make an identical page setup based on a sheet. If you simply have one
worksheet, you may quickly set the page setting for it. Also, if you wish to
create the same page configuration for additional worksheets in your
workbook, doing so one at a time is not a smart idea. Follow the steps
below to do so;

Click on the worksheet tab in which you want to copy the page setup.
Right-click and click on Select All Sheets.

Click the Page Layout tab. On the Page Setup group, click on the small
arrow located at the bottom right of the group menu.

This will open up the Page Setup Dialog box. Then, click Ok. This will
copy the page setup of the active worksheet to the selected worksheet.



To ungroup the worksheet, right-click on a tab, then, click Ungroup Sheets.

Preventing certain cells from being printed

First, click on the cells. Right-click and select Format Cells. You will see
the Format Cell dialog box, then click on the Number tab and select
Custom. In the type option box, type in this "";"";"";"". Then, click Ok.
This will hide the contents of that cells.



Preventing objects from being printed

You may have objects like boxes, pictures, shapes, etc. on your workbook
but don’t want to print them alongside other data.

To prevent them, first, click on Page Layout and select Print Titles.

Click on the Sheet tab and check the box on the Draft quality option. Click
on Print Preview to see if the object is on the preview. It will not be
available. Then, click Ok.



Creating custom views of your worksheet

The custom view helps in making your presentations smooth. To create
custom views, simply choose the area on your worksheet for the view. Click
View, then select Custom Views. Click Add, enter the name for the custom
view. Then, select Ok. To navigate to a view, click on the down arrow on
Custom View, then pick a view.

Creating PDF files.

Click on File > Print. On the Printer option, click the down arrow and
select Microsoft Print to PDF. Then, click Print. A menu will appear where
you will choose the location for the file and the file name.



Excel print's Limitations

●      When your printout is illegible, Excel does not notify you.

●      Adjusting the margins from the Preview Pane is difficult.

●       It will be difficult to discern cell borders when a user produces a
worksheet or a table without gridlines.

 

 



CHAPTER EIGHT

 CUSTOMIZING THE EXCEL USER INTERFACE

About the Quick Access Toolbar

The Quick Access Toolbar is located at the top left-hand side of the Excel
window (above the ribbon) by default. You easily access some tools from
there. It saves you time.

Customizing the Quick Access Toolbar

You can make some changes to the default settings of the Quick Access
Toolbar. You can add more tools, delete, and even change the position.

Adding new commands to the Quick Access Toolbar

On the Quick Access Toolbar, click the down arrow to see the list of
commands. Click on any to add it to the toolbar.



If the command you want to add to the toolbar is not on the list, click on
More Commands. This will open up the Excel Options window. On the
Quick Access Toolbar menu, you will be the Popular commands listed for
you. You can also find other commands. Simply click on the arrow below
the Choose Commands from option and select any of the options such as
Commands Not in the Ribbon, All Commands, Macros, and others.

Any of the options you select has a list of commands that you can choose
from. Choose the command, then click on Add>>. The command will be
displayed on the right side of the menu. After you have clicked Add>>,
click Ok. To remove a command, click on the command and then click
Remove.

You can also rearrange the order of the commands. Simply click on a
command, then click the up or down arrow at the right-hand side to move
the command above (to the left) or below (to the right).



You can also change the position of the Quick Access Toolbar. Simply click
on the drop-down arrow and click on Show Below the Ribbon. The Quick
Access Toolbar will go down below the ribbon.

Other Quick Access Toolbar actions

You can reset the customizations you made on the Quick Access Toolbar.
When you reset it, all the commands you added will be gone. To do this,



right-click on the Quick Access Toolbar and select customize the ribbon.
Below the menu, at the right-hand side, click on the drop-down arrow on
the Reset option and select Reset All Customizations.

A dialog box will appear for you to confirm your action. Click Yes. Then,
click Ok.

You can also Import or Export customization files. Simply click on the
Import/Export option and select an option. When you click Import, it
opens up a menu where you will choose the customization file you want to
import.

Customizing the Ribbon

This is where you get access to all the commands you are to use when
working on your workbook. You can change the settings of the ribbon. You
can hide the tabs or show them, add your tab or group to the ribbon, rename
groups and rearrange them, and lots more.

Why you may want to customize the ribbon



You may like to have your tab or group on the ribbon. You will like to
include those commands that you often use in the ribbon by adding them to
a group and building a tab for them so that you can easily access them. You
may also want to not display some tabs that you rarely use. Whatever the
reason may be, I will guide you on how to do all these.

What can be customized

Yes, the ribbon is customizable but it is not everything on the ribbon that
you can customize. Things you can customize in the ribbon are: Showing
and Hiding tabs, renaming tabs, adding and removing groups from the
ribbon, exporting and importing your customized ribbon, rearranging tabs,
custom commands, and groups, and creating a new tab and group.

What cannot be customized

The color of the ribbon cannot be customized, however, customizing the
color scheme of the whole Office is possible. Ribbon size, text size, and
default icons are not customizable but it is possible to hide the ribbon or
customize it to display just the names of the tabs. You cannot change the
names, icons on the ribbon. You cannot remove the built-in commands.

How to customize the ribbon

There are many ways you can customize the ribbon. You can do so using
the Customize the Ribbon window. You can create a new tab on the ribbon,
create a new group, add commands to the ribbon, and also add commands
to the new group you have created.

Creating a new tab

To create a new tab, simply right-click on the Quick Access Toolbar and
select customize the ribbon. This opens up the Excel Options menu. on the
Customize Ribbon option, on the bottom right-hand side of the window,
click on New Tab.



A New Custom tab and a Custom group will be added. The Custom group
was added because you can only add commands to custom groups.

Click on the New tab you just created, then select Rename to give the tab a
name of your choice.

Then, click Ok. You will see the newly created tab on the ribbon.

Creating a new group

As you can see in the image below, the new tab we created has no group in
it. Let’s create a group on it.

Right-click on the Quick Access Toolbar and select Customize the Ribbon.
On the right side of the window, click on the tab for the group (Here, I
clicked on Chameleon Entertainment). Click New Group. Click on the
Custom Group and select Rename to give it a name and symbol to represent
the group when the Excel window is in Restored mode (narrow). Click Ok.



After creating the group, you will first add some commands to the group.

Adding commands to a new group

From the Choose command, click on any of the commands you want to
add. Click the Add>> button after selecting each command.

Click Ok when you are done. Now, you will see the new group and the
commands in it on the tab.

Resetting the ribbon.

After making some customizations, you can change back the ribbon to its
default settings. Simply navigate to the Customize Ribbon Window. At the
bottom left side, click the down arrow on the Reset option and select Reset
all Customizations.



CHAPTER NINE

 GETTING STARTED WITH EXCEL CHARTS

What’s Chart

The chart is commonly referred to as a graph in Microsoft Excel. It's a
visual depiction of data from a spreadsheet that could help you comprehend
the information better than simply looking at the numbers.

A chart is a tool for graphically displaying data in different chart layouts
like Line, Pie, Surface, Bar, Scatter, Column, etc.

How Excel Handle charts

Charts provide a pictorial depiction of any data collection. A chart is a
visual description of data that uses symbols like columns in a column
chart to describe the data. You may pick from the list of chart kinds in
Excel, or utilize the Excel Recommended Charts option to see charts that
have been created for your data.

In Excel, the data which you are to use in creating a chart is the one in your
worksheet. However, you can use data from other worksheets or another
workbook. The Charts in Excel are not static i.e. you can make changes to
them anytime and anyhow you want.

Embedded charts

The charts you make in an Excel Worksheet are embedded charts. It stays
on the worksheets. On a worksheet, is see an invisible drawing layer, which
is where embedded charts are displayed.



Just like other objects, you can change the position of an embedded chart,
resize an embedded chart, change the properties, make changes to the
borders, and so on. To make changes to the chart, simply click on the chart.
The chart will be activated, then on the ribbon, the Design and Format tab
comes up. With those tabs, you can make changes to the embedded chart.

When you create a chart in Excel, by default, it is created as an embedded
chart.



Chart sheets

Chart Sheet is the sheet that holds a chart in your worksheet. It is just like a
worksheet just that worksheets contain both the data and your chart while
chart sheets contain just a chart. An embedded sheet is always on the chart
sheet. Just like how worksheets are called Sheet 1, Sheet 2, so are chart
sheets called Chart 1, Chart 2, etc.

You can change the position of an embedded chart to a chart sheet. A chart
sheet can be an embedded chart. Simply click on the embedded chart, click
on the Design tab and select Move Chart. A dialog box will appear. Check
the New Sheet option. Put in a name for the chart sheet if you want. Then,
click Ok.

Parts of a chart

A chart is made up of different parts. When you create a chart in Excel, you
will see the different parts of it located on the right side of the chart.

Chart Elements: These are parts of a chart that give more description to
your chart. They make your data have detailed meaning. When you click on
the chart element icon, you will see a list of different elements such as
Axes, Axis title, Chart title, Gridlines, Legend, etc.



When you check the box beside each of the elements, the preview of the
element will be displayed on the chart. As you can see in the image below, I
checked all the boxes and the preview of it is displayed on the chart.

Axes: A chart has two which are the Vertical axis (Y-axis) and Horizontal
axis (X-axis).

Axis Titles: This gives more understanding feature of the data in the chart.
You can add them to any vertical, horizontal, or depth axes in the chart. You



can’t add them to charts that do not have axes like doughnut charts or Pie
charts.

Chart title: This is the title of the chart you have added. It appears by
default on top of the chart sheet. Click on the chart title to edit it.

Data labels: This shows the details of a data series or data points. It makes
your chart to be easily understood by the readers or viewers.

Data table: This displays the table of the data for the chart.



Error Bars: Displays the possible error amounts comparatively to every
data marker in a data series.

Gridlines: This makes the data easy to comprehend.

Legend: Displays the rows or columns on which the chart is created on. It
also gives it a special representation with the use of different colors to
describe them.



Chart limitations

The amount of series available in a chart in Excel 2010 has stayed the same
as in previous versions, 255, but the number of points in a series has
expanded substantially, from 32,000 to 1,048,576, allowing whole columns
in Excel 2007 and 2010 to be utilized as the source data for a chart series.

Because the prior restriction of 256,000 points is less than the new
maximum of points per series, the total number of points permitted in a
chart has risen. I didn't have time to test this limit since drawing a series
with a million points takes over a minute. (Hmm, I'm not sure whether the
help files have been updated with the new restrictions yet.

BASIC STEPS FOR CREATING A CHART

Creating the chart

To create a chart, simply select the cell (s), row, or column that you want to
make a chart for. Then, click Insert on the ribbon. You will see the Chart
group in the Insert tab.



So, select the type of chart you want to use from the list of charts there.
Click on the drop-down arrow for each chart icon to see the different chart
styles. You can also click on Recommended Charts to select another chart
style. So, click on a chart and it will be displayed on your worksheet. The
chart represents the data of the selected area in the worksheet.

On the ribbon, you can change the chart style for the chart on your
worksheet.

Switching the row and column orientation

After adding your chart, you can switch the row and column. Simply click
on the Switch row and column icon on the ribbon.



Changing the chart type

Click on Change Chart Type in the ribbon. This opens up the Change Chart
Type menu. on it, you will see the list of different chart types.

Click on the one you want to change the chart type to and select Ok. The
chart will change on your worksheet.

Applying chart layout

At the left side of the ribbon is the Chart Layout group. Click on Quick
Layout, then select a layout.



Adding and deleting chart elements

Chart elements provide extra information to your charts, making them more
relevant and attractive to the eye. Click on Add Chart Elements and select
an element.

To delete, right-click and select Delete.

Formatting chart elements

To format the elements, right-click and select Format (the name of the
element you added comes after Format).



On the Format Pane menu, click on an option.

MODIFYING AND CUSTOMIZING CHARTS

Moving and resizing a chart

To move a chart, click the chart, then drag it to anywhere to want to place it.
To resize it, put the cursor on the chart edge, then drag it up, down, or
sideways. You can also right-click on the chart, then select Move Chart.
This opens a dialog box.

Converting an embedded chart

We can connect a chart in Excel and the data in a Word document together
using Embed in Excel. When linking them, any changes you apply in the



chart will also be applied on the Word document automatically only if they
are saved in a similar folder or location. Follow the steps to do so.

On the Insert tab, then select Object from the Text group.

Click on Create from file tab and select Browse.

Find the file (chart) and choose Insert. Check the box on Link to File. Then
click Ok.

To edit the embedded chart, simply double-click on it. the Excel worksheet
which contains the chart will open. make your edits and ensure you save
them after editing in Excel.

Copying a chart

Simply right-click on the chart, select Copy. Then, navigate to where you
want to paste it and right-click, then select Paste.

Deleting a chart

Click on the chart, then Press the Delete key on your keyboard.

Copying a chart formatting

First copy the chart. You can click on the chart and press Control key + C
or you right-click and select copy.



Then, click on the chart you want to format. On the clipboard group, click
the down arrow on the Paste icon and select Paste Special.

Check the Format box. Click Ok.

Renaming a chart

You might well have observed that when Excel generates a chart, it assigns
it a specific number. It is found in the Name Box on top of the grid in the
left corner. You have the option of changing the name to something more
informative to you.

There are ways to rename a chart. First, click the Name box, then, type in
the name for the chart.



Renaming a data series in a chart

Simply right-click on the chart and click on Select Data.

 

This opens up the Select Data window. So, highlight the data series you
want to rename. Click Edit.



The Edit Series dialog box will appear. On it, remove the names on the
type-in box and put in the name you want for the chart. Click Ok.

Click Ok again.

Printing charts

Choose the chart. Click on File and select Print. On the Printer option,
select a printer. Then, on the Print Setting option, make sure it is set to
Print Selected Chart, though it will be there by default. Click Print.

UNDERSTANDING CHART TYPES



Choosing a chart type

In Excel, there are different kinds of charts. You have a list of charts that
you can use when working on your worksheets. There are also sub-types of
these charts. Below are the charts;

Column charts

In a Column Chart, the horizontal (category) axis is used to show the
categories, while the vertical (value) axis is used to display the values.
Arrange the data in columns or rows on the spreadsheet to make a column
chart. The sub-types of the column chart are;

●      3-D Column

●      3-D 100% Stacked Column

●      Clustered Column

●      100% Stacked Column

●      3-D Clustered Column

●      3-D Stacked Column

●      Stacked Column

Bar charts

Individual item comparisons are shown using bar charts. The data are
grouped along the horizontal axis and the categories are arranged along the
vertical axis in a Bar Chart. Organize the data in columns or rows on the
Spreadsheet to Make a Bar Chart. The sub-types are

●      Clustered Bar

●      Stacked Bar

●      100% Stacked Bar

●      3-D Stacked Bar

●      3-D Clustered Bar

●      3-D 100% Stacked Bar.



Line charts

Line charts are used to show trends over time. It can be over years, months,
and days. It is also used to display categories when the order is not
important. You can utilize this chart when you have lots of data points on
your worksheet and the order is important. The sub-types are

●      Line

●      Stacked Line

●      100% Stacked Line

●      Line with Markers

●      Stacked Line with Markers

●      100% Stacked Line with Markers

●      3-D Line

Pie charts

This is a circular chart. It is a sort of graph that depicts the information in a
circular graph. The slices of pie illustrate the data's apparent size and are a
sort of graphical representation of data. A list of categories and numerical
variables is required for a pie chart. The phrase "pie" refers to the entire,
whereas "slices" refers to the individual components of the pie.

It is divided into different sectors in which each of them represents a part of
a whole. The number of elements in one data series is equivalent to the total
of the elements in a pie chart. In a pie chart, the data points are shown as a
proportion of the whole pie. Arrange the data in one column or row on the
spreadsheet to Make a Pie Chart. The sub-types are

●      Pie

●      3-D Pie

●      Pie of Pie

●      Bar of Pie

XY (scatter) charts



XY (Scatter) charts are often used to display and compare quantitative
quantities, such as data from science, statistics, and engineering. There are
two Value Axes in a Scatter chart.

●      Axis of Value Horizontal (x)

●      Axis of Vertical Value (y)

It merges x and y values into a singular data point and shows them in
clusters of irregular intervals. Organize the data in rows and columns on the
spreadsheet to make a Scatter chart. The X values should be in one row or
column. The y values should be in the adjacent rows or columns.

When in doubt, use a scatter chart when: 

●      You wish to adjust the horizontal axis scale.

●      You should use a logarithmic scale for that axis.

●      The horizontal axis values are not equally distributed.

●      On the horizontal axis, there are a lot of data points.

●       To expose additional information about data that comprises pairs or
grouped sets of values, you wish to modify the independent axis
scales of a scatter chart.

●       Instead of showing disparities between data points, you want to
illustrate commonalities across big amounts of data

●      You wish to compare a large number of data points over a long period.

●       The more data you put in a scatter chart, the more accurate your
comparisons will be.

Area charts

Area charts are useful for plotting changes over time and highlighting the
entire value throughout a trend. An area chart displays the connection of
parts to a whole by displaying the total of the plotted data. Arrange the data
in columns or rows on the spreadsheet to make an Area Chart. The sub-
types are



●      Area

●      Stacked Area

●      100% Stacked Area

●      3-D Area

●      3-D Stacked Area

●      3-D 100% Stacked Area

Radar charts

The average values of many data series are compared using radar charts.
Organize the data in columns or rows on the worksheet to create this chart.

Surface charts

A surface chart comes is helpful when you want to combine two sets of
data. Colors and patterns, much as on a geographical map, identify regions
with similar values. To make a Surface chart, make sure that the categories
and data series are both numeric values and organize the data on the
spreadsheet in columns or rows.

Bubble charts

A Bubble chart is like a Scatter chart, only that it has a third column that
specifies the size of the bubbles that indicate the data points therein the data
series.

Stock charts

Stock charts, as the name indicates, may depict price movements in stocks.
A Stock chart is used to display changes in other data, such as rainfall
intensity or yearly weather.

Organize the data in columns or rows in a specified arrangement on the
spreadsheet to make a stock chart. To make a basic high-low-close Stock
chart, for example, organize your data with High, Low, and Close as
Column headers in that sequence.



NEW CHART TYPES FOR EXCEL

Histogram charts

A histogram is a graphical illustration of numeric values distribution. A
histogram is a kind of column chart that displays the frequency of data in a
certain range in a more straightforward manner. It uses the number of data
points that fall inside a specific range of values to visualize numerical
values. It uses vertical columns to display the frequent increase and fall in
data. In Excel, a histogram chart is divided into five sections which are
Title, X-axis, Y-axis, The bars, and Legend.

The title of the histogram describes the information contained inside it. The
X-axis is a clustered interval that depicts the range of values in which the
measurements are taken. The Y-axis is a scale that displays the number of
times the values happened inside the intervals defined by the X-axis.

The bars: There are two dimensions to this parameter: height and width.
The number of times the values happened inside the interval is shown by
the height of the bar. The interval, distance, or area covered is indicated by
the width of the bars.

Pareto charts

A Pareto chart, also known as a Pareto diagram, is a graph that uses the
Pareto principle as its foundation. It's a kind of sorted histogram in
Microsoft Excel that includes both vertical bars and a horizontal line. The
relative frequency of values is represented by the bars, which are drawn in
decreasing order, while the line shows the cumulated percentage.



Pareto graph emphasizes the main pieces in a data collection and displays
their relative relevance to the whole.

Waterfall charts

A waterfall chart is a kind of graph that is often used to visualize financial
information, compare profits, and analyze sales or product value over time.
It's also used to visualize inventories and analyze profit and loss. They
originally gained popularity in the late twentieth century, when McKinsey
& Company used them in a client presentation.

Box & whisker charts

A box and whisker chart, also known as a box plot, is a statistical analysis
tool in Excel that shows you how values are dispersed in a collection of
data. For example, you may use a box and whisker chart to illustrate
statistical information on test results across topics to determine which
subjects need greater focus from pupils.

Treemap charts

A treemap chart is a style of data representation that excels at portraying
hierarchical data. Each element is displayed as a rectangular shape on a
treemap, with smaller rectangles representing sub-groups. The color and
size of rectangles are usually associated with the tree structure, making the
groups and sizes simpler to perceive. Treemap charts are excellent for
emphasizing each object's contribution to the overall hierarchy.



Sunburst charts

A sunburst chart, like treemap charts, is a style of visualization that works
well for visualizing hierarchical data. A sunburst chart is a circular diagram
in which each circle symbolizes a group hierarchy level. The high-level
groups are plotted in the inner circle, while the sub-categories are plotted in
the outer rings. The segments' sizes are proportionate to the values they
represent. A sunburst chart is divided into three sections: Plot Area, Chart
Title, and Legend.

Plot Area: The plot area is where the graphic expression occurs. Like pie
and donut charts, a sunburst chart illustrates parts of the full data set. A top-
level group is represented by each hue.  Chart Title: Make an effort to be
detailed and succinct. The legend is an indication that aids in the
differentiation of data sets. Each color denotes a category at the top level.

Funnel charts

Funnel charts are comparable to their name in that they are used to display
data behavior at each step specified, and when the numbers decrease, the
chart takes on the form of a funnel, thus the term funnel chart.

Map charts

These are used to depict a certain Key Performance Indicator (KPI) and
demonstrate its representation over different geographical locations for a
given category, such as a business, sector, or commodity.

 

 



CHAPTER TEN

 USING ADVANCED CHARTING TECHNIQUES

SELECTING CHART ELEMENTS

When you are done creating a chart, you can add some chart elements to
your chart. You can select the chart elements in different ways.

Selecting with the mouse

Simply click on the chart element. Also, click directly on a bar in your chart
to choose the data series. Double-click on an element for it to display.

Selecting with the Keyboard

You can use the up and down keys to select chart elements in your
worksheet. Simply, click on the chart, press down the Control key, then use
the up and down keys to navigate through the main chart elements.

Some chart elements have sub-elements. To access those sub-elements, use
the right and life arrow keys. Click the chart, use the up arrow key to pick
the element, use the right/left arrow keys to pick the sub-elements.

Selecting with the chart element control

You can select chart elements from the chart element control on the Format
tab. When you click on a chart, the list of the main Chart Elements will be
displayed on the menu.

With this menu, you can go to the chart title, plot area, and so on. When you
click on an element, the name will show there.



EXPLORING THE USER INTERFACE CHOICES FOR

MODIFYING CHART ELEMENTS

Using the format task pane

Pick the chart element that you want to modify, then right-click on it and
select Format (the name of the chart element comes after format). This will
open up the Format pane. On it, you will see a list of options for the selected
chart element.

Using the chart customization buttons

Click the chart you have created on your worksheet, then select a
customization button on the right side.

Using the ribbon



First, pick the chart element, navigate to the Format tab which is located
below the Chart Tools. You will see options for modifying your chart
elements.

Using the Mini toolbar

Right-click on the chart element to see the mini toolbar. On it, you will see
some chart modifying options like fill color, style, and outline. Click on any
of the options to modify your chart.

Modifying the chart area

The chart area is the part of a chart that encompasses all elements of a
particular chart. You may change the appearance and position of your chart.
A few options are shown here, but there are many more! To access Chart



Tools in any situation, you must first pick the chart. When you click on the
chart, you can use the Design tab and the Format tab to modify it.

To add labels such as title, axes, etc. Select the Add Chart Element option
and select a label. The Chart Tool tab contains many modifying options.
You can change colors, chart styles, move charts, add borders, add shapes,
etc.

Modifying the Plot area

The plot area of a chart is found inside of a chart. It consists of the actual
chart. Just like the chart area, you can change the border and fill the plot
area. When you add elements to a chart, it changes the plot area size.

When you right-click on the plot area, you will see some options for
modifying the plot area.



Working with Titles in a chart

The chart title is located at the top. When creating a chart with just a column,
the column heading becomes the title of the chart. When you create a chart
with a group of columns or rows, the title is Chart Title. Click on it to edit
the name.

You can add or delete the chart title if you want to. Simply click on the chart,
select the chart element icon, then uncheck the Chart title box. You can also
change the position of the chart title.



Working with Legends

As said in the previous chapter, the legend is displayed by default at the right
side of the chart when you create a chart. If you want to hide it, click on the
Chart Elements icon, then uncheck the box beside the Legends option.

To change the position of the legend, simply click on the chart element icon,
then, click on the arrow next to Legend, then select where you want to move
it to.

Working with Gridlines

Click the Chart Element icon on the chart and check the box beside
Gridlines. You can select the type of gridlines you want to use on your chart.



Click on the arrow next to Gridlines and select an option from the box.

Modifying the Axes

You may have added an axis on your chart but the scale of the axis is small
or too big to display the units in the chart. You can modify it to your choice.
Simply right-click on the axis you want to modify and select Format Axis.

This will open up the Format Axis pane. On the pane, select any icon to
modify the axis. Each of the icons has its modifying options.



WORKING WITH DATA SERIES

Deleting or hiding a data series

You might want to delete some data on your worksheet. Simply click on the
Chart Filter icon, then uncheck the box beside the data series you want not to
display.

Adding a new data series to a chart

Right-click on the chart, then click on Select Data. The Select Data Source
box will open. On the left side is where the data series are listed, such as
Add, Edit, and Remove buttons. So you can add, remove and edit data series
with these buttons.

Click on the Add button. The Edit Series box opens, then enter the name of
the series and its value. Then, click Ok.



Changing data used by a series

To change the data in a series, go to the Select Data Source menu using the
steps above. In the data series box, select the series that you wish you
change, then click on the Edit button. Then, apply your changes. 

Note that these changes are likely to break connections to the source data in
your spreadsheet.

Using the Edit series dialog box

If you want to edit a data series, select the Chart Filter icon. This opens a
box containing data series. Click on the Edit series icon at the right side of
the data series you want to edit. You will see the icon when you hover your
cursor on the data series.



When you click on it, it opens the Edit series dialog box. You can now edit
the series name and value from the box.

Editing the Series formula

The data in your chart is connected with the series formula. This formula is
only available for a chart. When you click on a series in your chart, you will
see the series formula on the formula bar. The formula is generated by
default. It is written by Excel after creating a chart or adding a series.

The formula for the data series I just selected is written in the formula bar as
=SERIES(Sheet2!$C$1, Sheet2!$C$2:$C$18,2).

So, you can add a new formula. You can change the “C” in the series
formula and add another alphabet like “G”. The chart will apply the series
name and Y values in Column G.

Displaying data labels in a chart

You may add data labels to your Excel graph to highlight information about
the data series, making it simpler to interpret. You may add labels to one
data series, all data series, or individual data points, based on where you'd
like to concentrate your users' attention.



Simply select the data series. If you want to add a label to just a data point,
select the data point after choosing the series.

Then, click on the Chart Elements icon, then, check the box beside Data
Labels. You can click on the arrow to decide the location where you want to
place the data series.

Handling missing data

The data you're graphing may be missing a data point or more. Excel has
some solutions for dealing with missing data, including the ability to chart
concealed data in a range. Right-click on the chart and choose Select Data.
Click on Hidden and Empty Cells.



The Hidden and Empty cells box will open. Then,  decide how to handle the
missing data.

Gaps: This is the default option of Excel. The missing data is not included in
Excel. A gap is given by the data series for every missing data point.

Zero: The missing data is seen as zero.

Connect Data missing data as zero: The missing data is calculated with the
data on either side of the missing point(s). This only works for some of the X
Y scatter subtypes and line charts.

Adding error bars

To add error bars on your chart, simply click on the chart, then select the
Chart Element and check the Error bars box. You can click on the arrow to
select the kind of error bar you want to add.



Creating combination charts

A chart that consists of two or more chart types in a chart. Follow the steps
below to do so;

Simply select the cells/range. Click the Insert tab and select the Combo
symbol.

Select Create Custom Combo Chart. This opens the Insert Chart menu.
Below the menu, select the chart type for the series name you have selected.
You can select two different types of chart types. You can check the box on
the secondary axis options. Then click Ok.



You will get the chart on your worksheet.

Displaying a data table

Select the chart you would like to display its data table. Click on the Chart
Element icon, then check the Data Table box. Click on the arrow beside it
to choose if you want to display it with legend keys or not.



Creating Chart Templates.

After creating a chart, right-click on it and select Save as Template. The
Save Chart Template dialog will open. Type in the name of the template then
selects Save. Chart Templates are saved in the Charts folder. They are
included in the Templates folder in the Insert Chart and Change Chart Type
dialog.



CHAPTER ELEVEN

 CREATING SPARKLINE GRAPHICS

What is a Sparkline

Sparklines are small charts that stay inside a cell. They serve as the
background of that cell. Sparklines make your look better. They display
trends over time.

Sparklines are changeable and reliant on the dataset they're based on. The
sparkline would update automatically as the underlying dataset changed. As
a result, it's a great tool for producing Excel dashboards.

The size of the sparklines is determined by the cell size. The sparkline will
alter in response to changes in cell height or breadth. You may type in a text
when sparkline is active in a cell.

Sparkline Types

The types of sparklines are Line, Column, and Win-Loss.

1. Column Sparkline: This sparkline comes in form of a column chart
or bar chart.

2. Line Sparkline: This comes in form of lines.

3. Win or Loss Sparkline: To display negative values. For example, it
displays the ups and downs of the floated costs.

A win-loss sparkline is more like a column sparkline, except that it does not
display the degree of the value. It's best for scenarios with binary outcomes,
such as Yes/No, True/False, Head/Tail, 1/-1, and so on. For instance, if



you're trying to figure out if there was rainfall in the last seven days or not,
you may use a win-loss chart with 1 for rainy days and -1 for dry days.
Everything discussed throughout this chapter for column sparklines could
equally apply to win-loss sparklines.

Importance of Using Sparklines
●       When the cell width is altered, Sparkline automatically switches its

size.
●      Evaluate data patterns over a certain period
●      For a limited period, data reports are being generated.
●       Data compression is the process of converting data into a smaller

format
●      The data variations are simple to comprehend.
●      Data representation, such as temperature and stock market price
●      A better comprehension of data points with high and low values.
●      Sparkline may efficiently float negative numbers.

Creating Sparklines

Choose the cell for the sparkline. Then, click Insert on the tab. On the right,
is the Sparkline group. Click anyone.

The Create Sparkline dialog box shows. Choose the data range for sparkline.
Here, my data range is A2:D2. Also, put in the location for the sparkline.
You can do so by clicking on the cell.



Then, click Ok.

Customizing Sparklines

You can make some customization to the sparkline you have just created.
Simply click on the cell which contains a sparkline. The sparkline tool
design will display on the tab.

On the tab options, you will see a lot of customization options for the
sparkline. You can change the color, change the style, add axis, show
negative, positive, low points. If you want to edit the data of the sparkline,
click on the Edit data option. You will see two options; Edit Group
Location & Data and Edit Single Sparkline only.



Use the Edit Group Location & Data option to edit grouped sparklines. Use
the other option to edit single sparkline data.

Handling hidden or missing data

The sparklines display a gap for an empty cell. 

In the image above, the value of Emeka's score on the second day is missing
and this created a gap in the sparkline. Look at the other sparklines and see
how there is no gap on them. You can decide how you want to handle these
empty cells.

Simply, select the cell which contains the sparkline. Click on the Design tab,
click on Edit data and then, click Hidden & Empty Cells.



This opens up a dialog box. Choose how the empty cells will show either as
Zero, Gaps, or Connect the before and after data points with a line (as
said earlier, this is only for line sparklines).

Check the box on Show data in hidden rows and columns to show the data.

Changing Sparkline types

Click the sparkline, then, on the Types group and click on any sparkline
type.

Changing Sparkline colors and line width

Click the sparkline. On the Sparkline Tools Design tab, on the Style group,
choose Sparkline color. Then, select a color



To change the width, click on Weight, below the Sparkline color option
drop-down menu. Then, select the line width you want from the displayed
options. This will apply changes to the thickness of the sparkline. This is just
for line sparkline.

Merging and Sizing Sparklines cells

The sparkline adjusts to the new cell size when you adjust the width or
height of a cell that has a sparkline. To merge cells, highlight the cells,
choose Merge & Center.



If you combine cells that span more than a row or column, Excel will not
allow you to insert a collection of sparklines into certain merged cells.
Rather, place the sparklines into a regular range (one that does not include
any merged cells), then merge the cells.

Highlighting certain data points

You can highlight some data points in your sparkline to make it more
understandable and meaningful. You can decide to highlight the last data
points, maximum points, negative data points, etc. Simply click on the cell
that has the sparkline, then on the Design Tools tab on the Show group,
which are different highlighting options.

●      High Point; for the maximum data point.
●      Low point; for the minimum data point.
●      First point; for the first data point.
●      Last point; for the last data point.
●      Negative point; for negative points if you have any.
●       Marker; just for line sparklines. When you tick the box, it highlights

the data points using a marker.

Grouping and Ungrouping Sparklines

You may have many sparklines. You can decide to group them. When you
group them, it makes it easier to make changes to them once rather than
doing it each.

To group them, first select the sparklines, then click on Group on the
Sparklines Tools Design tab.



To ungroup them, select the cells, then click on the Ungroup option.

Deleting Sparklines

The Delete key doesn’t delete a sparkline. Use the Clear option on the
ribbon. Select the cell, then on the Sparkline Design tool tab, on the Group’s
group, and click on Clear. You can decide to Clear Selected Sparklines or
Clear Selected Sparkline Groups.

Adjusting Sparkline axis scaling

A sparkline displays the least data point at the bottom and all subsequent
data points are linked to it.

You might not want it to be the case in certain circumstances since it seems
to exhibit a lot of variances. To adjust this, follow the steps below;

Click on the cell containing the sparkline. On the Design tab, select the Axis
option. From the drop-down menu, from the Vertical Axis Minimum Value
Options, or the Vertical Axis Maximum Value Options, click on Custom
Value.



Type in the minimum value you want for the vertical axis, click Ok.

Specifying a date axis

Click on the cell for putting the date values. On the Number section, click
the down arrow.

So, select Long Date or Short Date. Now, in the cells, put in the date
values. Click on the cell, then on the Design tab, navigate to the Group’s



group and click on Axis. This will display a drop-down. Select Date Axis
Type.

The Sparkline Date Range dialog will open. On it, choose the data cells.
Then, click Ok.

You will notice that the graph on the cell changed. It has been re-plotted and
has been sorted by date.

Auto-Updating Sparklines



A common problem people have with Excel and sparklines is that sometimes
people add more data to the worksheet and will forget to include the new
data in the sparkline. By default, as you modify the data in the cells, the
sparklines updates to the new data added.

Displaying a Sparkline for a Dynamic Range

The term "dynamic range" refers to a range that is selected automatically
when new data is supplied to an existing range.

When a new set of lines is added to the data, Dynamic Range in Excel
enables us to always utilize the freshly updated range. When we add more
cells or rows, it just updates itself. We've utilized a static range with fixed
value cells, but with a dynamic range, our range will vary as the data is
added. First, you have to format your data as a table. As you enter data in the
cells, it is automatically updated in the chart or sparkline.

To display a sparkline for dynamic range, simply select the range of cells,
then move to the Sparkline group on the Insert Tab. Select the sparkline you
want to add. On the Create Sparkline box, put in the location range. To do
this, select the cells you want the sparklines to display. You can hold down
the Control key while you select them.

Then, click Ok.



SUMMARY

Sparkline is a short graph that doesn't have any axes or coordinates.
Sparkline may be used to analyze a single column or row of data. For the
Sparkline, there are a variety of formatting options. A micrograph that fits
within a single cell is called a Sparkline. The delete key will not erase a
Sparkline that has been formed. In a Sparkline, distinct data points may be
highlighted.

 

 



CHAPTER TWELVE

VISUALIZING WITH CUSTOM NUMBER FORMATS AND

SHAPES

Visualizing with Number Formatting

Number, currencies, proportion, accounting, dates, and times are all
designed formats in Microsoft Excel. However, there are times when you
need something quite special. You may develop your number format if none
of the built-in Excel formats satisfy your requirements.

Number Formatting is a tremendously effective technique. The goal of this
lesson is to walk you through the components of Microsoft Excel number
formatting so you can understand custom number formatting.

Doing basic number formatting

So, highlight the cells containing the numbers for formatting. On the
Number group, the default format for your number is General format. So,
click the down arrow close to General and select the format you want.

I formatted the numbers using the Accounting format option.



Using the formal cell dialog box to format numbers

You may not find the formatting option on the menu. So, to find them,
simply highlight the cells containing the numbers, then on the Numbers
group, click on the down arrow which is the dialog box opener.

This will open up the Format Cell dialog box. On the Number Tab, you will
see lots of number formatting options. Click on the one you want to use,
then click Ok.



Using shortcuts keys to format numbers

With shortcuts, you can easily format the numbers in your worksheet. Use
Control + Shift + Number key. With it, you apply some formatting to your
numbers.

Simply select the cell(s), then press the keys below;

Control + Shift + ` = General Control + Shift + 5 =
Percentage

Control + Shift + 1 = Number Control + Shift + 6 =
Scientific

Control + Shift + 2 = Time Control + Shift + 7 =
Border

Control + Shift + 3 = Date

So, press and hold down the Control key and Shift key, then press any of
the numbers on your keyboard.



GETTING FANCY WITH CUSTOM NUMBER FORMATTING

Formatting numbers in thousands and millions

In Excel, you may wish to format a number in a custom manner, such as
formatting 421020000 as $421.02 M, and then store this for future use. You
can also apply it to multiple cells. To do this, follow the steps below.

Select the cell that has a number value in it, right-click on it, then click on
Format Cells.

Click on the Number tab on the Format cell box, then click on Custom. On
the box below the Type option, type in the format code $#.##,," M";



Then, click OK

Hiding and suppressing zeros

The number format can hide the zeros in the values of the cells. The hidden
values are shown in the formula section. When any number in the cells
changes to a nonnegative value, the value will be displayed in the cell with
a format similar to that of a general format.  Follow the steps to do hide
zeros;

Click on the cells that have zero value in them. On the Home tab, select
Format then select Format Cells.



On the Format Cell box, on the Number Tab, click on Custom. On the Type
box, put in this format code 0;-0; @. Click Ok. The Zeros will be hidden.

To display them again, select the cells, navigate to the Format cell box, then
on the Number tab, click General, and click Ok.

Applying custom format colors

So to apply custom format colors, simply highlight the cells, then open up
the Format dialog box with the steps we explained before.

Then, on the Formal cell box, click Custom. On the Type box, click any
format option there. In my case, I go with “#,##0”. So, I want to create a



custom currency format. So we add a dollar sign. You can see the preview
of what you are doing in the Sample box.

So, to apply color to the custom format, type in the color name at the front
of the format and it should be written inside a square bracket.

You cannot see the color preview in the Sample box. Click Ok. It displays
on your worksheet.



Formatting dates and time

Right-click on the cell, then pick Format Cells. On the Number tab, pick
Date or Time. Select an option. Then, click Ok.

Using a symbol to enhance reporting

Including symbols in your worksheet may help you visualize your data.
Here, I will go with the up and down arrows in our number formatting to
indicate the increase and reductions in our data. The symbols we'll employ
are Unicode symbols, which are a platform-agnostic standard that may be
found on any language PC.

First, we will access the symbols by inserting them. So, click on a cell that
has no data in it. Click Insert and select the Symbol icon on the Symbols
group. This opens up the Symbol menu.



Select the font you want from the Font box. On the Subset box, choose
Geometric Shapes. From the list of shapes, choose the up arrow shape and
click Insert. Choose the down arrow shape and click Insert. Then, close
the menu.

Now let’s use the symbols in our formatting

Choose the data to include the symbols. Then, right-click and choose
Format Cells. Select Custom on the Insert tab. In the type box, type in this
format code [Green] ▲  0.0%;[Red] ▼  0.0%. Click Ok.



The positive numbers will change to green and the up arrow will be there.
The negative numbers will change to red and the down arrow will be there.

USING SHAPES AND ICONS AS VISUAL ELEMENTS

Inserting a shape

Using shapes in your worksheet helps to make your work neat and
understandable. To insert a shape, click on the Insert Tab. Click on the
Shape icon on the illustration group. Select a shape.



Inserting SVG icon graphics

SVG means Scalable Vector Graphics. To insert them, click Insert Tab.
Click on Icons. This will display different icon categories. Click on any
category and select an icon. Then, click Insert.

You can insert more than one icon at the same time by clicking on them.
You can also search for icons. Click Insert, the icon displays on your
worksheet.

Use the Graphic Format tab to modify the icons.

Enhancing Excel reports with shapes

With Shapes, you display a perfect presentation of your work. You can use
shapes to show any common chart in Excel. Excel shapes are used to
enhance the appearance of your dashboards and reports, as well as for
realistic and efficient applications. We'll look at ways to make your
worksheets more appealing with shapes.

Creating Custom Button Links: Creating custom button links with
shapes is a wonderful way to move across worksheets, connect to reports on
shared servers or just link to a webpage.

To create a Hyperlink out of a shape, simply insert the shape. After adding
the shape to your worksheet, add text to it by right-clicking on the shape,
then, select Edit Text.

Once you have added a text, press Control key + K.



Here, I use the Place in this document option. We will choose the sheet for
linking. So, choose the “existing file or web page” option. Then, get the
location of the document or you put the address on a website.

Building Dashboards: Excel shapes most times, are used to enhance and
update the appearance of data in a worksheet. Flow charts and aesthetically
pleasing spreadsheets are often the first things that spring to mind when
people think about shapes in Excel. Smaller forms and other shape
attributes may be used to create some nice-looking dashboards.

Layering shapes to save space

The image below has different shapes on my worksheet like text box
images, charts slicers, etc.



To align your shapes, use the Align command to align them to the top,
bottom, right, or left to save some space on the worksheet. Simply select the
shapes by holding down the Control key and clicking on the shapes. Then,
on the Format tab, click Align, select an option.

Constructing your infographic widgets with shapes

Infographic is a method of presenting data or summary reports using
appealing charts and pictures. They are the ability to employ external
objects or visuals to visualize images. They are not like dashboards in that
they demand an architectural mindset to create your infographics.

So, to create them, first select the cells, then on the Insert tab, click on Bar
chart, then choose 2D Clustered Chart. we will have a chart like the one
below.

Right-click and select Format Data Series. On the series option, set the Gap
width to 0%. Make the chart background to be light white using the Shape
Fill icon. Adjust the chart size for the image to fit in.

Creating dynamic labels

To progress beyond your basic worksheet abilities, creating dynamic charts
can enhance it. The idea is to pick dynamic range as the source data.
Changes and additions to the source data will be instantly reflected in the
chart.



We will first create a table. So, select the data range, then, on the Insert tab,
navigate to the Tables’ group and select Table. Select the table. If your data
has headers, check the box next to My Table Has Header. Then, click Ok.

The chart built on the table is going to be dynamic. Now, let’s create a
chart. Highlight the table. Then on the Insert tab, on the Chart group, click
on Column Chart and select 2-D column chart. When you update the
table. It will reflect on the chart automatically.

Creating linked pictures

Picture link makes an image of grouped cells in form of a picture. You can
move it around the worksheet as well as resize them. The picture will
update as the source cells changes.

First, pick the cells and copy them by pressing Control + C. Pick the cell
for creating the link picture. Click Paste (Ribbon) > select Paste Special,
and pick Picture Link. The picture link will display on your worksheet.

Some do ask, the importance of creating a linked picture and when is it
needed?

At first glance, picture links may appear to be a pointless function. They
are, nonetheless, rather strong. Here are a few examples of how picture
links may be used:

In dashboards and reports, we usually need to mix charts, tables of data,
conditional formatting, and other elements on a single page. Build the
different dashboard components in different spreadsheets first. Then, in the
final dashboard, provide picture links to these sections. Resize and position
them as desired.

In Dynamic Charts: Because picture links are just photos with a formula
applied to them, you can quickly create dynamic charts and dashboards
with them.

Picture link helps as proof to your data just in case someone makes some
changes to the data.

USING SMARTART AND WORDART



SmartArt basics

SmartArt helps you to add diagrams, captioned pictures, and visual lists in
your work presentation. It comes in different forms, colors, arrangements,
etc. To insert a SmartArt, click on the Insert tab, then on the Illustration
group, click on SmartArt.

This will open up the SmartArt dialog box. On it, you will see different
SmartArt options.

Pick any SmartArt graphics, then click Ok. Check for the image in your
worksheet. On the [Text} placeholders, you can type in titles, captions,
pictures.



Modify the SmartArt Graphics such as changing the layout, styles, color,
etc. using the SmartArt tab.

WordArt basics

Select WordArt from Insert Tab. Select a style.

Click and type in your text.

Modify WordArt with the Format menu. You move it by dragging the
edges.

WORKING WITH OTHER GRAPHICS TYPES

About graphic files

When most people think about worksheets, the last thing that springs to
mind is art. Graphic images, when utilized with care, will not only draw
attention to otherwise dull tables and lists of statistics but also improve the
readability of their material. Hand-drawn visual shapes that you may add to
the spreadsheet to bring attention to unusual data points.

There are types of graphics in Excel for enhancing your worksheet. They
are Clip art images provided by Microsoft, hand-drawn graphics (shapes,



lines, text, WordArt), and graphics files that consist of digital images or
digital photographs.

Inserting screenshots

Click Insert, then click on Screenshot. This will display a menu where you
are to take a screenshot of any open window on your desktop or take a
screen clipping of just a part of your screen

Choose any of the options and the screenshot will display. You can modify
the screenshot using the Format tab.

USING THE EQUATION EDITOR



The Equation editor puts in equations or format equations. To insert
equations with the Equation editor, simply;

Click Insert, under the Symbols group select Equation and a drop-down
menu will appear.  This will display some of the preinstalled equations in
Excel. Click on any of the equations.

Here, I selected the Expansion of a Sum Equation. Then click Ok.



You have just inserted an Equation. You can also make your equation. To do
this, click on Equation (not the arrow). A text box will appear with a
caption of Type Equation here. Modify the equation with the Drawing too
and Equation tool tab.

You can right-click on the box, then select Format Shape for more
modifying options.

CONCLUSION

Number formatting, like all of Microsoft Excel's tools, has a multitude of
options. This chapter just skims the surface of what's possible. Number
formatting may be something you're already familiar with.

This chapter looks at how users may utilize formatting methods to construct
layers of visualizations and transform their data into useful representations.
It explains how to develop custom number formats and gives several
examples that users may use as-is or modify to meet their requirements.

Shapes are configurable graphical pictures that are available in Microsoft
Office, including Excel. Scalable Vector Graphics (SVG) icons are included
in Excel 2019's new icon collection. Without sacrificing picture quality,
SVG graphics may be resized and formatted.

 



 

 

 

 

 
 
 
 

 



BOOK 2:
EXCEL FORMULAS &

FUNCTIONS



CHAPTER ONE

 INTRODUCING FORMULAS AND FUNCTIONS

Until you create some form of connection among the numerous elements, a
worksheet is just a dead sequence of values and text. You accomplish this
by writing formulae that do computations and provide output. This chapter
covers the fundamentals of formula construction, including how to create
simple arithmetic and text formulae, how to grasp operator precedence, how
to copy and move worksheet formulas, and how to use range names to
make formulas simpler to develop and comprehend.

UNDERSTANDING FORMULA BASICS

You might be wondering what the formula is in Excel. The formula is
defined as being anything that starts with an equal sign and is not pre-
formatted as text. One of the most powerful features of Excel is the ability
to calculate numerical information using formulas. Just like a calculator,
Excel can add, subtract, multiply, and divide.

In Excel, every formula starts with an equal sign (=). This is because the
cell contains, or is equal to, the formula and the value it calculates.

If you don’t put the equal sign, you cannot perform the function. Supposing
you want to add 56, 65, and 76, you will have to apply the formula then you
apply the function. So, put the equal sign and then find the cell reference of
each of these numbers in your worksheet and put the plus sign after each
cell reference. As you can see in the image below.



Equations that execute calculations on data in your worksheet are known as
formulas. Whether or not the answer to your formula immediately updates
when changes are made depends on how you construct a formula in Excel.
A formula begins with the equal sign (=) and may include any or all of the
following elements:

Function: A function is a formula that accepts one or more inputs, acts, and
then returns one or more values. On a spreadsheet, functions are used to
simplify and shorten formulae, particularly those that conduct long or
difficult computations. A function is often made up of two parts:

1) The name of the function: A function's name indicates the kind of
arithmetic Excel will execute.

2) An argument: A function's arguments are the values it utilizes to
conduct operations or computations. The kind of parameter used by a
function is unique to that function. Numbers, text, cell references, and
names are some of the most common parameters used in functions.

Using Operators in Formulas

Every Excel formula uses the same structure i.e. it comes with an equal sign
which is followed by one or more operands and is separated by one or more
operators. Operands are values, ranges, function names, range names, cell
references while Operators are symbols such as a plus sign for addition (+),
a minus sign for subtraction (-), an asterisk for multiplication (*), a forward
slash for division (/), and a caret (^) for exponents.



You can make use of spaces between the operands and operators in your
formulae. It is good to make use of space because it makes the work easy to
understand. You can also make use of line breaks. If you want to insert a
line break, simply press the ALT key + Enter.

Using functions in your formulas

Following are some fundamental Excel functions to get you started,
assuming you can now input and function with your favorite formulae.

1. Excel's SUM formula

First and foremost, the SUM function in Excel is a must-know formula.
Values from several columns or rows are often combined.

=SUM(number1, [number2],...) =SUM(number1, [number2],...)
=SUM(number1, [num

Example: Summing up the values of a single row, =SUM(B2-G2).

=SUM is a simple selection that adds the column values (A2:A8).

A2:A7, A9, and A12:A15 are examples of A2:A7, A9, and A12:A15. The
collection sums values from A2 to A7, skips A8, adds A9, jumps A10 and
A11, and then adds from A12 to A15. "This is a highly sophisticated
compilation."

Note: You can alternatively express your function using a formula.

2. The MEDIAN Excel formulas

The average number of shareholders in a certain shareholding pool is an
example of a simple average that the AVERAGE function should bring to
mind.

=AVERAGE(number1, [number2],...) =AVERAGE(number1,
[number2],...) =AVERAGE(number1, [

Example: The formula =AVERAGE is used to calculate an average
(B2:B11). (SUM(B2:B11)/10) is likewise comparable.

3. Excel COUNT FORMULAS



The COUNT function keeps track of how many cells in a given range
contain just numeric values.

=COUNT(value1, [value2],...) =COUNT(value1, [value2],...)
=COUNT(value1, [value2

Example: COUNT is used to count the numerical values in a column (A:
A). To count rows, you must change the range of the formula.

4. Excel COUNTA Formula

COUNTA counts all cells in a specified range, precisely as the COUNT
function. All cells are tallied, regardless of their kind. It counts dates, times,
strings (including logical values and errors), and empty strings or text in the
same way as COUNT does.

=COUNTA(value1, [value2],...) =COUNTA(value1, [value2],...)
=COUNTA(value1, [value

Example: With COUNTA, any kind of row 2-13 in column C will be tallied
(C2:C13). On the other hand, COUNT cannot be used to count the number
of rows in a table. COUNTA(C2:H2) will be used to count columns C to H,
which will need a selection change within the brackets.

5. Excel's IF Formula

The IF function is often employed when you wish to sort your data
according to a set of rules. Other formulae and functions may be included
using the IF formula.

If the test is true, for example, the value is true and false.

Example: =IF(C2D3, 'TRUE,' 'FALSE') – IF(C2D3, 'TRUE,' 'FALSE') –
IF(C2D3, ' This method checks the two numbers to see whether C3 is
smaller than D3. If the reasoning is right, the cell value should be TRUE;
otherwise, it should be FALSE.

=IF(SUM(C1:C10) > SUM(D1:D10), SUM(C1:C10), SUM(D1:D10),
SUM(C1:C10), SUM(D1:D10)) - A lot of ins and outs in the IF logic. It
starts by multiplying C1 through C10 and D1 through D10, then comparing
the results. If the sum of C1-C10 is larger than the sum of D1-D10, cell



values are equal to the total of C1-C10. Otherwise, C1 through C10 would
add up to C11.

6. Excel TRIM Formula

By utilizing TRIM, you can ensure that your functions don't issue errors due
to unmanaged spaces. It guarantees that the design is devoid of cavities.
TRIM can only operate on one cell at a time, unlike other operations. As a
consequence, your spreadsheet will be clogged with useless data.

=TRIM(text)

7. MAX and MIN Formulas

The MAX and MIN functions may be used to determine the maximum and
least values in a range.

To put it another way,

=MIN

Example: =MIN(B2:C11) – Finds the least number between B2 and C2 in
columns B and C.

=MAX(number1, [number2],...) =MAX(number1, [number2],...)
=MAX(number1, [num

Example:=MAX(B2:C11) – =MAX(B2:C11) – =MAX(B2:C11) – =MAX
The maximum number between the two columns B and C is also calculated.

Examples of formulas that use functions

Formulas calculate the values in a cell and it is done with the help of a
function. For instance, the formula =B2+B3+B4+B5 adds up the values in
cell B2 to B5. The work of a function can come into this formula to make it
easier for you. The SUM function is needed here. Simply add the SUM
function like this =SUM (B2:B5). So, almost every formula has a function
attached to it.

Functions arguments

A function argument is a particular parameter that is sent to the function.
Let’s use the VLOOKUP function as an example. This function requires



four arguments as seen below;

=VLOOKUP (value, table, col_index, [range_lookup])

Not every argument is required. Some are optional. You will know an
optional argument with the square brackets that it comes with. Just like in
the VLOOKUP function above, the last argument [range_lookup].

Some of the Excel functions go with more than one optional argument. The
multiple arguments go with the ellipses (…). The COUNTIFS function is a
good example. See below;

=COUNTIFS (range1, criteria1, [range2, criteria2],…). So, you can
decide to include more arguments: range4/criteria4, range7/criteria7, and so
on.

More about functions

Some tips are necessary when using functions. When it comes to drafting
and modifying Excel formulas, there are a few factors that might help you
be as efficient as possible. You can see all of your formulae at once and
correct each one individually. Add-in wizards may aid in the creation of
functionality. Some of the tips are listed below;

Priority for the master operator

One of the most crucial aspects of formula writing is getting the operators
right, and I'm not talking about phone company operators. This has to deal
with mathematical operators, such as plus signs and multiplication signs,
and where the parenthesis should be. The sequence in which operations are
conducted, known as operator precedence, may significantly impact the
outcome.

This phrase serves as a mnemonic for the following information:

●      Settings

●      Exponents

●      Multiplication

●      Division



●      Addition

●      Subtraction

As a result, parentheses/settings take priority (first) while subtraction takes
precedence (last). To be honest, multiplication takes priority over division,
and addition takes priority over subtraction, but you get the picture!

The formula =1 + 2 15 equals 31 is an example. If you believe it should be
45, you should pay a visit to your aunt! If you use parentheses like this: =(1
+ 2) 15, the answer is 45.

Show Formulas

It's difficult to read your formulae without accidentally modifying them if
you haven't noticed. This is because if you're in "edit" mode and the
current cell includes a formula, the formula might include the address of
any other cell you click.

Isn't it simpler if you could simply glance at all of your formulas? There's a
way out. It's straightforward. Click File in the Excel workspace's upper left
corner, then Choices, the Advanced tab, and the Display options for this
worksheet section.

The Show formulae in cells instead of computed results check box is worth
noting. This box instructs Excel to show the formula itself rather than the
computed result in any cells with formulae. The worksheet that presents the
formulae is shown in the image below. Rep these steps and reject the option
to return to regular display.

Fix Formulas

Assume your worksheet has certain inaccuracies. Don't be alarmed! Even
the savviest users experience this, and Excel can help you find out what's
going wrong. The Error Checking button is located in the Formula Auditing
section of the Formulas tab. The Error Checking dialogue box appears
when you click the button, as illustrated above. That is, if your spreadsheet
has any problems, the dialog box will show. Otherwise, it simply displays a
message stating that the error check has been completed.



The dialog box opens when there are mistakes and remains visible as you
work on each one. Before the dialog box closes, use the Next and Previous
buttons to cycle through all of the errors. You decide what action to take for
each mistake it discovers:

●      Help on This Issue: This takes you to the Help system, where you can
look up the subject for the error you're having.

●       Show Calculation Steps: The Evaluate Formula dialog box appears,
and you may observe the formula being computed step by step. (NB:
This allows you to pinpoint the exact step that resulted in the
mistake).

●      Ignore Error: Excel may be incorrect. Ignore the mistake.

●      Edit in Formula Bar: If you don't need any more assistance, this is a
simple approach to fix the formula yourself.

There is also an Options button in the Error Checking dialog box. The
Formulas tab of the Excel Options dialog box is opened by clicking the
button.

Note: You may choose parameters and criteria for how mistakes are
identified and triggered on the Formulas page.

Use absolute references wherever possible

If you want to apply the same formula for a group of cells, such as those in
a column, the ideal technique is to type the formula once and then use the
fill handle to drag it down to the other cells. The issue is that any relative
references change when you drag the formula to different places.

This is often the objective. Each cell in the formula column often relates to
its neighbor in the data column when there is one column of data and an
adjacent column of formulae. If, on the other hand, all of the formula cells
refer to a cell that isn't nearby, the objective is typically for all of the
formula cells to refer to a constant cell reference. Use an absolute reference
to the cell to make this operate properly.

Apply conditional formatting to your documents



Conditional formatting allows you to apply a certain format to a cell when a
condition is true, similar to how the IF function returns a specific value
when the first parameter condition is true and a different value when it is
false. A drop-down menu with several conditional formatting choices may
be found in the Styles section of the Home tab.

This diagram depicts some conditionally formatted values. When you use
conditional formatting, you may provide the criteria and the format that will
be used if it is fulfilled. For example, if the value in the cell is larger than
100, you may request that it be shown in strong italic.

The conditions are established as rules. The rule types are as follows:

●      Format all cells according to their contents.

●      Only format cells that include.

●      Only the top or bottom ranking values should be formatted.

●       Only the numbers that are above or below the average should be
formatted.

●      Only format values that are unique or duplicate.

●      To identify which cells to format, use a formula.

Formatting may influence the following when the condition is true:
●      Borders
●      Font options (style, color, bold, italic, and so on)
●      Fill (the color or pattern of a cell's backdrop)

Validate your data

Data Validation is found in the Data Tools section of the Data tab. Data
Validation allows you to apply a rule to a cell (or cells), requiring that all
entries follow the rule. A cell, for example, may be programmed only to
accept integer entries between 50 and 100.

ENTERING FORMULAS INTO YOUR WORKSHEETS

Entering formulas manually



●      First, pick the cell for the formula.
●      Then, enter an equal sign (=) in the cell.
●       Then, put in the formula’s operands and operators. Most times, this

comes in with the open bracket and closed brackets.

●      Then, press Enter.

For example:

=SUM(29, 67, 89) This will add the numbers you have
mentioned here.

=SUM(B15:D15) This will add all the cells from B15 to
C15

=SUM(B15, D15, E17) This will add the cells B15, D15, and
E17.

Entering formulas by pointing

You can make use of the mouse to enter formulas in Excel. To do this, you
have to place some of the icons for the formulas in your Quick Access
Toolbar. So, right-click on the Quick Access Toolbar and select Customize
Quick Access Toolbar. Click the down arrow on the Choose Command
from option and select Commands Not in the ribbon. Then, add the icons
for plus, divide, minus, exponents, multiply, left parenthesis, and right
parenthesis.

Then, the icons will be displayed in the Quick Access Toolbar. To put in the
formulas, simply click on the formula icon you want to use as you type in
the values/number you want to calculate.

Pasting range names into formulas

●       To do this, first, enter the beginning of the formula. Here, I used the
SUM formula.

●      Navigate to the ribbon and click Formulas. Select Defined Names, Use
in Formula, and Paste Names. Then, choose the name. Click Ok.



Inserting functions into formulas

Select the cell you want to put in the formula. Select the Formula tab and
click Insert Function.

This will open up the Insert Function Dialog box. You can select a
category or search for a function. Here, I selected a function which is the
SUM function. Now, press OK.

The Function Argument box will display. In the Number1 box, choose the
number or the number range. You can decide to type in the range. If you
have more than one range, then you can select them from other Number
options. Choose OK.



The result will be displayed in the Function Argument box just in case you
don’t need the output in your worksheet. So, choose to cancel if you don’t
want it.  Select OK to see the output in your worksheet.

Function entry tips

1. AutoComplete and Tab

When you start typing a function name after entering an equal sign (=),
Excel uses AutoComplete to compare the text you input against a list of
accessible functions. Below the cell, you'll see a list of similar functions.
With each letter you enter, the selection of potential functions shrinks.

You may pick a function by double-clicking it or by using the down arrow
key and pressing Enter. Press Tab to add the beginning parenthesis or
bracket after you've typed the function.

2. Leave the closing parenthesis or brackets to Excel.

You don't have to input the final parenthesis or brackets when you're typing
a basic formula. If you type the formula below and click Enter, Excel will



automatically include closing  brackets (as well as capitalizing the cell
references):

=SUM(c1:c20

When the formula has many sets of parentheses or brackets, this won't
function.

3. Double-click the Fill handle to copy the formula down.

It's usual practice to replicate formulae from the first to the final cell in a
column. The Fill handle is mostly used to complete the other parts of a cell
with a particular formula that will correspond with the cells. It makes it
easier to input functions at once. 

4. Switch from relative to absolute cell references quickly.

Relative cell references are Excel's default kind of cell reference. A1 is a
relative identifier, for example. You may not want a cell to alter when you
duplicate it, use dollar signs ($) before the column and row numbers. $A$1
is an absolute reference, which means it won't change if it's duplicated. F4
is a shortcut for fast changing the chosen cells in a formula to absolute
references.

5. Choose arguments using the formula hint pop-up.

The formula hint pop-up may be used to pick arguments whenever you're
typing a formula that includes an Excel function.

Begin by using the function to input the formula. Below the Formula Bar or
the cell, a pop-up display. Click on the FX icon in the Formula Bar or the
cell whose parameter you wish to pick to quickly select arguments. Excel
will reveal all parameters in a hint pop-up for that function.

Select the argument you wish to choose from the pop-up menu. Even if the
argument includes additional functions or formulae, Excel will choose the
full argument. Substitute the value(s), cell(s), or range of cells for the
argument.

Editing Formulas



You might have made a mistake while inserting formulas in your cells. You
can easily modify them. Simply select the cell that has the formula which
you want to modify.

Then, click on the Formula bar. When you do this, the cell references for
that formula will be highlighted.

Depending on what you want to modify. It might be the operator or the cell
references. Simply click on the one you want to modify and enter in the
correct operator or reference. You can choose the correct cell to replace a
cell reference.

USING CELL REFERENCES IN FORMULAS

Changing the types of your references

There are two types of references in Excel which are Absolute and Relative
references. In relative reference, in a formula, the cell address is determined
by the relative location of the cell containing the formula and cell referred
to. The reference automatically updates you when you replicate the
formula. This reference takes the form of A1. This is the default cell
reference for Excel.

The Absolute cell reference is the precise cell address in a formula. It is
independent of the cell that carries the location of the formula. It is written
with a dollar sign preceding it such as $A$1. When you press F4 once, it
will change to the relative cell. Press F4 twice to change to a mixed
reference that is if the row is locked.



Referencing cells outside the worksheet

While you are working in Excel, you may want to bring in data from
another worksheet. You can do that easily. The best way is by creating a
relationship between the two worksheets. You do this with what is called
External reference. Follow the steps below to do so;

To refer to an individual cell, simply enter the name of the worksheet, put
an exclamation mark, and then put the cell address. For example, assuming
you want to refer to cell B2 which is in Sheet3, simply put it as Sheet3!B2.
Making a reference to a range of cells still follows the same process. Put in
the Sheet name, an exclamation mark, then the range cell address.

Referencing cells in other worksheets

You can do so with the steps above but there is a faster way of doing so. It
is done by pointing out the cell in the other worksheets.

�        You are to first enter the formula in a cell.

�        Navigate to the other sheet and choose the cell or range of cells for
reference.

�        Typing in the formula, then pick Enter.

Let’s say you are to know the Value Added Tax to a sale in another sheet,
and you have your sales number in Sheet sales in another sheet. Simply
enter in the formula =18%* in cell G2 on the VAT sheet. Then, navigate to
the Sales sheet, select cell G2. The external reference will be added by
Excel.

Referencing cells in other workbooks

You can reference a cell in another workbook whether it is closed or open.
For an open workbook, put in the name of the workbook in a square
bracket, enter the name of the Sheet with an exclamation mark next to it,
then enter the cell address. For instance, you want to refer to cells E2:E5 on
sheet May and the worksheet name is Products.xlsx, simply enter it this
way [Product.xlsx] May! E2:E5.

USING FORMULAS IN THE TABLE



Summarizing data in a table

There are different ways you can summarize your data in a table and this
will make your work very arranged. Some of the ways are listed below;

1. Sort: If all you need is a fast glimpse at organized data, the simplest
method to summarize data would be, to begin with, a basic sort.
Furthermore, many summarizing jobs need sorted data. If users are unaware
of this, the analysis produced will be erroneous. If feasible, simplify any
needed sort process while developing workbook apps for others. If you
don't want to utilize automation, make sure your employees are well &
informed of this information. It'll play an important role between accurate
information and a jumble.

2. AutoSum: This is a good method of data summarization. Just choose a
cell below or to the right of a value range. Then, pick AutoSum. A Sum
function will be inserted and it will give a reference to the data above the
range of values or the left of the range of values. However, you can make
use of other functions like Count(), Average(), Maximum(), etc.

3. Pivot Table: This option has more impact in structuring your data rather
than a summary, though they still have some good summarizing options.
Below is an example of how it works;



First, pick the data range. Choose Insert and select PivotChart. Then, click
PivotChart & PivotTable.

On the dialog box, select the data you want to summarize, analyze and
arrange. You can choose to analyze more than one piece of data. Then, pick
OK.

The pivot table will appear in your worksheet and on it, you can make some
changes to your work such as regrouping the table.

4. Consolidate: This feature is used for merging and summarizing data in
multiple workbooks. It is also used to summarize data that is in a particular
file. To use this feature, you have to be sure of the following;

�        The columns must have a range name and a heading.
�        The values to be summarized have to be on the left of the values to be

summarized.



Click the upper left anchor cell in which the summary is to show. Select the
Data tab and pick Consolidate.

In the dialog box, select the right function from the Function menu. Put in
the range name of the data you are summarizing. Pick the options you need
from the Use Labels option. Press Ok.

The summarized data of your work will be displayed.

Using formulas within a table

In Excel, after you have created a table, a name is given to that table and
column header automatically by Excel. While adding formulas in the Excel
table, the names are displayed automatically when you do so. See an
example:  =SUM(F2:F7) and =SUM(Sales[Profit]).

Excel will use the name of the table and columns rather than the cell
references. A structured reference is a collection of table and column
names. When you update or delete values in the table, the names in
structural references change. Structured references can emerge when you
build a formula that refers to table data outside of an Excel table. In a big
worksheet, the references might help make it simpler to find tables.

Select the cell you want to add a structured reference rather than typing the
cell reference in the formula. An example is displayed below; we will be
making use of the data sample in the image below.



First, you are to create a table. So, pick the cells and press Control Key +
T. Check the box next to My table has headers option. Enter an equal sign
in cell E2 and select cell C2. You will see the structured reference [@Sales
Amount]] display after the equal sign.

Referencing data in a table

Simply type in the formula and ensure that you do that with an equal sign
preceding the formula. Then, on the first reference, choose the cell or the
range of cells in the table. The column name will be chosen by Excel which
will create a structured reference for you. Then, enter the closing
parenthesis. Hit Enter. The formula will be entered by Excel in the column
if the formula was generated inside the table.

CORRECTING COMMON FORMULA ERRORS

Handling Circular references

Sometimes when you are handling your data and values in Excel using
formulas, you experience some error messages just like the one in the image
below;



If you get the following warning, choose Help for additional details, or
select OK or the x button to end the message window. Excel shows a zero
(0) or the latest computed value in the cell after you shut the dialog window.
Yes, in certain situations, a circular reference formula might finish
successfully while attempting to compute itself, and whenever this occurs,
Microsoft Excel delivers the result from the most recent valid computation.

Simply said, a circular reference occurs when you have a formula in a cell
that utilizes the cell (in which it was inserted) to do the computation. Let's
say in cell B1:B5, there is a dataset. Then, you use this formula
=SUM(B1:B6) in cell B6; you will get a circular reference warning. WHY?
This occurred because you want to add the values of cell B1:B6, and the
result should be in cell B6.

So, how do you discover a circular reference?

Open the worksheet containing the circular reference. Select the Formula
tab and choose Error Checking. Select Circular References and this will
display to you the cell which contains a circular reference. Then, click on
the cell option displayed for you so you can know the cell.

There are things you should note when handling circular references. They
are listed below;

�        The circular reference may not be in the active sheet and this will
only display the circular reference but will not display the cell
address.



�        When you get that warning sign as seen earlier, and you close the
box, likely, the box won’t appear again.

�        This prompt appears whenever you open a workbook that contains
the circular reference.

Specifying when formulas are calculated

There are different calculation modes in Excel. Sometimes, you may be
calculating some stuff but they don’t calculate automatically. This might be
because you are not using the right calculation option. You need to know
the calculation mode that is in order to avoid this issue.

To do this, go to the Formula tab and choose the Calculation Option. You
will see the three calculation options that you have.

When the option is set to Automatic, it means that your formulas will
calculate automatically while if it is set to Manual, it will not calculate
automatically. The settings you choose here will apply to every workbook.

There are shortcuts for calculating your works with the Manual mode. See
the image below.



USING ADVANCED NAMING TECHNIQUES

Using names for constants

Navigate to the Formulas tab and select Define Name. The Name box will
open and on it, enter in the name for the constant.

Move down to the “Refers to” box and put in the constant. Here, I made
use of ={"January","February","March"}. Then, press Ok.

Then, choose the cell for the constant. Then, navigate to the formula bar
and put in an equal sign. Then, enter the constant’s name. Here, my
constant’s name is Quater1. Don’t forget to put the equal sign. =Quarter1.
Then, hit Enter.

Using range intersections

Range intersections are individual cells that two ranges have in common. If
you have two named ranges, you can use the intersection to reference
individual cells. When you include a space character between two cell
ranges, this means that you want to return the intersection.

A space character is known as Intersection Operator. This operator can be
used to return the intersecting value of two correlating cell ranges. For
example, select cell 9 and press the equal to sign. Select the range C2 to C5.
Press the Spacebar and then select range B3 to E3.



Press Enter. The formula will return the value 85 and that is the value at the
intersection cell C3 of the two ranges.

You can use multiple rows and multiple columns to return more than one
value in more than one cell. Select cellC9 and press equal to sign. Select B3
to E4. Press the spacebar and select cell D2 to D5.



This formula will return an array of the intersection of both ranges. Press
ENTER.

Applying names to existing references

Names may be added to existing formulae. If you use ordinary cell
references in your formula and then assign Names to those cells, the
formula will automatically change to utilize the Defined Names. As an
example, consider the formula =B7+G7. You may pick the cell that has
the formula, go to the Insert menu, Select Name, and then Apply if you
subsequently give the names CellOne to B7 and CellTwo to G7. Pick the



relevant names from the list, or choose all of them, and then click OK. The
formula will be changed to =CellOne+CellTwo in Excel.

WORKING WITH FORMULAS

Not hard-coding values

Hard coding is among the worksheet errors you can experience while
working with formulas in Excel. Hard coding of values simply indicates
that when you have a formula such as =C2*G3, you can add a value to it.
For example, =C2*G3 + 750.

The value that was added which is +750 is a hard-coded number. This value
will bring up errors. So, ensure that your cells contain just data or formula.
Do not mix them up.

Using the formula bar as a calculator

You can perform some calculations using the formula bar in Excel. The
formula can serve as a calculator for you. For instance, put in the formula
below and after putting it, do not press the Enter key.

= (165*3.86)/16

Let’s say you press the Enter key, the answer to this equation will be
displayed in the selected cell. Though the answer will be the same even if it
is displayed in the formula bar. To make the answer display in the formula
bar, simply press F9. You will see the answer in the formula bar.

Making an exact copy of a formula

Choose the cell that has the formula. Press Control key + C on your
keyboard. You can also choose Copy on the Home Tab. The cell that you
want to copy the formula will be highlighted. The cell will stay that way till
you have pasted the formula.



Now, pick the cell for pasting the formula. Then, press Control key + V.
You can right-click and choose any of the Paste options given to you. 

Converting formulas to values

First of all, choose the cells with the formula for the changing of value.
Press Control key + C to copy them. Then, right-click and navigate to the
Paste Options and pick Values. This will convert the formulas to values.

There are shortcuts for doing this to make it easier for you. The first one is
the Shift key + F10 + V. After highlighting the cells and copying them,
press this shortcut key. The second one is the ALT key + E + S + V. The
third one is the ALT key + H + V + S + V. They are following the same
process but different shortcut keys.



CHAPTER TWO

USING FORMULAS FOR COMMON MATHEMATICAL

OPERATIONS

Calculating Percentages

Calculating percentages in Excel is an easy process and it can be done in
many ways such as Formulas and Formatting. How you calculate it depends
on the type of data you have. There is no particular formula for calculating
the percentage. Below is how to do so;

First, choose a cell and put in an equal to sign = and then put in an open
parenthesis. Put in the name of the cell you want to calculate the
percentage. Put an asterisk. Select the cell that has the percentage you want
to calculate. Then, put in a close parenthesis. Then, hit Enter.

Calculating percent of goal

This is a super quick and simple Excel formula. In the image below, you
have Office, some sales, and you have your goal.



So in the first case of Alabama, we are going to say our goal was $100,000
and our total sales were $65,954. So, we need to calculate the percentage of
our goal that we reached. The formula will be our Sales over our goal which
is =B2/C2

You will get 66%. Always make sure that you are highlighting your column
at least before pressing the percentage icon, otherwise, it is going to come
out as a decimal, and obviously, we want it to be displayed in terms of
percentage. So, use the fill handle to fill in the other cells with their
respective percentage goal.



Calculating percent variance

Percentage variance is the change or difference between two variables. it
can be a difference between the sales you made last year and the sales you
made this year. It displays how things have changed over some time.
Calculating percent variance can be done with two formulas which are;
(new value – old value) / (old value) and new value / old value – 1.

For example, you have an estimated sale and an actual sale. Now, let’s find
the percent variance. Using the image below, the formula will be =(C2-
B2)/B2 or =C2/B2-1. Then, press Enter. You will get the result. Both
formulas give you the same answer. You can use the fill handle to fill in the
percent variance for other cells.

 

As you can see in the image, the numbers are in decimals. You can modify
it by clicking the percentage icon in the Number group on the tab or you
right-click and format the cells as a percentage.



Calculating percent variance with negative values

Most times, you may have a negative value in your work and you want to
calculate the percent variance of those values. The formula used above will
not do that for you. You have to use the ABS formula which is (new value
– old value) / ABS (old value).

So, now we have negative values as you can see below. The formula for this
will be =(C2-B2) / ABS (B2).

This formula gives the correct answer but is likely to bring out some
misleading results. This may occur when the main value is positive while
the new value is negative.

Calculating a percent distribution

A percent distribution explains how something is distributed within the
different parts that make up something. Calculating this is an easy process.



Simply divide each of the parts by the total part. The cell reference to the
total is absolute.

Calculating a running total

Assuming you want to save about 5000 dollars and all you have now is
2450 dollars in your account. You can decide to find out the percentage of
the amount you have saved. You can do this with Excel.

1. First, enter the total amount to want to save up in a cell and enter in the
amount you have in another cell.

2. On another cell, put in an equal sign followed by the cell address of the
total amount. Then, put in a slash / and enter in the cell address of the
amount you have now followed by a closing parenthesis.

3. Then press Enter. You will see an answer displayed on the cell. Simply,
right-click, then pick Format Cell. Choose Percentage. You can modify the
decimals places if you wish to. Select OK.



You will get the percentage.

Applying a percent variance with negative values

This can be done with the IF function and MIN function.

=IF(MIN(old value, new value)<=0,"--",(new value/old value)-1)

The following is how it works:

The IF function's logical test (MIN (old value, new value) =0) determines
the minimum of the two numbers and checks if it is below or close to 0. 
TRUE or FALSE will be the outcome.



When the answer is TRUE, it means that there is a negative number (or
zero). We may show some text in this scenario to inform the reader. This
might be whatever you want it to be. I just used two "–" dashes. You may
alternatively use the NA () method to return a N/A error or any text that
informs the reader that the percentage change could not be computed.

When the result is FALSE, the percent difference method is used to bring
back two positive integers to calculate the % change.

Dealing with divide-by-zero errors

The IF function is a great function to use when dealing with divide-by-zero
errors in Excel. There are other functions that you can use to perform the
same action. Here, we have got just the simple table that we have which
consists of Year one sales, Year two sales and we have calculated the dollar
change and the percent change. But for one of these items, since there were
no sales in year 1, we inherently have it divided by zero error.No no way we
can avoid that.

So, no one wants to see an error message locked out on the report. So we
need to find some way to deal with it. So, we will make a different formula
for our percentage change. Instead of dividing D8 BY D8, let’s just take out
the values in the percentage cells.



Then, using the Function Wizard, we will make a formula for it. So, type in
this =IF(, then press the FX icon to open the Function Argument. The first
option is our Logical text and that is going to be cell B8=0. The second
option is the Value if true which is where you decide what you want to
display. A lot of times, I will just put in two quotations (‘’) marks so that I
will get nothing in there.

If you want the text, the text has to be always in quotation marks. That is
the two quotation marks if you want nothing and maybe you would want to
say NEW product and therefore we cannot calculate a percentage change or
if you wanted to show 0 as a percentage change on those products. I will let
you argue with the match nerds about whether or not it should show zero.
but whatever you want to put in there that’s going to be the value if true.

The value of false is our original formula and that will be the dollar change
divided by last year's sales. Press OK.



Then, when you use the fill handle to fill the other cells in, you will see we
no longer have the Divide by Zero Error.

ROUNDING NUMBERS

Rounding off numbers can be done with the use of the Round function.
There are two arguments for the Round function which are the Number and
the Number digits. The number consists of the number that is to be rounded
up while the number digits are the number of digits which the number is to
be rounded. The function is located in the Formula tab.

Rounding numbers using formulas

In the image below, you are to round up the percentages. So first select the
cell.



Then click the Formula tab, Math & Trig, and then ROUND.

Then, on the Function Argument dialog box, enter in the Number and the
Number Digits. You can click on the cell to select the number. Choose OK.

You can use the =Round function to do the same thing as well.



Rounding to the nearest penny

You can round to the nearest penny by using the MROUND, CEILING, or,
FLOOR function. MROUND function rounds a number to the nearest
multiple that you pass to it.

So, to round up the amount in cell A1 to the nearest penny, simply use
MROUND with a multiple of 0.001. Your formula should be this way
=MROUND(A2, 0.01).

Then, hit ENTER. You will see the 5.323 rounded up to 5.32. Use the fill
handle to fill in other cells.

The CEILING function will round a number up to the nearest multiple of
significance that you pass to it. So, passing a 0.01 as the sign tells the
CEILING function to round up to the nearest penny.



5.323 is rounded to 5.33 and 5.567 is rounded to 5.57.

The FLOOR function works the same way except it forces rounding down
to the nearest significance. So, passing a 0.01 as the sign tells the FLOOR
function to round down to the nearest penny.

5.323 is rounded to 5.32 and 5.567 is rounded to 5.56. If you want to round
to the nearest nickel, use 0.05 as the multiple. For example, MROUNDS
rounds 5.32 to 5.3, CEILING rounds to 5.53, and FLOOR rounds to 5.3.



If you want to round to the nearest dollar, use 1 as the multiple. For
example, MROUND rounds 5.32 to 5, CEILING rounds to 6, and FLOOR
rounds to 5.

Rounding to significant digits

Significant numbers are digits that add to the correctness of a number, in a
scenario if you didn't know or didn't recall. The functions ROUND,
ROUNDUP, and ROUNDDOWN may be used in these situations since they
include rounding techniques for positive, negatives, full, and fractional
values.

However, there are a few guidelines that you should follow:

A negative number is first transformed to its actual values before being
rounded (its value without the negative sign). The negative sign is then
reintroduced after the rounding step. Although it may seem illogical, this is
how rounding works.

When the ROUNDDOWN function is used to round -779 to two significant
digits, the output is -770. To begin, we convert -779 to its absolute value of



779. The result is then rounded down to two significant numbers (770).
Finally, the negative sign is repeated, yielding a -770 result

When you use the ROUNDDOWN function on a positive number, it still
rounds it down, and when you use the ROUNDUP function, it always
rounds it up.

The ROUND function rounds a fractional value in the following way: The
number is rounded up if the fractional portion is 0.5 or more. The number is
rounded down if the fractional portion is less than 0.5.

The ROUND function rounds a whole integer up or down in the same way
as fractional numbers are rounded up or down, replacing multiples of 5 for
0.5.

When rounding a number that has no fractional portion (a whole number),
you subtract the length from the number of significant digits you wish to
round to.

To round 2345678 to three significant digits, for example, use the
ROUNDDOWN function with the argument -4, as shown below: = round
numbers in Excel. The result is 2340000, with the "234" component serving
as the significant digits.

COUNTING VALUES IN A RANGE

You count the number of values that match a certain range. Counting values
in a range are done with the use of the SUMPRODUCT and COUNTIFS
functions. It counts how many cells match one or more
conditions/requirements. The COUNTIFS function uses this formula
=COUNTIFS(criteria_range1, criteria1, [criteria_range2, criteria2]…)

Explanation:

�        Criteria_range 1 is the data range that will be calculated with the use
of criteria1.

�        Criteria1 is the condition that defines which cells are to be counted.

�        Criteria_2 & Criteria2 are voluntary; they are applied when there is
an existence of over one criterion.



In the image below, the formula in F6 is
=SUMPRODUCT(1/COUNTIF(B5:B14, B5:B14))

Explanation:

COUNTIF is used from B5:B15 which uses the same values as criteria
COUNTIF(B5:B14, B5:B14). We have ten values for criteria, so we are to
bring back an array that has ten results such as {3;3;3;2;2;3;3;3;2;2}. These
numbers signify counts. For instance, Jim displayed three times, Mark
displayed three times, etc.

The array will be configured as a divisor. The number 1 will be the
numerator. When you are done dividing, you will have another array as
seen below;

{0.333333333333333;0.333333333333333;0.333333333333333;0.5;0.5;0.
333333333333333;0.333333333333333;0.333333333333333;0.5;0.5}

Every value that is displayed once in that range will be displayed as 1s
while values that are displayed more than once will be displayed as
fractional values.

USING EXCEL’S CONVERSION FUNCTIONS.

The Excel conversion function is used to convert numbers in a
measurement system to another system such as gallons into liters, pounds
into kilograms, and so on. For instance, the formulas you see below make
use of the Convert function. Here, it converts yards to meters, gallons to
liters, Celsius to Fahrenheit, and square meters to square yards,

=CONVERT(100,"yd","m") //



returns 91.44
=CONVERT(22,"C","F") //
returns 71.6
=CONVERT(1,"gal","l") // returns
3.79
=CONVERT(100,"m2","ft2") //
returns 1076.39

There are things you need to note down when working with the conversion
function. It is case-sensitive. If a unit string is not found or recognized, it
will display a #N/A error. If the units are not well-matched, it will display
the #N/A error. Also, it will display the error if the number is not valid.

This function has the following arguments:

1. The number which you are to convert (Number)

2. The unit in which the number you want to convert is in (From Unit)

3. The unit in which you want to convert the number into (To Unit)

 

 



CHAPTER THREE

 USING FORMULAS TO MANIPULATE TEXT

WORKING WITH TEXT

When you work on Excel, you go on with numbers, text, calculations,
formulas, and so on. Almost everything done in Excel is done with Text.
There are different functions and formulas used in Excel when working
with text. The text splitting function helps you disperse words from a
particular cell to another.

There are tips you need to know while working with text. Some of the tips
are listed below;

Changing Text Case: You must know when the text you work with should
be uppercase, lowercase, or proper case. Some of the text functions are
case-sensitive. So, when you don’t put in the correct case, the function will
not work properly.

Imagining "Beyond the Cell'': I often observe Excel users retyping or
manipulating data inside a cell to get the desired format and appearance. To
borrow an overused cliché, you'll frequently work “outside of the cell"
when transforming text, which means adding additional columns to contain
the formula to display the results. You may have some version of the data,
don't retype it; instead, use any of the text functions below to construct what
you need such as the Paste Values option to copy and paste the results into
the cell or another column after you have the results.

Cleaning up Data: Having too much text and spaces on your worksheet is
not proper. You can use the TRIM or CLEAN function to clear out strange
characters and extra spaces in your worksheet.

Using Text Function

You make use of the Text Function to change values into text. Even after
changing the value to text, you can still format the value to your desired



format. Most times, people use it to change numeric values to text, though it
can be used to change any value at all into text. The formula is

The value means the number that is to be changed to text. It might be a
number, date, cell reference, etc. while the Format_text is the format you
want to use. So, the formula is an easy process. However, there are some
tricky parts to it. That is the ability of it to give you a code that will bring
out the number in a format of your choice. Though, the function agrees with
most if not all the format codes used in Excel number formats.

For example, you want to convert a date like 2/1/2019 to February 1, 2019,
simply select the cell for the input and put in this format code =TEXT(A1,
“mmmm d, yyyy”)

Joining text strings

There is an Excel function that is used to join two or more text strings and
that function is the CONCATENATE function. There are two ways to go
about and use this function. Hers, what I have is the first name mentioned in
column D and the last name of the dimension mentioned in column D. The
idea is to give the full name by joining the text in column D and column E
by giving in a space in-between and that will result in the full name of the
individual.



So, to do this, write the equal sign, followed by the CONCATENATE
function, then select the first cell and press comma. Now, I need to give a
space, though the space will be treated as a text in the formula and hence I
will give the space within quotes. So, press the open quotes, give a space,
put in another quote, put in a comma, and enter the second text string
poster. Then, close the parenthesis. =CONCATENATE (D4, “ “, E4).

Press Enter. The first name and the last name will be joined together in the
full name column.

Use the fill handle to fill in other cells.



Settings text to sentence case

In Excel, you have three functions that change the text to sentence case.
They are the UPPER, LOWER, and PROPER functions.

�        UPPER (): This changes the text to uppercase.

�        LOWER (): This changes the text to lowercase.

�        PROPER(): This changes the text from the improper case (which is
the mixed form) to the rightful cause. The beginning letter of the
word is changed to uppercase while the rest are in lowercase.

For example, let’s use the upper function. Using the image below, I would
like to change the values in cell A1 to the upper case. So, I insert the
UPPER function followed by the cell. Then, I hit Enter.

It will change to uppercase. If you would like to change all the values in
your work to uppercase, simply use the fill handle and drag it down.



The same process goes with the LOWER function and the PROPER
function.

     



Removing spaces from a text string

While working with Excel, it is likely that at some point, you will see data
that has extra spaces. Extra spaces can cause issues with charts, formulas,
and printing. These extra spaces can occur at the beginning and the end of
the text. They can also occur between text strings.

The good news is that Excel has a function named TRIM that helps remove
extra spaces. The first example we will look at is removing extra space
from the beginning of a text string. In Cell B4, we have the texturing Hello.
As you can see in the image below, there is an extra space at the beginning
of the string.

So, let’s go to cell C4 to fix this. We will specify a formula with an equal
sign followed by the TRIM function and then opening parenthesis. Put in
the cell and add a closing parenthesis. =TRIM(B4).

Press ENTER. Now, you can see that the Hello text no longer has an extra
space in front of it.



In the next example, we will remove extra spaces between two words. As
you can see in cell B4, we have the text string GOOD MORNING and it is
quite obvious that we have extra spaces in between the words.

Now, let’s go to cell C4 to fix the issue. We will try a slightly different
method. Last time we wrote in the formula using the formula, now we will
use the INSERT function command. Click on the FX icon close to the
Formula tab and then search for the TRIM function. As you can see in the
image, it says TRIM removes all spaces from a text string except for single
spaces between words.

So, go ahead and click OK and you will need to specify the text. Click on
the Good Morning cell to specify it.

 



Click OK. As you can see, the good morning now does not contain the extra
spaces between the two words.

Extracting parts of a text string

Depending on the part of the text string you want to extract. Functions like
MID, RIGHT, LEFT, FIND, LEN, SUBSTITUTE, REPT, MAX, and TRIM
to do so. Let me give you an explanation of them and how they work.

MID: This is used to extract a part of a string from the middle of that string.
It extracts six characters and begins at a position 7 (O)

LEFT: This is used to extract a part of a string from the left.



FIND: This is for extracting a part of a string of any length before the dash.
It discovers the position of the dash. Minus one from the result to extract
the right values for the left characters.

Right: For extracting the right part of a string.

If you want to extract the parts after the dash, you will have to include the
LEN and FIND functions.

The function of LEN is to bring out the length of the string while the
function of FIND is to discover the dash position.

Finding a particular character in a text string

This is done with the Find Function. The function is case-sensitive. Also,
the IFERROR function will bring out the value as output i.e. when there is
an error when using the Find function. Example below;



In the image below, there is a list of items and their amounts. If you look
well, you will notice that some of the amounts have a question mark instead
of the actual amount.

Now, to find “?”, we will put in this formula =IFERROR(FIND("?",
B2)>0, "Not found") in cell C2. Then, hit Enter.

Copy the formula. Then, select the range C3:C8 and paste the formula. The
cell that has the “?” will display “Not Found”.



Now, the Search function comes in. it will help find the character. Navigate
to cell D2 and put in this formula =IFERROR(SEARCH("Amt", B2)>0,
"Not Found"). Hit Enter.

Then, copy the formula. Select range D3:D8 and paste.



Substituting text strings

The SUBSTITUTE function can be used to substitute characters in a text
string. This is an easy process. Simply select the cell in which you want to
get the result. Type =SUBSTITUTE (cell name, open quotes (“), the text
you want to replace, closed quotes (“), open quotes, the text you want to
replace with, closed quotes, and then close parenthesis. Press Enter.

Counting specific characters in a cell

You can count the number of times that a character displays in a cell. This is
done with the SUBSTITUTE and LEN functions. In the formula here;
=LEN(A1)-LEN(SUBSTITUTE(A1," a",")), “A1” stands for the cell
reference while “a” stands for the character that is to be counted.

Using the image below, the cell which is selected contains this formula;
=LEN(B3)-LEN(SUBSTITUTE(B3, C3,"")).

How does this work?

The SUBSTITUTE function removes the characters that are being counted
in the source text. The original text minus the length of the text (minus the
characters). The number of characters that were discharged with the



SUBSTITUTE function is the result and it is in line with the count of those
characters. Note that this function, SUBSTITUTE, is case-sensitive.

LEN function calculates the total number of characters in a cell. It
calculates both spaces.

You can use both functions to calculate the number of characters in a range
of cells.

Adding a line break within a formula

People do wonder if it is possible to add a break line in a formula. The
answer is YES! It is done with the CHAR function followed by number 10,
as well as & operator. The operator combines the line break character with
the other text in a formula.

For example, you want to calculate the total sales on a cell, and you used
this formula =SUM(B1:B6). To add a break line to this formula, it changes
to =&CHAR(10) & SUM(B1:B6).

After adding the line break, hit ENTER. You may or may not see a small
strange box where the line break is. This means that the wrap feature is not
on. So, to turn it on, pick the cell that contains the line break, then select
Wrap in the ribbon. This will display the line break in the cell and the
square box will disappear.

Cleaning strange characters from text fields



While working on your worksheet, you may have some strange characters
on your work and you would like them to be removed. This mostly occurs
when you are importing from external databases.

To fix this problem, the CLEAR function comes in. This function removes
all non-printable characters.

Simply enter the formula =CLEAN (then put in the text you want to clear).
You can do this by tapping on the cell or cells that contain the strange
characters.

Also, to remove unnecessary spaces, you can use the TRIM function
together with the Clean Function. The formula is =TRIM (CLEAN,
followed by the text or the cell reference)

Adding leading zeros in Excel

You may want to add leading zeros to numbers if you have a variety of
different ranges of numbers but they have a different amount of numbers
within them. In other words, if there is a number that starts with 100 and
there are other numbers that are just single digits but you want all of your
data to look uniform and if they don’t have numbers in the hundreds place,
you want there to be zeros.



You want those leading zeros to be there to make everything uniform. Also,
if you just want to add a couple of zeros to any data that exists for any
reason, there are ways to do that. So, the first thing to do is to select the data
you want to add that information to.

Here, I have cells containing two-digit numbers, three-digit numbers, four-
digit numbers, and a five-digit number. So, I will try to make everything
even. I want all of these numbers to have leading zeros so that they can be
of the same length.

After choosing the cells, right-click, then pick Format Cells. Pick Custom.
Up in the menu where it says General, type in zeros and the first two zeros
that you type will be replaced by the actual numbers themselves because
there are two-digit numbers. But if you continue to type and you make five
numbers i.e. five zeros, you will see that the sample displayed for you has
three leading zeros now followed by the actual number and that is going to
populate your data.



Pick OK and then on your worksheet, the leading zeros will be put in just
the way it was planned. They all now have the same length with the five-
digit number.

Using the DOLLAR function

The Dollar function converts a number into a piece of text formatted as a
currency. The foremost formula for this function is =DOLLAR (Number,
Decimals). The number here stands for the number which needs to be



converted while the DecimalPlaces stands for the number of decimal places
needed in the converted number.

For example, in the image below, we are to convert the numbers to currency
using this dollar function. So, on cell C1, enter in the formula
=DOLLAR(B1,2). Press Enter.

You will get the number converted to the dollar currency. Use the fill handle
to fill in other cells.



 



CHAPTER FOUR

USING FORMULAS WITH DATES AND TIMES

UNDERSTANDING HOW EXCEL HANDLES DATES AND TIMES

These are some of the prerequisites for mastering Excel. One of them is the
ability to utilize Excel Date Formulas. This is because a lot of the data we
deal with in our jobs includes dates and times, such as how old your
customer or employee is today, when was the last time a certain client
purchased from you, the length of a contract, and so on.

So, if you don't understand how Excel's date and time functions operate,
you'll waste a lot of time manually converting dates to the appropriate
month or year before you can start your research.

Given this, we believe we must begin this section by sharing with you our
understanding of how Excel keeps dates and timings in spreadsheets.

You will be able to freely use the date and time formula in your worksheet
if you have a strong grasp of date and time in Excel. And I promise you'll
be more productive than ever when it comes to data analysis.

How Excel stores dates:

The way Excel maintains information is the cause of the majority of the
misunderstanding around dates and timings. You'd think it'd remember the
month, day, and year when it comes to dates, but that's not the case...

Excel keeps track of dates as a serial number that indicates the number of
days that have passed since the year 1900 began. This implies that January
1, 1900, is just a 1. The year 1900 begins on January 2nd. The statistics
have become very huge by the time we reach the current decade... The date
of September 10, 2013, is saved as 41527.

How Excel stores time:

Excel uses the same serial numbering scheme for times as it does for dates.
The day begins at noon (12:00 am or 0:00 hours). Because each hour



represents a quarter of a day, it is denoted by the decimal number
0.041666...

That implies the time on September 10, 2013, at 9:00 a.m. (09:00 a.m.) will
be saved as 41527.375.

When you provide a time without a date, Excel treats it as though it
happened on January 1, 1900. To put it another way, 3:00 p.m. (15:00) is
saved as 0.625. This might make performing arithmetic for time-only
numbers (without a date) difficult, since subtracting 6 hours (6:00) from
3:00 am (03:00 hours) can result in a negative number, which will be
recorded as an error: 0.125 – 0.25 Equals -0.125, which is shown as
######### on the screen.

In Excel, minutes and seconds function in the same manner as hours...

A minute is 1/60 of an hour, 1/24 of a day, or 1/1440 of a day in total, which
equals 0.00069444...

A second equals 1/60 of a minute, 1/60 of an hour, 1/24 of a day, or 1/86400
of a day in total, which is 0.00001157407...

Understanding dates serial numbers

The date serial number, also known as the date-time serial number, is a
number that Excel uses to record dates and times

When you look at a date in Excel, you're looking at a standard number that
has been formatted to seem like a date. You may view the underlying date
serial number if you set the cell format to 'General.'

The day is represented by the integer component of the date serial number,
while the time is represented by the decimal portion. The date serial number
1 begins on January 1, 1900, i.e. 1/1/1900 has a date’s serial number of 1.

Example of a serial number in Excel Date and Time

Caution! After February 28, 1900, Excel dates are one day out. Excel acts
as though the date 29 February 1900 existed, although it did not.

Microsoft incorporated this problem in Excel on purpose to keep it
compatible with Lotus 1-2-3, the spreadsheet application that dominated the



market at the time.

Lotus 1-2-3 was designed improperly as though 1900 was a leap year. This
isn't an issue as long as all of your dates are after March 1, 1900.

Starting on January 1, 1900, Excel assigns a number value to each date. The
first day of the year 1900 has a numeric value of 1, the second day of the
year 1900 has a numeric value of 2, and so on. These are known as 'date
serial numbers,' and they allow us to conduct arithmetic and employ dates
in formulae

The Date Serial Number column presents the values of the Date column as
date serial numbers. 1/1/2017, for example, has a date serial number 42736.
Since December 31, 1899, the 1st of January 2017 has been 42,736 days.

Note: If you format the date serial number column as a Date, the values will
seem to be the same as those in the Date column.

Entering dates

You may write in numerous date formats, and Excel will recognize it as a
date, convert it to a date serial number and assign a date format to the
column when you click ENTER.

Try entering (or simply copying and pasting) the dates below into an empty
cell:

●      1-1-2022               

●      1-1-22

●      1/1/2022

●      1/1/22

●      1-Jan-22

●      1-Jan 22



Entering integers that seem like dates and are separated by a forward slash
or hyphen will be recognized as a date, as shown in the table above. Even
the month name is transformed to date when entering in a date.

Dates separated by a period, such as this 1.1.2009, or with spaces between
digits, such as this 01 01 2009, will appear as text rather than a date. You've
got to set some boundaries!

Note: When a cell displays ##### in a cell, it typically means that the
column is too narrow to show it.

However, if you expand the cell very large and it still shows #####, then,
the date is a negative number, and Excel is unable to display negative dates.

Using Two-Digit Years to Enter Dates

Excel must determine if you mean 2022 or 2020 when you provide a date
with two numbers for the year, such as 1/1/22.

 

Those with the years 29 or before are classified as 20xx, whereas dates with
the years 30 or after are handled as 19xx. 

Note: If you input the day and month components of a date, Excel will
automatically insert the year depending on the time on your computer. This
is useful information for data input.

Understanding time serial numbers



Times are also expressed as decimal fractions and employ a serial number
format.

Hours: Because 24 hours equals one day, we may deduce that 24 hours has
a time with a serial number of 1, which can be expressed as a time to
represent 24:00, 12:00 AM, or 0:00. While 12 hours or noon has a value of
0.50 because it is half of a day, and 1 hour has a value of 0.41666' since it is
1/24 of a day.

Minutes: Because 1 hour is 1/24 of a day and 1 minute is 1/60 of an hour, 1
minute equals 1/1440 of a day, or its time serial number is 0.00069444'.

Seconds: whereas a second equals 1/60 of a minute, 1/60 of an hour, and
1/24 of a day. One second is also 1/86400 of each day or
0.0000115740740740741 in time serial number form...

ENTERING TIMES

When entering time, you must use the h: mm format at the very least. i.e. a
colon separates the hour and minutes, with no gaps from either side. When
you provide the h: mm elements, the time will be represented in military
time, for example, 2:00 PM is 14:00 in military time.

Excel will structure the cell as h:mm: ss if you provide a time that contains
a seconds component, such as 3:15:40.

If you wish to format the time with AM/PM, just put a space after the time
and then write AM or PM, or use the number format later. Listed below are
some instances.



FORMATTING DATES AND TIMES

You can select how your date and time value will be by changing the
format. To do this, simply pick the cell containing the date or time. Right-
click > Format Cells. Click on the Date option and select the format you
want.

Click on the Time option and select the time format you want to use.

PROBLEMS WITH DATES

Excel’s leap year bug

Since its inception, Microsoft Excel has wrongly assumed that 1900 is a
leap year and that February 29 falls between February 28 and March 1 of
that year. The problem originated in Lotus 1-2-3 and was intentionally
introduced in Excel for backward consistency.

Every four years, there is a leap year, which has one extra day (February
29). Excel considers the year 1900 as if it were a leap year, even though it
was not. In other words, Excel does not argue if you enter 2/29/1900 into a
cell. This is interpreted as a legitimate date, and a serial number of 60 is
assigned. However, if you put 2/29/1901, Excel recognizes it as a typo and
does not convert it to date. Rather, it turns the cell input into a text string.
How can a product utilized by millions of people every day have such a big
flaw?

The solution is based on history. Lotus 1-2-3 faulted the first edition that led
it to treat 1900 as a leap year. When Excel was introduced later, the
designers were aware of the flaw and opted to replicate it in Excel to keep
Lotus worksheet files compatible.

Why is this problem still present in subsequent Excel versions? According
to Microsoft, the drawbacks of fixing this defect outweigh the benefits.
Getting rid of the bug would wreak havoc on hundreds of thousands of
current workbooks. Furthermore, resolving this issue would have an impact
on Excel's interoperability with other date-based products. Because most
users do not utilize dates before March 1, 1900, this defect now causes
relatively few issues.



Pre-1900 dates

The number of days that have passed since January 1, 1900, is stored in
Excel as a date. This implies that none of the interesting date features apply
to dates from the 1800s. For historians and genealogists, this is a dilemma.

Boller presented a method for calculating elapsed days dating back to
January 1, 1000. This formula has been slightly modified by me. The
difficulty was addressed by Boller's original calculation, which included
adding 1,000 years to the date. As a result, a legitimate date like December
26, 2008, becomes December 26, 3008. An invalid date, such as February
19, 1857, becomes February 19, 2857. This strategy works well since Excel
can handle dates up to and including the year 9999.

In A4, you must specify a start date and an end date, and in B4, you must
input both dates. When inserting dates, use a format like 2/17/1865. If the
date is after 1900, Excel transforms it to a date serial number instantly.
Excel preserves the date as text if it is before 1900.

You choose to add 1,000 years if the cell has a true date. Using the EDATE
function and adding 12,000 months to the date is a simple method to
achieve this. A date 1,000 years after a valid date in A4 is returned by
=EDATE(A4,12000). In Excel versions before 2007, this function needs the
Analysis Toolpak. You may use =DATE(YEAR(A4)+1000, MONTH(A4),
DAY(A4)) if you make sure the Analysis Toolpak is installed. If the cell
does not include an actual date, you must separate the date, add 1,000 years,
reconstruct the date, and convert it to a real date.

Inconsistent date entries

When inputting dates with two digits for the year, you should be cautious.
Excel has various rules that come in to decide which century to use when
you do so. And the restrictions differ depending on the version of Excel
you're using. Dates in the twenty-first century are regarded as two-digit
years between 00 and 29, whereas dates in the twentieth century are
regarded as two-digit years between 30 and 99.

For example, if you type 12/15/28 into Excel, it will be interpreted as
December 15, 2028. Excel, on the other hand, interprets 12/15/30 as



December 15, 1930. Because Windows has a default boundary year of
2029, this is the case.

You may either leave the default setting alone or alter it in the Windows
Control Panel (use the spinner in the Calendar area of the Date tab of the
Regional and Language Settings Properties dialog box).

Do you have a date problem? Date formatting in a column that is
inconsistent is inconvenient. When you mistakenly receive two alternative
date formats in a column, Excel sometimes refuses to allow you to change
your mind. Sometimes it's as simple as changing the format; other times,
this two-step approach is required.

Clear the formats. A white button that appears like an eraser may be found
on the Home tab, Editing group. Clear Formats may be found by clicking
on them. This converts the dates to serial numbers. Simply format the
column in the appropriate date format at this point. All of the formats
should now be in sync.

USING EXCEL’S DATE AND TIME FUNCTIONS

Getting the current date and time

Choose the cell. Then, press Control key + Semicolon (;). This will
add the current date to that cell. To enter the time, select the cell, then
press Control + Shift + Semicolon (;) on your keyboard. This will add
the current time on that cell.

You can also enter date and time using some functions. To do this,
simply Activate the cell you want to add a date on, type in this



function on the cell =TODAY() and then press Enter. For the time,
select the cell, type in this function =NOW(), and press Enter.

Calculating age

To determine age in Excel, we'll need the person's date of birth. The
TODAY function in Excel may be used to compute the age. To do so, pick
the cell containing the Date Of Birth and subtract it from today's date,
which can be obtained using the TODAY function.

This will tell us the number of days between the date of birth and the
current date. Then multiply it by 365, which is the total days in a year. This
will offer you the age of the person. Follow the steps below to do so;

Put the birth date in the cell. Here, I used cell A2.

Put in the Today function. This is to display the present date.



The DATEDIF function will calculate the person’s age.

Complete the “Y” value to get the number of the total years between the
birth date and present date. You can compute the person’s age without
showing the present date.

To know the person’s age on a specific date

Calculating the number of days between two dates

This is done using the DATEDIF function. It helps in figuring out the
difference between various units such as dates, years, and months. To do
this, you will first provide the start date in the 1st argument, then, the end
date for the second argument, and then the “D” unit in the last argument.

DATEDIF(start_date, end_date, "d").



My example goes with the formula =DATEDIF(A2, B2, "d"). A
DATEDIF function, unlike a subtraction function, could only remove an
older date from a current date, but never the other way around. The
algorithm gives a #NUM! error if the start date is later than the end date.

Calculating the number of workdays between two dates

This is done with the NETWORKDAYS function. NETWORKDAYS
(start_date, end_date, [holidays]). Utilize the NETWORKDAYS.INTL
method to define which days of the week should be designated weekends if
you need to handle unique weekends (e.g., Saturdays and Sundays alone).

USING NETWORKDAYS.INTL

Generating a list of business days excluding holidays

In Excel, it's common to need to calculate the total number of working days
between two dates. We often overlook weekends and holidays when
calculating this. When calculating the number of workdays in Excel, you
may use two separate procedures to eliminate weekends and holidays.

When calculating the total number of working days in Excel, the function
NETWORKDAYS is utilized. Saturdays and Sundays are automatically
counted as weekends when using this method to calculate workdays.
=NETWORKDAYS (start date, end date, [holidays]) is the notation for
this function. The statement holiday is an optional argument in this case. It
is used to compute the number of working days omitting holidays.

Take the example here, where I computed the number of workdays in two
distinct scenarios for July. The holidays are included in one case and are not
included in the other. Saturdays and Sundays are treated as weekends in
both circumstances.



That the very first formula, as you've seen, calculates the entire number of
working days, including holidays. The holidays are listed from cell B7 to
cell B11, and the next formula calculates the number of working days
except for the holidays.

=NETWORKDAYS(B2, C2) and =NETWORKDAYS (B4, C4,
B7:B11) are the formulas used here 

Count Workdays excluding Holidays and Particular Weekends

You learned the process of calculating working days with and without
vacations in the last example when Saturdays and Sundays are generally
omitted as weekends. Weekends are varied in several places throughout the
globe.

Friday and Saturday are considered weekends in certain nations. The old
formula will not work in this scenario. Another built-in function in Excel is
NETWORKDAYS, which allows you to enter weekends of your choosing.
NETWORKDAYS.INTL is the name of this function.

=NETWORKDAYS.INTL (start date, end date, [weekend], [holidays])
is the syntax for this function. The justifications for weekends and holidays
are optional in this case. If the weekend statement is left blank, the
algorithm will consider Saturday and Sunday to be weekends.

Look at the table below before using the function NETWORKDAYS.INTL
to count the total number of working days. The values in this database are
used in the NETWORKDAYS.INTL function's weekend parameter section.



Weekend Days Weekend
Number

Saturday & Sunday 1 (default)
Sunday & Monday 2
Monday & Tuesday 3
Tuesday & Wednesday 4
Wednesday & Thursday 5
Thursday & Friday 6
Friday, Saturday 7
Sunday only 11
Monday only 12
Tuesday only 13
Wednesday only 14
Thursday only 15
Friday only 16
Saturday only 17

Extracting parts of a date

You can extract month, day, and year from a date in Excel. Below are the
formulas you can do that with;

●      Extract Year =YEAR(D4)
●      Extract Month =MONTH(D4)
●      Extract Day =DAY(D4)
●      Extract Weekday =WEEKDAY(D4) or =WEEKDAY(D4,1)
●      Extract Week Number =WEEKNUM(D4)

Simply choose the formula that matches your task and put it into an empty
cell. Press Enter and the part of the date will be extracted. You can use the
fill handle to fill in other cells.



Calculating the number of years and months between dates

In Excel, the ratio between two dates is commonly calculated and shown as
days, months, or years. I will show you how to use a formula to show the
difference among two dates as A Months B days, C months, such as three
years, 60 days, and so on.

The formula is DATEDIF (start date, end date, "y")&" years
"&DATEDIF(start date, end date,"ym")&" months "

Start date and end date are the dates between which you wish to compute
the years, months, and days.  If the end date is less than the start date, the
algorithm returns #NUM! as an error value.

Converting dates to Julian dates formats



The general formula for this is =YEAR(date)&TEXT(date-
DATE(YEAR(date),1,0),"000").

In Excel, you may transform a date to Julian date format by creating a
formula that includes the TEXT, YEAR, and DATE functions.

The "Julian date format" is a date stamp type that combines the year value
of a date with the "ordinal day for that year" (i.e. 14th day, 100th day, etc.).

There are a few different versions. A date within that format may have a
four-digit year (yyyy) or a two-digit year (yy), and the day number can be
padded with zeros or not to always utilize three digits. For the date January
21, 2017, for example, you may see:

●      1721 // YYD
●      201721 //YYYYMM
●      2017021 // YYYYDDD

Returning the last date of a given month

To obtain the month's end date, we'll utilize Excel's built-in function,
EOMONTH. This function will assist us in retrieving the month's final date.

This function's capabilities are not limited to knowing the current month's
end date; we may also select to discover the prior month's last day, the
following month's last day, and the last day of the month at a Custom
determined separation of months.

To find the last date of a given month, follow the steps below:

Put the date in a cell. Put in the formula =EOMONTH (put in the cell
address)



Press Enter. Use the fill handle to fill in other cells. The date will be
displayed in the vale format.

Now, we will change the format to the date format. So, select the cells and
click General on the home tab. Choose a Short Date.



USING THE EOMONTH FUNCTION

Calculating the calendar quarter for a date

There is no straight function in Excel for calculating a quarter from a date.
You may, however, build a formula for this. You can compute a quarter
from a date using a formula. Even so, you have the option of using more
than one approach. Okay, as you may know, there are four quarters in a
year, but you may derive a quarter from a date in a variety of ways.

The easiest technique to determine the quarter of a date is to combine
the ROUNDUP and MONTH functions.  It gives you the quarter as a
number (like 1,2,3,4). The formula is as follows;
=ROUNDUP(MONTH(A1)/3,0)

The formula yields 2 in the result when we use the date 26-May-2018. If
you wish to add a Q before the quarter number, use the formula below.

=“Q-”&ROUNDUP(MONTH(A1)/3,0)

What this formula entails

There are three elements to this formula.  We utilized the MONTH function
in the first portion and referenced the date, which outputs the month
number.

Then, in the second section, we divided that month's number by three,
resulting in a decimal number.



Finally, in the third section, we utilized the ROUNDUP function to round
(that number with decimals) to the nearest quarter.

Here's what it's all about:

You are aware that there are four quarters and twelve months in a year.
Right? And if you divide all of the month numbers by three (yes, only
three), you'll end up with something like this. And if you round them up,
you'll always receive the month's quarter number.

Calculating the fiscal quarter for a date

A fiscal quarter is the third quarter of a corporation's fiscal year. If a
corporation's fiscal year runs from February to January, the first fiscal
quarter will include the months of February, March, and April. In the same
way, the second, third, and fourth quarters now have the prior three months'
following three months.

It's also known as a company's financial quarter. To calculate this, use this
generic formula =CHOOSE(MONTH(date),1,1,1,2,2,2,3,3,3,4,4,4). The
Date stands for the date for getting the fiscal quarter.

The numbers in the formula are cleverly arranged. The formula perceives
that the fiscal year started in January. Assuming it started from February,
then the formula will be 4,1,1,1,2,2,2,3,3,3,4,4. So, in the image below are
dates in range B4:B8. The fiscal year began in March. That means that the
dates in March, April, and May should appear in the first quarter and so on.
Put in the formula =CHOOSE(MONTH(B4),4,4,1,1,1,2,2,2,3,3,3,4)

It provides 1 for the first date since March 3rd is undoubtedly in the first
quarter of the company's financial year, which begins in March. And



February is the fourth quarter since it is the last month of the year for such a
company.

What is the mechanism behind it?

This is straightforward. The month of the supplied date is returned by the
MONTH function. The month of March is represented by 3 in the formula
above.

The CHOOSE method then returns the third entry from the array we've sent
it. The number 1 is the third value in the array 4,4,1,1,1,2,2,2,3,3,3,4.

Similarly, the MONTH function gives 2 for the date of the FEB month. And
the array's second value is 4.

So, this is how the method for determining a fiscal quarter for a particular
date works.

Returning a fiscal month from a date

The EOMONTH function retrieves the final day of the month from a
specified number of months ago or in the future. EOMONTH may be used
to determine due dates, expiry dates, and other dates that must fall on the
final day of the month.

The start date and months inputs are sent to the EOMONTH function. The
start date field must be filled up with a valid Excel date. The month
argument indicates how many months to travel ahead or backward in time;
a positive number moves forward in time, while a negative number moves
backward in time.

EOMONTH gives you a serial number that corresponds to a date in Excel.
Use a number format of your choosing to show the result as a date.

For example, if you have May 12, 2021 in cell D5

●      =EOMONTH(D5,0) // returns May 31, 2021

●      =EOMONTH(D5,4) // returns Sep 30, 2021

●      =EOMONTH (D5, -3) // returns Feb 28, 2021

You can also use this function to move through years.



●      =EOMONTH(B5,12) // returns May 31, 2022

●      =EOMONTH(B5,36) // returns May 31, 2024

●      =EOMONTH(B5, -24) // returns May 31, 2019

Tips

�        Add a positive value for future dates and a negative value for
previous dates when calculating months.

�        Whereas if the start date is not proper, EOMONTH will display the
#VALUE error.

�        It will be eliminated if the start date has a fractional time associated
with it.

�        The month's parameter will be eliminated if it includes a decimal
number.

�        The EDATE function may be used to transfer any date n months into
the future or past.

�        The date serial number returned by EOMONTH must be represented
as a date.

Calculating the date of the Nth weekday of the month

As you may be aware, several significant days fall mostly on the nth day of
the week, such as Christmas, which falls on the 4th Sunday in December,
and Mother's Day, which falls on the 2nd Sunday in May.

Is there a method to compute the date of the nth day of the week in a given
month and year, if your employer informs you the due date is the third
Tuesday of September, apart from choosing a day out of the calendars?
Let’s find that out.

So, write down the days of the week and their numbers in a table.



Then, list the criteria you are to calculate the date based on such as the year,
month, ordinal number, and days of the week.

Enter the formula below in an empty cell.

=DATE(E3,F3,1+H3*7)-WEEKDAY(DATE(E3,F3,8-
VLOOKUP(G3,B3:C9,2,FALSE)))

In this formula,



�        E3 = The year

�        F3 = The month

�        H3 = The specified nth of the day of week

�        B3:C9 = The table where you defined the numbers for weekdays

�        G3 = The specified day of the week

Calculating the date of the last weekday of the month

Select an empty cell and enter the formula below;

=DATE(E3,F3+1,8)-WEEKDAY(DATE(E3,F3+1,8-
VLOOKUP(G3,B3:C9,2,FALSE)))-7

Calculating elapsed time

Whether you're working on a task or parenting a child, assessing elapsed
time is a typical task. The period between a beginning point and the present
point in time is known as elapsed time. We may simply compute elapsed
time using Excel formulae.

Calculating the amount of time that has passed in years

We assume that the beginning time and date from which we need to
compute elapsed time is in Cell A1 for all of the examples in this article.

Use the calculation =(NOW()-A1)/365 to compute the elapsed time in
years. 

Months of elapsed time

The formula =(NOW()-A1)/30 may be used to compute the elapsed time in
months. This gives the value in months of 30 days.

Weeks that have passed

We apply the formula =(NOW()-A1)/7 to determine the elapsed time in
weeks.

The amount of time that has passed in days.



The formula for calculating elapsed time in days is =TODAY ()-A1.
Fractions are also included in the outcome. To get rid of the values
following the decimal point, utilize number formatting.

In working days, the amount of time that has passed.

The NETWORKDAYS formula, like this = NETWORKDAYS (A1,
TODAY()), may be used to compute elapsed time in working days. This
formula assumes a week of five working days, beginning on Monday. You
may also provide it with an optional holiday list as a parameter.

Time elapsed in hours

We may use the calculation =(NOW()-A1) *24 to compute elapsed time in
hours.

Time elapsed in minutes

Use the formula =(NOW()-A1) *24*60 to calculate elapsed time in
minutes.

In seconds, the time has elapsed.

You may need to determine the elapsed time in seconds in certain machine-
critical cases. Simply multiply =(NOW()-A1) *24*3600.

Rounding time values

Dealing with time values does have its set of difficulties. How to round off
time numbers from seconds to minutes or minutes to hours is one of the
challenges.

To round off time numbers, use the MROUND function. The MROUND
function returns a number that has been rounded to the closest multiple.

When time values are rounded off, it is simpler to handle them. This advice
will be valuable to HR people, IT security specialists, stock controllers, and
others who deal with time values.

To do this, you will have to first format the number to time format (if they
are not in time format). Then, select the cell and type the MROUND



function. Then put in the cell address and the value you want to round up.
To round up to the nearest hour, enter in =MROUND (B3, “1:00”)

Press Enter. If the result is displayed in decimal, format the cell to Time.

To round up to the nearest minutes, enter the formula =MROUND (B3,
“0.01”).

Converting hours, minutes, or seconds to a decimal.

Simply select the cell containing the hours. Right-click and select Format
Cells. On the dialog box, select the decimal places you want to convert the
hours of minutes to.



Adding hours, minutes, or seconds to a time.

Let’s say you want to add some seconds, hours, and minutes to your time in
Excel, you will make use of this formula;
Start_time+hours/24+minutes/1440+seconds/86400. With the table
below, you want to add some time, to cell C3:E3, simply use this formula to
do so; =B3+C3/24+D3/1440+E3/86400

Press Enter.



Explanation: A day has twenty-four hours, 1440 minutes, and 86400
seconds in it, therefore one hour is 1/24, one minute is 1/1440, and a second
is 1/86400.

 



CHAPTER FIVE

USING FORMULAS FOR CONDITIONAL ANALYSIS

UNDERSTANDING CONDITIONAL ANALYSIS

In Excel, we use the IF, AND, OR, NOT functions to get conditional
formulas. The functions are used to check out if conditions are true or false
as well as make logical comparisons among different expressions. These
functions help us create basic logical IF (this), then (that) arguments.

Applying logical comparisons between different expressions and checking
out if conditions are true or false applies to lots of tasks. We apply the IF
and AND functions to generate our conditional formulas in Excel. To carry
out this, follow the steps below;

First, enter the data for the work in your worksheet. In my worksheet here,
we want to ascertain if a student that partaken in 2 different examinations,
qualified with the criteria we specified.

The conditional formatting will be applied in cell D2. Here is the formula;
=IF(AND(B2>=20,C2.>=30),”Pass”,”Fail”). This means that if a student
got 20 and 30 in both tests, it is likely that they will fail or pass.



Use the fill handle to fill in other cells.

Checking if a simple condition is met

To do this, we will apply the IF function. This function will check if the
conditions are met and will provide a specific value you choose when it is
true. It will also provide another value when it is false. You can select the
values yourself.

Put in this formula in a cell; =IF(A1>5,"Correct","Incorrect"). This
formula is for Excel to check if the value in cell A1 is bigger than 5. If it is
true, it will display correctly. If it is false, it will display false.



So, in the image above, the value in cell A1 is bigger than 5, so it displayed
Correct.

Checking for multiple conditions

To check for multiple conditions, the AND function is applied. The function
will display true if the criteria are met. It will display false negatives. Put in
the formula in a cell; =IF(AND(A1>5,B1>20), "Correct","Incorrect").

In the formula, Excel will determine if the value in cell A1 is greater than 5
and the value of cell B1 is greater than 20. If both are true, it will display
Correct and will display Incorrect when false.

Validating conditional data

One may wish to regulate data entry into particular cells when putting up a
worksheet for your users to ensure that all data inputs are valid and
constant.

You could wish to allow just certain data types in a cell, such as numbers or
dates, or restrict digits to a specific range and text to a specific length,
among other things.

To avoid errors, you may wish to give a predefined set of permitted entries.
All of these things are possible using Excel Data Validation.

What is data validation: Conditional data validation limits the options
inside of an Excel drop-down list based on values in some other cell (or in



another drop-down). We'll learn how to use Data Validation to construct
conditional Excel dropdowns.

First, create a named range on your worksheet. Then, select a cell > click
Data Validation on Data Tab.

Click on the down arrow and choose List. Then enter the name of the cell
address. you can do so by clicking the cell.

Press Ok. This will create a drop-down arrow on the cell.



Select another empty cell and move to the Data Validation box with the
same step above. Then, put in this formula; INDIRECT($B$2). It will
create another drop-down arrow on the cell.

Checking if Condition1 AND Condition2 are met

This is done with the nested IF function. It comprises an IF inside another
IF function. The formula goes this way; 

IF( condition1, true_value1, IF( condition2, true_value2, false_value2))

�        The 1st IF function is applied, and condition 1 is tested.

�        The true value1 is performed if condition1 is true.

�        The following IF function contains the false value1 variable. As a
result, if condition1 is false, the IF function below will be executed.

�        Condition2 is checked, and when it is true, true value2 is returned.
False value2 is supplied anyway.

If necessary, you may layer up to seven IF functions.

Below is how this function works.



IF(B4=" Beauty"," 7%", IF(B4=" Electronics", IF(B4=" Sports","
4%"," Not applicable")))

�        The tax % for every product category is shown in the table on the
right. The nested IF function is used to express this.

�        Whether TRUE, we verify if the cell content is "Beauty," which
yields "7%."

�        If the cell content is FALSE, it is tested for "Electronics," which
shows "5%" if TRUE.

�        If not, it will double-check to see if the cell content is "Sports." If
TRUE, "4%" is shown; if FALSE, "Not Applicable" is given.

Checking if Condition1 OR Condition2 are met

The IF and OR functions are used together to perform some tasks. Check
out this formula; =IF((OR(C2>=20, D2>=30)), "Pass", "Fail"). This
function is to determine if the 1st score is the same or bigger than 20 or if
the 2nd score is the same or bigger than 20. Enter in the formula.



Press Enter. Then, use the fill handle to fill in the cells.

PERFORMING CONDITIONAL CALCULATIONS

Using SUMIFS

The SUMIF function sums integers depending on a single condition.
According to its syntax, it considers one range, one criterion, and one sum
range by default. The formula is; =SUMIFS(sum_range, criteria_range1,
criteria1, criteria_range2, criteria2,....)

The SUMIFS function has the following arguments;

�        The sum range means the range of cells that is to be summed up

�        The criteria range1 means the first range of cells that are to be
examined for a criteria match.



�        The criteria1 means the criteria in opposition to which criteria range1
is to be examined

�        The criteria range2 means the second range of cells that are to be
examined for a criteria match.

�        The criteria2 means the criteria in opposition to which criteria range2
is to be examined.

Summing all values that meet a certain condition

Let’s say you have data in range A1:B6. And you want to add up the values
in a column (Column B) in regards to the text value in another column
(Column A). To do this, you will have to remove the values that are
duplicated in column A, then add up the values in Column B in regards to
the unique text values in column A. Below is how you can do so;

Pick the text values in the A column. Copy the values and paste them into
another empty cell.

Select the new column you have pasted the values. Click the Data tab and
select Remove Duplicates. Then, pick the pasted columns in the column
option. Select OK.



The duplicate values will be removed.

Choose an empty cell next to the pasted column. Enter the formula
=SUMIF($A$2:$A$6, D2, $B$2:$B$6).

Hit Enter. Then, use the fill handle to fill in the cell. The summed-up values
will display.



Summing greater than zero

This is done using the SUMIFS function. Here, we will sum the values that
are greater than zero. This is the formula; =SUMIFS(C3:C9,C3:C9,">0").

Press Enter.

To total all positive Scores, we use the condition ">0." The conditions are
also applied to analyze the data in the Score column in this example, thus



the cell range C3:C9 is utilized as both the total and the criterion range.

Summing all values that meet two or more conditions

The SUMIF function sums integers depending on a single condition.
According to its syntax, it considers one range, one criterion, and one sum
range by default. However, if you prefer to add numbers depending on
different criteria, you may utilize the choices below.

�        You combine numerous SUMIF functions based on OR logic and
apply them one by one to each condition.

�        You must utilize the SUMIFS function, which is built to add values
with various criteria using AND logic by default.

�        You may likewise utilize the SUMIFS function with an integer
variable to add numbers with various criteria using OR logic.

Based on OR logic:

You must sum up two or more SUMIF functions in a single calculation if
you wish to include integers that fit either of the criteria (OR logic) from
several criteria.

If you wish to aggregate order values for "Beans" and "Broccoli" goods
using OR logic, you'll need to use the following pattern to combine two
SUMIF functions into a single formula:

=SUMIF(range, criteria1, sum_range) + SUMIF(range, criteria2,
sum_range)

=SUMIF(B2:B22,"Beans",D2:D22)+SUMIF(B2:B22,"Broccoli",D2:D2
2)

OR

=SUMIF(B2:B22,G2,D2:D22)+SUMIF(B2:B22,H2,D2:D22)

Based on AND logic:

You may use the SUMIFS function to add values from a range if all of the
stated conditions are matched, which is based on AND logic. It's vital to
remember that to add up values from the sum range, all of the conditions



must be satisfied in a single or double range. SUMIFS has the following
syntax:

SUMIFS(sum_range, criteria_range1, criteria1, criteria_range2,
criteria2,...)

If you wish to total the quantities of orders supplied across two dates, you
may utilize the SUMIFS function. You must specify two conditions within
the same range, and the SUMIFS function adds the amounts of such orders
when both criteria have been met.

Summing if values fall between a given date range

Apply the SUMIFS formula using start and end dates as parameters to sum
data inside a certain date period. The SUMIFS function's syntax mandates
you to first indicate the numbers, to sum up (sum range) before providing
range/criteria pairs. The range (a list of dates) for both parameters would be
the same in our scenario.

 

In light of the above, the typical formula for summing values between two
dates are as follows:

With bound dates:

�        SUMIFS(sum_range, dates,">="&start_date, dates, "
<="&end_date)

Without bound dates:

�        SUMIFS(sum_range, dates,">"&start_date, dates, "<"&end_date)

The difference here is found in the logical qualifiers. To add the lower and
upper limit dates in the result, we apply greater than or equal to (>=) and
less than or equal to (=) to the 1st formula. The 2nd formula, which
excludes the start and finish dates, determines whether a date is larger than
(>) or less than ().

Assume you want to add up all of the projects that are due within a certain
time frame in the figure below. To do so, input the start and end dates in F1



and G1, respectively, then with the formula below, add up the budgets in
B2:B10 between these dates, inclusive:

=SUMIFS(B2:B10, C2:C10, ">="&F1, C2:C10, "<="&G1)

Getting a count of values that meet a certain condition

The COUNTIF function in Excel is used to enumerate cells that fulfill
given criteria or conditions inside a defined range.

For instance, a COUNTIF formula may be used to determine the number
of cells in your worksheet that consists of a number that is higher than or
lesser than the value you give. COUNTIF is also often used in Excel to
count cells that contain a given word or begin with a specific letter (s).

The COUNTIF function has a very basic syntax: =COUNTIF(range,
criteria)

It has just two arguments which are Range and Criteria. The range here
defines one or multiple cells for counting while the Criteria here defines the
condition which lets the function of the cell that is needed for counting. You
write in the range as you do normally such as B1:B15. You can put in the
criteria as "10", B2, ">=10", "some text"

Getting a count of values that meet two or more conditions

The COUNTIFS function may be used to display the number of cells that
satisfy a specified condition. COUNTIF may be used to count items based
on dates, numbers, text, and other parameters.



COUNTIFS additionally requires the use of logical expressions (>,>,=).

COUNTIFS is a function that counts cells that satisfy several criteria. Since
we provide the same range for two criteria in this situation, each cell in the
range must fulfill both requirements to be tallied. The formula is
=COUNTIFS(range,">=X",range,"<=Y").

�        For greater than or equal to, use >=.

�        For less than or equal to, use =.

So, if we wish to count depending on conditions in our dataset, we use the
following formula: =COUNTIFS(B2:B9,">=80",B2:B9,"<=90")

 

Finding nonstandard characters

We understand that the TRIM and CLEAN Excel functions should be used
to remove non printable characters and excess gaps from strings, but they
aren't very helpful in recognizing strings that include
nonstandard characters like @ or! We utilize UDFs in these situations.

So you won't be able to tell whether a string includes any special characters
using an Excel formula or function. By directly typing, we can discover the
special characters on the keyboard, but we can't tell whether the string
contains symbols or not

For data cleansing reasons, locating any special characters might be critical.
And in certain circumstances, it is unavoidable. So, how do we go about



doing this in Excel? What is the best way to tell whether a string includes
any nonstandard characters? To accomplish so, we may make use of UDF.

If any cell includes any characters other than 1 to 0 and A to Z, the equation
below will yield TRUE (in both cases). It will yield FALSE if
no nonstandard characters are found.

The formula is; =ContainsSpecialCharacters(string)

Before this formula will work, it has to be placed in the module. So, open
up the VBE and insert a module from the Insert Menu. Use the code below
in the VBE. Press ALT + F11 to open.

Function ContainsSpecialCharacters(str As
String) As Boolean
For I = 1 To Len(str)
ch = Mid(str, I, 1)
Select Case ch
  Case "0" To "9", "A" To "Z", "a" To "z", " "
   ContainsSpecialCharacters = False
  Case Else
   ContainsSpecialCharacters = True
  Exit For
End Select
Next
End Function

Getting the average of all numbers that meet a certain condition

Excel's AVERAGEIF function computes the average (arithmetic aggregate)
of all cells that fulfill a set of conditions. The formula is:
AVERAGEIF(range, criteria, [average_range]). The first two parameters
to the AVERAGEIFS function are necessary, while the final one is optional:

�        Range - the number of cells that will be compared to the supplied
criteria.



�        The criterion used to choose which cells to average is known as the
criteria. The criterion may be specified as a number, a logical
expression, a text value, or a cell reference, for example, 5, ">5",
"cat," or A2.

�        Average range - the range of cells to average (optional). If the range
parameter is omitted, the formula will compute an average of the
values in it.

EXAMPLE:

The AVERAGEIF function in Excel is most often used to obtain an average
of cells that perfectly fit a specific requirement. Let's average just the sales
(B2:B8) for the Banana orders (A2:A8) in this illustration:

=AVERAGEIF(A2:A8, "banana", B2:B8). You can put the formula in an
empty cell. =AVERAGEIF(A2:A8, E1, B2:B8)

Getting the average of all numbers that meet two or more conditions.

The AVERAGEIFS function is the plural version of the AVERAGEIF
function. It takes many factors into account and provides the average
(arithmetic average) of units that match all of the requirements.

The formula is; AVERAGEIFS(average_range, criteria_range1,
criteria1, [criteria_range2, criteria2], …)



The following are the parameters to the AVERAGEIFS function:

�        The average range parameter specifies the range of cells to average.

�        Criteria range1, Criteria range2, Criteria range3, Criteria range4,
Criteria range5, Criteria range - 1 to 127 ranges to be compared to the
set of criteria The first criteria range is necessary; the others are
optional.

�        Criteria1, criteria2…. means the cell that is to be averaged. It can be
provided in a number form, logical expression, cell reference, or text
value.

The Excel AVERAGEIFS function, as previously stated, finds the average
of cells that fulfill all of the conditions you give (AND logic). In principle,
it works similarly to AVERAGEIF, with the exception that you may use it
in formulas with multiple criteria ranges and criteria.



CHAPTER SIX

 USING FORMULAS FOR MATCHING AND LOOKUPS

Introducing Lookup Formulas

Just like how you open your dictionary to look up the meaning of a word
and then find the meaning, that’s how the LOOKUP function works. You
use this function to retrieve some data by looking it up.

The lookup function is the predecessor and the simpler version of the
VLOOKUP function. It looks for a number in a range (which may be a row
or column) and produces a LOOKUP from another range at the same spot
(single row or single column). The LOOKUP that corresponds to the data
being examined is a collection of data.

The formula is: =lookup(lookup_value, lookup_vector, [result_vector]).
The Lookup value stands for the data value you want to look up for. The
Lookup vector stands for the row or column where the value is to be
searched. You should sort this out alphabetically or rather in ascending
order. It will help you get an accurate result.

Leveraging Excel’s Lookup Functions

Excel consists of many Lookup functions. The functions and their
descriptions are listed below;



Looking up an exact value based on a left lookup column

To do this, we will utilize the INDEX and Match function. The MATCH
function will display the position of the value in a particular range.

The 104 is seen at position 4 in the range $G$4:$G$7. With the result with
the INDEX function, you can display the 4th value in the range $E$4:$E$7.



Use the fill handle to fill in cell B2.

 

Looking up an exact value based on any lookup column

Pick the cell. Then, put in this formula;
=SUM(INDEX(C3:E7,0,MATCH(H2,C2:E2,0))). Here, I selected cell H3.
Press Enter.

�        The array consists of the data for Sales (which is the range).

�        The row is set to “0” to Lookup the whole column.

�        The MATCH function is to decide the number of the column.

�        The result displayed in cell H3 is $3,000. It is the overall sales in
October.

Looking up values horizontally



If the items in your data sources seem to be in rows rather than columns,
this is a horizontal arrangement.

The student name and registration id are organized horizontally in rows in
this table array. To get the desired outcome, we must choose the row range
for both.

The Lookup value means the value that is to be searched for. The Lookup
vector means the range that consists of one row of text. In my scenario, it is
“G6:K6”. It is organized horizontally. The Result vector is the one-row
range which is where the result will be provided. In my scenario, it is
“G7:K7”.

There are things you need to consider when applying this vector
Lookup.

�        The Lookup formula might produce errors or an inaccurate result if
the values in the lookup vector are not ordered in alphabetically or
ascending order, i.e. from biggest to smallest in numeric values or
from A to Z in text.

�        The Lookup vector and the Result vector must both be a one-row or
one-column range of the same size.

�        The LOOKUP function does not distinguish between lowercase and
uppercase text because it is not case-sensitive. Uppercase and
lowercase characters are regarded as interchangeable.

�        The Lookup algorithm looks for a precise match. The LOOKUP
Function returns the #N/A error if the lookup value does not locate



the appropriate value in the lookup vector.

FINDING THE CLOSEST MATCH FROM A LIST OF BANDED

VALUES

Finding the closest match with INDEX and MATCH functions

In my table below, I have a number list in the A column. I want to find the
closest value of 18 in Column A. To do this, first choose a cell, enter this
formula; =INDEX(B3:B22,MATCH(MIN(ABS(B3:B22-
E2)),ABS(B3:B22-E2),0)).

Press Enter.

Looking up values from multiple tables

Put in an empty cell, the value that you want to look up. Enter in the
formula in the adjacent cell;

=IF(ISERROR(INDEX($A$1:$B$7,SMALL(IF($A$1:$A$7=$D$4,ROW(
$A$1:$A$7)),ROW(1:1)),2)),"",

INDEX($A$1:$B$7,SMALL(IF($A$1:$A$7=$D$4,ROW($A$1:$A$7)),R
OW(1:1)),2))



Press Shift + Control + Enter. Use the fill handle to fill other cells.

In this formula, $A$1:$B$7 means the data range. $A$1:$A$7 means the
column range for the lookup. $D$4 stands for the cell in which you type the
lookup value.

Looking up a value based on a two-way matrix

Once you search for a variable at the intersection matching the specified
row and column variables, you'll utilize a two-way lookup. For example,
suppose you have a table with several rows and column headings, and the
value you're looking for is the intersection of column 5-Jan and row AA-3,
as seen in the picture below.

Follow these steps to do so;

List out the headers of the row and the column for the lookup.



Move to the cell where you want to display the lookup value. You can use
any of the formulas below.

�        =INDEX(A1:I8,MATCH(L1,A1:A8,0),MATCH(L2,A1:I1,0))

�        =SUMPRODUCT((A1:A8=L1)*(A1:I1=L2),A1:I8)

�        =VLOOKUP(L1,$A$1:$I$8,MATCH(L2,B1:I1,0)+1,FALSE)

�        Press Enter.

A1:A8 means the column range. The header of the row is L1 and the header
of the column is L2. A1:L1 means the row range.

The 2nd formula will display 0 when the lookup value is in the form of a
text.

Finding a value based on multiple criteria

If you got a fruit sales table like the one below, you'll need to calculate the
amount depending on numerous factors. This approach will provide various
array formulae that will make it simple to locate values depending on the
supplied criteria. This will be done using the Array formula.



The basic statement for this formula is: {=INDEX(array,MATCH(1,(criteria
1=lookup_array 1)*(criteria 2= lookup_array 2)…*(criteria n=
lookup_array n),0))}.

To find the number of sales of Mango which occurs 9/3/2022, simply put in
the formula below. After that, press Control + Shift + Enter.

=INDEX(F3:F22,MATCH(1,(J3=B3:B22)*(J4=C3:C22),0)).

You may simply add criteria as needed using the array formula statement.
For example, if you're searching for the mango sales amount on
9/3/2022 and the mango weighing 211, you may use the MATCH section to
enter the criterion and lookup array as described in the following:

=INDEX(F3:F22,MATCH(1,(J3=B3:B22)*(J4=C3:C22)*(J5=E3:E22),0)).
Press Control + Shift + Enter.

Finding the last value in a column

This will be achieved using the MATCH formula. The syntax of the formula
is =MATCH(lookup_value,lookup_array,[match_type]). In my data below,
we have values in the range A1:C5. Column A consists of an Order ID,



Column B consists of Unit Price, and Column C consists of Quantity. We
are to get the last value in the column using the steps below;

 
Put this formula in cell D2. =MATCH(12982,A2:A5,1). Press Enter. This
will display 4. 4 here stands for the 4th cell which matches the given
criterion.

Finding the last number using LOOKUP.

The formula for this is =MATCH(LOOKUP(ANY VAGUE
NUMBER,1/(ROW: ROW<>”), ROW: ROW), ROW: ROW,0)

First, click the cell where the value is to be displayed. For our example, put
in this formula =MATCH(LOOKUP(3512,1/(2:2<>””),2:2),2:2,0). This will



display the column number of the last number/cell that contains the data in
row number 2.

Press Enter.

 



CHAPTER SEVEN

USING FORMULAS FOR FINANCIAL ANALYSIS

Performing common business calculations

A financial feature in Excel, in essence, performs a standard company
calculation that involves money. Calculating interest payments, calculating
the income and capital part of a loan, and computing different elements of
depreciation are all examples of this. The determined value is then used to
make decisions.

Calculating gross profit margin and gross profit margin percent

The formula for doing this is =(price-cost)/price. You will minus the cost
of the products from the price. Then, you will divide by the price. Here, I
worked with =(C5-D5)/C5 on cell E5. Your result may show in decimal
values but you can change the format to percentage.

Explanation: the main thing in this example is to compute and show the
profit margin as a percentage for the products in the table. Each of the
products here has its price and cost and this means that they all have



different profits. To find the profit margin, use this formula X = Profit/Price.
For-profit, Price – Cost.

Calculating markup

The profit margin your company earns from products and operations is
known as markup. To compute markup on materials from wholesale to
retail price or on products & services from supplier price to customer price,
you can save time and ensure reliability by using Microsoft Excel. You may
test "what-if" situations by varying your markup percentage if you format
your spreadsheet content for optimum versatility.

Steps in doing so:

1. Make separate columns for the expenses you would like to mark up,
the markup %, and the calculation's outcomes. The calculation
column should be left empty.

2. On the column that consists of the cost value, click on its heading. On
the Home tab, click on the little arrow at the bottom right corner of
the Number Group.

3. On the Format Cell box, choose the decimal places for your number
values in the cost column. If you want a lengthier value, make it to
two decimal places. Select OK.

4. Choose the column where the markup percentage will be displayed.
Also, use the same steps above to format the numbers to their decimal
places.

5. To choose your calculation column, hit the column header. Choose
the "Currency" format in the Format Cells dialog box to see your
findings preceded by dollar signs or other currency indicators. To
show a comma in numbers bigger than 999.99, enable the thousands
divider.

6. Fill in the relevant column with your expenses. Type the number in
the first cell of the markup column and hit "Enter" to confirm the
value if your markup % is the same for all cost kinds and categories.
Use the fill handle to fill in other cells in regards to the cost column.



7. Select the first cell in the calculation column. Press "Enter" after
typing the following formula, substituting the templates with the
necessary cell references. =[first cell of cost column] + ([first cell of
cost column] * [first cell of markup column])

8. Your cost might display in column A while your markup percentage
is displayed in Column B. Then, your formula will provide this result:
=A1 + (A1 * B1).

9. Finally, on the cell that consists of your calculation, use the fill handle
to fill in the cells.

Calculating EBIT and EBITDA

EBITDA: Earnings before Interest, Tax, and Depreciation and
Amortization. It is the net income plus the interest, D&A, and Tax included
back to net income. This is mostly used to calculate and determine the
difference between the profit of two or more companies. The formula for
this is Income + Interest + Taxes + Depreciation & Amortization. It is
obtained by getting the total income, then minus it from the total expenses
without the interest, Tax, and D & A.

EBIT: Earnings before Interest and Tax. You compute the net income
before computing the interest and income tax. The formula is Net Income +
Interest +Taxes.

Calculating cost of goods sold

The expenses of obtaining or producing items to be sold by a corporation
over a certain period are referred to as the cost of goods sold (COGS).

It only comprises expenses paid explicitly in the production of the items,
such as labor, raw materials, and overhead expenditures linked to the
production of commodities to be sold.

When calculating COGS, indirect costs like marketing and sales
expenditures, shipping, legal charges, taxes, licensing, and so on are not
taken into account.

As a result, COGS is determined by adding starting inventory and any extra
expenditures made during the year, then deducting closing inventory from



the total opening inventory and further purchases.

The unsold inventory after the preceding fiscal year is known as beginning
inventory. The closing inventory, on the other hand, is the unsold inventory
after the present fiscal year.

The cost of goods sold, also known as Cost of Sales, is an essential item on
your firm's income statement since it helps determine Gross Margin, a
performance indicator that shows how well your company manages raw
materials and manpower.

Example: A company named B has a beginning inventory of $40000. So,
they bought raw materials. They made use of labor to manufacture their
goods. Their total value for everything is $10000. So, the ending inventory
for them at the end of the year is $30000.

To calculate the cost of goods sold here, we will apply this formula; Cost of
Goods Sold = Beginning Inventory + Purchases during the year – Ending
Inventory. So we do,

$40000 + $10000 - $30000 = $20000

The cost of goods sold is $20000.

Calculating return on assets

In financial ratios, return on assets (ROA) is used to measure a company's
financial performance in proportion to its total assets. Divide a company's
net income by its total assets to get its ROA. To assess a company's
efficiency in producing profits utilizing its assets, the ROA calculation may
also be computed using Microsoft Excel. We'll show you how to do this
computation in Excel.

Key points

�        Return on assets (ROA) is a measure of a company's profitability
concerning the resources and assets it controls.

�        ROA may help investors uncover potential stock chances since it
measures how well a business uses its assets to produce profits.



�        Excel is a fantastic tool for quickly calculating a firm's ROA and
contrasting it to its rivals.

The formula is = Net Income / Total Assets.

For example: in the year 2015, Netflix announced that they got over
$23,696,000 in their net income. Also, they had total assets of
$9,240,626,000. Now, let’s find the return on assets for Netflix.

To calculate this, simply divide the net income with the total asset which is
23,696,000/9,240,626,000 = 0.0026 or 0.26%.

Calculating return on equity

In financial accounting, the return on equity, or ROE, is used to determine a
firm’s performance. The ROE formula calculates the amount of net income
generated by a corporation using its shareholders' equity. The return on
investment (ROI) may be used to evaluate the profitability of one business
to that of another in the same industry.

Keywords

�        Analysts use return on equity, or ROE, as a metric to evaluate a firm’s
competitiveness.

�        The return on investment (ROI) is a helpful metric for comparing the
profitability of two rivals in the same industry.

The formula for this is the Net Income/Shareholder’s equity.

Calculating break-even

Break-even analysis is the study of how many sales, or units sold, are
needed to break even when all fixed and variable expenses of operating a
firm are included in. Because estimates about expenses and future revenues
decide whether a firm (or project) is on schedule to profitability, break-even
analysis is essential for any business development and financial analysis.

Fixed and variable costs are the two types of expenses considered in break-
even analysis. Fixed expenses stay relatively constant regardless of the
number of units sold, but variable costs fluctuate with the number of units
sold. Inventory of raw materials used in manufacturing are examples of



variable costs. The rent for the producing facility would be a fixed expense.
Break-even analysis assists businesses in determining how many units must
be sold to pay their variable expenses as well as the percentage of their
fixed costs associated with manufacturing that unit.

The formula for break-even

When the following conditions are met, the break-even point is reached:

Revenue = Total Fixed Costs + Total Variable Costs

The total fixed costs, which include items like rent, salary, utilities, interest
expenditure, depreciation, and amortization, are typically known.

Total variable costs are more difficult to estimate, however they include
items such as material cost, chargeable labor, incentives, and fees.

Unit Price * Number of Sold Units = Revenue

Calculating the average customer lifetime value

Customer lifetime value (LTV), often called lifetime value, is the total
income a firm anticipates to generate from a single customer throughout
their relationship. Client recruiting costs, operational expenditures, and
costs to create the products or services that the firm produces are all
included in the customer lifetime value estimate. Many businesses
underestimate the LTV measure, although client lifetime value is critical to
a business's success.

The formula is as follows:

How do you figure out a company's LTV?



The average purchase value is computed by dividing the industry's total
income over a certain period by the entire sales made by its consumers
within that particular period.

The overall items purchased over a duration of time by the individual
consumers who made such purchases during that time are used to determine
the average purchase frequency rate.

Customer value is determined by multiplying the average transaction value
by the number of times the transaction has been made.

Average customer lifetime - This is the mean number of years that a client
maintains its purchase of products and services from a firm.

Calculation of lifetime value - The LTV is computed by multiplying the
customer's worth to the firm by their typical lifespan. It helps a corporation
in determining how much money they may anticipate from a client
throughout their partnership.

Calculating employee turnover

Employee turnover is calculated by taking the number of employees that
leave an organization and dividing it by the total number of employees that
are typically carried on the payroll. To make that number relevant you want
to be able to put it within a time frame.

Typically, when we talk about employee turnover, we talk about it on an
annual basis. To come up with an annual turnover, you want to take the
number of employees that left the organization over an entire year and
divide it by the average number of employees that you carry over the year.

The first step would be to go back over the last 12-month period in the last
calendar year and figure out how many employees you carried each month.

One way of doing that is just to take a particular payday each month. Let’s
say the first Friday of the month or the first pay period of the month and
count the number of paychecks that went out.

Turnover is important because it's a good indicator of how good a job was

of recruiting the right people, selecting and hiring the right people, how
good our training programs are, and how good a job we're doing of creating



a culture that makes the right people want to stay and be committed and be
productive and longtime employees in your workforce.

You constantly want to be developing new programs and implementing new
approaches to keep that number as low as you can

Leveraging Excel’s Financial functions

Excel has lots of financial functions. People use these functions to calculate
their day-to-day activities in their company or firm. Some of the functions
are Future Value (FV), FVSCHEDULE, Present Value (PV), XNPV, PPMT,
and lots more. Below are some of the ways you can utilize these functions
in Excel.

CONVERTING INTEREST RATES

Computing effective rate with FV

The Function Value (FV) is used to discover the future value of an
investment. It contains the interest rate that doesn’t change and the payment
made periodically. To, do this, the formula below is used;

Rate here means the interest rate or the period. Nper means the number of
periods.

[Pmt] means the payment period. PV means the Present Value. [Type]
means when the payment is made. In this [type] option, when something is
attached to it, it means that the payment was made at the period end.

Example: Apple invested $100 in 2017 and this payment has been made
yearly. They have an interest of 10% per annum. What would be their future
value in 2021?



You will get the US $129.79

Creating an amortization schedule

This is done using the PMT function. We use it to compute the payment
made monthly on a loan. It has an interest rate of 5%, a duration of two
years, and a present value of $20000. Named ranges are used for the input
cells.

With the PPMT function, compute the principal part of the payment.



Then, using the IPMT function, compute the payment with the interesting
part.

Fill in the balance.

Pick range A7:E7. Then drag it down one row. Modify the balance formula.



Pick range A8:E8. Drag it down to row 30.

CALCULATING DEPRECIATION

Calculating accelerated depreciation



Accelerated depreciation is a form of depreciation whereby a capital asset's
purchase price is reduced at a quicker (accelerated) pace than it would be
using typical straight-line depreciation like the straight-line approach. As a
result of accelerated depreciation, an investment's value is reduced more
quickly in the early years than in the later years. Accelerated depreciation is
a common tax-saving approach.

The twofold decreasing balance technique and the summation of the years'
figures approach are the most prominent accelerated depreciation methods.
The following is the formula for computing depreciation using each of these
methods:

1. Depreciation method with a double falling balance: Depreciation
method with a dual declining balance = 2 x Straight-line depreciation rate x
Book value at the start of the year

2. The way of adding the digits of the years:

Applicable percentage (percent) = Number of anticipated years of life left at
the start of the year / SYD

Where:

SYD = n(n+1) / 2 

SYD means the sum of the years' digits, where n is the number of years.

Calculating the net present value

This is done using the Present Value function. It is easier to calculate the
present value if you can calculate the future value.

Example: The FV of investment in Canada is $100 in 2017. They make the
payment yearly with an interest rate of 10% per annum. Calculate the
present value?



You will have $72.64

Calculating the positive and negative cash flows

This is done using the Net Present Value (NPV). It is the total sum of the
positive and negative cash flows over years.

Rate means the discount rate for some time. The Values mean the positive
or negative cash flows. Negative values are seen as payments while positive
values are seen as inflows.

Example: You will get $240.87.

CALCULATING AN INTERNAL RATE OF RETURN



Internal Rate of Return (IRR) is an abbreviation for Internal Rate Of
Return. The concept NPV, or Net Present Value, is used to describe it. This
IRR is defined as the depreciation rate that brings the net present value
(NPV) among all working capital (both positive and negative) out of a
business or operation to 0.

It's a crucial financial instrument for determining the viability of a new
project or venture. A greater IRR than that of the firm's own appropriate
pace suggests that the particular investment will likely pay off in the future.
The lower IRR, on the other hand, implies a bad return on investment.

The formula for the internal rate of return is IRR (value1, value2,... ). Value
one means the initial payment. Now, let’s solve some problems. Below is a
table that consists of different cash flows for many periods that differ. The
main investment for this business was $5000. This means that the cash flow
from day 0 is -5000. Because of this, it is seen as negative cash flow. With
the data in this table, we will compute the Internal Rate of Return.

Now, input your data in your Excel worksheet.



Now, put in this formula =IRR(B1:B7). Press Enter.

Here is your result.

Calculating non-periodic future cash flows

This is done with the XIRR function. The syntax for this formula is XIRR
(values, dates, [guess]). Values here mean the range of cells or arrays that
represent a series of income and expenditures. Dates mean the dates for the
cash flows. It can be in any order. The date of the first investment has to
come first. Guess means the expected IRR is given as a percentage or a
decimal.

For example;



Things to note down when using these functions

�        The Excel formula XIRR is used to calculate the internal rate of
return for cash flows with mismatched scheduling. The IRR function
may be used to model periodic cash flows with unpredictable
payment dates.

�        At most 1 good (income) and 1 bad (extrovert expenditure) value
must be present in the range of outcomes.

�        The initial value must be expressed by a negative integer if it is an
expenditure (initial investment). The original investment is not
amortized; future payments are rolled back to the first cash flow date
and marked down on a 365-day basis.

�        The proportional component of a date that reflects time is deleted, and
all dates are shortened to integers.

�        The dates should be correct. Dates are input as hyperlinks to cells
with dates or as the output of formulae like the DATE function. Issues
may arise if dates are entered in text format.

�        Also when computing monthly or weekly cash flows, XIRR in Excel
always produces an annualized IRR.

Performing financial forecasting.

The forecast function is the most basic forecasting function you can have. It
forecasts the chosen repetition series, but we should first get all of the other
known sequences and known outcomes. To anticipate the upcoming
demand, the forecast function just employs the Moving Average Forecast



technique. If we don't know X, we've input the number manually, starting
with 1 for the initial value and working our way up.

Now, on the formula tab, pick Insert. On the dialog box, click the down
arrow and choose Statistical. Pick Forecast function.

The formula for this is

Example;

Here, this function will help us predict next month's sales data. Let’s say a
company has monthly sales data. Then, the board wants to figure out the
sales forecasting so that they can have an idea of their future month sales. In
my table below, we are to predict that of 2009.



On the empty cell, type in the FORECAST function.
=FORECAST(D12,C3:C11,D3:D11).

Press ENTER.



You can modify your work by adding a graph to it.

 

 

 



CHAPTER EIGHT

USING FORMULAS FOR STATISTICAL ANALYSIS

Working with weighted averages

The weighted average is calculated with the SUMPRODUCT and SUM
functions in the numerator and the denominator, respectively. The weighted
average is a method for calculating the averages of numerical values with
varying weights.

The relevance (or importance) of each value in the set of data varies
depending on the weights used. You will multiply the values with the
weights to get the weighted average. The sum of the weights is then divided
by the product sum

For instance, in company Z, each employee is rated on two variables:
"quality" and "quantity" of projects completed (on a level often). The
former is given an 80 percent weighting, while the latter is given a 20
percent weighting.

Only two workers are being considered for clarity's sake (A and B). The
employee with a better-weighted average will get a raise.

"Quality" ratings are in cells A2 and B2, while "quantity" ratings are in
cells A3 and B3. Ignore the following items' double quotation marks.

For instance, in Column A, cell A1 consists of Employee A, Cell A2
consists of 8, and cell A3 consists of 5. In Column B, cell B1 consists of
Employee B, cell B2 consists of 6, and cell B3 consists of 9. In Column C,
cell C1 consists of Weights, cell C2 consists of 80%, cell C3 consists of
20%.

This formula; “=SUMPRODUCT(A2:A3,C2:C3)/SUM(C2:C3)” will
display 7.4. this is the weighted average of employee A. When you use this
formula, “=SUMPRODUCT(B2:B3, C2:C3)/SUM(C2:C3)” it will
display 6.6 which is Employee B.



The weighted average of A is bigger than that of B and that will make
Employee A be promoted. If it was done by the normal average, employee
B will get promoted.

The weights allocated to the individual variables may not always add up to
100% when computing the weighted average. Furthermore, as matched to
values with lower weights, some with higher weights have a bigger
influence on the weighted average.

The weighted average is used to get a result that represents the relative
significance of each data item. The basic average allocates equal value to all
of the data sets. As a result, the weighted average provides more accurate
results and a clearer picture of the database than the standard average.

Procedures in carrying out weighted average.

There are some procedures you are to follow when carrying this out. First,
you need to make a table. In a column, it should consist of numeric values
and in another column, adjacent to the first column, should be the
corresponding weight.

 

Then, in an empty cell, put in the SUMPRODUCT function. This function
is to multiply the numeric values with the weight. It will also sum up the
resulting products.



Hit Enter.

Now, put in the SUM function. This function will add the weights values of
all the numeric numbers.

Press Enter.



 

Now, we will divide the result of the SUMPRODUCT function with the
result of the SUM function to get the weighted average.

 

Press Enter.

 



That’s how you carry out the weighted average.

Smoothing Data with moving averages

By using the AVERAGE function in several iterations, the Moving Average
function in Excel is used to provide the average of moving iteration data.
The dataset, which may include several ebbs and flows, is smoothed out
using a moving average.

We may utilize an integrated program for Moving Average, which can be
found under the Data menu ribbon's Data Analysis option. Pick the input
range and output cell for this, and the smoothed moving average data will
be returned instantly.

Pick at most the latest three iteration data if we wish to utilize the
AVERAGE function. In several disciplines, the moving average approach is
commonly utilized in Sales Forecasts and Estimation of the Next Quantity.

Where to find this tool:

The tool is in-built, yes, but you have to unleash it from where it is. You can
find it under the ANALYSIS TOOLPAK option in Excel. Follow the steps
below to unleash it.

Click on File and select Options. In the dialog box that displays, click Add-
Ins, choose Excel Add-Ins, and click GO.



The Add-Ins dialog box will open. Click on Analysis ToolPak. Click Ok.

 

The tool will be added to the Data Analysis group under the Data Tab.

When you click on it, you will find the Moving Average option. Now, let’s
have an example. We will do this with the help of the average formula. So,
below I have some data on my worksheet.



  

So, I click on the Data Tab and pick Data Analysis. The Data Analysis box
will display. Search for Moving Average and choose it. select Ok.

In the next box that displays, choose the sales data from B2 to B13 for the
Input Range option. On the interval option, you are to put in how many
months that is needed to be removed by the average.

Here, I used 3. Then, choose the output range. I chose cell C2. Choose the
Chart Output. This is optional. If you want to show a chart, then pick it.
choose Ok when you are done.

You will find the Moving Average chart and the output in your worksheet.



Applying exponential smoothing to volatile data

This is just like the moving average. Once you have your data ready, click
on the Data Tab and select Data Analysis. Search for Exponential
Smoothing and select it. Click Ok.

The Exponential smoothing box will display. On the Input Range, choose
the range. Here I choose C2:C13. For the Damping Factor box, put in the
value 0.9. This is the damping factor. It is equal to the 1- α which is the
smoothing factor. On the Output range, choose the cell where you want the
output. If you need a chart, tick the chart output box. Select OK.



You will find the exponential smoothing figures and the chart on your
worksheet.

Explanation: When α=0.1 is used, the prior data value is given a low
weight, while the prior smoothed value is given a high weight (0.9). The
data points in the graph here are rising in number. Since there is no data
point before it, the graph does not compute the smoothed value for the
initial data point.

Using functions to create descriptive statistics

With every piece of data, descriptive statistics are among the core "should
learn" concepts. It offers us an overall picture of data patterns, such as
learning about the range, the mean, mode, and median, as well as the
variance and standard deviation, , Count, maximum, and minimum are all
used.

Descriptive statistics are helpful because they enable you to describe a vast
quantity of data. Let's imagine you have information on one thousand
people's earnings. Nobody wants to read a thousand bits of data, and even if
they did, they will not be capable of extracting any relevant information.
When you condense it, though, it does become useful: an average pays or



median income is a lot simpler to comprehend than lots of data. Below is an
image of its features;

How do you calculate this?

First: enter your information into Excel in a single column. For instance, if
your data collection has ten items, enter them into fields A1 through A10.

Second: go to the "Data" tab, then to the "Analysis" group, and finally to
"Data Analysis."



Third: on the pop-up Data Analysis box, choose "Descriptive Statistics."

Fourth: In the "Input Range" text box, enter an input range. In the box,
enter "A1:A10" for example.

Fifth: Once you have named the column in row 1, click the "Labels in the
first row" check box; otherwise, leave it unmarked.

Sixth: In the "Output Range" box, enter a cell location. Type "C1" as an
example. Make sure there is no data in two neighboring columns.

Seventh: To show Excel descriptive statistics, tick the "Summary Statistics"
option and then click "OK." In the column you chose as the Output Range,
a set of descriptive statistics will be supplied.
Let's work with an example.

 

So, follow the steps above to the third three. With my data above, I will
select the input range as $C$2:$C$13. I have named my first row, so I will
check the Labels in the First-row box. My output range will be $D$2. Click
the box on Summary Statistics. Select OK.



You will see the descriptive statistics on your worksheet. You will see the
mean, median, mode, and other useful stats of your data.

 

Getting the largest or smallest value

With these steps used above, you will find the largest and smallest value
within the descriptive statistics column. This time, you will have to tick the
box on the Kth Largest and Kth Lowest boxes.



Calculating mean, median, and mode

As I explained in the topic on Descriptive Statistics, you get the mean,
median, mode, and other options for your data using that process. It is an
easy thing to carry out.

Identifying statistical outliers with an interquartile range

An outlier is a value that deviates abnormally from the rest of the dataset's
values. Outliers may be troublesome since they can skew an analysis'
findings. The interquartile range is a frequent approach to discovering
outliers in a dataset.

The distance between the 25th percentile (Q1) and the 75th percentile (Q3)
together in the dataset is known as the interquartile range or IQR. It
calculates the dispersion of values in the middle 50%. An event is
considered an outlier if its value is 1.5 times more than or less than IQR,
according to one prevalent technique.

Follow the steps below to do so:

First, you create your data.



 

Then, find out the first and third quartile. Here the first is 5 while the third
is 20.75.

The interquartile range will be 20.75 – 5 = 15.75.

The next step is to get the lower and upper limits. To get the lower limits,
use this formula; Q1 – 1.5*IQR. Here, it is 5 – 1.5*15.75 = -18.625.

To get the upper limit, use this formula; Q3 + 1.5*IQR. Here, it is 20.75
+1.5 = 44.375.



The final step is to figure out the Outliers. The only thing observed in this
dataset that has a value less than the lower limit or bigger than the upper
limit is 46. So, 46 is the outlier.

Creating a frequency distribution

We will do this by using the frequency function. The frequency formula is
=FREQUENCY (data_array, bins_array).

Data array: The frequencies are counted using a set of array values. The
frequency function outputs an array of value 0 if the data array values are
zero.

Bins array: A collection of array values that are used to organize the input
array's contents. It will yield the array items from the data sequence if the
bin array values are zero. you will find this function in the formula tab.

Steps in doing this:

Here is my table here, I have a dataset that consists of twenty values.



So, the first thing to do is to let Excel know the upper limits for our bins in
the frequency distribution. Here, I used 10, 20, and 30 i.e. 0-10, 11-20, 21-
30, and 30+.

  

Now, to calculate the frequency of each bin, I will apply the Function
formula. =Frequency (A2:A21,C2:C4).



 

Only 6 values are in the range of 0-10, only 7 values are in the range of 11-
20, only 5 values are in the range of 21-30, and only two values are bigger
than 30. Now, with the steps below, we will visualize the distribution.

First, highlight D2:D5. Select Insert from the ribbon and click on the 2-D
Column. A chart will be displayed on your worksheet which shows the
frequencies for each bin.

 

An alternative to the Frequency function

The Analysis ToolPak serves as an alternative to the frequency function.
With it, you can create histograms for your frequency distribution. So with
your data and the bin ready, simply click on Data Analysis. Search for
Histogram and pick Ok.



In the Histogram box, put in the input range and the Bin range. Click on the
box next to the labels, Cumulative Percentage, and Chart Output options.

Click Ok two times.

You will get the histogram and the chart on your worksheet.

 

 

 

 

 

 

 

 

 

 



CHAPTER NINE

USING FORMULAS WITH TABLES AND CONDITIONAL

FORMATTING

Highlighting cells that meet certain criteria

With Conditional formatting, you can highlight cells that meet up certain
conditions in Excel. In my example here, I want to show the formatting of
cells that are below the value of 4000.

Follow the steps below:

Select the cell range for the formatting. On the Home tab, pick Conditional
Formatting. Select New Rule.



The New Formatting Rule window will display. Select “Use a formula to
determine which cell to format”. in the Edit the rule description, put in the
formula =C3<4000. Do not include the dollar sign. Click Format.

The Format cell box will be displayed. On it, you have different formatting
options to choose from. Make a choice and select OK. Then, on the New
Formatting Rule box, click OK.



Highlighting cells based on the value of another cell

In my example below, I want to highlight the records that contain
everything about Bob.

 

So, I highlight the entire worksheet, select Conditional Formatting (Home
tab) and select New rules. Choose the “Use a formula to determine which
cells to format” option. On the box, below it, type in this formula =$C2=”
Bob”



Then, click on the Format option. Click on the Fill tab and choose a color
that you want it to be highlighted with. Then, click Ok.

This will be the result.



Explanation

Conditional Formatting examines each cell for the condition we've set,
which is =$C2=" Bob" in this case. As a result, it will check whether cell
C2 contains the name Bob or not while inspecting each cell in row A2. If it
does, that cell is highlighted; if it does not, it is not.

It's important to note that the dollar symbol ($) comes before the column
alphabet ($C1). By doing so, we've ensured that the column will always be
C. When cell A2 is tested for the formula, it will also check cell C2, and
when cell A3 is examined for the condition, it will also check cell C3. By
using conditional formatting, we can highlight the whole row.

 

Highlighting values that exist in List1 but not List2

First, choose the cells in List 1 whose values are for highlighting. Click on
Conditional Formatting. Pick New Rule.



Pick “Use a formula to determine which cells to format”. In the formula
box, type in this formula; =ISERROR(MATCH(A2,$C$2:$C$14,0)).

Click Format and choose a color from the Fill Tab. Click OK. Select OK
again. You will find out that values that exist in List 1 but not in List 2 are
highlighted.



In the formula I used above, A2 means the first cell in the column for the
highlighting. C2C14 is the other column that you are comparing.

Highlighting values that exist in List1 and List2

Select the column of the range for highlighting. Choose Conditional
Formatting and pick New Rule. Pick “Use a formula to determine which
cells to format”.

Put in this formula =NOT(ISNA(VLOOKUP(A2,$B:$B,1,FALSE))). A2
here stands for the first cell of the column for highlighting. B: B stands for
the column for comparison. You can modify them whenever you want to.

Click on the Format button. Make some formatting for the highlighting.
Choose a color, font, and so on. Click OK. You will see that they have
highlighted the values that exist in List1 and List2.

Highlighting based on Dates

Conditional formatting could be used to highlight cells that include dates
before today or throughout a date range before the present date. Conditional
formatting allows you to highlight certain cells in a worksheet by coloring
them depending on rules or criteria.

If you wish to emphasize past due dates, such as bills that are 30, 60, or 90
days past due, this formatting is useful. You may apply many rules to a
variety of cells by using conditional formatting.



There are different ways you can highlight dates using conditional
formatting. Here, I will show you the ways.

The first process is by using built-in conditional formatting

�        First, choose the cells for highlighting.

�        Select Conditional Formatting and pick Highlight cell rules.

�        A list will appear. Pick Dates Occurring. On the dialog box that
displays, pick an option from the first drop-down list such as Today,
Tomorrow, etc. From the second list, pick a custom format. Then,
pick a color you want for the cells.

�        Select OK and OK again.

 

The second process is by creating a conditional formatting rule based
on the content of the cells.



This process allows you to choose how you want the cells to be formatted,
and you can make some modifications more than the in-built process. So,
let’s get started.

First, pick the cells for highlighting and pick Conditional formatting.

Hit New Rule. Choose Format only cells that contain.

On the first down arrow, the option there should be Cell Value. On the
second one, pick Less Than or Greater Than as the option. For the Text
Box, type in =TODAY().

Click Format and make some modifications. Click Ok two times.



Highlighting days between two dates

First, select the cells. Click Conditional Formatting. Choose New Rule.

Pick Use a formula to determine which cells to Format. in the formula box,
enter this formula; =AND(E3>=$B$3, E3<=$C$3). The AND function is
used here to compare the date in the cells you have selected. Do not apply
the dollar sign for the targeted cell. Here, mine is cell E3. If you click on the
cell instead of typing it in, Excel will make it an absolute reference.

Click Format and make some modifications. Click OK two times.

Highlighting days between a due date.

Pick the cells for formatting. Click Conditional Formatting. Pick Highlight
Cells Rules.

Hit Less Than. In the dialog box that displays, you will see a date that was
entered by Excel automatically as the LESS THAN rule. You will also find
out that the cells have been highlighted with a red color which is displayed
as the preview for you.



Excel wants to highlight the cells but we want to highlight just the due
dates. To do that, we will replace the date with the TODAY function which
is =TODAY(). Click OK.

Conclusion.

So, we learned how to develop a conditional formatting rule that formats a
cell that consists of a date if the date is earlier than today in this course.
Also, I examined how to expand our conditional formatting rule to
incorporate criteria depending on cells except for the formatted cell.

Conditional Formatting is a useful Excel tool that can be used in a variety
of ways to automatically format cells and data depending on both basic and
sophisticated criteria.

 

 



CHAPTER TEN

UNDERSTANDING AND USING ARRAY FORMULAS

Understanding Array Formulas 

An array formula is a method that can perform several calculations on
multiple items in an array. An array is a collection of data in a column or
row or a collection of data in a combination of columns and rows. Array
formulas may give several results or simply one. As you may know, the
combination of multiple keys CTRL + SHIFT + ENTER converts a regular
equation into an array formula.

Array formulas may be utilized to do complex tasks like:

1. Quickly create sample datasets.

2. Count the number of letters in a group of cells.

3. Only include numbers that meet particular requirements, such as those in
the lower half of a range or ones that fall between two lines.

4. In a collection of numbers, add up all of the Nth values.

A multi-cell array formula

This is an array formula that returns multiple results to multiple cells at the
same time. In the example, the formula for B3:B12 is =ROW(1:10). In this
scenario, the ROW function returns a ten-item array: {1;2;3;4;5;6;7;8;9;10}



To enter a multi-cell array formula, follow these steps:

1. Choose several cells to work with, for instance, cells that will contain the
formula

2. Enter an array formula in the formula bar.

3. Press Control + Shift + Enter to double-check the formula.

There are a few characteristics that differentiate multi-cell array
formulae:

1. All cells have the same formula 

2. It is not feasible to insert cells in a range comprising a multi-cell array
formula.

3. You must choose the whole range to update the formula.

4. To confirm changes, press Control + Shift + Enter.

To choose each of the cells in a multi-cell array formula, employ the
keyboard shortcut control + /.

A single cell array formula

An array formula may create a single cell or a group of cells. A multi-cell
formula takes a variety of cell types as input. A single-cell formula, on the
other hand, is comprised of an individual cell of an array.

Many Excel array functions, such as TRANSPOSE, TREND,
FREQUENCY, and LINEST, are intended to return multi-cell arrays.

When you press Ctrl + Shift + Input to start an array expression into an
individual cell, the SUM, AVERAGE, AGGREGATE, MAX, MIN, and
related procedures may compute array expressions.

The examples below show how to utilize a single-cell array formula and a
multi-cell array formula.

1. A formula for a single-cell array:



Let's say you have got double columns, B and C, which represent the
number of items sold in two different weeks, and you desire to figure out
which one has the highest rise in sales.

Normally, you'd construct a new column, say column D, that uses a formula
like =C2-B2 to estimate the earnings change for each product and then
check for the highest figure in that column =MAX (D:D).

An array formula requires no additional column since it appropriately keeps
intermediate results in memory. Simply write the following formula and
press Ctrl + Shift + Enter:

2. An Excel formula for a multi-cell array:

Assume, as in the previous SUM example, that each sale is subject to a 10%
tax, and that you want to calculate the tax for every item utilizing a single
formula. In a blank column, choose a cell range, such as D2:D6, and then
enter the equation =B2:B6 * C2:C6 * 0.1 in the formula field.

When you press Ctrl + Shift + Enter, Excel will copy your array formula
into every cell in the given range, providing you the corresponding result:

3. Returning a multi-cell array utilizing an Excel array function



 Microsoft Excel provides a few  "array functions" which are designed
expressly for use with multi-cell arrays. TRANSPOSE is among these
functions, and we shall use it to reorder the rows in the table above.

Select an empty section of cells for printing the transposed table. Since we'll
be changing rows to columns, ensure that you choose the same number of
rows or columns as the columns and rows in your source data. In this
example, we've used six columns and four rows. Press F2 to enter edit
mode.

Insert the array function =TRANSPOSE by pressing Ctrl + Shift + Enter
(array). In our situation, the formula is =TRANSPOSE($A$1:$D$6). The
final output will resemble the following:

Creating an array constant

In Microsoft Excel, an array constant is effectively a group of static values.
When you duplicate a formula to other cells or values, the values of the
original cell or value stay unchanged. Let's have a look at some of the
various array types and how to create them.

UNDERSTANDING THE DIMENSIONS OF AN ARRAY

One dimensional horizontal array

Each row holds a constant from the horizontal array. To create a constant
for a row array, break the values with commas and surround them with
braces, as in 1,2,3,4. Note, When creating an array constant, the start and



exit braces must be explicitly entered. Create a horizontal array in a
spreadsheet by selecting the required amount of blank cells in a row,
entering =1,2,3,4 in the formula bar, then hitting Ctrl + Shift + Enter.

One dimensional vertical array

A column holds a constant representing a vertical array. It is constructed
identically to a horizontal array, except that the components are divided by
a semicolon.

Naming array constants

Assign a name to an array constant to make it easier to use. Consider
how it is accomplished:

1. In the Formulas tab > Defined Names group, choose Define Name.
Alternatively, when clicking New, press and hold Ctrl + F3.

2. Enter the name in the Name column.

3. In the Refers To box, enter the elements of your array constant, wrapping
them in parentheses with the following equality sign (=).

4. Click OK to store the array you specified and close the window.

Select any number of cells in a column or row equal to the number of items
in your array. In the formula bar, type the array's name followed by a = sign,
and then press Ctrl + Shift + Insert to insert the specified array constant into
a sheet.

WORKING WITH ARRAY FORMULAS

Entering an array formula

An array of constants can be made up of numerical data, text elements,
Boolean values (TRUE or FALSE), and error values that are separated by a
comma or a semicolon. You can enter a numeral in any of the following
ways: integer, decimal, or scientific notation, to name a few. In Excel, if
you use text values, you should put them inside double quotation marks (")
as you might with any other formula.



A constant array can't have any other constant arrays, cell references,
ranges, dates, specific names, formulas, or functions in it.

Selecting an array formula

1. Choose the cells in which you want your findings to appear.

2. Begin by entering your formula.

3. Press Ctrl+Shift+Enter three times. Excel inserts the value into every one
of the cells you've chosen.

Editing an array formula

1. In the spreadsheet, click the cell that has the array formula.

2. Navigate to the top of the screen and click the formula bar.

3. In the formula bar, change the formula

4. Click the Esc key to quit a formula array without altering it.

5. Press Ctrl+Shift+Enter on your keyboard.

6. From the File menu, choose Save.

Expanding or contracting a multi-cell array

You've constructed a fantastic array formula, and now you're required to
input a dozen rows of data to it, and you're discovering that you can't just
enter the data into your formula. All you have to do is as follows.

1. Select the region of cells that includes the array formula now in use, as
well as the vacant cells beside the new data.

2. Press the F2 key. You may now modify the formula.

3. Substitute the new range of data cells for the old one: For instance, if
your previous data ended at cells C11 and D11 and your new data finishes
at cells C13 and D13, substitute C13 and D13 for C11 and D11 in the
calculation.

4. Press the Ctrl+Shift+Enter combination.



USING MULTICELL ARRAY FORMULAS

Creating an array constant from values in a range

You can enter the array formula in a variety of cells in the spreadsheet, but
you do not have to. You may also use array constants that are values that
you easily place between parentheses in the formula bar: Then, to make it
easier to remember, give your constant a name. Constants may be utilized in
array equations or as stand-alone values.

1. Enter an opening brace, the values you desire, and a closing brace in your
array formula. Here's an illustration: =SUM(A1:E1*{1,2,3,4,5}). The
constant is contained inside the braces (), and yes, those braces are typed
manually.

2. Finish your formula by pressing Ctrl+Shift+Enter. The formula will be
similar to this: =SUM(A1:E1*1,2,3,4,5)

Performing operations on an array

The operations that an array may do are listed below.

1. Operation Traverse: Every element of an array is retrieved precisely
once for processing during an array traversal operation. This is also known
as array visiting.

2. Insertion Operation: Inserting one or even more data elements into an
array is called an insert operation. New elements may be made at the
beginning, end, or any specified index of the array depending on the
necessity.

3. Deletion Operation: Deletion refers to the removal of a current element
from an array and the reorganization of all array items.

4. Operation of the Search: A search for an array element may be done
using its value or index.

5. Update Operation: An update operation refers to changing the index of
an existing element in an array.

Counting characters in a range



The LEN function may also be used to count the overall set of characters in
a range. Consider the following scenario: we have the same dataset, but
instead of retrieving the number of characters for each cell, we want to
know how many there are throughout the whole range.

You may accomplish so by using the formula below:
=SUMPRODUCT(LEN(A2:A7))), as also seen in the image below:

Summing the three smallest values in a range

1. Type =SUM(SMALL(A1:D10,1,2,3)) into a blank cell, then press the
Ctrl + Shift + Enter keys to receive your result.

2. As n becomes greater, this formula will get complicated. To aggregate the
top 20 integers in a range, for example, a formula must have a list of
integers ranging from 1 to 20.

Here's a faster and more practical array formula:

LARGE(A1:D10,ROW(INDIRECT ("1:20"))
=SUM(LARGE(A1:D10,ROW(INDIRECT ("1:20"))

Remember to click Ctrl + Shift + Enter after entering this formula. Simply
replace 20 with the required amount if you require aggregating a different
number of integers.

Counting text in a range

On a Windows machine, perform the following to estimate the cells that
contain text in your spreadsheet:



1. To input the formula, click on an "empty cell" in your spreadsheet.

2. To check the number of cells having text within a given cell range, type
or paste the function "=COUNTIF (range, criteria)" without quotes.

3. Type the cell range you wish to check in the "range" box. Separate the
first and final cells with a colon. Through count cells A2 to A9, for
example, type "A2:A9."

4. Type ""*"" in brackets for "criteria." Within the supplied range, this
counts the number of cells that contain text. "=COUNTIF (A2:A9, "*")" is
an example of a full formula.

5. To apply the formula, hit "enter." The result will appear in the cell of the
formula.

Eliminating intermediate formulas

When creating a worksheet with more intricate calculations, rows of data
are often employed for intermediate computations before arriving at the
final result. It's not unusual for me to have many sheets of this. To avoid
things from becoming dirty, you must then conceal the rows or sheets.

Array formulae, on the other hand, may frequently remove most or all of
these intermediary computations. This not only makes your spreadsheet less
cluttered but may also help speed it up significantly. This is shown in the
example below.

We would compute the greatest value in column B for which there is a
matching "Yes" in column A in the example below.



Making column C become an intermediate column that removes the
numbers with "No" beside them is one method we could achieve this. We
could then calculate the maximum value of the remaining numbers. When I
was finished, I would conceal column C.

However, instead of using column C, we could use an array formula,
obviating the requirement for it. Converting your single-cell references into
the complete ranges is how this works. When you're finished, hit Ctrl-Shift-
Enter to get those beautiful brackets around it, which indicates that you're
working with an array formula.

 

 

 



 

 

 

 

 



CHAPTER ELEVEN

MAKING YOUR FORMULAS ERROR-FREE

Finding and correcting formula errors

Many Excel spreadsheets include mistakes, which might result in unwanted
"intrigues" in certain instances. There are several distinct types of
spreadsheet errors: Some of these are obvious, and some are more
sophisticated. When you, for example, fail to modify an external data
source or duplicate some formulae from the cell underneath rather than the
cell to the left. Alternatively, you might wind up numbering certain cells
twice, and so on.

To find errors, pick Find & Select from the home tab. Choose Go to
Special.

  

Select Formulas. pick Check Errors. Then, OK.



If there are errors in your worksheets, they will be displayed on the screen
for you.

You can also check errors by using the Formula tab. Click on it and select
Error Checking.

Any available errors will be displayed.



Mismatched parenthesis

In every formula in Excel, there is an open and closed parenthesis. Most
times, when you start with the open parenthesis, and you don’t complete it
by closing the parenthesis, Excel does it for you automatically. For instance,
you put in this formula =SUM(B5:B78. The formula has a missing
parenthesis and that is the closed one. So, Excel will still act without the
closed parenthesis.

The problem comes in when there are lots of parentheses in a formula and
you do not use it well. When you put a parenthesis in the wrong position,
Excel will display an error for you. The formula might have the right
number of parentheses but may not be matched well. just like this formula
=UPPER(LEFT(A1))&RIGHT(LOWER(A1), LEN(A1)-1), it has equal
parenthesis but is mismatched. The correct formula is
=UPPER(LEFT(A1)&RIGHT(LOWER(A1),LEN(A1)-1))

Cells are filled with hash marks

There are two reasons why you may experience this issue. The first is that
your cell may not be big enough for the values in it. You can correct this by
increasing the size of the cell or you apply another format for the values.

The second reason is that the cell might consist of formula(s) that are
invalid such as dates. For instance, you may input a date that is before 1900,
which Excel doesn’t support. So, any of these will bring up hash marks in
the cell.

Blank cells are not blank



Sometimes, when you press the spacebar, you will notice that your cell
contents are removed. No, it didn’t go away. When you press the spacebar,
there is an invisible character inserted in the cell. For instance, this formula,
=COUNTA(A1:A10) will display the number of non-empty cells in range
B2:B10. When you press the spacebar to remove any of the cells, the cells
will still be added to the count. The formula will display a wrong result.

Extra Space Characters

If your calculations depend on text comparisons, make sure your content
doesn't include any extra space characters. When data is transferred from an
external source, including an additional space character is quite typical.

Excel eliminates leading spaces from numbers you input automatically,
however leading spaces in text inputs are ignored. It's hard to discern if the
text has one or many leading space letters solely by glancing at a cell.

Formulas returning an error

There are different errors that formulas in Excel display when you insert the
formulas wrongly. Below are the errors that you can get from formulas.

#DIV/0! Errors

It is not possible to divide by zero. When you try to divide by zero in a
calculation, Excel shows the classic #DIV/0! error result.

Excel regards an empty cell to be zero, if your formula divides by a blank
value, you'll get this error. It is a typical issue when creating formulae for
data that hasn't been inputted yet. You can use the IF function to check for
any blank cell in your worksheet.

#N/A errors

This occurs when a cell that is referenced by a formula shows #N/A. Most
times, people put in the =N/A or #N/A formula for missing data. This issue
also occurs when some functions do not find a match to the cell you
provided.

#NAME? errors



This error might occur based on these conditions;

�        If a formula consists of an undefined cell name or range.

�        If it consists of text that is interpreted by Excel as an undefined name.
For instance, you may spell a name incorrectly. This error will
display.

Range names are a smidge of a stumbling block in Excel. Whenever you
remove a name from a cell or range but it's still utilized in an equation, the
equation will continue using the name even if it's no more specified. As a
consequence, #NAME? appears in the formula. You might assume
that Excel will transform the names to their matching cell references
instantly, but this does not occur. Excel doesn't even offer a means to
transform formula names to cell values!

#NULL! errors

This error occurs when you want to use a formula to join two ranges that do
not intersect. When the ranges have no cell in common, this formula will
display.

#REF! errors

When you use a formula in an invalid cell reference, this results in this
error. This error will display in the following conditions;

�        If you erase a cell that has a formula reference in it.

�        If you copy a formula to another place that nullifies the relative cell
references.

#Value! Errors

This error occurs in the following conditions;

�        A function parameter is of the wrong data type, or the formula tries to
execute an action with invalid data. A calculation that inserts a
variable to a text string, for instance, yields the #VALUE! error.

�        The proposition to a function is a range when it could perhaps be only
one value.



�        There is no calculation for a specific worksheet function. Placing or
hanging a sheet in certain versions of Excel may result in this error.
To initiate an adjustment, press Control + ALT + F9

Operator Precedence problems

The sequence in which arithmetic calculations are executed in a
formula follows certain simple guidelines. Operations with such a less
precedence number are executed before those with a larger precedence
number in the image below. The image shows that multiplication takes
precedence over addition. As a result, multiplication comes earlier.

Utilize parenthesis to guarantee that actions are done in the right sequence.
The formula below multiplies A1 by A2 before one is added to the result.
Because it has a greater order of precedence, the multiplication is done first.

=1+A1*A2

This formula is explained in more detail below. The parenthesis isn't
required, but the sequence of operations is evident in this example.

=1+(A1*A2)

It's worth noting that the negation operator's symbol is identical to the
subtraction operator's symbol. As you may think, this might lead to some
uncertainty. Take a look at these two formulas:

=-32% =0-32%



The first formula yields 9, as predicted. The latter, on the other hand, yields
9. How is it that Excel can provide the 9 results while squaring a number
always yields a positive result?

In the preceding formula, the negative symbol is a denial function and
possesses the greatest precedence. The negative sign, on the other hand, is a
reduction operator in the latter formula, and it has lower precedence
compared to the multiplications operator. As a consequence, the number 3
is doubled and then deducted from zero, yielding a negative outcome.

When you use parentheses in a calculation like this, Excel interprets the
expression as a negative sign instead of a negative operator. This formula
yields a result of 9.

=-(3^2)

Formulas are not calculated

If you employ VBA-written custom worksheet functions, you can notice
that formulae that use such features don't get calculated, resulting in
inaccurate results. Simply, choose the cell, then hit F2, and then Enter to
compel a single formula to be computed. If you want to recalculate all the
formulas by force, hit Control + ALT +F9.

“Phantom link” errors

Most times, when you open your workbook, you will see a box with this
description here written in it, “This workbook contains one or more links
that cannot be updated”. This description displays when a workbook has
no linked formulas. you can change the source of links or update the values
again, simply click Edit Links. If you want to leave the links as it is, click
Continue.

Using Excel Auditing tools

Excel has lots of functions, formulas, and so on. Sometimes, when entering
formulas, functions, and so on, you make some mistakes or do not hear the
right answer to the equation you are working on. This issue is why Excel
has some other in-built tools that help in auditing the formulas which help
them function well. Below are some of the tools and how to use them.



Viewing formulas

The command for viewing formulas is Control Key + ~.’. You can also
click on Show Formulas on the Formula Auditing Group under the Formula
Tab. Select the

TRACING CELL RELATIONSHIPS

Identifying precedents

In the image below, I have the highlighted formula in cell D2. So, I want to
know the precedents for the formula.

So, press F2. This will get us into the Edit Mode. So, select the cells before
pressing F2. The precedence cells will be colored with different colors with
the cell reference as well.

To trace the precedence easily, navigate to the Formula Auditing group and
select Trace Precedents. Click the cell that contains the formula and select
Trace Precedents. An arrow will be displayed on the cells with dots
representing the precedents.

Identifying dependents



This is used in identifying the cell that is depending on another cell. In the
image below, different formulas have been applied to the worksheet.

Now, I want to figure out the cells that are depending on cell G2. I will
simply choose G2, and then navigate to the Formula Auditing group and
select Trace Dependents. The dependents will be shown with arrow signs
on them.

Fixing circular reference errors

A circular reference mistake arises when a formula refers to a cell that
currently has it, either explicitly or implicitly. As a consequence, the
formula dynamically adjusts the previously acquired result, resulting in this
sort of mistake. The automated computation will not be done when
your worksheet has a circular reference.

Alternatively, you'll have to utilize Excel's error checker to figure out where
the circular references are and then eliminate them. When you don’t do so,
each cell will be computed in the circular reference with the preceding
iteration's findings. Keep in mind that iterating involves continuing the
recompilation procedure until it satisfies a set of numerical requirements.

There are ways to solve this issue. You can activate the iterative calculation
function. Select File > Options > Formulas > Tick the box on Enable
iterative calculation. You can also move the formula to another cell



manually. To find the cell that is causing the issue, use the Check for Error
option.

Using the background error-checking feature

This feature helps you to find errors in your worksheet and it clears them
for you. Click on the Formula tab > Error Checking. Then, wipe the Enable
background error checking box.

Using Formula Evaluator

This is found under the Formula tab.

First, pick the cells for the evaluation. Click on the Evaluate Formula. The
window will display. Then, click Evaluate. This is done to cells that have a
formula in them.

Searching and Replacing

This is done with the find and replace options in Excel. It makes it easier
for you to find texts, information, and other things in Excel. You use the
find to find the information you are looking for. If you want to replace it,
you have to use the find option to find it first before using the replace
option.



You will find the Find and Replace option and the Editing option on the
home tab.

Select Find. Then, type in the word you want to find.

Select Replace. Then, input the word you want to replace in the Find what,
and input the word you want to replace it within the Replace with box.
Click Replace All to replace all the words in the spreadsheet with the new
word.

Spell-checking your worksheets

Right-click on any of the sheets below the screen and choose Select All
Sheets. Click the Review tab and pick Spelling from the proofing group.



Click Yes on the dialog box. Then, on the box that appears next, you will
see the suggested words that are spelled incorrectly. From the suggestion
box, select the correct spelling for the word.

Click change when you are done. Then, unselect the worksheets.

Using Autocorrect

When you are typing in stuff in your cells, Excel sometimes corrects the
wordings for you. It helps sometimes but sometimes it may not be what you
want. For instance, if you type a web address in a cell, it is changed to a
hyperlink. You can modify the settings of the autocorrect in Excel.

Select File > Options. Click Proofing and select AutoCorrect Options.
The box below will appear.



Click on the AutoFormat As You Type tab. You will see a list of autocorrect
options. Check the boxes of the options you want.

Click OK.
 
 
 



 
 
 
 
 
 
 
 
 

 



BOOK 3:
EXCEL PIVOT TABLES &

DASHBOARDS



CHAPTER ONE

 INTRODUCTION TO PIVOT TABLES

What are Pivot Tables?

A pivot table is a particular Excel feature that enables you to visually
analyze and study data. It is a tool that enables you to interactively study
vast amounts of data. With a pivot table, you can rapidly turn a large
number of rows and columns into a comprehensive, neatly designed report.

A PivotTable is a user-friendly tool for efficiently summarizing vast
volumes of data. A PivotTable may be used to study statistical data in-depth
and to solve unexpected queries about your information. A PivotTable is
particularly useful for:

●       Large volumes of data may be queried in a variety of user-friendly
methods.

●       Numeric data subtotaling and aggregation, data summarization by
categories and subcategories, and custom computations and formulae

●       Extending and compressing data levels to narrow your findings, as
well as diving down to specifics from data collected for fields of
interest to you.

●      To view alternative representations of the original data, move rows to
columns or columns to rows (or "pivot").

●       Filtration, sorting, grouping, and conditional formatting are the most
relevant and intriguing subset of data, allowing you to concentrate on
just the information you need.

●       Reports that are succinct, beautiful, and annotated may be presented
online or in print.

In essence, Pivot Table extracts value from the infinite clutter of data on
your computer. And, more particularly, it allows you to organize your data
in various ways so that you may readily make useful conclusions.



The "pivot" aspect of a pivot table refers to the ability to twist (or pivot) the
data in the worksheet to examine it from a wider viewpoint. To be clear,
when you pivot, you are not adding to, removing from, or otherwise
affecting your data. Rather, you're merely restructuring the data so that it
may be mined for important information.

What are the main parts of a Pivot Table?

Filters: A report filter is used to apply a filter to a table as a whole. Filters
are used to conceal certain data.

Columns: Column labels are used to add a filter to one or more columns in
the pivot table that must be shown. Values under various situations

Rows: Row labels are used to add a filter to one or more rows in the pivot
table that must be shown. Data that is used to specify something.

Values: This generally takes the form of a field with numerical values that
may be utilized for various sorts of computations. The total number of data
points.

Importance of Pivot Table

When working with data in Microsoft Excel, there are several tools and
features available. Pivot tables are an essential feature of Excel that allows
you to work with data in several ways. Pivot tables are useful because they
enable anybody to filter and retrieve information from the data set, they're
working with.

Pivot tables enable anybody to see their data from a variety of angles. Users
may construct interactive visualizations for anybody viewing them with the
help of these pivot tables.

You may construct a pivot table after the data is in Excel. To create a pivot
table, highlight all of your data, go to the Insert tab, and choose Pivot table
from the drop-down menu. The Pivot Table option gives the user the
maximum flexibility with their data, allowing them to investigate all
conceivable combinations of their categories. If the user wishes to have
Excel present some pivot tables already built with their data, they may click
the Recommended Pivot Tables option.



The pivot table dashboard will appear in a new excel sheet once you click
OK, and the user will be able to examine all parts of the data.

When the user begins adding items to the filters, rows, columns, and values
sections on the right side of the dashboard, the numbers appear on the left
side of the dashboard. All of the data's columns appear in the box, and they
may be dragged and dropped into any of the four categories.

If you drag anything into the rows field, it will display all of the data from
that column in rows on the left side. The same is true if you drag anything
into the column field; only the data will appear in columns across the page.

The values field enables the user to get and display data linked with
categories in the rows or columns. Finally, the filter field is quite valuable
because it allows for the user to split down the data so that they may only
view the bits of it that are relevant to them. To the left is a representation of
these pivot tables' fundamental functions.

Another useful feature of pivot tables is the large number of functions that
can be applied to the data in the columns and rows in real-time.

The pivot table's values may be translated in many ways. The lists on the
left are just a few of the many methods to extract essential values from data
quickly. Users may retrieve the total amount of numbers in a category, the
count, and other statistics that can be utilized to locate crucial data.

If a user wants to make calculations from the data in a column right away,
they can do so with just one click on each cell. Instead of typing long
formulas into each cell, pivot tables allow you to perform calculations that
would otherwise necessitate a long formula in each cell.

Creating a new field calculated from a function made up of other fields is
another intriguing possibility with pivot tables. A user can manipulate
different fields in a pivot table by adding, subtracting, multiplying, and
dividing them.

Conclusion

This chapter simply explained what a pivot table is all about. As you were
reading through, you got to know about the meaning, parts, and importance



of a pivot table. With a pivot table. You can efficiently carry out several
tasks.



CHAPTER TWO

 BUILDING A BASIC PIVOT TABLE & CHART

A PivotTable may be created from a set of data or an Excel table. If you
know what you're searching for, you may start with a blank PivotTable to
add in the specifics. You may also utilize Excel Recommended PivotTables
to get an idea of which PivotTable layouts are most appropriate for
summarizing your data. It is an easy process to create a Pivot Table in your
worksheet. Follow the steps below to do so;

First, choose the cells for the pivot table:

Navigate to the Insert tab and select Pivot Table. Select where you want the
pivot table to be placed. Click Ok. It is advisable to pick a New Worksheet.
You can also decide to analyze multiple tables by clicking the boxes on Add
this data to the Data Model.

The Pivot table will be created on your worksheet in relation to the data in
your new worksheet. It will consist of an empty worksheet. Name the
worksheet.



Summarizing Numbers

Excel provides several techniques for summarizing your data in the Pivot
table. Sum, Count, and Average are some of its summary capabilities.

If you insert a field in the Values section of the field list pane, the value in
the column is instantly summed. The Sum function is the standard summary
function for the PivotTable's arithmetic value fields, but you may change it.

●      In the PivotTable, on the Grand Total field, right-click on it and select
Summarize Values By.

●      Choose the function that you want to use from the drop-down menu.

Below are the summarize options that you can use alongside the
function.

SUM: The standard adding function. It adds up the details in the column. It
is the basic function for numerical value fields in value fields. When the
sum method is used, all empty or non-numeric variables in the PivotTable
are set to 0 so that they may be totaled.

COUNT: It shows the total number of non-empty values. It is the standard
value for value fields that include non-numeric data or spaces.

AVERAGE: With this, the average of the provided data is shown.

MAX: With this, the highest value is shown.

MIN: With this, the lowest value is shown.



PRODUCT: With this, the composite of the values is shown.

StDev: An estimation of a population's standard deviation, when the sample
represents a portion of the total population.

StDevp: The population standard deviation, in which the population is all
the other data to be summed.

VAR: It provides an estimation of a population's variation, where the
sampling is a portion of the full population.

VARP: It shows the variation of a population, in which the population is the
total amount of data to be evaluated.

Distinct Count: It shows the number of distinct values. This summary
feature is only available in Excel when you utilize the Data Model.

How to Drill-Down Pivot Table Data

Particularly when it comes to data analysis, pivot tables are our best friends.
Let's look at how a table's structure develops. One or more records may be
found in each value.

Let's have a look at an example of this. When it comes to passport IDs, one
ID may belong to just one individual, which is referred to as a 1:1
relationship. If we're talking about a birthdate, the 1: N relationship comes
into play. More individuals can easily tolerate it on the same day, as we can
see.

Let's return to the original data set after this little diversion. A sales table is
seen in the diagram below. At first sight, the number in cell C6 (East /
Office Supplies) does not provide much information.

To find out all the specifics, we are using the drill-down tool!



In Excel, we should design a dashboard using the drill-down approach.
We've summarized the data by regions and categories in the sample below.
We'd want to see all of the cell C6's connected records.

To begin, choose one of the data-filled columns in the Pivot table. Right-
click the highlighted cell after that. Finally, choose "Show Details" from the
drop-down menu that appears.

Tip: There is a much quicker way to do the drill-down than using the Show
Details command. We'll highlight the cell value we'd want to go through in
more depth. It's finished after two clicks!

A new worksheet with a list of 'Office Supplies' entries will be created
instantly.



When utilizing slicers, use extreme caution!

When we link slicers, namely filters, to the Pivot table, we might get some
unexpected results. In Excel versions before 2016, utilizing the drill-down
feature with slicers might result in incorrect results!

However, Excel's newest versions, they're worth using, particularly when
we want to further filter the table's data before drilling down. Click the
Insert tab and pick the Slicer symbol to add a new slicer.

The slicer in the image below has all of the categories. All components will
be in the list if we want to calculate the Grand Total in the E5 cell.

 

Do you want to see just one category before drilling down? Select a
category by clicking on its name.



When we double-click the B5 cell, just the records from the highlighted
category are shown.

Watch out for the source data

Whenever we deal with data that isn't tied to the actual source or the Pivot
table, it's far more annoying. What occurs if the Pivot table's new data
arrives?

Let's look at the analyst's worst disaster: data that isn't refreshed! When we
utilize an external data source, this is quite simple to happen.

We can't stress enough that when we utilize the drill-down function, all we
get is a stagnant list. This isn't tied to the initial Pivot table anymore!

Drill-down PowerPivot Data Model

We'll teach you how to create a tiny data model using tables and
PowerPivot in this segment. You may also obtain an insight into the Quick
Explore tool with only a few taps. If you want to delve down into the
specifics in Excel, Quick Explore is the way to go. It's important to note
that this feature requires Excel 2013 or later.

On the Tables worksheet, we have sales-related datasets.



Let's start by establishing table connections.

Insert the specified table first from the Worksheet to the Data Model after
selecting the range.

In PowerPivot, choose the Manage option. That's a sandstone Excel add-in
for data analysis. We'll construct a Data Model that includes the following
connections between the sales tables:



Build a pivot table using the data from the source tables. Select the
PivotTable symbol in the PowerPivot pane. A new Worksheet will be
created to describe and organize the design.

Select a data-filled cell on the new worksheet! The symbol for Quick
Explore now shows.

Select the icon. The Explore area will appear on the screen. The Pivot
Table's tables are shown in the pop-up pane. You may drill down deep using
any of the available choices.



Select the symbol for Quick Exploration. A pop-up panel called Explore
emerges. This panel displays all of our Pivot Table sales tables.

To drill down deeper into the information, choose one of the available
fields. We wish to select the required product names from cell C8 in this
case.

Customers of Blue Technology in the Midwest will get a value of $25630.
On the Explorer window, select this option.

Excel will construct and alter the Pivot table. Check out the filters in the
top-left area. The pivot table has been reorganized to display information
about the chosen cell.

Is it necessary to reorganize the layout? To restore your default table
structure, use Control key + Z on your keyboard.



It is beneficial for anyone to look beyond the exterior. In circumstances
when we need to dig down to the base of the data sets and inspect the
specifics, it is achievable. The drill-down approach is our ally in this
approach. When dealing with enormous data tables, utilize this function
with caution since there's a lot to learn with little investigation.

Adding Additional Rows (categories) to your Pivot Table
●      On your worksheet that contains the PivotTable, then, click on any of

the cells in the pivot table area to open the Pivot Table Wizard.
●      Choose the column label selected. Then, drag and drop it into the Row

Labels section.
●      Now, rearrange the field labels in the Row Labels section. You will see

some modifications on the Pivot Table. Choose how you want to
order the row labels.

●      Review the Page Layout for the worksheet.

Charts: How to create a basic Pivot Table Chart

A normal chart makes use of a variety of cells, but a pivot chart is formed
based on the data summarized in a pivot table. A pivot chart is essentially a
dynamic chart, however, converting a regular chart to a dynamic chart
requires data adjustments.

To create the chart, simply choose the cells in your worksheet. Navigate to
the Insert tab, then pick Chart before choosing Pivot Charts.

A menu will appear which will contain the cells you have selected. Choose
where you want the chart to be placed. You can Use an External Source if
you want to create the Pivot Chart from another source.



Pick Ok.

Pivot Chart has four elements just like a pivot table which are Axis,
Legend, Values, Report Filter.

Conclusion

This chapter explained all about the steps in building a basic pivot table and
chart. It examined how to summarize numbers, add additional rows to your
pivot table, drill down your pivot table, and lots more. With what you have
read, I know you understood it all.



CHAPTER THREE

 DISPLAYING PERCENTAGES

Several designed percentage calculations are available in the Pivot Table's
“Show Values As” option. We would like to understand how to evaluate
quantities in calculations using Pivot Table percentages rather than Totals in
a sales collection of various cigarette brands in various locations.

Percentage of Grand total

To evaluate each number to the grand total value in Pivot Table
percentages, we utilize the percent of Grand Totals computation. Branding
is put in the Row area, Areas in the Column area, and Sales Amounts in the
Value area of our Pivot Table. We wish to compare the proportion of each
brand's sales in each location to the total sales of all brands across all
regions. To alter the sales amount of each brand as a percentage of the
Grand Total, we perform the following:

1. Click the right mouse button on any of the brand's sales amount cells.

2. Select Show Values as 

3. Choose Percentage of Grand Total

Percentage of Column Total

The percentage of Column Total calculation compares every value to
the total of a column value and displays the result in Pivot Table
percentages as a percentage of column total. To display the proportion of
sales for each brand inside each area, just do the following steps in your
Pivot table:

1. Select any of the brand's sales amount cells using the right mouse
button.

2. Pick Show Values As



3. Choose the percentage of Column Total from the Show Values As
drop-down menu.

Use this same method to display the percentage of the row total as well.

Conclusion

So, I have given you the concept of how to display percentages in your
pivot table. You can display the grand, row, and column percentages. Use
the methods here to make it easier for you to display percentages.

 

 



CHAPTER FOUR

 RANKING RESULTS AND DISPLAYING AVERAGES

A Pivot Table is Excel's greatest useful means, that enables you to evaluate
your data in a variety of ways with the click of a button. You may also use
the Average instead of the Sum in a Pivot Table!

You may pick a kind of computation (Sum, Count, Average, Max, Min,
Count Numbers) when using the Summarize Values By option. 

Whenever you place a value field into the Pivot Table's Values box, it will
automatically sum it and give you a Summation of the Values.

This computation may simply be changed to an Average and that will
display the Excel pivot table mean scores for your dataset.

Displaying Averages

The estimated daily measure is helpful for analyzing patterns in daily sums
over time (monthly, halves, etc.) or even divisions. To rapidly understand
how the daily average varies over time, we may utilize a line chart or a
column chart.



How does this calculation work?

The Power Pivot Data Model employs DAX measurements in this method.
To compute the original time duration in the data collection, we'll utilize the
DISTINCTCOUNT function. In Power Pivot, the DISTINCTCOUNT
function is a DAX function.

The Average of Total Daily Sales is calculated by dividing Total Sales by
the Distinct Day Count. This might be any amount (numeric value). It is not
required that the data come from sales.

Formula = [Average of Total Daily Sales] = [Total Sales]/[Distinct Day
Count]

Below are the procedures in creating pivot tables and measures
(showing average):

1. The first step is to insert a Pivot Table and add it to the Data Model.
When inserting the pivot table, click on the box next to the Add this data to
the Data Model option.



2. The next step is to construct the measures. For three computations, we'll
define explicit measures:

Total Sales = SUM((Amount)), Distinct Day Count =
DISTINCTCOUNT((DATE)), and Daily Average = (Total Sales) / (Distinct
Day Count).

1. To construct the measures, on the table name in the pivot table list,
right-click and pick Add Measure.

2. This will open the Measure Panel. In the box, type Total Sales while
in the formula box put in =SUM([Amount]). Pick Ok.

The measure will be constructed and placed to the Fields List's base. For the
other two measures, follow the same instructions above.

Measures: Implicit vs. Explicit

We could alternatively do the calculations for the first two formulae by
moving the Amount and Date fields into the Values section, then adjusting
the calculation type as needed. When we utilize Excel to generate a measure
by using the drag & drop fields, we call them implicit measures.



Another method is to type the formulae in the Measure box as we
performed before. We called them explicit measurements because we
described or specified them explicitly in the formula operator.

The explicit measurements have the benefit of being reusable in other
calculations or pivot tables. The Total Sales metric will be accessible in all
new pivot tables created from the data model now that we've established it.

You can also utilize the Total Sales measure again, just as we did with the
Daily Average measure, to create more sophisticated calculations. This
saves time and improves the efficiency of formula writing in the long term.

3. The next step is to add the measures to the Pivot Table. You need not be
required to populate the pivot table with all of the measure fields. Even
though you merely add the Daily Average field to the Values box, the
computations will still function.

The Total Sales and Distinct Day Count fields, on the other hand, might be
useful additions to the pivot table. They may be useful in revealing further
patterns or explaining why a daily average is high or low for a certain time.

4. To generate the trend report, we must now insert fields to the Rows
and/or Columns Areas. In our sample, we'll group the Date field by Year,
Quarter, and Month in the Rows section. The Subtotals in your pivot table
are switched off if you're not seeing data for the Year, Quarter, or Month
lines.



To enable Subtotals in a pivot table, follow these steps:

1. Within the pivot table, choose a cell.

2. Inside the ribbon, go to the Design tab.

3. Choose "Show all Subtotals at Bottom of Group" or "Show all
Subtotals at Bottom of Group" from the Subtotals drop-down option.

4. The subtotal computations for the row area groups should now be
visible (year, quarter, month).

Lastly, we will add a short pivot chart to examine the daily average
patterns. A line chart comparing Average Daily Sales by Month and Region
is shown below.

In the latter two months of the year, the North area performed greater than
the South. After March, the South saw a downward trend.



So, with Power Pivot and DAX Measures, you can generate daily averages
using pivot tables. The potential of DAX measures is astounding, and this
basic example merely scrapes the surface of what they can do.

Ranking Data

One of the most frequent methods for assessing data is to rate it. Comparing
categories and items may be made easier by ranking them. The nice aspect
about ranking is that you can see what's at the upper and lower part. You
could save a huge amount of time and work by using ranking in a pivot
table, and it will aid us in your evaluation. There are different ways to rank
data in Excel. I will show you the methods. So, follow the steps below to do
so;

1. In the pivot table that you intend to measure the ranking, add the
value field two times.

2. Right-click on any of the cells in the second data column to choose
them.

3. Select "Show Values As" from the drop-down menu.

4. You have two choices for adding ranking: "Rank Smallest to Largest"
or "Rank Largest to Smallest." Choose whichever one you like.

5. The column values will be converted to rankings, and then you may
sort the data to see how it ranks.

Note that the rank will be modified when you filter the pivot table.

In Source Data, Using RANK.EQ and RANK.AVG

This approach is a little more difficult, but it works perfectly. The advantage
of utilizing RANK.EQ and RANK.AVG is that you don't have to modify
your pivot table in any way. Simply take these few instructions below.

1. Add this formula:
=IF(COUNTIF(C$2:C2,C2)>1,””,SUMIFS($E$2:$E$1507,$C$2:
$C$1507,C2)) in the formula bar after inserting your raw data. For
each category in the column, the formula will add a single total. You
may then use that sum to determine where each category ranks.



2. Below your data, include two extra columns. Then, enter this
formulas =IF(H2=””,0,RANK.EQ(H2,$H$2:$H$1507,1))
=IF(H=””,0,RANK.AVG(H2,$H$2:$H$1507,1)).  The rating for the
category in your data dump will be calculated using AVG. Both of
these routines were used to generate various ranking kinds.

3. Then, using this data dump, generate a pivot table similar to the one
below. To determine the ranking, you can use either of the columns.

With this method, the filter you use on the data will not affect the ranking.

In a Pivot Table, create a separate Rank Column.

You may create a manual distinct column for ranking rather than using
formulae or any other way. This function may be used to add ranks to a
specific instance. Simply take these few instructions below;

1. Select a pivot table and organize the data as desired, ascending or
descending.

2. Add the formulae below to the next two columns beyond the pivot
table.

=RANK.EQ(E4,$E$4:$E$15,1)

=RANK.AVG(E4,$E$4:$E$15,1)

3. Drag them. You will see the ranking along with the pivot table.



Conclusion

I have explained how to rank your data or records using rank EQ and rank
AVGand how to display averages in your pivot table. The steps I have
explained in the implicit and explicit measures are very important. Ensure
that you utilize them well.



CHAPTER FIVE

SLICERS (INTERACTIVE ANALYSIS) AND ADVANCED

FILTERING

Slicers are a graphical filtering feature in Excel that allows you to view
what elements are filtered inside a Pivot Table. Visualizations and summary
reports are the most typical uses for Pivot Table Slicer. Slicers have the
benefit of being able to link to many pivot tables and pivot charts, as
opposed to pivot table filters. The slicer tool may be used on a data table,
pivot table, and charts starting with Excel 2013.

Timeline Slicer

Slicers are similar to timelines. They let you analyze your data with the help
of a visual interface, but they're only good for date fields. They make it
simple to filter date categories by weeks, quarters, days, or years.

As you move from two directions on the timeline, the dates show in a
horizontal line, progressing from oldest to newest. In PivotTable, timelines
may only be used with date columns.

Adding a Timeline to a pivot table

Pick the Pivot Table for the timeline. Navigate to the Pivot Table Analyze
tab and then select Insert Timeline.

Slicer

To add a slicer to a table, your data must be organized in an Excel table.
Select a cell within your data and navigate to the Insert menu and
choose Table to build an Excel table.

When your data is now in a table, a tab will be shown. On the Table Design
tab, select Insert Slicer.



It will bring up the Insert Slicer box, where you can choose whatever fields
in your data you wish to add a slicer too.

To generate many slicer objects at once, pick one or much more fields out
from the list. You'll be capable of utilizing them both at the same time to
sort data depending on different fields.

If you press OK, Excel will automatically construct the slicer objects.

Adding a Slicer to a Pivot Table

1. Simply, choose the pivot table for the slicer. Navigate to the Pivot
Table Analyze tab and select Insert Slicers.

2. Then, choose the fields to add. Click Ok.

Advanced Filtering

There are lots of advanced filtering that you can do to/with the pivot table.
So, I will be giving you some of the advanced filterings below;

Create a calculated field

You're probably aware that Excel is a calculating engine, as well as the
ability to construct a calculated field, is a feature you'll want in your
toolbox when dealing with pivot tables.

A calculated field lets you maintain a computation operating across a pivot
table, just as you would with a formula in a worksheet.

Ryan desires to know how much money he makes on each style of beer he
sells: Pilsners, Stouts, Ambers, and IPAs. It's a pain to make the income
computation outside the pivot table since he has to remove the Q1 expense
from the Q1 revenues and do the exact thing for Q2, and so forth.



He can create a calculated field that will calculate the figures for him and
tell him how much money he'll make on each sort of beer. And here is how
you do it:

1. While within a pivot table cell, move to the "Pivot Table Analyze"
tab, choose the "Fields, Items, and Sets" button, and then pick
"Calculated Field."

2. Then, Ryan has to enter the name of the field.

3. Ryan must now input the formula he is attempting to compute. To
calculate profit, he understands he must deduct his costs from his
sales.



4. So, he'd go to "sales" and press "Insert Field," enter in the negative
sign, and then go to "Cost" and press "Insert Field."

5. Ryan can readily view his income for each kind of beer—as well as
his overall profit—on the lower part row of his pivot table now that
the computed field is in position.

Using one Pivot Table to generate many pivot-tables

Understanding how to divide a pivot table into several tables comes in
handy whenever you need to disintegrate your information even more.

Here is another illustration: Ryan has a pivot table that shows his quarterly
beer sales. He wishes to go a little further and look at his beer sales by
quarter and by kind of beer (Amber, Pilsner, IPA, or Stout).

He'll achieve this by making a pivot table for each variety of beer: one for
Amber, another for Pilsner, and so forth. Luckily, utilizing his initial pivot
table as a starting point, he can do so in only a few clicks. So, this is how
he'll go about doing it:

1. You'll have to add a filter to anything you want to sort your pivot
tables with (in Ryan's case, the kind of beer). Select inside the pivot
table, then go to the "Pivot Table Analyze" tab, choose "Field List,"
then move "Type" to the filtering list.



2. Ryan will select within the pivot table with that filter set, then return
to the "Pivot Table Analyze" tab and click "Options," and afterward
pick "Show Report Filter Pages." When Ryan selects "Variety" as the
criterion for breaking down the data, Excel creates a whole new
spreadsheet with a pivot table for every brand of beer.

Hiding and unhiding subtotals

We've previously discussed how Excel can save you a lot of time when it
comes to mathematical calculations. However, this isn't limited to the whole
quantity of digits. If you want, you may also show subtotals in your pivot
table.

Let's pretend Ryan is going through his beer sales statistics by size and
kind. Excel doesn't show the subtotals for each area since his settings are set
to show just the cumulative sum of all beer sales.

Ryan would want to examine the data in greater detail as well, and it's
simple for him to just do so:

1. First, select the Pivot Table and pick the Design tab.



2. Click on Subtotals. Choose where you want to display the subtotals.
It can be at the bottom or at the top.

3. If you don’t want to show the subtotals, select them from the options
there.

Refresh your Data

Here's just a nightmare situation suitable for a horror movie score: You've
been working with your data for hours, and you've created a plethora of
pivot tables from your source data, just like Ryan.

You re-examine several of your pivot tables and discover that you messed
up; maybe the data set contains an error. For instance, Ryan misspelled
"growler" as "grolwer," and it now looks that way throughout.

Is he going to go through his worksheet with a fine-toothed comb to make
sure the issue is corrected in all of his data and pivot tables? Certainly not.
All he has to accomplish now is:

1. Perform a "search and replace" on the raw set of data from which the
pivot tables are derived. He'd press Control key + F, then type in what
he wanted to detect and what he wanted to replace it with.



2. This will replace the errors in that spelling. Click on the Data tab and
choose Refresh All to get an update on everything.

Conclusion

A slicer is an important tool in Excel. It helps in adjusting your data. There
are lots of advanced filtering that you can perform on your table. The ones I
have given here as an example will serve as a guide on how to go about
with others.



CHAPTER SIX

INTRODUCTION TO DASHBOARDS

A dashboard is an arrangement of information in a visual format. It's a
procedure whereby you put forth all of your attempts to make your difficult
data seem more understandable and manageable via the use of visual tools.
There are a variety of Excel tools that may be utilized to build a dashboard.
Here are a few examples:

Histograms, Bar Charts, Pie Charts, Line Charts, Combo Charts, Pivot
Tables, Slicers, KPIs, and so forth. These are the technologies that may be
used to construct a dashboard and make data that seems to be difficult
easier to grasp.

To make an Excel dashboard, we must first construct a pivot table with the
data. There must be a separate pivot table for each graphic. After that, drag
and drop the pivot table into position, and create as many sheets as needed.

After we've built and labeled each Chart, we can use the Chart area of the
Insert menu item to create various graphics using different chart kinds. Take
all of the charts from their individual sheets and set them on the sheet for
the final dashboard after they've been produced. We may also include the
slicers in the final dashboard.

Adding Multiple Pivot Tables to a Worksheet

Sometimes when the data is spread across multiple workbooks or
worksheets, you have two options for creating a pivot table: one of which is
to copy and paste all of the data into a single sheet and then create a pivot
table from it; the second is by using the MS Excel wizard to create a pivot
table from multiple sheets.

Let's say we get data from a store that sells computer components like
keyboards, mouse, hard drives, monitors, and so on. They have always had
this data on an annual basis; as seen in the figure below, we've taken three
years' worth of data and reduced it to only three columns, one of which is
used to designate the specific sheet.



    

The following data is spread over multiple sheets in a single workbook;
we've labeled each sheet with the sales year. We have data for the years
2015, 2016, and 2017, and we're double-checking that the columns,
categories, and sales counters are all the same. The data in this table
displays the products sold by this store in each of the years.

We have to enter the Pivot table and Pivot Chart Wizard to generate the
main pivot table from these separate worksheets; this feature was blocked in
older MS Office versions, but it can be accessed using the shortcut keys Alt
key + D + P. Alt key + D is the office access key for Microsoft Excel. When
you press P after that, it will navigate you to the wizard.



The wizard will display two questions for you which are; Where is the data
you want to analyze and What kind of report do you want to create. Pick
Multiple consolidation ranges from the “Where is the data you want to
analyze option”. Then, pick the Pivot table on the “What kind of report do
you want to create option”.  Click Next.

The next box will ask you “How many page fields do you want”. Pick “I
will create the page fields option”. Choose Next.

The next box will ask “Where are the worksheet ranges that you want to
consolidate”. Simply select the ranges of the cells in each of the sheets and
select Add.



On the option on “How many fields do you want”, select One. However, it
is set as 0 by default but here we want our table to have a difference of one
year in it. When you do so, click Next.

Then, select where you want to put the Pivot table report. Click on New
Worksheet and pick Finish.



The Pivot Table will display in Sheet 4 of your workbook.

You should note that the sheets you wish to be included in the pivot table
must all have the same column when generating the pivot table from several
sheets.

You can also give the table a name (just as we did with the matrices) so that
anytime you alter the values in the sheet, the data in the pivot table will
update as well.

Formatting the Dashboard.

You can choose whether to improve the report structure and format after
establishing a Pivot Table and inserting the fields you want to examine.
This will make the data simpler to read and search for details. You may
modify the PivotTable form, as well as the way fields, columns, rows,
subtotals, empty cells, and lines, are shown to change the design of a
PivotTable. You may use a predetermined style, banded rows, and



conditional formatting to customize the PivotTable's format. so, let’s look at
some of the formatting options for the Pivot Table.

Default style: You can change the default structure of your pivot table. On
the Design tab, you will see the different styles. You can pick a color from
the list of different colors displayed for you.

  

Simply right-click on the style you want. then, choose “Set as default”. the
style you have selected will become your default style for the pivot tables.

Creating New Style: On the Design Tab, click the down arrow on the Pivot
Styles menu. Click on the New PivotTable Style. On the New Pivot Table
Style box, enter the name for the style.  Pick an element for formatting and
click Format. Click Ok.



Duplicate and Multiply: Right-click on the style you want to duplicate.
Choose Duplicate from the list of options displayed for you. This will open
up the Modify PivotTable Styles box.

Copy Layout to a Different Worksheet: First open the workbook that has
the custom layout. Then, open the new workbook where the layout will be
copied to. Put the two workbooks close to each other. To do this, use the
Arrange all options in the View tab.

Then, hold the Control key and drag the layout sheet to the new workbook.

Adding Charts to the Dashboard

To add a chart, go to Menu > Add New Widget...

Pivots and Charts may be accessed by clicking on them.

Select a chart type from the drop-down menu.

Choose one of the following options for the data source:

a. Select a data source after clicking the Search button

b. Select another widget on the same dashboard from the Link to
the drop-down list.



Specify the settings for the chart

Select Ok.

Parameters for Charts

When the data source utilizes members as rows and measurements as
columns, a chart is typically more informative.

Notes:

If you utilize a pivot table with a summary row or column, the row or
column will be disregarded.

Almost all of the chart types may also be seen in the Analyzer before being
added to a dashboard.

Only the top 400 chart elements are shown, with the exception of line and
time charts.

Conclusion

The dashboard helps to make your data understandable and neat. Here, I
have given different ways of how to format your dashboard to enhance its
performance. Use them very well on your pivot table.



CHAPTER SEVEN

 ADDING SLICERS AND PERFORMANCE SYMBOLS TO YOUR

DASHBOARD

Slicers

Many capabilities were integrated into Microsoft's slicers that enable users
to personalize them. You may change the caption that appears above the
slicers. The numbers of columns in which the slicers are shown may be
customized. You may conceal or make some contrast adjustment to the text,
fill, and outline of 16 slicer components by going to the Slicer Styles
gallery and creating a new Slicer Style.

Having so much flexibility available, using a slicer on a dashboard as a
quick method to choose one or more things from a list is logical. Make a
brief list of objects that should be in the slicer as a resolution. Create a pivot
table with those entries in the rows part of the pivot table in an out-of-the-
way area of the worksheet. Make a slicer out of the pivot table and design it
to look like your dashboard.

Figure 1 shows a list of months in cells X1 through X13. Choose the
information you want. Insert a pivot table in cell Z1 using the pivot table's
location specified. In the rows box, type "Months." Delete the Grand Total
by right-clicking it and selecting Remove Grand Total.

Select Insert Slicer, then Months from the PivotTable Analyze tab. Figure 1
shows the slicer in AB2:AF9.

The Slicer tab may be customized in a variety of ways:

1. "Select a Month" should be the caption.

2. Expand the number of columns to 3 or 6.

3. Select New Slicer Style from the Slicer Styles collection. To
eliminate the Whole Slicer's edge, format the different parts of the
slicer.



You can be confident that when customers click on a month in the slicer, the
chosen month will display as the second cell in the pivot table. You can see
in Figure 1 that Z2 includes the specified month.

You may use FILTER, INDIRECT, SUMIFS, COUNTIFS, VLOOKUP,
XLOOKUP, or other functions with the specified month in Z2 to get
information about the selected month. A SUMIFS in AB10 obtains the total
sales for July, and the formula in AB11 presents the result with the month
name and total sales amount, as shown in Figure 1.

Performance Symbols (up/down arrows and other indicators)

There is a super-obvious method to put up or down markers to a pivot table
to show an increment or reduction.

Insert columns to illustrate increments or reductions beyond the pivot table.
The disparity between I6 and H6 in the picture below is 3, but you only like
to indicate it as a successful development. SIGN(I6-H6) returns one of three
values: +1, 0, or -1.



Choose Home, Conditional Formatting, Icon Sets, 3 Triangles from the
two-column range that shows the indication of the change. (I'm not sure
why Microsoft named this selection Three Triangles when it's obviously
Two Triangles and a Line.)

Choose Home, Conditional Formatting, Manage Rules, Edit Rule with the
same range selected. Select the Show Icon Only option.

To copy, hit Control key +C   while keeping the same range chosen. In the
pivot table, choose the first Tuesday cell. Click the Paste Dropdown from
the Home menu and select Linked Picture. Over the table, Excel displays a
live image of the icons.



Modify the column dimensions of the additional two columns displaying
the icons at this stage so that the icons align with the values in the pivot
table.

Having viewed this, I'm not a fan of the broad yellow dash used to denote
"no change." Select Home, Conditional Formatting, Manage Rules, edit if
you don't like it. Pick No Cell Icon from the selection for the bright yellow
line.



Conclusion

You work well on your pivot table when you add slicers and the
performance symbols to it. Use the examples given here to add slicers to
your pivot table.



CHAPTER EIGHT

 REFRESHING PIVOT TABLE AND DASHBOARD DATA

When data in the PivotTable source list is modified, the PivotTable does not
immediately recalculate. Below are some reasons why you might need to
refresh an Excel Pivot Table

●      When the data structure changes, the pivot table must be refreshed.

●      At a later time, a source data variable is changed or modified.

●      More rows are included in the basic pivot table data set.

●       Existing rows in the source data used as a source for the Pivot Table
are removed, or

●       The fresh data entering from the sources (SAP, ERP, upstream data
sources) varies as the day, week, month, or quarter changes.

So, if you create a pivot table to evaluate data and afterward the data
changes after several days or weeks, you need not recreate the Pivot Table.
You just need to refresh it. There are different ways you can refresh a pivot
table.

1. Existing Data, the values vary considerably, while the numbers of
rows of data remain constant:

The data is changed first in this approach.

●       Navigate to the Pivot Table. Right-click within the Pivot and select
Refresh.

●       The Pivot Table is instantly updated. Use this simple method
whenever the source data alters.

●      In the Excel Ribbon, you may also pick the Refresh All button.

2. The size of the data in Excel changes



New rows or columns are added to the data collection, but this new data is
not represented in the pivot table. In this scenario, we must change the pivot
table's data range source to include the most recent data rows and columns.
There are a few options for doing this.

A. When your pivot table is reliant on data in a variety of cells, such as cells
B1:H50, you must increase that range to cover more rows and columns.

The simplest method is to go to the Pivot Table Analyze Tab and select the
Change Data Source choice button. The current data range from the source
will be indicated (highlighted). Re-select the new data range and choose the
OK button.

After it is done, click the Refresh All option to refresh the data from the
newly chosen rows/columns and update the pivot. The pivot table
will quickly be refreshed.

B. The process is considerably simpler if your pivot table is based on a
Table, such as Pricing Table, Table1, and has been turned into a Table.

C. All you have to do is click the Refresh button under the Analyze Tab,
and the pivot table will be instantly refreshed.

To use a Table as a data source for a Pivot Table is a smart technique that
you should use more often. When generating a new pivot table, it utilizes
the whole Excel table, and any additional rows added or deleted afterward
are automatically regarded as part of the Pivot Table.

3. Refresh automatically when the Pivot Table is opened.

You may also choose to have your PivotTables update every time you open
the worksheet. On the Options tab, click the Options button, and then on the
Data tab, check the box next to Refresh data upon opening the file.

Conclusion

Here, we have discussed how to refresh your Pivot Table. As stated above,
it is an easy process and it can be done in different ways. Simply use any of
the options that are most suitable to you.

 



 



CHAPTER NINE

PROTECTING YOUR DASHBOARD

You may wish to enable users to make modifications to a pivot table in
certain workbooks, but you must secure formulae or data in other portions
of the worksheet.

Users will be able to alter the pivot table if you protect the worksheet and
allow pivot table usage, but they will not have access to the other restricted
elements of the worksheet.

Hiding your Pivot Table Source Data

Go to the table you wish to hide in Excel, then click "Add to Data Model"
from the Power Pivot menu. In Power Pivot, you can now "Hide from
Client Tools" to make the table immediately visible.

I agree that tables outside of your data model should not be shown in the
PivotTable Fields view, but with this approach, you can at least hide them,
and as long as you don't build any relationships, you should be OK in terms
of speed.

Protecting the Dashboard or any other Worksheet

You may want to be the only one that has access to your worksheet or
dashboard of your Pivot Table. This can be achieved by protecting the
sheet. To do this, simply follow the steps below;

Click on the Home Tab and select Format.

From the drop-down window, select Protect Sheet.



Now, enter the password for the worksheet. Also, you can select what you
want users to do with the sheet.

Conclusion

Protecting your pivot table is very important. It is advisable to do so. It
saves you from people making some adjustments to your work when you
are not around.



 

 



CHAPTER TEN

GROUPING PIVOT TABLE DATA

Large volumes of data may be readily summarized, analyzed, and presented
using pivot tables. To do so effectively, you must first be able to arrange the
data into suitably sized and ordered subgroups. You can easily achieve this
using Pivot Tables' grouping and ungrouping functionalities.

Understanding how to arrange data quickly in a PivotTable report may be
really beneficial. This is due to the fact that it makes it simple to organize a
large quantity of diverse data into a few categories or subcategories. Fewer
groups enable you to streamline your assessment and concentrate on the
most important (grouped) things.

Grouping Records

1. Right-click a value in the PivotTable and choose Group.

2. Choose the Starting at and ending at checkboxes in the Grouping box,
then modify the values as necessary.

3. Select a period of time under By. Add a number that determines the
intervals for each group in mathematical fields.

4. Choose OK.

Group the selected data.

1. Select two or more values while holding the Control Key

2. Select Group from the context menu by right-clicking.

Name a group.

1. Choose a group.

2. Select Analyze. Then, pick Field Settings from the drop-down menu.

3. Select OK after changing the Custom Name to whatever you like.



Ungroup data that have already been grouped.

1. Any item in the group may be selected by right-clicking it.

2. Choose Ungroup.

Errors Troubleshooting (Grouping)

Whenever you attempt to group a selection, you may get an error message
stating that you are unable to do so. This could happen for a variety of
reasons. Being that you must pick two additional entries to establish a group
if you want to group data within your own custom groups; you cannot
construct a group with just one item.

You will have an error notice if there are empty cells in a field, such as a
date or a number field. If you have a text input in a date or number field,
you will get an error. Examine the actual data and rectify the issue in each
instance, then reload the PivotTable prior to actually attempting again.

Multiple Consolidation Ranges and Grouping

You may also make groups in a PivotTable using data from several
consolidation ranges, such as data from multiple sheets in a workbook. To
do so, go to the Quick Access Toolbar dropdown menu, pick More
Commands, then scroll down to find the PivotTable and PivotChart Wizard
in the All-Commands group. To put it to the Quick Access Toolbar, click
Add.

You may now make a PivotTable out of a collection of sheets that are all put
up in the same way. Whereas each sheet may have varying amounts of rows
of data, you'll require data with the same number of column titles.

Count Function

Even if the other numbers are presented using another function, such as
COUNT, a computed field always utilizes the SUM of those values. You'll
see an illustration of this issue in this example, where:

1. The COUNT function is used in the date field.



2. In the computed field of a pivot table, dates are summed rather than
counted.

These are the stages that indicate the computed field issue in the
specific procedures below:

1. Construct a pivot table.

2. Change the Date field to Count.

3. Create a field that is calculated

4. The date count is discarded in favor of SUM.

The procedures for resolving the computed field issue are as follows:

1. In the source data, add a new field.

2. In the computed field of the pivot table, use the new field.

Count the field

1. First, we'll add the order Date field and use it to show a count of
orders to demonstrate the issue with utilizing a field shown as
COUNT.

2. Build a pivot table with the Orders data in the Row area, and Units
and Total in the Values section, using the Rep and Product columns.

3. In the Values box, add the Date field, which should display as Count
of Date.

4. This column displays the total number of orders for each item and
sales rep.



After that, we'll make a calculated field and see whether the date field is
bigger than two.

●      Pick a cell in the pivot table, then choose the Analyze tab, underneath
the PivotTable Tools tab.

●       Hit Fields, Items, & Sets in the Calculations group, then Calculated
Field.

●       The Insert Calculated Field window pops up, where you may input
formulas for calculated fields.

●      As the name, type CountA.

●      Type =Date > 2 in the Formula box.

NOTE: If you choose, the spaces may be removed.

●      Click Add to preserve the computed field, then Close.

Conclusion

When you group your data, it makes it easier for you to access them. When
you have large files, grouping them is the best option for you. And I
explained how to do that as well as how to handle the grouping error issues.

 



CHAPTER ELEVEN

CALCULATED FIELDS IN PIVOT TABLES

Calculated Fields are most often used to add a new Field to your Pivot
Table. The newly introduced Field performs computations depending on the
values of other fields, in most cases.

Calculated Fields, in more specific terms, employ the sum of the original
data of the Field(s) that the Calculated Field calculation
uses. Furthermore, when you interact with Calculated Fields, you're dealing
with all of the relevant Field's underlying data (rather than individual
Item(s). Calculated Fields are handy when you wish to utilize all of the data
from a specific Field(s) in your computations for the reasons stated above.

Assuming you need to calculate the Cost of Goods Sold for every retailer
and item using a simple technique. The computation is quite basic to make
the instances as easy as possible and to concentrate on the concept of
Calculated Fields. For each item and shop, we'll believe you can compute
the Cost of Goods Sold as a percentage of the Sales Amount.
Arithmetically:

COGS = Total Sales multiplied by a percentage

It's worth noting that the Pivot Table's source data lacks a column for Cost
of Goods Sold.

In certain cases, you may be able to add such a column by going back to the
source data. In other circumstances, however, making a new column to the
data sources may not be feasible or practical. Using a Calculated Field
instead of adding a new column to the source data is an option.

This isn't to say that Calculated Fields aren't useful in certain situations. I'll
go through a few typical Calculated Fields issues and restrictions further
down. That overview should aid you in identifying situations when
Calculated Fields are not the best option.

Adding a basic calculated field



We'll be dealing with a Calculated Field titled "Cost of Goods Sold" in
this example. This Calculated Field consists of:

1. Values from other fields are used (Total Sales).

2. Performs certain computations (multiply Total Sales by a percentage).

Calculated Fields are not to be confused with Calculated Items. These
names pertain to separate constructions, despite the fact that they have
certain characteristics.

Calculated Items vary from other types of items in that they function with
individual data. Calculated Items, in other words, enable you to operate
with Item(s) from inside a Field.

As previously stated, Calculated Fields employ all of the original data of the
Field(s) that the Calculated Field formula uses.

To put it another way, you typically do the following:

1. When you wish to deal with all of a Field's underlying data, use
Calculated Fields (s).

2. As previously said, adding a column to your source data is an
approximate approximation of Calculated Fields.

3. If you want to interact with a particular Item(s) inside a Field, use
Calculated Items.

Calculated Items are essentially comparable to increasing row(s) to your
source data, just as Calculated Fields are approximately comparable to extra
columns in the source data. Now that you know what a Calculated Field is,
let us just look at how to create one:

1. Simply choose the Pivot Table.

2. Click on Analyze on the ribbon. Pick Fields, Items, and Sets. Then,
choose the Calculated Field.

3. The Calculated Field box will display. Put in the name for the
calculated field. Then, enter the formula as well.



4. Click Add.

Changing the display of formula error messages

In most circumstances, I love seeing mistakes on the spreadsheet so that
issues may be quickly identified. Nevertheless, instead of displaying the
faults in the pivot table, you could wish to hide them.

Error data are shown as a pivot table by default. You may conceal the
mistakes by modifying the PivotTable Options so that blank cells display
instead of the errors:

●      Select a cell in the pivot table by right-clicking it.

●      Select PivotTable Options from the context menu.

●      Click the Layout & Format tab in the PivotTable Options dialog box.

●      Put a checkmark next to For Error Values in the Format section.



The errors will be substituted with blank cells if the text field is left blank.
Note: You may write other characters in the text field to substitute the
incorrect values with that character, such as a hyphen.

●      To exit the dialog box, click OK.

Note that this option only has impacts on cells in the pivot table's Values
section. Error-values will not be updated if they occur in the Row Labels,
Column Labels, or Report Filter areas.

Removing or changing calculated fields

You might not want to show a Calculated Field in your Pivot Table report in
certain circumstances. In such circumstances, you have two choices:

●      Hide the Calculated Field.

●      Delete the Calculated Field.

The major distinction in hiding and deleting a Calculated Field is that when
you delete one, Excel permanently deletes it. If you just hide the Field, this
isn't the case. Whenever the Calculated Field is hidden, it remains visible in
the Pivot Table Fields task window.



Let's have a look at how you can put each of these ideas into action:

Excel adds a Calculated Field to the Field List when you add it to a Pivot
Table. More specifically, the Calculated Field is most often seen in the
following areas:

1. The list of Pivot Table Fields.

2. The Pivot Table's Values Area.

Calculated Fields are only found in the Pivot Table Report’s Values Area.

The Field List in the sample is shown in the image below. Take note of
how the Cost of Goods Sold field is calculated:

1. The Pivot Table Fields task window closes with this option.

2. As demonstrated by the checked checkbox to its left, it is added to the
Pivot Table. The Calculated Field is added to the Values box, to be
more accurate.

To remove the calculated field, simply drag the calculated field and drop it
outside the Pivot Table. You can also uncheck the box located at the left-



hand side of the calculated field or you right-click and select Remove (with
the name of the calculated field next to it).

Conclusion

So, I have explained here the steps involved in adding the calculated field.
You also understood the steps in changing the display of formula error
messages.



CHAPTER TWELVE

CREATING PIVOT TABLES FROM IMPORTED FILES – USING

THE DATA MODEL

The data model is a method of organizing tables and calculations for usage
in PivotTables. The data model was once accessible as a Power Pivot add-in
and is now included with Excel 2016+ for Windows. Excel 2016 for
Windows is used to provide the rest of this article.

There are various benefits to creating a Pivot Table from the data model
instead of a single Excel table. To get us started, here are a few examples.

1. We can create a PivotTable that combines data from different tables.

2. We can build formulas that vastly outnumber those accessible in a
standard PivotTable.

3. The formulae are written in a language called DAX, which has a lot
of sophisticated features.

4. Using named sets, we may select and pick rows and columns.

5. We can utilize a Get & Transform query (to clean the data before it
comes) and link to several data sources (e.g., a CSV file, a database
table, and an Excel workbook) in a single model rather than
copying/pasting data into a worksheet.

6. We may just Refresh the report in the following times after it has
been produced (instead of going through the whole export, clean,
import, and merge into a single data table process).

This is only a sampling of the highlights. So, below are the steps that we are
going to follow in doing so.

1. Activate the data model.

2. Importing the data model.

3. Define the relationships.



4. Construct the PivotTable

Activate the data model

To enable the data model, simply click the Data tab and select Manage Data
Model.

If it is your first time doing this, you will be asked to enable the add-ins.

After you have enabled it, you will see the Pivot table tab on the ribbon.

Import the data models

The data tables are then imported. We have certain transactions in a Data
Table workbook in our situation. The bank account is included in the
transactions, but not the user id. Thankfully, we have a chart of accounts
that is kept in the Lookup Table worksheet.

The procedure for importing data tables varies based on the location of your
source data. Click the Power Pivot, then select the Manage ribbon
command to get started. The Power Pivot window will appear, as illustrated
below.



To access the underlying data source, run the Get External Data command.

Because the data is stored in a few Excel files in our situation, we utilize the
Get External Data > From Other Sources option and then pick Excel File
from the subsequent box. We open the appropriate worksheet and choose
the option to use the first row as column headings. After we complete the
process, the data is imported into our data model, as seen below.

 

Note: You should use the Power Pivot > Add to Data Model command if
you're constructing a data model within the workbook with the tables.

Then we repeat the process using the data from the Lookup Table Excel file.
Below is a screenshot of the new Power Pivot window.

After we've put our data into the data model, we'll need to define the
relationships to inform Excel how the tables are connected (which fields are
shared between them).



Define the Relationship

Relationships may be defined in a variety of ways; however, my personal
preference is to utilize the visual diagram approach. Just tap the Home >
Diagram View command to switch between Data View (shown above) and
Diagram View (shown below). Instead of viewing the data transactions,
we'll see the tables with the column names, as seen below.

To define the relation, drag the column name from the Data Table to the
Lookup Table’s associated column. In this scenario, the AcctNum column
of the Data Table is linked to the AcctNum column of the Lookup Table.
The relationships are shown in Excel as seen below.

Now, we can create our pivot table.



Construct the Pivot Table

You simply pick a New Worksheet or an Existing Worksheet in the resultant
Create PivotTable dialog in the Power Pivot pane by clicking the PivotTable
> PivotTable command. When we hit OK, the typical PivotTable field panel
appears.

But hold on a second... It seems to be distinct from the usual field panel
upon closer study. In most cases, we'll get a list of fields that we may use in
the report. But now we can see the tables and expand them to see the fields
inside them, as seen below.

Yes, we may choose fields for our report from any or both tables. For
instance, we would like the Lookup Table’s AcctName in Rows and the
Data Table’s Amount column in Values. And that's it!



So, assuming your initial thought is that it would have been simpler to build
a single table using VLOOKUP, I completely understand. Well, here is the
point: there's a catch. Because there is just one lookup table in this case, it is
pretty straightforward. A chart of accounts, a calendar table, a department
list, and other lookup tables are supported by the data model. You may also
have numerous data tables in your data model, in addition to multiple
lookup tables.

There's also the difficulty of always amending our report. We don't need to
supervise several lookup formulae each month since we aren't utilizing
VLOOKUP to obtain related data. We may simply Refresh and the new
data flows into the report when the external data source is updated, whether
for a new account or new transactions. As you may see, this offers up a lot
of intriguing options and can help us save time in our workbooks that we
use often.

Conclusion

As you can create a pivot table from a single file, so can you create it from
an imported file using the data model. And I know that you understood how
to do so from the steps and examples I have given above.

 

 

 



CHAPTER THIRTEEN

TROUBLESHOOTING

Pivot Table displaying duplicate values

Whenever you construct a pivot table, it divides your data into groups and
generates a total for each group. However, you may come across duplicate
entries in the pivot table sometimes.

There is duplication for one of the text elements in the Row section in this
sample — Instead of appearing once, Boston appears three times.

Although these items seem to be duplicated, they vary in certain ways,
which is why they display on distinct rows in the pivot table.

Typically, the issue with trailing spaces is that one or more space signs exist
at the end of some, but not all, of the data elements. You'll have to fix the
source data to get away with the duplicates in the pivot table. Nevertheless,
since Excel table filters disregard trailing spaces, it's difficult to locate the
problematic data.

It's simple to eliminate all duplicate entries from a list using Excel's
Remove Duplicates tool, which is based on items in one or more columns.



However, if the list contains numbers, you may have issues, since
duplicates may stay in the list. Let’s work with an example;

Choose a cell in the list. Click on Remove Duplicate on the ribbon.

In the dialog box, choose the column where the duplicates will be removed.

Click on the box next to the My Data Has Headers i.e., if it has headers.
Click Ok.

Formula – LEN

In Excel, the LEN function is designated as a text function. LEN is a text
counter that counts how many characters are in a text or strings. The length
function is used to determine the length of a string that includes special
characters, space, integers, letters, and other elements. This will count all of
the characters in a string, including special characters and spaces.

As output, something always returns a number. By placing the string inside
a double quote or refereeing a cell, the string may be directly stated in the
function. The LEN function may be used with the cell address if the cell
includes the text or string in which you wish to get the count of characters.

Formula – TRIM

The TRIM function is part of the Excel Text functions category. TRIM
helps to tidy up the cells in the worksheet by removing superfluous gaps in
data.



The TRIM function might be beneficial in financial analysis to remove
uneven space from data transferred from other apps.

A few remarks about the TRIM Function:

1. Extra spaces in the text will be removed using TRIM. As a result, just
single spaces will be left between words, with no space characters at
the beginning or conclusion of the text.

2. It comes in handy when you need to clean up text from other apps or
settings.

3. The ASCII space character (32) is the single character that TRIM
removes from the text.

4. A non-breaking space character (160) is often seen in Unicode text
and appears as an HTML object on web pages. With TRIM, it will
not be eliminated.

Conclusion

A pivot table does come with some errors that occur while you work on
them. I have explained some of the errors and all you need to know about
them.

 

 



CHAPTER FOURTEEN

TROUBLESHOOTING

How to resolve common Pivot Table Errors.

Divide by Zero (#Div/0) is the most prevalent sort of error I encounter in
pivot table data. You can obtain an incorrect number like a #DIV/0
whenever you conduct a calculation in an Excel Pivot Table!

A calculated field or a computation on a field is usually the source of this
issue (show values as an option).

Our pivot tables may become unsightly if we display inaccuracy.
Fortunately, the error may be corrected or replaced. When you're delivering
crucial information, this looks bad. Fortunately, you may use a custom
value or text to overrule this.

To enable this, right-click on any value in your Excel Pivot Table and
choose PivotTable Options.



You may manage the mistakes by using the "For error values show" feature
on the Layout & Format tab of the PivotTable Options.

The value in the text box to the right will be shown in the pivot table after
the box is ticked. This box may be used to enter a number or text. The pivot
table's error values will be substituted with anything you type into the text
field.

You may also keep the box empty if you want the pivot table to show an
empty cell.

Press Ok. When you uncheck this option, it will show the error again.

The "For error values show option" is disabled by default. This is beneficial
since it alerts you to any flaws in your calculations. However, having to
modify this setting, or any of the other 30+ pivot table choices, every time
you build a pivot table may be inconvenient.

Correcting the Source Reference not Valid Error in a Pivot Table



One or more of the following is most likely the cause of the error:

1. The letters " [" or "] " or square brackets appear in the Excel file
name.

2. The file is not stored on the local disk and arrives via email or the
internet.

3. The data source for the pivot table is for a range that does not exist.

4. A specified range with an incorrect reference is referenced by the data
source.

Old items in the Drop-Down Menus

If you reload the pivot table after removing or changing data in the source,
the old items may remain in the drop-down lists. Even though all of the
sales data were altered, the Central region remains in the Area heading drop
down after it was amalgamated with the East region.

You can address this by changing a pivot table configuration to prevent
outdated data from being saved in the pivot cache.

You may alter an option setting to prevent outdated items from being
kept in a pivot table:

1. Any cell in the pivot table can be selected by right-clicking it.

2. Select PivotTable options from the drop-down menu.

3. Select the Data tab in the PivotTable Options dialog box.

4. Select None from the drop-down list in the Retain Items section.

5. The pivot table will be refreshed after you click OK.



You may manually delete the old items from the drop-down lists instead of
updating an option setting:

1. Ungroup any groups that incorporate the old items that you manually
established.

2. The pivot table's pivot field should be removed.

3. Refresh the pivot table by right-clicking on it and selecting Refresh
from the menu.

4. Re-insert the pivot field into the pivot table.

Overlap Errors

The error “PivotTable Report cannot overlap” means your pivot table is
attempting to extend vertically or horizontally. This will result in data
overlap with another pivot table. The pivot table throws the following error
notice as a warning concerning pivot table overlap issues.



Some of the primary causes of the Excel error code pivot table that cannot
overlap are listed below.

●      When you have numerous pivot tables on the same page in your Excel
document. However, the pivot table you've chosen to refresh could
not be the one with the issue.

●       When a pivot table doesn't have enough room to display its data and
can't overlap with another pivot table.

●      When there isn't enough vacant space for the PivotTable to expand for
new data, you'll receive this PivotTable Report Cannot Overlap Error
notice.

How to fix it

We all have a bad habit of not refreshing data after making changes.
Moreover, if your pivot table is connected to an external source, you'll want
to display your visitors the current values. After you've opened your file,
you'll need to refresh the Excel Pivot Table.
Here's how to go about it:

Solution One

1. Pivot Table Tools will appear on your Excel ribbon if you tap
anywhere within your Pivot Table.

2. Then right-click and select Pivot Table options.

3. Select the checkbox "Refresh data on opening the file" on the Data
tab.



Solution Two

You can also resolve this error by disabling AutoFit. Pivot tables utilize the
"Autofit column width" feature by default. Whenever you modify the data,
you may adjust the column width, however, when you refresh the pivot
table, it will revert to Autofit.

You must deactivate the Autofit default as follows to retain direct
formatting:

1. Right-click anywhere in your pivot table and choose "Pivot Table"
from the drop-down menu.

2. Select "Layout & Format" from the drop-down menu.

3. Within the "update" tab, uncheck the "Autofit column widths" option.



4. Then press the OK button.

The "Autofit" feature of the pivot table must be disabled.

After you disable this feature, custom "column widths" will persist after you
reload the page.

Solution Three

Refreshing regularly can also be of help. Whenever the data is too
complicated or the Excel pivot table is one of the dashboards's components,
you'll need to refresh frequently. Excel offers capabilities that allow you to
effortlessly update pivot table data on a frequent basis so that visitors
always see the most up-to-date information.

To construct a pivot table inside the data model, follow the steps below and
save it.

1. Within the data set, tap anywhere.

2. Toggle to the Insert Tab. Select the PivotTable option from the Tables
group.

3. Select the "Add this data to the Data Model" option from the opened
dialog box.

4. If you need to make any further adjustments to the settings, you may
do so.

5. Toggle the OK button. (Adding data to the data model, on the other
hand, will just take a minute.)

6. Within the data model, add several additional pivot tables.

You should generally configure the PivotTable at this stage. When
you're finished, make the following adjustments to the interval:

1. Within the Pivot table, tap anywhere.

2. Select the contextual Analyze tab from the Data group. On the
"Change Data Source" drop-down menu, choose "Connection
Properties."



3. In the Refresh control area of the opened dialog box, choose the
Refresh every option. On the right, enter the minute interval.

4. Then press the OK button.

5. In minutes, set the time interval.

6. For "external data sources," such settings are quite useful.

How Do I Figure Out Which Pivot Tables Overlap?

It's often pretty simple to locate and resolve an Excel pivot table issue.
However, finding the exact location of the issue in a large Excel worksheet
with several pivot tables and multiple data sources has proven to be quite
challenging.

If you want to retrieve a list of all the pivot tables in your worksheet,
together with information like where they are, how big they are, and what
data they use, you may use this function. Then you'll need to utilize the
"List All Pivot Table – Information" macro, which will display all of your
pivot tables' details.

This macro, for example, shows practically every pivot table detail in your
Excel file, including the size, source data, and position.

If the data source is a worksheet list or a table in the same Excel workbook,
the macro will additionally display information about it.

When multiple pivot tables use the same data source, the error This
PivotTable report cannot overlap another PivotTable report occurs. The
pivot table that uses the same data source is updated at the same time by
default. Even if you're just updating one pivot table at a time.

So, if you're getting this Excel pivot table cannot overlap error because
you're using the same data source, first address this issue. Only Excel will
enable you to reload non-problematic pivot tables after that.

CONCLUSION

There are lots of errors that can occur in a Pivot Table as you work with
them. It depends on how you do so. In this chapter, I have listed the errors



that are likely to occur in a Pivot Table as well as how to resolve them. So,
use the step-by-step processes in this chapter to resolve those issues.



 
 
 
 
 
 

 
 
 
 



BOOK 4:

EXCEL POWER PIVOT &
POWER QUERY



CHAPTER ONE

INTRODUCING POWER PIVOT

Power Pivot is an Excel add-in that can be used to do an advanced analysis
of data and model creation. It can handle massive amounts of data
(thousands and thousands of rows) from a multitude of different sources, all
in one Excel document. You may develop a Data Model, which is a
grouping of tables with connections, in both Excel and Power Pivot. The
data model in an Excel worksheet is the same as the data model in the
Power Pivot interface. Every dataset you upload into Excel is also
accessible in Power Pivot.

Every data that users deal with in Excel, as well as the Power Pivot
window, is saved in an analytical database within the Excel worksheet,
which is loaded, queried, and updated by a prominent local engine. Since
the data is in Excel, users can use PivotTables, Pivot Charts, Power View,
and other Excel capabilities to combine and engage with it right away.
Excel is responsible for all data display and interaction, and both the data
and the Excel presentation objects are housed inside the same workbook
file. Power Pivot allows you to deal with documents up to 2Gigabytes in
size and up to 4 Gigabytes of data in memory.

Workbooks that you alter using Power Pivot may be accessed in the same
way that some other documents can be accessed. However, exporting your
workbook to a SharePoint environment with Excel Services enabled
provides even more advantages. Excel Services analyses and presents data
in a web browser so that others may study it on the SharePoint server.

Understanding the Power Pivot Internal Data Model

Power Pivot is a SQL Server Analysis Services engine that is made
accessible via an in-memory procedure that operates inside Excel. Internal
Data Model is the term used to describe it. The Power Pivot Ribbon
interface is the most efficient method to deal with the Internal Data Model.



You may construct a Data Model, which is a group of tables with
relationships after the Power Pivot add-in is installed and accessible. Any
data you bring into Excel or already have in Excel becomes accessible in
the Power Pivot window after it has been added to the data model. Over and
beyond the conventional Excel Data tab, the Power Pivot Ribbon provides
extra functionality.

Now let us take a glance at how Power Pivot fits into the entire Business
Intelligence workflow and how it interacts with the other BI tools in Excel
to get a sense of where it fits in when utilizing Excel for analysis of data or
presentation.

Because Power Pivot is a data model, the first step is to import some data.
You'll need a tool or connector to connect to various sorts of data sources
and get your data unless it's already in your Excel sheet. Depending on your
data source, this may be a complicated issue that is beyond the scope of this
essay.

After you've got the data, you'll have to clean it up and modify it. Another
Excel add-in called Power Query does both of these capabilities. The Power
Pivot data model is created as the last stage. This is where we make the
connections between the various data tables.

Lastly, once you've calculated all of the required metrics, you can use Pivot
Tables and/or Pivot Charts to summarize the data in your Power Pivot data
model. A dashboard can be created by combining multiple Pivot Tables /
Pivot Charts with slicers.

Activating the Power Pivot Ribbon

1. To activate Power Pivot in Excel, access the backstage view by
clicking the "File" button inside the Ribbon.

2. Secondly, on the bottom left of the backstage view, choose the
"Options" section to access the "Excel Options" box.

3. Choose the "Add-Ins" option on the left flank of this window.

4. Pick "COM Add-ins" out from the "Manage" drop-down just at
the bottom right-hand side of this window.



5. Next, to access the "COM Add-Ins" panel, select the adjoining
"Go..." button.

6. Tick the box on the "Microsoft Power Pivot for Excel" add-in in this
window.

7. Now, on the right, press the "OK" button to activate the add-in.

Linking Excel Tables to Power Pivot

In only a few minutes, you may attach the Excel table to Power Pivot. Make
an Excel table containing the information. On the Ribbon, choose the
PowerPivot tab. In the Tables category, click Add to Data Model. The Excel
table is connected to the PowerPivot Data Table of the same name.

Preparing the Excel Tables

While any huge piece of data may be transformed into a pivot table, it's
critical to prepare your Excel data in preparation for PivotTables evaluation.
Otherwise, you risk encountering flaws or inconsistencies that cause your
data to be misrepresented.

To guarantee that your pivot table produces the results you want,
follow these guidelines.



1. Make a distinct heading for every column in your dataset. Instead of
using "Name" for both, provide "First Name" and "Last Name."

2. Give each column a classification, such as money or time. To do so,
click the symbol above the column to select the whole column. Then,
with the drop-down box inside the Numbers category on the Home
tab, choose the correct classification. You can also style your data by
choosing the Number tab after right-clicking the column and picking
Format Cells. You'll be able to select your classification and
customize how the data is presented.

3. Totals, averages, subtotals, and the like should not be included in the
data. Calculations will be considerably easier to create using pivot
tables.

4. Erase all of the data's blank cells. If there are any empty cells in the
supplied data, an error notice will appear in the results. To get rid of
blank cells, type "not available" or "n/a." Shift key + Down Arrow is
a quick technique to discover blank cells. This will shift you to
another empty cell in the column instantly.

5. Delete any data that is repeated. The findings of repeating data will be
wrong. While certain data may recur (for instance, goods in total
sales), multiple inputs for a single occurrence should be avoided.

6. Delete all of the data's filters. Within the pivot table, filters may be
built. The Sort & Filter function in the Editing section on the Home
tab may be used to change filters.

7. Any clustered cells should be ungrouped. To group data, await till
you've generated your pivot table. The Ungroup function in the
Outline category on the Data tab may be used to remove clustered
cells.

8. Your data should be formatted into a table as the last step before
building your pivot table. Select Format as Table from the Styles
category on the Home tab once you've highlighted all of your data.

Adding your Excel tables to the data model



In Excel, a PivotTable may only be created from a single table or range.
You may use the Data Model to add new tables to the PivotTable if
necessary.

Assume your workbook has two worksheets.

●       The first is a table that contains the data of salespeople and the
territories they represent.

●      The second contains sales data by area and month

The sales may be summarized per salesperson as shown below.

●      Sales may be accessed by clicking the table.

●      Choose the INSERT tab.

●      Inside the Tables category, choose PivotTable.

A blank PivotTable will be constructed using the variables from the Sales
data – Region, Month, and Order Amount. Underneath the PivotTable
Fields list is a MORE TABLES command.

selecting more tables.

The dialog box Create a New PivotTable opens. To leverage several tables
in your analysis, a new PivotTable must be built using the Data Model,



according to the information provided. Select Yes. A new Pivot Table will
be created.

You'll see that there are two tabs under PivotTable Fields: ACTIVE
and ALL.

●      Click the ALL tab.

●       In the PivotTable Fields list, there are two tables: Sales and
Salesperson, each with its own set of fields.

●       Drag the Salesperson field from the Salesperson table to the ROWS
area.

●      Drag the Month field from the Sales table to the ROWS area.

●       Drag the Order Amount field from the Sales table to the VALUES
box.

The PivotTable is now ready to use. A notification occurs in the PivotTable
Fields stating that table relationships may be required. Besides the message,
select the CREATE button. The dialog box for creating a relationship
displays.



●      Choose Sales from the Table drop-down menu.
●      Choose Region from the Column (Foreign) box.
●      Choose Salesperson from the Related Table drop-down menu.
●      Choose Region from the Related Column (Primary) box.
●      Choose the OK button.

The PivotTable has been created from two tables on separate spreadsheets.

Importing tables versus views has advantages and disadvantages.

Tables provide the advantage of clearly stated connections. Whenever you
import tables, Power Pivot can detect the connections between them and
reproduce them in the Data Model instantly. Tables are also much more
accessible, enabling you to view all of the raw data without being
manipulated. Whenever you import tables, nevertheless, you must have a
basic grasp of the database structure as well as how the contents in the
tables are used in the framework of your company's business requirements.
Furthermore, importing a table imports all columns and entries, whether or
not you use them. It typically compels you to take the additional step of



manually filtering out all the columns you don't want in order to maintain
the complexity of your Power Pivot Data Model reasonably.

Because views are already tailored to contain just the columns and data that
are required, they are frequently simpler datasets. Furthermore, you are not
required to have a thorough understanding of the database structure.
Someone with that expertise has previously completed the task for you,
including joining the right tables, applying the necessary business
processes, optimizing output, and so on.

Something you lose with views is Power Pivot's ability to detect and
develop connections inside the Data Model dynamically. You also lose
visibility since you probably wouldn't be able to see precisely what the view
is doing to arrive at its finished product if you just do not have the
permissions to access the views in design mode.

When feasible, it's regarded as a recommended method to utilize views
rather than tables. They may help you simplify your Power Pivot Data
Model by restricting the quantity of data you import. Tables, on the other
hand, are by no means sneered upon and are sometimes the only alternative
owing to a lack of database privileges or preset views. It's possible that
you'll need to import both tables and views from the same database.

Creating relationships between your Power Pivot Tables

Dealing with several tables adds intrigue and relevance to the data in the
PivotTables and reports that utilize it. When you're utilizing the Power
Pivot add-in to deal with your data, you can utilize Diagram View to
establish and manage relationships between the tables you loaded.

In order to create table connections, each table must have a column with
corresponding values. If you're linking Customers and Orders, for instance,
each Order record should include a Customer Code or ID that points to a
specific customer.

1. Click Diagram View in the Power Pivot window. The tables are
immediately sorted based on their connections, and the Data View
worksheet style switches to a visual diagram structure.



2. Build a relationship by right-clicking a table diagram and selecting
Create Relationship. The dialog box for creating a relationship
appears.

3. A column is preselected if the table comes from a relational database.
Pick a column from the database that includes the data which will be
utilized to connect the rows in each table when no column is pre-
selected.

4. Pick a table with at least 1 column of data that is connected to the
table you just chose for Table for Related Lookup Table.

5. Choose the column that holds the data that is associated with the
Related Lookup Column from the Column drop-down menu.

6. Select Create from the drop-down menu.

When you've created or imported a table for each topic in your Data Model,
you'll have to allow the coming together of related data in Excel whenever
you need it again. This is accomplished by guaranteeing that linked tables
have similar fields and by creating connections among tables. It allows
Excel analysis tools like Pivot Tables to pull data from multiple tables.

NB: Despite the fact that Excel verifies if the data categories in each
column correspond, it doesn't validate that the columns comprise
corresponding data and will build the connection even though the values do
not match. Construct a PivotTable that includes fields from both tables to
see if the connection is genuine. If the data seems to be incorrect (for
instance, blank cells or a similar value repeated down each row), you'll
choose alternative fields and maybe different tables.

Finding a related Column

It might be difficult to decide the columns to employ in a table connection
when data models have a big variety of tables or tables comprised of a
significant number of fields. Searching for a similar column inside the
model is one option. This method is handy if you identify the column (or
key) you want to utilize but aren't certain if the column exists in other
tables.



A data warehouse's fact tables, for instance, usually have a lot of keys.
Begin with a keyword in that table and check the model for additional
tables with the same key.

In a table connection, any table with a matching key may be utilized.

1. Select Find on the Power Pivot window.

2. Input the key or column as a search word in Find What. The field
name must be included in the search words. You can't search for a
column's attributes or the kind of data it includes.

3. When you're looking for metadata, check the Show hidden fields
option. You may not notice a key in the Diagram view if it was buried
to minimize clutter in the model.

4. Then, choose Find. If a similarity is discovered, the column in the
table diagram is emphasized. You should know which table has a
corresponding column for a table connection.

Modifying your active relationship.

Several connections may exist between tables, but only one of them can be
active. In DAX computations and Pivot report navigation, the active
relationship is utilized by default. The USERELATIONSHIP function in
DAX may be used to calculate inactive relationships. 

Numerous connections occur if the tables were imported this way, if the
original data source declared several connections for that table, or if you
dynamically construct extra relationships to accommodate DAX
computations. Advance an inactive connection to modify the active
relationship.

The existing active connection is immediately deactivated.

1. Navigate to the table-to-table connection line. A dotted line
represents an inactive connection. (The connection is inactive since
the two columns already have an indirect link.)

2. Set the line as active by right-clicking it and selecting Mark as
Active.



NB: The connection can only be activated if there is no other connection
between the two tables. If tables are already connected, but you wish to
modify the way they are connected, you must first deactivate the existing
connection before activating the fresh one.

Managing existing relationships

There are ways you can manage your existing relationships. You can edit
(make changes) or delete them.

To make changes to a relationship, follow the steps below:

1. Select a relationship by clicking on it.

2. Select the Edit option. A dialog window called Edit Relationship
displays.

3. Make the necessary adjustments to the connection.

4. Click the OK button. The connection alters as a result of the changes.

To delete a relationship, simply

1. Select a relationship by clicking on it.

2. Select the Delete option. A warning notice displays, describing how
removing the connection may impact the tables and reports.

3. If you're sure you want to delete, click OK. The specified relationship
is removed from the list.



Using Power Pivot data in reporting

Using Power Pivot Data in Data Model, you may generate visually
appealing reports for your data processing.

The most significant characteristics are:

●       Pivot Charts may be used to create visual reports from your data.
Report Designs may be used to organize your PivotTables and render
them more legible.

●      Slicers may be used to filter data in the report.

●       A single Slicer may be used for both the PivotChart and the
PivotTable in the same report.

●      You may select to hide the Slicers from the display when your official
report is complete.

You'll learn how to generate reports using Power Pivot's settings. For
example, have a look at the Data Model below.

The image above will be our sample for this topic.

Power PivotChart-based reports

Constructing a Power PivotChart by following these steps:

●      In the PowerPivot window, choose the Home tab on the Ribbon.



●      Select PivotTable.

●      From the selection menu, choose PivotChart.

●      Inside the Create PivotChart popup, choose New Worksheet.

In the Excel window, a new worksheet is generated with a blank
PivotChart.

●      Move Sport to the Axis area from the Medals table.
●      Move a medal from the Medals Table into the VALUES section.

●      On the Ribbon, choose the ANALYZE tab under PivotTable TOOLS.

●      In the Filter Group, choose Insert Slicer. The dialog box Inset Slicers
displays.

●      In the Medals table, choose the field NOC CountryRegion.

●      Click the OK button.



Loading data from other data sources

There are two methods to get data into Power Pivot.

1. Data should be loaded into Excel and then added to the Data Model.

2. Directly load data into PowerPivot, creating the Data Model (the
PowerPivot database).

When you want the data for Power Pivot without Excel realizing it, do it
using the second approach. It is because the data will only be loaded once
and in a very compacted format. You may either load data from numerous
data sources into the Power Pivot Data Model or create and/or leverage
connectivity. The corresponding data sources are supported by Power Pivot:

1. SQL Server relational database
2. Microsoft Access database
3. SQL Server Analysis Services
4. SQL Server Reporting Services (SQL 2008 R2)
5. ATOM data feeds
6. Text files
7. Microsoft SQL Azure
8. Oracle
9. Teradata
10. Sybase
11. Informix
12. IBM DB2



13. Object Linking and Embedding Database/Open Database
Connectivity

14. (OLEDB/ODBC) sources
15. Microsoft Excel File
16. Text File

Loading data from a relational database

Among the most prevalent data sources utilized by Excel users, is relational
databases. It's not hard to locate a researcher who works with Microsoft
Access, SQL Server, or Oracle databases on a regular basis. We'll go
through how to load data from different database systems in this part.

Loading data from SQL Server

To fully comprehend PowerPivot's capabilities, we must first input data
from several sources into the PowerPivot worksheet before doing an
analysis. We'll start by importing data from a SQL Server database. I'll be
working with Microsoft's Contoso data warehouse example.

Choose From SQL Server from the From Database option inside the
PowerPivot worksheet.

This launches the Table Import Wizard, which will walk you through
setting up a SQL Server relationship. Input or pick the SQL Server instance
name and the database name through which you will import data on the
Connect to a Microsoft SQL Server Database page. Regardless of whether
Windows-integrated or SQL Server, use the proper authentication
mechanism. Next should be selected.

You may select from a range of tables or views accessible from the database
you chose on the Choose How to Import The Data page, or you can
construct your personal custom SQL expression to extract the rows to
import. For this demonstration, I'll simply select the data to import from a
selection of tables and views and press Next.

Choose the tables out of which you wish to import data on the Select Tables
and Views page. To show importing a huge number of entries from inside
the PowerPivot worksheet, I'll use the FactOnlineSales table.



Remember that the FactOnlineSales table in the example Contoso database
has more than 12.6 million entries, so ensure you have enough RAM on
your desktop if you want to import all of the information.

You may modify the tables name you picked on the worksheet to make
them more understandable, and you can even filter the columns to just show
the ones you wish to import. I'll just utilize the default settings and import
all of the rows and columns in this instance. To begin the data import
procedure, select Finish.

The Importing page will show you how far along the import procedure is.
After all of the data has been properly imported, select Close to exit the
Table Import Wizard. There are 12.6 million records in the
FactOnlineSales database that PowerPivot has imported.

It's worth noting that the PowerPivot add-in allows you to import millions
of entries.  You may now classify and filter the data in the same way that
you would in Excel.

Loading data from flat files

The phrase "flat file" applies to a file that includes tabular data but has no
hierarchical hierarchy or relationships between items. Excel and text files
are the most prevalent forms of flat files. Flat files hold a lot of vital
information. You'll learn how to import various flat file data sources into
the Power Pivot Data Model in this part.

Loading data from Excel files

You may construct a linked table if your source data is in an identical
workbook as your data model. Connected tables have a benefit over other
forms of imported data including that they react very instantly to
modifications in the source data inside the worksheet. When you alter the
data from one of the workbook's tables, the connected table in the Power
Pivot Data Model updates as well. It's good to get the real-time interaction
that linked tables provide.
The source data needs to be retained in the same workbook as the Power
Pivot Data Model, which is a disadvantage of linked tables. It isn't always
feasible to do so. You'll come into a lot of situations when you need to use



Excel data in your analysis, but the data is stored in a different workbook.
You may link to external Excel files using Power Pivot's Table Import
Wizard in certain circumstances.
Take the following steps:

●      On the Home tab of the Power Pivot interface, select the From Other
Sources option.

●       Choose the Excel File option in the Table Import Wizard dialog box
and press the Next option.

●       Provide the wizard with the information necessary to link to your
desired worksheet. Once you're finished, select Next.

Friendly Connection Name: This field enables you to give the
external source a unique name. Add a comprehensive and easy-
to-understand name.

Enter the complete path to your target Excel workbook in the
Excel File Path field. You may use the Browse option to look
for and pick the worksheet from which you wish to extract data.

Use the first row as column headings: Your Excel data will
almost always contain column headers. To ensure that your
column headers are identified as headers when imported, click
the Use First Row as Column Headers check box.

●       Choose the worksheets you wish to import in the Select Tables and
Views window.

●      Inside the Friendly Name column, you may give the table a new title
that would be utilized in Power Pivot to refer to it.

NB: Power Pivot is unable to recognize individual table objects while
receiving from external Excel files. As a consequence, the Table Import
Wizard only allows you to pick complete worksheets. Taking this into
account, ensure you only import spreadsheets with a single data range.

●       If you ever need to filter out undesired columns and records, choose
the Preview & Filter option.

●      To complete the import procedure, click Finish.



Constantly check and develop connections with any additional tables you've
added to the Power Pivot Data Model.

Loading data from text files

The format termed comma-separated values is among the most used data
representation methods (CSV). Every data row/record is expressed as a text
line, with commas between the columns/fields. Several databases allow you
to save your data as a CSV file.

You must select the Text File option if you wish to import a CSV file into
Power Pivot.

Assume you have the following CSV-formatted text file:

1. Select the PowerPivot tab 

2. In the PowerPivot panel, choose the Home tab.

3. In the Get External Data category, choose From Other Sources. The
Wizard for Importing Tables appears.

4. Scroll to Text Files at the bottom of the page.

5. Then choose Text File.

6. Then press the Next button. With the display Connect to Flat File, the
Table Import Wizard opens.



7. In the File Path window, go to the text file. The first line of a CSV
file generally contains column headings.

8. Select the checkbox. If the first line includes headers, use the first
row as column headers.

9. The default in the Column Separator box is Comma (,), but if your
text file contains some other operator, like Tab, Semicolon, Space,
Colon, or Vertical Bar, choose it.

10. There is a glimpse of your data table, as you can see. Finish by
clicking the Finish button.

Loading data from the clipboard

Assume you got data in an application that Power Pivot does not identify as
a data source.

 

You have two choices for loading this data into Power Pivot.

1. Copy the data to an Excel document, then utilize the Excel document
as a Power Pivot data source.

2. Copy the information to the clipboard, then paste it into Power Pivot.

Assume you have the following data in a word document:

Power Pivot does not support Word as a data source. As a result, do the
following:

●      In the Word document, choose the table.



●      Copy it and it should be pasted into the PowerPivot window.

A dialog window called Paste Preview displays.

●      Assign the table the name Word-Employee.

●       Select the checkbox. Click OK to use the first row as column
headings.

With the tab Word-Employee table, the data copied to the clipboard will be
transferred into a new data table in Power Pivot.



Let's say you wish to change the information in this table with
something fresh.

●      Make a copy of the table in Word.
●      Select Paste Replace from the menu.

A dialog window called Paste Preview displays. Make sure the items you're
utilizing for replacement are correct.

Click the OK button.



The values of the data table in Power Pivot are substituted by the values of
the clipboard, as you can see.

Let's say you wish to add two additional data rows to a data table. The two
news rows are in the table of the Word document.

●      The two new rows should be selected.

●      Select Copy.

●       In the Power Pivot window, choose Paste Append. A dialog window
called Paste Preview displays.

●      Make sure the material you're using to attach is correct.



To continue, click OK.

The contents of the data table in Power Pivot are concatenated with the
contents of the clipboard, as you can see. Transferring data to an excel file
and utilizing linked tables is preferable to copying from the clipboard.

This is due to the following factors:

1. When you utilize a linked table, you can see where the data came
from. On the other side, you won't know the data's source or whether
it's utilized by someone else afterward.

2. The Word file contains tracking information, such as when data is
changed and when data is inserted. There is, however, no method to



replicate the data into Power Pivot. You may save the information for
later use if you copy the data to an excel file first.

3. If you wish to make some remarks when copying from the clipboard,
you won't be able to do so. You may add comments to your Excel
table that will be connected to the Power Pivot if you copy them to an
Excel file first.

4. The content taken from the clipboard cannot be refreshed. If the data
comes from a corresponding table, you can always make sure it's
current.

Refreshing and managing external data connections

This is more like updating your power pivot. At any moment, you may
update the data imported from external data sources. You may refresh the
data for the PivotTables in your worksheet at any moment by clicking
Refresh. PivotTables linked to external data, such as a database (SQL
Server, Oracle, Access, or other), an Analysis Services cube, a data stream,
and many more sources, may have their data refreshed. In the same or a
separate spreadsheet, you may also refresh data from a source table. You
may also configure your worksheet to automatically update its PivotTable
data whenever you open it.

PivotTables are not automatically refreshed by default, but you might also
specify that they are refreshed whenever you open the worksheet that
includes the PivotTable.

If you simply wish to update one data table in Power Pivot, follow these
steps:

●      Select the data table's tab.
●      Refresh the page by clicking the button.
●      From the dropdown menu, choose Refresh.

If you wish to update all of the Power Pivot data tables, perform the
following:

●      Refresh the page by using the Refresh button.
●      From the dropdown menu, choose Refresh All.



Manually refreshing your Power Pivot data

To bring up the PivotTable Tools on the ribbon, click anywhere in the
PivotTable.

●      Press Alt+F5 or select Analyze, then Refresh.

Hint: Pick Analyze > Refresh All to update all PivotTables in your
worksheet in one go.

Whenever refreshing takes much longer, verify the refresh progress by
going to Analyze, then, select Refresh arrow, and choose Refresh Status.

●      Tap Cancel Refresh to halt the refresh.

Setting up automatic refreshing

On the Pivot Table ribbon, click Analyze. Click on Options. Then, select the
Data tab and check the box on the Refresh data when opening the file
option.

 

Select Ok.

Editing your data connection

If you wish to update a table's connection, navigate to PowerPivot's
"Design" ribbon, pick "Existing Connections," then "PowerPivot Data
Connections," which will show you all of your previous connections. Hit
"Edit" after selecting the connection you wish to change. By selecting
"Refresh" in the "Existing Connections" pane, you may reload all the tables
from the now-changed connection.



CONCLUSION

I have just discussed all the Power Pivot. Power Pivot is very helpful in
carrying out some tasks. With the samples we used in this chapter in
creating relationships, loading data from different sources, linking Excel
tables, managing relationships, and lots more, you can utilize them to carry
out your task on Power Pivot. 



CHAPTER TWO

WORKING DIRECTLY WITH THE INTERNAL DATA MODEL

This chapter describes how to interact directly with the underlying data
model without using the Power Pivot Ribbon interface by using a mix of
PivotTables and Excel data connectors. The associations between both
tables may have to be adjusted if a user adds tables to the internal data
model.

The Manage Relationships dialog box must be activated before changes to
relationships in an internal data model may be made. To delete a table or
data source from the internal data model, the operator must activate the
Data tab on the Ribbon and then select the Queries & Connections
command.

Managing Relationships in the Internet Data Model

Power Pivot's main feature is its ability to handle data tables and
connections between them, making it easier to analyze data from multiple
tables. While constructing a PivotTable, or straight from the PowerPivot
Ribbon, you may add an excel table to the Data Model.

Only when there are linkages between tables can you evaluate data from
various tables. You may construct relationships in Power Pivot using the
Data View or Diagram View. Furthermore, if you opted to include a table in
the Power Pivot, you must also include a relationship.

Removing a Table from the Internal Data Model

Let's suppose you've previously generated a pivot table from a dataset.
You've also created a report using that pivot table. You now wish to remove
the pivot table while keeping the rest of the report. To do so, follow the
below instructions:

Click on the Analyze tab. This tab will only display when you click or
select a cell in the pivot table report.

Click on Select. Pick Entire Pivot Table.



This will select the entire pivot table.

Press Control key + C to copy the table.

Choose a cell in the same worksheet. You can select another worksheet if
you want to.

Press Control key + V to paste.



Click on the Control Key dropdown symbol. Click on the Paste Values
option there.



The first step above was for saving the file in another location so as to keep
it safe in case of any mistakes.

Now, let’s delete the pivot table.

Manually select the pivot table. Then, press the Delete key on your
keyboard. You can also select Clear All on the Home tab.

Without losing data, there is no straightforward method to remove the pivot
table. This is the simplest method for deleting a pivot table while keeping
all of its data.

CONCLUSION

In this chapter, I have explained the steps in managing relationships and
removing a table from the Internal Data Model in Power Pivot. Making
connections between tables it’s really important. It helps you to understand
more about the tables you are working on. So, ensure you utilize the steps
and instructions given here when dealing with your Internal Data Model.

 



CHAPTER THREE

 ADDING FORMULAS TO POWER PIVOT

Data analysis expressions, or DAX functions, are a powerful collection of
functions in Power Pivot that enable users to execute arithmetic
computations, recursive computations, data lookups, and much more. This
chapter exposes users to DAX functions and lays out the groundwork for
creating their own Power Pivot data models computations. Calculated
columns are columns that users construct to add their own formulae to a
Power Pivot table.

Building formulae in an Excel table is similar to generating a calculated
column. DAX is the mathematical language that Power Pivot utilizes to do
computations inside its own table and column structure. The functions that
come with the DAX formula language are unique. A few of the DAX
functions that may be used in calculated columns are discussed in this
chapter. Cube functions are Excel functions that allow you to retrieve data
from a Power Pivot data model without having to utilize a Pivot Table.

Enhancing Power Pivot Data with Calculated Columns

Creating your first calculated column

The tables in the Power Pivot data model may be used to produce computed
columns and measurements. This allows you to generate table data for use
in PivotTables and Pivot Charts. It is one of the main advantages of the
Power Pivot add-in over Excel's regular PivotTables.

The Power Pivot data model has a number of formulae that allow you to
compute values for current table columns. Such formulas are not
necessarily identical to the conventional Excel workbook formulas. DAX
formulas are the name for these formulae. To compute numbers, they can
employ somewhat diverse functions and syntax than standard Excel
functions. The syntaxes, though, are fairly identical. The DAX formula for
calculated columns and fields may be created using Excel's aid. You won't
have to bother more about the syntax of the formulae you make this way.



To construct a column value, you use Power Pivot to generate calculated
columns inside a table in the data model window. In the "Values" area of the
PivotChart or PivotTable, you may summarize that value. For instance, if an
"Order Details" table included both a "Quantity" and "Unit Price" field, you
might construct an additional calculated column called "Order Total" that
presents the outcomes of the combination of these two columns. To get the
sum of order totals for a specific grouping, you might add this column to
the "Values" portion of a PivotChart or PivotTable.

 

Conversely, you may utilize Power Pivot in Excel to construct calculated
columns to produce a new column to use in the "Row" or "Columns"
portions of a Pivot Table or PivotChart. For instance, if you have an "Order
Date" field in a "Orders" table and need to arrange outcomes by the quarter
wherein the order was made, you might build a calculated column in the
database that shows the quarter for every related "Order Date" value. You
might then arrange by the values of this new computed column in the
appropriate portion of a PivotChart or PivotTable.



To add a calculated column to a table in a Power Pivot data model, open the
data model window and choose the table tab. Furthermore, at the far right
end of the table, tap onto the highest cell in the "Add Column" column.
Now, in the cell, type the formula for the column to compute.

The formula displays in the Formula Bar for formulae that you type in by
yourself. Begin by inputting the equal sign, then the field names wrapped in
parentheses, and then the typical mathematical operations to connect them
together then. To add a field link to the formula you input, you may simply
press the field names of the fields in the table. To verify the formula, use the
"Enter" key on your computer or select the checkmark icon in the Formula
Bar.

By tapping the "Design" tab in the Ribbon of the data model's window, you
may also generate a formula that employs a function. To enter the "Insert
Function" dialog box, click the "Insert Function" icon in the "Calculations"
tab group. The functions you may enter are listed in this chat window. This
list allows you to choose a function.

The function and any extra parameters are shown at the bottom of the
dialog box as a result of this action. To put a function into the Formula Bar,
first, choose one and then hit the "OK" icon. Next, in the Formula Bar,
finish inputting the function's extra parameters. To verify the formula, use
the "Enter" key on your computer or click the checkmark icon in the
Formula Bar.



Formatting your calculated columns

There are different ways you can format the calculated columns that you
have created. Below are some of the ways that you can do so.

Giving names to Calculated Columns

New calculated columns are placed at the right of existing columns by
default, and the column is given the names CalculatedColumn1,
CalculatedColumn2, and so forth.

You may reorganize and rename columns once they've been created.

1. Changes to computed columns are subject to the following
restrictions:

2. Within a table, each column name should be unique.

3. Avoid using names for metrics that have previously been utilized in
a similar worksheet. However, it is feasible for a measure and a
computed column to get the same name, but calculation mistakes may
easily occur if names are not unique.

4. When referencing a column, do use a professionally competent
column reference to prevent mistakenly executing a measure.

5. You must therefore change any calculations that depend on the
current column when renaming a computed column. Unless you're
manually updating settings, formula results are updated automatically.
This procedure, however, may take some time.

6. In Power Pivot, there are several elements that can't be included in
the column names or the names of many other objects. 

To rename or change the name of an existing computed column, follow
these steps:

1. Right-click the header of the computed column you wish to rename in
the Power Pivot panel and choose Rename Column.

2. To approve the new name, input a new name and then hit ENTER.

Changing the Type of Data



A computed column's data type may be changed in the same manner that
other columns' data types can be changed. The following data-type
conversions are not possible: text to decimal, text to integer, text to
currency, and text to date. You have the option of switching from text to
Binary.

Hiding calculated columns from end-users

You may conceal whole tables or specific columns in a data model for a
Power View or PivotTable report such that only pertinent things are
displayed in the field list. This is especially helpful if you have duplicate
tables or columns. You may not want the Product Category table to appear
in the fields list if you add "Product Category Name" to the Products table.

Calculated fields may also be hidden. You may, for instance, conceal
intermediate computations from the fields list if you have sophisticated
computations that contain additional calculations you don't want to disclose.

1. To conceal an entire table, right-click the tab containing the table and
select Hide from Client Tools.

2. To conceal specific columns, open the table where you want to hide
them, right-click the column, and choose Hide from Client Tools. By
pressing and holding the Control or Shift keys, you may conceal
numerous columns at once.

3. Ensure the computation area is displayed before right-clicking the
field and selecting Hide from Client Tools.

The column will be effectively wiped out to indicate that it is unavailable to
reporting users who use the model. Hidden columns in the model are
effectively wiped out to show their status, but they remain available in the
Data View so you may interact with them.

A column's concealing doesn't really make it disappear from the model. In a
table, a concealed column may still be utilized as a sort column. It may also
be used to specify calculated columns or calculated fields in a formula. The
option to conceal columns is meant to clarify and reduce the list of columns
displayed to reports that need them, not for data protection.



UTILIZING DAX TO CREATE CALCULATED COLUMNS

Identifying DAX functions safe for calculated columns

Data Analysis Expressions (DAX) may seem scary at first, but don't be
fooled by the word. The fundamentals of DAX are actually pretty simple to
grasp. To begin, keep in mind that DAX is not a programming language. A
formula language is DAX. Custom computations for Calculated Columns
and Measures may be defined using DAX (also called calculated fields).
Some of the capabilities included in Excel formulae are included in DAX,
as well as extra functions for working with relational data and performing
dynamic aggregation.

DAX Formulas: What You Need to Know

Formulae in DAX are fairly similar to formulas in Excel. You enter an
equal sign, then a function name or expression, and any needed values or
parameters to construct one. DAX, like Excel, has a number of functions for
working with strings, doing computations with timelines, and creating
conditional values.

DAX formulae, on the other hand, vary in the following significant
ways:

1. If you wish to personalize calculations row by row, DAX has
methods that enable you to utilize the current row value or a linked
value to conduct computations that change depending on the context.

2. A function in DAX that produces a table instead of a single value is
called a table function. These routines may be used to feed data into
other programs.

3. In DAX, Time Intelligence Functions enable you to do computations
utilizing date ranges and analyze the outcomes over many periods.

Building DAX-driven calculated columns

Constructing a calculated column in Power Pivot allows you to add new
data to a table. As with any other column, the new column may be utilized
in PivotTables, Pivot Charts, and reports. You must insert a DAX formula in



calculated columns. In a Finance table, for instance, the formula =
[Earnings] + [Bonus] might be used to generate a new Total Pay column.
For every row, this increases values from the same table's Earnings column
to the Bonus column's values.

Calculated Columns in Power Pivot is a good place to start to learn
more.

1. Scroll to and select the right-most column in the table where the new
column will be added.

2. Enter a valid DAX formula into the formula bar and hit Enter.

3. Right-click the column heading and choose Rename, then enter a new
name.

You can't enter a name within the formula itself, unlike with Calculated
fields.

Month sorting in Power Pivot-driven Pivot Tables

The sort by columns function in PowerPivot is among the additional
features. It enables you to sort one column by another (for example,
weekdays names) (e.g. weekday number). This may be handy for sorting
month names, for instance.

Normally, when your months of the year are arranged from January to
December, but when you decide to sort them alphabetically, it will display
as;

●      April

●      August

●      December

●      February

●      January

●      July

●      June



●      March

●      May

●      November

●      October

●      September

Basically, this is how your months are sorted in a power pivot. If you want
it to be in the normal way, simply follow the steps below;

●      Click on the Sort button on the Home Tab. Select Sort by Column.

●      On the box that appears, input the columns that you want to sort.

●      Press Ok.

Nesting functions

If some of the PivotTable areas have greater than a field, the PivotTable
layout is determined by the order in which the fields are placed in that area.
The Nesting Order is the term for this.

You may set the fields in the necessary order provided you understand how
your data is formatted. If you're not certain how the data is structured, you
may rearrange the fields in the PivotTable to modify the layout
instantaneously.

Fields in Nesting Order

Given the below instance of sales data, in which the fields are arranged in
the correct sequence:



Here, there are two fields in the rows area: salesperson and region, within
this order. Nesting order refers to the order in which the fields appear, such
as Salesperson first and Region second.

The variables in the rows in the PivotTable will be shown in this order,
as shown below.

As you can see, the contents of the second field are nested underneath the
contents of the first field in the nesting sequence.

Each salesperson is related to just one area in your data, although the
majority of the regions are connected with many salespeople. As a result,



it's possible that reversing the nesting order will make your PivotTable more
relevant.

Changing the Order of Nesting

Simply select the field and drag it to the desired location to modify the
nesting order of the fields in a section.

Drag the field Salesperson to the right of the field Region in the ROWS
area.

As a result, you've modified the nesting order to Region first,
Salesperson second, as seen below:

The PivotTable that results will look like this:



You can see that the layout with the nesting order Region and then
Salesperson produces a more concise and useful report than that of the
layout with the nesting order Salesperson and then Region.

The prior Layout would've been a better alternative if a Salesperson handles
more than one region and you will need to summarize sales per
Salesperson.

Understanding calculated measures

A measure is a calculation written expressly for use in a Powerpivot
PivotTable (or PivotChart) using PowerPivot data. Measures may be created
using common aggregation methods like COUNT or SUM, or you can use
DAX to create your own formula. In the Values section of a PivotTable, a
measure is utilized. Utilize a calculated column instead of a calculated row
if you wish to put calculated results in a separate region of a PivotTable 

Hardly anything occurs when you create a formula for just an explicit
measure unless you attach the measure to a PivotTable. The formula is
tested for every cell in the Values section of the Pivot Table when you insert
the measure. Because when a result is generated for every conjunction of
row and column headings, the measure's outcome in each cell may change.
You connect a measure with a table in the workbook when you create it, and
the measure description is preserved with this table.

The way you utilize measures in a PivotTable or PivotChart, as well as
other programs that utilize a Power Pivot Data Model as a data source,
depends on whether they're implicit or explicit.

Calculated Field Implicit

Whenever you move a field, like Sales Amount, to the VALUES section of
the PivotTable Fields list, Excel creates an implicit measure. Since Excel
creates implicit measures, you may be unaware that a fresh measure has
been produced. However, if you look carefully at the VALUES list, you'll
notice that the Sales Amount column is really a measure called Sum of
Sales Amount, which displays in the VALUES section of the PivotTable
Fields list as well as on the PivotTable itself.



Implicit measurements must utilize the data format stated for that aggregate
and can only employ a basic statistic (SUM, COUNT, MIN, MAX,
DISTINCTCOUNT, or AVG). Furthermore, implicit measurements may
only be utilized by the PivotTable or graphic that they were built for.

An implicit measure is inextricably linked to the field on which it is built,
which has implications for how you remove or amend the measure in the
future.

Calculated Field Explicit

Whenever you input or choose formula in a cell in the Calculation Area, or
when you use the AutoSum function in the Power Pivot window, you
generate an explicit measure. The majority of the metrics you define will be
clear.

Any PivotTable or PivotChart in the worksheet, as well as Power View
reports, may utilize explicit measurements. They may also be expanded to
make a KPI or structured using one of the several numeric data strings
available. When you use an explicit calculated field, context menu actions
for Create KPI and Format are only accessible.

Note that once you've used a measure as a KPI, you can't use it again; you'll
need to generate a duplicate if you wish to use the formula in additional
calculations.

 

For Instance;

Adventure Works' sales manager has indeed been requested to offer
resellers sales predictions for the coming fiscal year. She chooses to base
her projections on sales from the previous year, with a 6% yearly rise due to
numerous promotions planned for the following six months.

She uploads previous year's resellers' sales data and inserts a PivotTable to
create the estimates. She locates the Sales Amount column in the Reseller
Sales table and drags it to the PivotTable Fields list's VALUES section. The
column shows a single value in the PivotTable, and it represents the total of
all reseller sales from the previous year. She notes that, despite the fact that
she did not express the calculation herself, one has been given immediately,



and the column in the field list and on the PivotTable has been changed to
Sum of Sales Amount. =SUM('FactResellerSales'[SalesAmount]), an
Excel built-in aggregate, does the calculation. She changes the name of the
implicit metric Last Year Sales.

The sales prediction for the following year would be predicated on last
year's sales multiplied by 1.06 to account for the predicted 6% rise in
reseller trade. She must build the measure directly for this calculation, using
the New Calculated Field option to make a calculation called Projected
Sales. =SUM('FactResellerSales'[SalesAmount])*1.06 is the formula she
writes in.

In the PivotTable Fields list, the new measure is placed in the VALUES
section. It's also described in the table in the PivotTable Fields list that's
now active. In the workbook, the table serves as a home for the measure.
She modifies the measure to modify its table connection since she wishes it
to be in a separate table.

The sales manager gets the fundamental information in place fast and with
little work on her side. She may now refine her forecasts by focusing on
individual resellers or incorporating product portfolio information to ensure
that future offers are for items carried by the reseller.

Editing and deleting calculated measures

Naming a Measure

After you've generated a measure, you may rearrange and rename it.

 Modifications to measurements are, nevertheless, subject to the
following limitations:

1. Measures, like other objects, are shown in the PivotTable Fields list
unless they have been hidden. Contemplate naming them in a manner
that makes the activity they'll execute obviously.

2. Inside a table, every measure title should be distinctive.

3. In a current worksheet, try avoiding names that have previously been
utilized for computed columns. However, it is feasible for a measure



and a computed column to have the same name, calculation mistakes
might occur if names are not unique.

4. Whenever you rename a measure, all formulae that use it should be
changed as well. The results of formulae are automatically updated
unless you are in manual update mode. This procedure, however, may
take some time.

5. There are certain characters that cannot be used in the name since it is
part of the measure's formula. 

Make a Change to an Existing Measure

The PowerPivot Field List displays a list of all tables in the present
PowerPivot panel, encompassing raw data columns, calculated columns,
and any custom measures you've created. You may launch a context menu
that enables you to see and alter the measure definition by right-clicking on
the definition of any measure and selecting the Edit formula.

To see and modify an existing measure, follow the steps below;

1. Find the table that includes the measure you established in the
PowerPivot Field List.

2. Base columns, computed columns, and measurements may all be
found in a table. A little calculator icon appears to the right of the
measure name to denote the measure.

3. Select Edit Formula from the context menu by right-clicking.

4. Edit the formula in the Measure Settings chat window.

5. You may also edit the measure or customer's name, as well as the
table connected with it.

Using Cube Functions to Free your data

Introduction to cube using

The data in Power Pivot's Data Model is hidden from the view in the
spreadsheet. That implies there are really no cells on the worksheet that can
be referenced by traditional Excel formulas. As a result, typical Excel



formulae will not be able to obtain data from the Data Model. Cube
Functions, on the other hand, are Excel formulae that enable users to extract
data from specific sources. In Power Pivot, Cube functions may
communicate with the Data Model.

"Well, I've spent all of my time studying DAX to make calculations on the
Data Model," you could remark now. "How do Cube functions get data
from the Data Model in the Excel Worksheet?" you may wonder.

There's no reason to be concerned. In reality, DAX (measures) and Cube
functions have a wonderful relationship. To do calculations on your dataset,
you'll need to use the DAX language. The concept of a measure is kept as a
component of the Data Model in a so-called Measure.

Cube functions, on the other hand, refer to components of the data cube and
retrieve values from it. Among the elements that cube functions may
reference is a measure specified in DAX. Cube formulae may be thought of
as a link between both the Data Model and the Excel Worksheet. The Excel
user obtains entry to the Data Model data via this gateway. The DAX
formula language will never be replaced by cube functions. Rather, they
rely on the DAX-defined metrics.

Using the cube function

Utilizing a Pivot Table with the Data Model as the Data Source is the
simplest method to get started with Cube functions.

Setup of Data

Assume you have the dataset below.



A Product Sales table, which is linked to a Gender table and a Calendar
table, may be found. Excel's Data Model includes the tables. The tables of
the Data Model are linked together as shown below.

A measure using the DAX formula may be found in the table Product Sales.

SUM('Product Sales'[Sales]) = Total Sales

By using a Data Model, construct a PivotTable.

After you've set up the data, you can create a pivot that displays Total Sales
per Day Name of the Week.

1. Select Insert -> Pivot Table from the drop-down menu.

2. Use the Data Model in this Workbook -> OK

3. Insert Day Name to the rows, and Total Sales as a Variable to the
measure.



Notice how the Data Model is used in the above Pivot. A Table Icon with a
yellow database icon in the bottom right corner precedes the utilized tables
(presented in bold text). The table is a component of PowerPivot's Data
Model, as shown by the yellow sign.

Formula Conversion

The Total Sales are classified by Day Name in the Pivot Table. This
configuration hasn't done anything spectacular thus far. However, we may
convert the shown data to Cube formulae from here.

So, how do you convert Pivot Table formula to Cube formulas?

4. Check to see whether your cursor is within the Pivot Table.

5. Select Analyze from the contextual tabs. (Note that this tab displays
only while the cursor is inside the Pivot Table.)

6. Select Convert to Formulas from the OLAP Tools menu.

From a Pivot Table to a Cube Formulas, the shown values in the Pivot Table
transform. The result is the same.



Study the formulae for a moment. The formulae in the colored cells on the
right are comparable to those in the colored cells on the left.
CUBEMEMBER() and CUBEVALUE() are two new cube functions ().

●       A CUBEMEMBER formula in the orange indicated cell has a cell
reference to the DAX Measure named Total Sales.

●       The CUBEMEMBER formula in the green indicated cells relate to a
single member of the data model. The column Day Name from the
Calendar table was filtered on Friday in this example.

●      The blue indicated cell has a CUBEMEMBER formula that also refers
to the Calendar table's Day Name field. However, instead of filtering
a particular day, it refers to all of the data.

●       The numbers are CUBEVALUE formula that relate to two
CUBEMEMBER formulas in this case. The CUBEVALUE formula is
the same for all of the values. It always refers to the Total Sales
Measure as well as the cube member to the left of it, which refers to
the weekday. The CUBEVALUE formula may be readily copied
down without any modifications.

Conclusion

Calculated Fields are a wonderful choice for inserting your own formulae
and performing computations inside Pivot Tables because of their
scalability, versatility, and simplicity of maintenance. Calculated Fields,
notwithstanding the above, have certain limits and constraints. As a result,
they aren't the best tool for every circumstance you could encounter.



To minimize possible mistakes in your data analysis, it's critical that you
comprehend what happens behind the scenes when you utilize pivot table
calculations. It is much more critical that you grasp the bounds and
constraints of calculated fields and calculated items.



CHAPTER FOUR

INTRODUCING POWER QUERY

Excel Power Query is among the most effective and user-friendly
capabilities in Microsoft Excel. You may utilize Power Query to combine
several files with a similar format, filter and manipulate data downloaded
from any industry's database system, and show that in an Excel report.
Power Query is an excellent substitute for Excel VBA since it allows you to
analyze tables without scripting, see actions go through without executing a
single macro, and quickly change the order of various stages by using
the drag & drop feature.

Even among novices, Power Query is a user-friendly and useful technique
since it doesn't need any coding knowledge to get going. Furthermore, the
initial data source is unaffected. The end result looks like a picture of
altered data imported into Excel. So, what's the big deal about that?
Because the source data is not immediately imported, your Excel file will
not get heavier.

To make data analysis and time-related computations easier, Excel Power
Pivot is often used in conjunction with Power Query. Power Pivot allows
you to analyze databases with millions of lines of content by obtaining
gathered information based on business rules. It's just the next stage in the
data process of conversion, allowing people to develop data models from
tables that have already been cleansed by Power Query.

Understanding Power Query Basics

Understanding query steps

There are lots of things you need to know and understand about Power
Query. They are to guide you on your experience with Power Query.

Below are some of them:

Power Query experiences



This interface provides the Power Query user experience. This interface's
purpose is to make it easy for you to do the modifications you need by
engaging with a user-friendly collection of ribbons, menus, buttons, and
other interactive elements.

The Power Query Editor is where you link to a variety of data sources and
perform hundreds of various data conversions by evaluating data and
choosing transformations from the UI. These data transformation
capabilities are universal across all data sources, regardless of the
restrictions of the underlying data source. There are two Power Query
Experiences which are Power Query Online and Power Query for
Desktop.

Transformations

The transformation engine in Power Query contains a number of
preconfigured conversion methods that may be accessed using the Power
Query Editor's graphical interface. Simple changes like eliminating a
column or filtering rows are frequent, as is utilizing the first row as a table
header. Advanced transformations like merge, append, group by, pivot, and
unpivot are also available. All of these conversions are available by
selecting the transformation option from the menu and then applying the
necessary settings.

DataFlows

Many programs, including Power BI and Excel, support Power Query.
When you use Power Query inside a product, nevertheless, you can only
use it with just that product. Dataflows are a cloud-based, sustainable
product version of the Power Query experience. You can receive and
manipulate data in an exact manner with dataflows, but rather than sending
the result to Excel, you can save it in alternative storage solutions like
Dataverse or Azure Data Lake Storage. The result of dataflows may then be
used in other goods and services.

Power Query M Language

There are certain conversions that can't be done as well using the graphical
editor in any data transformation situation. Several of these modifications
may need unique setups and configurations that aren't presently supported



by the desktop environment. For all Power Query transformations, the
Power Query M formula language, often known as M, is used behind
scenes by the Power Query engine.

The M language is Power Query's data transformation language. Everything
that occurs in the query is expressed in M at the end. You may utilize the
Advanced Editor to examine the query's scripting and edit it as needed if
you wish to execute advanced transformations with the Power Query
engine. If the user interface functions and transformations aren't performing
the precise modifications you require, utilize the M language and Advanced
Query Editor.

Viewing the Advanced Query Editor

Using Power Query's Advanced Editor, you can conduct a variety of
complicated tasks with any data source. But wouldn't it be more enjoyable
if you knew what was going on under the surface? Let's walk through the
processes in order to see how Power Query works. To see the current Power
Query stages, we'll need to do the following:

Select Data. Choose Get & Transform, then pick Show Queries .

Now double click on the Table1 query.

The Power Query Editor will appear.



In the Index Column spreadsheet, you obtained earlier, you could see the
Applied Steps we have.

The following is a breakdown of the steps:

●      SOURCE: Get the Table of Contents

●      TYPE CHANGE: The Table's column types have been changed.

●      INDEX COLUMN ADDED: An Index Column was added.

Now comes the exciting part! Select Advanced Editor from the drop-down
menu at the top of the page.

You'll now see our precise three methods in detail!

�        Use Table1 as a starting point.

�        Modify the Sales Month column type to text as well as the Sales
column type to number.

�        Create a new index column named Index that begins at 1 and
increases by 1 each time it is used.



You can now view what's going on behind the scenes of your Power Query
transforms!

Refreshing Power Query Data

The underlying data underpinning the queries are often modified after we've
developed them by inputting and editing fresh data. For instance, the
finance department may get new data files that must be uploaded to current
datasets, live online data may be updated, or the user may manually
contribute additional data to the dataset. The benefit of refresh is that it
allows you to build queries once and then reuse them by just renewing the
connection to the data source, which may be anywhere. When calculating in
Excel, the data engine will automatically recalculate whenever the data in
the spreadsheet changes. Nevertheless, Power Query requires instructions
on when to update data. Understanding refresh is essential for ensuring that
the ultimate result of your data transformation is correct.

You never have to recall any steps from the last time you operated on the
data if you use a refresh. As you may know, Power Query uses the M
language code to record these stages as APPLIED STEPS. As a result,
refreshing it is a straightforward procedure for Power Query, which
involves loading or importing new data and then repeating the processes,
this time with the new data.

Select the Home Tab | Refresh Preview button, then choose Refresh All
to refresh all queries straight inside Power Query.

Refresh Preview, on the other hand, will simply refresh the current query.
When dealing in Power Query, the refresh notification bar will appear right



above the formula bar to notify you to update your queries, as illustrated in
the following picture.

Keep in mind that refreshing all queries may take some time, particularly if
the datasets are large. Another key point to remember is that while
renewing all queries, the order in which they are refreshed is maintained. If
we prefer to refresh queries separately and manually, we must do it in the
exact sequence and at the exact time.

If your data source is stored in an external file, Power Query will only load
the most recent version of the source. Even though the external file is open
on the computer and you have recently updated it, you will need to save it
in order for the refresh to reflect the most recent changes. If the source data
and queries are both in the same worksheet, any changes will be instantly
fused without the need to save them before refreshing. When renewing a
query that is predicated on another query, keep in mind that not all of the
queries will be renewed.

The background refresh option may be enabled to update automatically as
we work. This strategy has both advantages and disadvantages. One
advantage is that you may work while the refresh is occurring; however,
you may alter a formula, recalculate, or edit Pivot tables while operating,
and these changes may not be reflected if the background refresh is not yet
finished. To discover how to refresh.

Follow the steps given below:

1. Ensure that Excel is open with an active query and connection before
you enable the automatic background refresh. To refresh all



connection properties, go to Data | Refresh All Connection
Properties...

2. Find the Refresh control heading on the Usage tab of the Query
Properties dialog box.

3. Make sure Enable background refresh is turned on. Then, in minutes,
choose a Refresh duration.

4. Whenever you open a file, you may select to refresh the data, as well
as the connection, if you choose the Refresh All option.

5. Choose OK to verify the modifications you've made.

Managing existing queries

The Queries page contains information regarding the current queries as well
as the ability to create new ones. The Queries page shows the queries that
you have generated or that have been published to you for the specified
project and data settings.

The screen also includes unreported queries made by any users in your
login group.



1. Hover over through the Data Analysis icon (Data Analysis icon) in
the left navigation window, then select Queries.

2. As needed, filter the list of your inquiries and queries that have been
published to you.

a. Choose the plan for which you wish to examine queries from
the Project drop-down list.

b. Choose the configuration for which you wish to examine
queries from the Configuration drop-down selection.

c. Choose the origin of the queries you wish to see from the
Origin drop-down box; select — to see all kinds.

What you can do after that

1. Pick Rows to print, download, or delete multiple queries. Choose one
or more rows by checking the boxes, or select the Select All option to
check all rows (or Clear All to uncheck all rows). Then choose Print,
Download, or Delete from the drop-down menu.

2. Click the Generate Using Query Wizard link to use the built-in Query
Wizard to create a query.

3. To accomplish the following below, go to the Row Action menu
(Row Action menu icon) in a query.

a. Select Run and choose a data configuration to run the query.

b. Pick Generate Case Series to run the query and create a case
series from the results. When saving the case series, you choose
a data configuration, examine variables and values, and
optionally update the name, description, and project assignment.

c. Pick View to see the query logic. This option displays the
query's variables and values, as well as the logic.

d. Pick Report and pick a data configuration to run the query and
then a report against the cases detected by the query. The Report
Definitions page comes when you execute the query.



To accomplish the following with queries you've made, go to the Row
Action menu (Row Action menu icon) and select:

1. Click Copy to copy a query. After that, give the duplicate a name and
save it.

2. Click Edit to make changes to the query. To choose an alternative
data configuration, click Back.

3. Click Rename to rename the query. You may also alter its name or
move it to a different project.

4. Pick Publish, choose the login group(s) and then click Back to
publish the query. (You may publish settings produced by any user in
your login group if you have the Administer Users capability.)

Hint: You may publish to numerous login groups, including —All–if you
are a super user. Select login groups from the Publish to Login Groups
drop-down list by clicking or Press the Control key as you click. If you
publish an item to —All– and then create a new login group later, the object
is immediately published to the new login group.

●      Click Report and pick a data configuration to run the query and then a
report against the cases detected by the query. The Report Definitions
page comes when you execute the query.

●       Click Delete to get rid of a query. Click OK when the popup asks
whether you want to remove the query. The query has been removed
from the Queries page and is no longer visible.

Note: Changing or removing a query has no impact on any case series,
database constraints, custom terms, or interactive reports produced with it.

Merging columns using combine

We may combine data sources or data tables that have completely different
architectures. The sole need is that the sources have a connection. This is
often a standard field that connects one field in one data source to another
field in another data source. 



When we have a list of students in one database and data on payments made
per pupil in another table, we can combine the two tables to flatten the data
into one. The Merge tool allows you to choose a common field and
construct a connection between the two tables, allowing you to merge data
into a single flattened data table.

Let's get started:

1. Generate 2 queries using the data columns STUDENTS and
YEARLY FEES in the SSGSchoolAdmin.accdb data source.

2. StudentList should be the new name for the Students2 query. A
similar field named Code appears in both tables. This field will be
used to connect the two tables together.

Go to Home | Merge Queries | Merge Queries as New: after clicking on the
StudentList query.

Choose Code from the STUDENTS table, which will be the joining field, in
the Merge dialog box that appears. Choose the YEARLY FEES table from
the second drop-down list, then tap the Code column to identify it as the
matching join. The column headings of the connecting fields do not have to
match.

If you have more than one corresponding column, just use the Control
key + click approach to choose them in the order you want to combine
them. After that, a value in order is set next to each matched column. You
may also choose a Join Kind from the supplied drop-down list. The most
popular is Left Outer (all from first, corresponding from second), which
matches all fields from the first table and also matches fields from the
second table.



To finalize the merging, click OK.

Together with the result, a new query named Merge1 will be produced. The
YEARLY FEES column has been added to the table if you scroll to the
extreme right of the table. This column is termed a structured column
because it contains a structure (table) in each cell that displays another table
whenever you click on the empty space (not the word Table) of the cell. As
a result, Student 1005 has made two transactions toward the TOTAL
YEARLY FEE:

We'll need to take it a move further and combine the data to simplify the
structure since Power Query won't recognize the idea of a table inside a
table. Toggle to the right of the YEARLY FEES column header and choose
the Combine Files icon. The Combine group, which is placed on the Home
tab ribbon, also has a Combine Files option:



Choose the fields you want to add in the combine process by clicking:

 

The tables are consolidated into a single table that can be used to evaluate
data in Excel. You've now learned how to utilize the Combine tool to
combine tables based on the main key.

Defining a query using the Query Wizard

The Query Wizard simplifies the process of selecting and combining data
from various tables and columns in your database. You may choose which
tables and fields to include in your query using the Query Wizard. When the
wizard identifies a primary key field in one database and a field with the
same name in a second table, an inner join (a query action that specifies that
rows from two tables be merged based on identical field values) is
constructed automatically.

The wizard may also be used to sort the results and do basic filtering. You
have the option of returning the data to Excel or refining the query in
Microsoft Query in the wizard's last step. You may execute the query in
Excel or Microsoft Query once you've created it.

Take the instructions below to launch the Query Wizard.



1. Select From Other Sources, then From Microsoft Query, in the
Get External Data group, on the Data tab.

2. Ensure that the Use the Query Wizard to create/edit queries check
box is checked in the Choose Data Source dialog box.

3. Select the data source you wish to utilize by double-clicking it.

-or-

Click OK after selecting the data source you wish to utilize.

You may directly interact in Microsoft Query if you wish to write a more
complicated query than the Query Wizard permits. You may use Microsoft
Query to inspect and modify queries created using the Query Wizard, or
you can utilize it to build new queries without utilizing the wizard. When
you wish to develop queries that perform the following, work directly in
Microsoft Query:

Choose particular information from a field. In a huge database, you may
wish to pick and select part of the data in a field and leave out the
information you don't need. For instance, if you only require data for two of
the items in a field with information for many, you may use criteria to
choose just the two items you require.

Every time you execute the query, it will return data based on various
criteria. You may use a parameter query to construct the same Excel report
or summary for many locations in the same external data, such as a different
sales report for each region. Whenever you execute a parameter query,
you'll be asked to provide a value to use as the criteria for selecting records.
A parameter query, for instance, would ask you to input a certain area, and
you can even reuse this query to build every one of your regional sales
reports.

Data may be joined in several ways. The Query Wizard builds inner joins,
which are the most frequent form of join used in query creation. However,
there are situations when you'll want to employ a different form of join. An
inner join (the kind generated by the Query Wizard) will restrict the
retrieval of customer data for customers who have not made a purchase, for
instance, if you possess a table of product sales data and a table of customer
data. You may connect these tables using Microsoft Query to get all of the



customer information as well as sales data for those who have placed
orders.

Getting Data from External Sources

Microsoft Query can be used to get data from other sources. You won't have
to rephrase the data you want to examine in Excel if you use Microsoft
Query to obtain data from your business databases and files. You may also
automatically refresh your Excel reports and summaries from the actual
source database when it is updated with new data.

You may connect to external data sources using Microsoft Query, choose
data from those other sources, import it into your worksheet, and refresh the
data as required to maintain your worksheet data synced with the data in the
external sources.

You can access a variety of databases. Microsoft Office Access, Microsoft
SQL Server, and Microsoft SQL Server OLAP Services are among the
databases from which you may access data. You can also get data from text
files and Excel spreadsheets.

You may also get information from data sources not specified here, such as
different kinds of OLAP databases, using ODBC drivers or data source
drivers from other vendors. Check the database documentation or contact
your database vendor for information on installing an ODBC driver or data
source driver that isn't mentioned here.

Choosing information from a database: A query, which is a question
regarding data stored in an external database, is used to get data from a
database. You may wish to know the sales numbers for a given product by
area if your data is housed in an Access database. By choosing just the data
for the product and location you wish to investigate, you may obtain a
subset of the data.

Utilizing Microsoft Query, you can pick and choose the columns of data
you wish to import into Excel.

In a single process, you may update your worksheet. Whenever you have
external data in an Excel worksheet, you may refresh the data to update
your analysis without the need to constantly recreate your summary reports



and charts anytime your database alters. You might, for instance, construct a
monthly sales summary and update it every month when new sales statistics
arrive.

Importing data from files

Getting data from Excel Workbooks

●      Click on the Get Data option in the Power Query Data Tab.

●      Choose Excel Workbook in the Choose data source box

●      Pick Browse to choose the file you want to import

●      Choose the data. Then, select the Load button.

Getting data from CSV and text files

You can import data from a text file into Excel in two ways: by opening it
in Excel or by importing it as an external data range. Use the Save As
command and choose the file type from the drop-down menu to export data
from Excel to a text file.

There are two types of text files that are often used:

Delimited text files (.txt): TAB character (ASCII character code 009)
commonly divides each field of text into delimited text files (.txt).

Comma separated values text files (.csv): The comma character (,)
commonly divides each field of text in comma separated values text files
(.csv).

In both delimited and.csv text files, you may modify the separator character.
This may be essential in order to ensure that the import or export procedure
goes as planned. There are a total of 1,048,576 rows and 16,384 columns
that you may import or export.

1. Choose Data. Pick Get Data and select From a File, then pick From
a Text/CSV File

2. Search for or input a path to the file you wish to query in the Comma-
Separated Values Browse dialog box.



3. Choose Open.

Remember: When importing data from a CSV file, Power Query will
discover column delimiters such as column names and types immediately. If
you import the sample CSV file below, Power Query will utilize the first
row as the column names and update the data type of each column.

Load a text file in Excel to import it.

Using the Open command, you may convert a text file written in another
software into an Excel workbook. When you open a text file in Excel, the
file's format remains the same – you can see this in the Excel title bar,
where the file's name keeps the text file extension (for example, .txt or
.csv).

1. Navigate to File > Open and navigate to the text file's location.

2. In the Open dialog box, choose Text Files from the file type selection
list.

3. Locate the text file you wish to open and double-click it.

Excel launches the Import Text Wizard if the file is a text file
(.txt). When you're through with the instructions, click Finish to
finish the import. For additional information on delimiters and
advanced settings, see Text Import Wizard.

Excel opens the text file and shows the contents in a new
worksheet if the file is a.csv file.

Note: When Excel opens a.csv file, it interprets how to import each column
of data using the current default data format settings. Use the Import Text
Wizard if you want greater freedom when converting columns to alternative
data formats.

For instance, a data column in a.csv file may be MDY, but Excel's default
data format is YMD, or you wish to convert a column of integers with
leading zeros to text so that the leading zeros are preserved. You may
compel Excel to execute the Import Text Wizard by changing the file's
extension from.csv to.txt before opening it, or by linking to a text file.

Connect to a text file to import it.



Data from a text file may be imported into an existing spreadsheet.

1. Select the cell where you wish the contents from the text file to be
entered.

2. Click From Text in the Get External Data category on the Data pane.

3. Locate and double-click the text file you wish to import in the Import
Data dialog box, then click Import.

Perform the Text Import Wizard's directions. For additional
information about how to use the Text Import Wizard, hit the
Help button picture on any page. When you've finished with the
wizard's stages, select Finish to finish the import process.

4. Do the following in the Import Data dialog box:

a. Do one of the following under Where do you wish to place the
data?:

●       Choose the Existing worksheet to return the data to the place
you specified.

●       Choose a New worksheet to restore the data to the upper-left
corner of a new worksheet.

b. To configure refresh, formatting, and layout settings for the
imported data, click Properties.

c. Click the OK button.

The external data range is saved in the place that you designate in Excel.

If Excel fails to convert a column of data to the desired format, you may
transform the data after it has been imported. See Convert numbers saved as
text to numbers and Convert dates stored as text to dates for further details.

Importing data from database systems

Importing data from relational and OLAP databases
You may establish a flexible relationship between an Excel workbook and a
SQL Server Analysis Services Online Analytical Processing (OLAP)



database server and then update it anytime the data changes. If an offline
cube file has been produced on the database server, you may link to it. You
may either import data as a
Table or a PivotTable report into Excel.

1. Select Get Data. Choose From Database. Then, Pick From SQL
Server Analysis Services Database from the Data tab (Import). If the
Get Data button isn't visible, choose New Query > From Database >
From SQL Server Analysis Services Database instead.

2. Press OK after entering the Server name.

Note that you may specify an MDX or DAX query as well as a particular
database name.

3. Choose the database, then perhaps the cube or tables you wish to link
in the Navigator window.

4. To load the chosen table, click Load, or click Edit to apply further
data filters and modifications before importing it.

Importing data from the Azure database

Azure SQL Database is a mission-critical relational database created for the
cloud that is strong, completely controlled, and extensible.

1. Choose Data. Select Get Data > From Azure. Then, choose From
Azure SQL Database

2. In the Server Name field of the Microsoft SQL Database dialog box,
enter the name of the SQL Server you want to connect to. You may
also give a Database Name if you like.

3. Enter your query in the SQL Statement box if you wish to import data
using a local database query.



4. Choose OK.

5. To connect to the SQL Server database, choose an authentication
mode.

a. Windows This is the pre-selected option. If you wish to connect
using Windows authentication, check this box.

b. Database If you wish to connect using SQL Server
authentication, check this box. To connect to your SQL Server
instance, pick this option and provide a user name and
password.

6. By default, the Encrypt connection check box is checked, indicating
that Power Query uses a secure link to link to your database. Uncheck
this check box and then select Connect if you don't wish to connect
utilizing a secure link.

If you don't use a secure link to connect to your SQL Server, Power
Query will urge you to use an unsecured connection. To connect via
an unsecured connection, click OK on the message.

Importing data from ODBC connections to nonstandard databases

1. Navigate to the Data tab in Excel. After that, select From Other
Sources, then From Data Connection Wizard.

2. To proceed, pick ODBC DSN from the popup window and click
Next.



3. Next, choose a data source to link to and click Next.

4. Choose Next to input and save information about your new file, or
click Finish to connect to the table holding the relevant data.

5. Choose how your data will be displayed in Excel and where it will be
placed in the worksheet in the Import data window, then click OK.

6. The necessary information is now visible in the current Excel
spreadsheet.

Getting data from other data systems

1. Select the Data tab

2. Select From Other Sources, then From Microsoft Query from the
dropdown option.

3. You may choose the data source you wish to link to in the resulting
dialog.

4. Following a good connection, pick the data you wish to see in Excel
and hit Next.

5. The data may be filtered and sorted in the following two stages. To
skip these steps, click Next.

6. You may store the query by hitting the Save button on the right if you
want to use it again.

7. Hit Finish after selecting Return Data To Microsoft Excel.

8. Choose how your data will be displayed in Excel and where it will be
placed in the worksheet in the Import data window, then click OK.

9. The necessary information has been successfully imported into Excel.

Managing data source settings

It's useful to know which dialog box to use when you need to inspect or
control an external data source:

Utilize the Recent Sources dialog box to see a list of commonly used data
sources that you've previously imported, as well as to make modifications



to each data source's connection details.

To find or change data source credentials, or to configure privacy settings,
utilize the Edit Permissions dialog box. Adjust privacy settings for
additional information.

Set extra security parameters for native database queries, certificates, and
authentication services using the Query Options dialog box. Increase the
security of your data even further.

Editing data source settings

1. Choose one of the following to bring up the Data Source Settings
dialog box:

Choose File, Home, then Data Source Settings in Power
Query.

Pick Data, Get Data, then Data Source Settings in Excel.

2. Choose one of the following options:

Data sources in the current workbook: The Change source
button is also shown at the bottom of this choice, which is the
default.

Global Permissions:  To make changes to all of your
workbooks' permissions.

3. If you have a lot of data sources, type a search term in the Search data
source settings box, or use the Sort A to Z function in Excel to sort by
the name or type of data source.

4. To modify a data source, first, click it, then pick Data Source, and
then make adjustments in the Data Source dialog box. This is the
identical dialog box that appeared when the data was originally
imported. A distinct dialog box appears for each kind of data source.

Note:  You may only examine the SQL query from this dialog
box if the database has a Native Database Query (such as
SQL). 



5. You may clear permissions for the specified data source or all data
sources using the Clear Permissions/Clear All Permissions option.
Use this command with caution. You won't be able to reclaim
permissions after they've been removed.

6. Select a data source from the list and then Edit Permissions to open
the Edit Permissions dialog box.

7. Observe that the data source's authorization type, such as
Anonymous, is shown under Credentials.

8. Pick Delete to remove the permission. The permission type has been
changed to Not Specified.

9. Tap Edit to add or modify permission.

10. Choose the credential type you want in the left pane (colored green)
of the dialog box:

Hint: When the password is transmitted, it is not encrypted.
Specific credential types aren't supported by all data sources.

Anonymous: The data source may be accessed by anybody,
and no credentials are necessary.

Windows: Put your Windows login and password in this
box.

Basic: Fill up your username and password.

APIs for the web: Enter a key that will allow you to access the
Web source, which may need pre-registration.

Organizational account: Log in to your school or work
account.

Conclusion

In Power Query, all you have to do with power query is build table
connections and combine queries. The nice aspect is that if you add new
data to the amount list, the new table is automatically updated. In this
chapter, you understood the different ways you can import different data



sources from various places. Inside the Query Properties dialog box, we
learned how data is refreshed and the many settings connected to refresh.
Ensure that you utilize the samples and instructions given here very well
while working with Power Query.



CHAPTER FIVE

TRANSFORMING DATA WITH POWER QUERY

Transforming data entails renaming tables or columns, as well as presenting the data for analysis. You'll learn how
to turn tabular data into an approved tabular format using the Pivot and Unpivot tools. We'll eliminate any
unneeded columns, rename column headings, and rename queries after utilizing these tools. We'll take note of the
actions we took and learn how to use Power Query to update data sources. All of these processes are required to
arrange the data for further investigation or reporting.

For a variety of reasons, data is presented in a variety of formats. Some, like a basic financial revenue budget with
financial years as rows and months as column headings, might be made aesthetically attractive, while others could
be more complicated and utilized for analysis using PivotTables and/or storing data in a data storage program like
Power Query. Prior to completing any calculations or analyses, always consider the goal of the dataset you're
dealing with and prepare the data. In these situations, Power Query is unquestionably the tool of choice for data
transformation.

The drawback of not properly organizing a dataset may lead to a slew of analytical issues, and we end up spending
time constructing several computations. If the dataset was properly prepared from the start, you wouldn't have to
perform this.

There are a number of procedures to take when preparing data for use in PivotTables, for example, to ensure that
you get the most out of summarizing and analyzing enormous datasets.

Prior to employing any analytic tool, we should follow the following guidelines:

1. Ensure that the spreadsheet doesn't include any duplicated data.

2. Delete any data filters you've applied and ungroup any cells you've grouped using Excel's Outline tool.

3. For each column in the spreadsheet, format the data type. This implies that dates must be formatted using
the correct date format, with values such as number, currency, accounting, and so on. Ensure that the
column headers are accurately labeled so that they are easy to understand and do not include lengthy
details.

4. Do not use totals, subtotals, or average columns in your computations. The reason for this is because after
data has been cleansed and converted in Power Query, it is analyzed using Power Pivot, Power BI, or
Excel tools to arrive at various conclusions.

5. Any blank cells in the data source should be removed.

Performing common transformation tasks

The screenshot below depicts a source dataset that has been badly constructed for Power Pivot or any other
analysis application.

The dataset does not follow the guidelines given in the previous section:



  

It includes extra quarter-by-quarter computation columns, as well as the final total sales. It's also possible to delete
the combined column heads. Within Power Query, the Region column may likewise be transformed from rows to
columns after this is done.

The dataset seems much more appealing after following the adjustments to arrange the data for analysis, but we
still need to edit it a bit further using Power Query's Unpivot tool. We'll utilize the sales columns from January to
September to show the Unpivot tool. Rather than having distinct columns for each of the three quarters' sales
numbers, we'll combine the data from all nine columns into two rows.

Let’s begin.

In Power Query, load the dataset YearlyProductSales.xlsx. This may be done using Excel

In the dataset, select all nine sales columns. Then, from the Any Column group, Pick Transform | Unpivot |
Unpivot Columns.

A column for Attribute, which lists the months, and a column for Value instances, which are connected with each
month, are produced as a result.

Rename the columns to make them more appropriate for the table's content. Just double-click the Attribute column
header and change the wording to anything you like. Carry out the same procedure with the Value column.

Simply go to the APPLIED STEPS window to view, delete, rename, or reorder steps you've applied to the data if
you need to undo a previously performed step or if you want to know if a certain step was performed on the query
data. Click the red cross to the left of the applied step to delete it, or right-click on a specific step to access various
options.



Let's try the Pivot column option, which works in the opposite direction of the Unpivot feature by displaying data
from rows across columns using the names of the data. For this example, make sure you're utilizing the
SafestSolutionsLaw.xlsx data source.

To utilize the items in the CASE TYPE column to base the new columns on, choose the column. Then select
Transform | Pivot: from the drop-down menu.

Choose BALANCED OWED from the Values Column.

We don't want to sum values at this point, so select Advanced options and choose Don't Aggregate for the
Aggregate Value Function.

To see the Pivot's result, select OK.

In the Queries pane, we can now see two newly created queries.

Change the names of the first and second queries to UnPivot and Pivot, respectively:



With that knowledge, you should feel comfortable utilizing Power Query's Pivot and UnPivot tools to transpose
row and column data. We'll look at the several refresh choices and how the refresh process works in the following
section.

Removing duplicate records

An exterior data source may not be as reliable as you think. Among the most vexing qualities of low-quality data is
the prevalence of duplicates.

Two goods with ProductNumber DS803 may be found in the Products table if you look attentively.

Follow the methods below to get rid of the duplicates listed above:

●      Make that the Products query is selected in the Power Query Editor.

●      Choose Remove Rows. Pick Remove Duplicates from the Home tab.

●      One of the rows with the ProductNumber DS803 has been deleted, and a new step has been added to the
APPLIED STEPS pane.

●       Close and load the window by clicking the Close & Load button. The Products table in your worksheet
will be refreshed as a result of this.

Filling in blank fields



Utilize the Use First Row as Headers split icon drop-down on the Transform tab to demote the header row by
selecting "Use Headers as First Row." The first row in the table will be the header row.

The Transform Tab’s Transpose button should be clicked. The rows become columns when the table is turned on
its side.

Everything but apart from the first column should be selected. After selecting the second column, press Shift and
choose the last column or Control key + A, then Control key + Click the first column.

To fill the null (blank) cells, click the Fill > Down button on the Transform tab.

To reposition the table, click the Transpose button on the Transform tab.

To restore the headers, choose the Use First Row as Headers option from the transform tab.

If you really want to fill the table completely, this method works great. If there are further columns off to the right
that might include gaps that you don't want to be filled, it could be best to generate the filled values in new
columns using an If statement (conditional column).

Concatenating columns

Merging data in columns might be handy, for example, to create a lookup helper column.

We utilize the 'Custom column' option in Power Query to merge columns. Go over to the 'Add Column' tab in the
Power Query Editor window and click the Custom Column icon.

`

Hint: We're not repartitioning our current columns by utilizing Custom Column.

You name the new column and put your formula in the custom column formula field in the Custom Column dialog
box. The column header may also be changed or named in the main Power Query Editor window.

Hint: If you click the I information symbol above the box, Excel will tell you that you may press Ctrl-Space to see
a list of possible columns and additional formula options.

=[Column1] & [Column2] & "_" & [Column3] 

In Power Query, the fundamental syntax for concatenating is to put column names in square brackets [] and
separate them with the & (ampersand) symbol. To incorporate more text strings, wrap them in double quotation
marks, such as &"_"& divide the column data with an underscore.



         

Changing case

There's an entire category of Excel functions dedicated to dealing with text, and these three will assist us in
changing the case of the text.

The LOWER function only accepts one input, which is the text to be converted to lower case characters. The
function will return text that is entirely in lower case.

=LOWER(Text)

The UPPER function accepts just one argument: the text to be converted to upper case characters. The function
will return text in full capital letters.

=UPPER(Text)



The PROPER function accepts just one input, which is the text to be converted to proper case. The function will
return text in all appropriate cases, with each word beginning with a capital letter and ending with lower case
letters.

=PROPER(Text)

Finding and replacing specific text

In Power Query, you may substitute one value in a specified column with another one. You may change individual
values or the entire value in a cell. Changing values in a query has no effect on the external data source.

Replacing Text Values

Text values' default behavior is to find for and replace a given text string. This is a behavior that can be altered.

●      To open a query, choose one that has already been loaded from the Power Query Editor, pick a cell in the
data, and then go to Query > Edit.

●      Choose a text data type for a column.

●      Choose Home or Transform > Replace Value from the drop-down menu. The dialog box Replace Values
displays.

●      Enter the value to be searched in the Value To Find box.

●      Enter the value to be replaced in the Replace With box.

●      Perform one or more of the following actions under Advanced options:



Match Specific text values are substituted by default. Select Match full cell contents to replace
the entire cell value.

Characters who are unique Select Insert special characters and then one of the options from the
drop-down list: Tab, Carriage Return, Line Feed, Carriage Return, and Line Feed, Carriage
Return and Line Feed, and Non-breaking Space.

●      Choose OK.

Replace Number, date, time, or logical values

For non-text columns, the default action is to search and replace the whole contents of a cell.

This is an unchangeable habit.

●      To open a query, choose one that has already been loaded from the Power Query Editor, pick a cell in the
data, and then go to Query > Edit.

●      Choose a numeric, date/time, or logical data type for a column.
●      Choose Home or Transform > Replace Value from the drop-down menu. The dialog box Replace Values

displays.
●      Enter the value to be searched in the Value To Find box.
●      Enter the value to be replaced in the Replace With box.
●      Choose OK.

Trimming and cleaning text

You may have utilized the Trim-function (Text.TrimStart or Text.TrimEnd) to remove preceding or the following
whitespace from your strings while cleaning bad data. Exactly, do you know, though, that you can use these
methods to remove any additional characters from the beginning or end of a string? Trimming text using custom
characters is a simple process:

Assume you have a column with the following values:

 

And you want to get rid of every number at the end, as well as every "-" that is directly linked to a number. So that
the end product looks like this:

 

By default, the Text only accepts one parameter. TrimStart or Text are two options. TrimEnd is a function that
removes whitespace characters from a string.

Text.TrimEnd(text as nullable text, optional trim as any) as nullable text



However, the second option allows you to provide a list of your own characters to be eliminated. As a result, I can
make a list of all the characters that should be eliminated from the end, as follows:

"0"...."9" & "-"

This combines two lists: The first list has ten items, all of which are integers as strings. The second list has just one
item: "-." I also need to place this element in a list so that I may use the ampersand ("&") as a simple concatenator.

So here's the whole statement for the "Add custom column" dialog:

Text.TrimEnd( [MyColumnName], {"0".."9"} & {"-"} )

You can see this in action by pasting the following code into the advanced editor and following the steps:let

Source =
Table.FromRows(Json.Document(Binary.Decompress(Binary.FromText("i45WcvL389AN0PXVNTRTitWJVnJ29N
BinaryEncoding.Base64), Compression.Deflate)), let _t = ((type text) meta [Serialized.Text = true]) in type table [p

#"Changed Type" = Table.TransformColumnTypes(Source,{{"product_name", type text}}),

#"Added Custom" = Table.AddColumn(#"Changed Type", "Custom", each Text.TrimEnd([product_name], {"0".."9

in

#"Added Custom"

Extracting characters

Whenever working with data in Excel which has been transferred from another source, the text is frequently not
formatted as you would want. Product referencing may be made up of a product code, a code reference, and a
product category all combined into one piece of text that displays in one worksheet column. Your need is to break
the appropriate portions of the text string into separate cells in your worksheet.

This might be due to the fact that you wish to sort or group by a certain chunk of text. On that divided piece, you
could also wish to employ additional equations. For instance, you could wish to use that chunk of text as the
lookup value in another table of data. With data in its initial state, it would be unfeasible. If you're utilizing the data
in a pivot table, you may need a distinct column for the split data to enable filtering and consolidation.

Extracting the left, right, and middle values

The functions Left, Mid, and Right return a piece of a string.

1. The initial characters of a string are returned by the left.

2. The middle characters of a string are returned by mid.

3. The concluding characters of a string are returned by right.

When you provide a single string as an argument, the function returns the piece of the string that you requested.
When you supply a single-column table containing strings, the method produces a single-column table containing
the sections of those strings that you requested. As described in Working with Tables, you can transform a multi-
column table into a single-column table.

Mid returns blank if the beginning point is negative or beyond the end of the string. The Len function may be used
to determine the length of a string. If you ask for more characters than the string can hold, the function will return
as many as it can.



Syntax

Left( String, NumberOfCharacters )

Mid( String, StartingPosition [, NumberOfCharacters ] )

Right( String, NumberOfCharacters )

●      String - This field is required. The string from which the result will be extracted.

●       Starting Position - This field is required (Mid only). This is the beginning point. Position 1 is the first
character in the string.

●      NumberOfCharacters - This field is required (Left and Right only). The maximum amount of characters
that will be returned. If the Mid function is not specified, the function returns the chunk of the string from
the beginning to the end.

Left(SingleColumnTable, NumberOfCharacters) 

Mid(SingleColumnTable, StartingPosition [, NumberOfCharacters]) 

Right ( SingleColumnTable, NumberOfCharacters )

●       SingleColumnTable - This is a must-have. The results will be extracted from a single-column table of
strings.

●       Starting Position - This field is required (Mid only). This is the beginning point. Position 1 is the first
character in the string.

●      NumberOfCharacters - This field is required (Left and Right only). The maximum amount of characters
that will be returned. If the Mid function is not specified, the function returns the chunk of the string from
the beginning to the end.

Extracting first and last characters

The first and final two characters from the ProductSKU in the aforementioned set of little product data will be
extracted in the instance in this topic. The product category code is found in the first two characters of the SKU,
while the product size is found in the final two characters. We will utilize the Excel LEFT and RIGHT

Functions in doing this. The syntax of the formulas is as follows:

LEFT ( Text, [Number] ) and RIGHT ( Text, [Number] ).



Text – The textual string from which you want to extract information. Inside a workbook, it can also be a
legitimate cell reference.

Number [Optional] – This is the number of characters from the text string that you want to extract. A value that is
larger than or equal to zero is required. All characters will be provided if the value is larger than the size of the
string of text. If the value isn't specified, it's considered to be one.

Splitting columns using character markers

In Power Pivot, divide a column. Data > Text to columns > Delimited > Space > Finish in Excel. After that, import
the data into PowerPivot.

In Power Query, divide a column. A column of text may be divided into numerous columns in Power Query using
the Query Editor in one of two different ways: by delimiter or by a group of characters.

By Delimiter divides a text value into two or more columns depending on a common character. The comma (,)
character may be used to break a Name column into two columns, such as LastName, FirstName.

By Number of Characters decodes a text value depending on the location of a character inside it.

Unpivoting columns



You may wish to unpivot data, also known as flattening data, in order to convert it to a graphical form with all
related values in one column.

Whenever you unpivot, you extract the criterion pairs that constitute the new columns' intersection points and re-
orient them into flattening columns as follows.

Values are unpivoted into a separate column (in blue on the left) 

Attributes (on the left in green) are unpivoted into a separate column (on the right in green), and repetitions are
transferred to the new Values column.

So,

1. To start a query, choose one that has already been imported from the Power Query Editor, pick a cell in
the data, and then go to Query > Edit.

2. Choose one or more columns to work with. Pick all columns except Country in this sample. Press Shift
key + Click or Control key + Click on each successive column to pick more than one column sequentially
or discontinuously.

3. Choose Unpivot Columns from the Transform menu.

Unpivoting other columns

This command unpivots columns that have not been chosen. Whenever not all columns in a query are specified,
use this command. During a refresh process, new columns are also unpivoted.

●      To open a query, choose one that has already been loaded from the Power Query Editor, pick a cell in the
data, and then go to Query > Edit.

●       Choose the columns you don't want to unpivot from the list. Press Shift key + Click or Control key +
Click on each successive column to pick more than one column sequentially or discontinuously.

●      Pick Unpivot Other Columns from the Transform menu.

Creating custom columns

Adding a custom column to your query can be done by generating a formula. The syntax of the formula will be
validated by Power Query just as the Query Editing box does. Assuming you require more freedom in adding



additional columns than what Power Query offers out of the box, you may use the Power Query M formula
language to construct your own custom column.

Assume that you do have a table with the columns shown below.

You want to make two new columns out of the Units, Unit Price, and Discount columns:

1. Total Sale Before Discount: Multiply the Units column by the Unit Price column to get the total sale prior
discount.

2. Total Sale after Discount: Multiply the Total Sale before Discount column by the net percentage value to
get the total sale after discount (one minus the discount value).

The aim is to create a table with additional columns that resemble the one below.

Let’s create the custom column.

Navigate to the Add Column tab. Choose Custom Column

This will show the Custom Column dialog box. In the box, you will define the formula to create the column.



Choose a column from the Available columns list on the right-hand side of the dialog box to create a new custom
column. Then, underneath the list, pick the Insert column button to include it in the custom column formula. You
can also include a column to the list by choosing it from the drop-down menu. Additionally, you may use the
Power Query M formula language in the Custom column formula box to create your own formula.

Understanding data type conversions

If you get an error while choosing a data transformation option, it's possible that the column's existing data type
doesn't allow the translation you've chosen. For certain data formats, not all transformations are possible. If a
column's existing data type is either a number (whole or decimal) or text, you could only alter it to a Boolean data
type. As a result, for the data in the column, you must select a suitable data type.

Power Pivot will notify you about potential modifications to your data after you select an adequate data type, such
as precision loss or truncation. Adopt the current data type by clicking OK.

If the data type is permitted, but Power Pivot discovers values that aren't assisted by the new data type, you'll
receive additional mistakes and will have to modify the data values before continuing.

Understanding the present data type

Excel analyzes the columns of data to determine what data types each column includes whenever you add data to a
Data Model. It provides the most exact data type to the column if the data in that column is constant.

When you import data from Excel or from an alternative source that doesn't require the usage of an individual data
type in each column, Excel creates a data type that can hold all of the values in the column. Excel uses a decimal
data type when a column includes numbers of various sorts, such as integers, long numbers, and money. If a
column contains both numbers and text, Excel applies the text data type.

If you discover that your data is of a different data type than you expected, you have numerous options.

The data may be re-imported. To do so, re-import the column using the inherent relationship to the data source.
You may be eligible to employ a filter during import to eliminate troublesome values, based on the sample source
type. If you want to filter data during import, you'll need to use the Power Pivot add-in.

To produce a new value of the required data type, you may use a DAX formula in a calculated column. For
instance, you may use the TRUNC function to transform a decimal number into a whole integer, or you can utilize
a combination of information and logical functions to test and transform values.

Adding conditional logic to custom columns

A table with three main categories and a column containing customer names has been created. We'll presume that
this Table was obtained using Power Query (also known as getting & Transform) and imported into our Power
Pivot data model.

Let's pretend for the sake of this example that we want to develop a conditional column that returns "Included" if a
client is "Y" in Category 1 and "N" in Category 2.

To create our own column, we'll use the following code:

=IF(OR([Category 1]="Y", [Category 2]="N"),"Included",BLANK())



What if we want a three-condition conditional column?

1. Category 1 = “N”

2. Category 2 = “Y”

3. Category 3 > 1

Remember that Power Pivot's OR function only supports two conclusory statements:

OR(Logical 1, Logical 2)

We'll have to resort to using the dreaded nested IF formula:

=IF(OR([Category 1]="N",OR([Category 2]="Y",[Category 3]>1)),"Included",BLANK())

We accomplish the desired outcome:

That's great, but what if there are four or five criteria? We may use the '||' operator as an alternative.

We may construct the following formula using the '||' operator instead of the OR function:

=IF([Category 1]="N" || [Category 2]="Y" || [Category 3]>1,"Included",BLANK())

The '||' operator in the IF formula enables us to combine numerous requirements into a single logical test, greatly
easing the expression. When generating custom columns in Power Pivot, the '||' operator is a fantastic method to
avoid building unpleasantly nested IF equations.



Grouping and Aggregating Data

Aggregations are a technique of grouping, compressing, or summarizing data. When working with original data
through databases or other datasets, the data is often flat, indicating there is still a lot of information but no
organization or grouping. Because there are no summaries or organizations, it may be tough to locate trends in the
data. Defining aggregations that compress, explain, or summarize trends in response to a particular business query
is an essential aspect of data modeling.

Most popular aggregations, such as those that use AVERAGE, COUNT, DISTINCTCOUNT, MAX, MIN, or
SUM, may be automatically constructed in a measure using AutoSum. AVERAGEX, COUNTX, COUNTROWS,
and SUMX are examples of aggregations that yield a table and need a formula written using Data Analysis
Expressions (DAX).

Selecting groups for Aggregation

Whenever you aggregate data, you first group it by criteria like the product, price, location, or date, and then create
a formula that applies to all of the data in the group. Whenever you calculate a year's total, for instance, you're
doing an aggregate. That's a completely separate form of aggregation if you make a ratio of the current year to the
prior year and display it as a proportion.

The business issue drives the choice of how to categorize the data. Aggregations, for instance, can address
the following questions:

1. Counts in a month, how many transactions were there?

2. Averages What were the average monthly sales by salesperson?

3. Values at their lowest and highest points What were the top five sales districts in terms of units sold?

To build a computation that addresses these queries, you'll need specific data that includes the numbers to count or
total, as well as numeric data that is relevant to the groups you'll use to arrange the findings in some manner.

If your data does not already contain values for grouping, such as a product class or the title of the geographical
area where the shop is situated, you may wish to create categories to establish groupings to your data. You should
personally input or pick the groups you wish to utilize from among the columns in your Excel spreadsheet when
creating groups.  In a network of associations, nevertheless, structures such as product categories are often
recorded in a database separate from the fact or value table.

A key connects the categorization table to the fact data in most cases. Consider the case when you discover that
your data includes product IDs but not product names or classifications. You'd have to duplicate the column with
the category names onto a flat Excel spreadsheet to add the category. You may import the product category table
into your data model using Power Pivot, construct a link between the table with the numerical data and the product
category list, and then categorize data using the categories.

Selecting an Aggregation Function

You must determine the arithmetic operations to utilize for aggregation once you have discovered and added the
categories to employ. The phrase aggregation is often used interchangeably with the mathematical or statistical
procedures employed in aggregations, such as sums, averages, minimums, or counts. In addition to the
conventional aggregations provided in both Power Pivot and Excel, Power Pivot allows you to develop custom
aggregation formulae.

Conclusion

This chapter has simply explained the different ways you can transform data using the Power Query. So, with the
examples listed out on how you can perform some of the transformation tasks, you can execute a variety of
operations based on the report's requirements. You may use it to update numerous choices if you wish to alter data.



If you have data in an improper or unstructured format, you may use the procedures to clean and transform it, as
well as execute error management techniques. Many times, we have problems with data generation, which may be
resolved with the help of the Power query editor.



CHAPTER SIX

MAKING QUERIES WORK TOGETHER

Layered data analysis is common, with every layer of analysis relying on or
elaborating on the prior one. People layer their analysis when they create a
pivot table from the output of a Power Query output. This chapter gives an
explanation of a few methods in which the user may enhance their data
analysis by combining their queries. The Append functionality in Power
Query enables you to add data from one query to the outcomes of another
query.

When a user has to combine numerous similar tables into one, the Append
function comes in helpful. The user may utilize the Merge functionality in
Power Query to combine data from various queries in this chapter. Power
Query supports the following types of joins: left outer, right outer, complete
outer, inner, left anti, and right anti.

Reusing Query Steps

If you often have to perform a similar set of changes to various queries or
data, establishing a Power Query custom function that you can reuse as
many times as you need might be useful. A Power Query custom function is
a binding between a collection of input values and a single output value that
is built using native M functions and expressions.

Let's imagine you have a number of queries or data that all need the same
changes. You may write a custom function that you could then use against
your desired queries or data. This custom function will end up saving you
time and allow you to manage all of your conversions in one place, which
you can change at any time.

Current queries and parameters may be used to develop bespoke Power
Query functions. Consider a query that has numerous codes in the form of a
text string, and you want to write a function to decrypt those numbers.



To begin, you'll need a parameter with a value that acts as an example.

You build a new query based on that parameter and perform the
modifications you need. In this scenario, you'll need to break down the code
PTY-CM1090-LAX into various parts:

Airline = CM, Origin = PTY, Destination = LAX, and 1090 = Flight ID.



The query may then be turned into a function by right-clicking on it and
picking Create Function. Lastly, as demonstrated in the figure below, you
may call your own function from any of your queries or values.

After a few more changes, you'll see that you've arrived at your expected
outcome and used logic from a custom function to achieve it.

Understanding the Append Feature

An append feature generates a new query with all rows from one query
accompanied by all rows from another query. At least two queries are
required for the append operation. These searches may be based on a
variety of other data sources as well.

The add procedure uses the names of the column headers in both tables
rather than their relative column positions. All similar columns from all
tables are added to the final table. If there are no similar columns in the
tables, null hypotheses are inserted into the mismatched column. Beginning
with the Main table, the tables will be attached in the sequence in which
they were chosen.

There are two sorts of append procedures available. You attach data to your
current query until you achieve a final result using an inline append. As a



consequence, a new step has been added at the end of the current query. For
each append procedure, you construct a new query with an interim append.

Privacy Levels protect users from mistakenly merging data from several
data sources, which might be private or organizational. Depending on the
query, a user may mistakenly communicate data from a confidential data
source to a potentially dangerous data source. Every data source is analyzed
and classified into one of three levels of privacy: public, organizational, or
private. Adjust privacy levels (Power) for additional details.

Creating the needed base queries

There are various methods to construct and load Power queries into your
worksheet using Power Query. In the Query Options box, you can also
select default query load parameters.

Hint: Select a cell of data in a spreadsheet to see whether it was molded by
Power Query. If the Query context ribbon tab shows, the data was imported
from Power Query.

You have the option of creating a query using imported data or a blank
query. Making a query using the data you just imported is the most typical
method of query creation.

●      Import some data.

●      Choose Query > Edit after selecting a cell in the data.

Making a query that is completely blank.

You may wish to start from the beginning.

There are two options for doing this.

●      Select Data. Choose Get Data and Select From Other Sources. Then,
click Blank Query.

●      Choose Data > Get Data > Launch Power Query Editor.

If you are familiar with the Power Query M formula language, you may
manually add steps and formulae at this stage.

You may also choose Home and then command from the New Query group.



Choose one of the options below.

1. To add a data source, choose New Source. This command is the same
as the Excel ribbon's Data > Get Data command.

2. To choose a data source you've been dealing with recently, go to
Recent Sources. This command is the same as the Excel ribbon's Data
> Recent Sources command.

3. To manually input data, choose Enter Data. This command may be
used to test the Power Query Editor without using an external data
source.

Appending the data

To start a query, choose one that has already been loaded from the Power
Query Editor, pick a cell in the data, and then go to Query and select Edit. 

Choose Append Queries from the Home menu. An inline append is the
default action. Choose the arrow next to the command and then Append
Queries as New to execute an interim append.

The dialog box for appending displays.

Choose how many tables you'd want to append:

�        To append, select Two tables and then the second table from the drop-
down list box.

�        Three or more tables should be chosen. Add the tables you wish to
attach to the Tables to append box from the Available tables box. To
modify the sequence, use the arrows on the right of that box.

Choose OK.



Outcome

�        A new step in the current query is produced if you decided to conduct
an inline ad in step 2. To append new inquiries, keep adding steps to
the same query.

�        A new query is created if you chose to do an intermediate append in
step 2. You can continue to create more queries.

Understanding the Merge Feature

Understanding the Power Query joins

When you combine two queries, you're usually joining them from inside
Excel or from an exterior data source. Furthermore, the Merge function
features an easy-to-use user interface that allows you to quickly merge two
linked tables.

A merge query combines two existing queries to generate a new one. All
columns from the main table are included in a single query result, with one
column functioning as a single column carrying a connection to a
supplementary table. The connected table includes all rows that have a
similar column value and match each entry from the main table. A linked
table's columns are added to the main table using the Expand procedure.

Merge operations may be divided into two categories:

�        Merge inline: You keep merging data into your current query until
you get a final result. As a consequence, a new step has been added at
the end of the current query.

�        Merge in the middle (intermediate): Each merging action
necessitates the creation of a new query.

Choose View. Then, pick Query Dependencies to view a visual depiction of
the connections in the Query Dependencies dialog box. To adjust the
diagram orientation, pick the Layout command at the bottom of the dialog
box.



Merging queries

In a joint operation, you'll require at least two queries that can be combined
and have at least one or more columns that match. They might originate
from a variety of various data sources.

Products and Total Sales are used in the given example.

1. To launch a query, choose one that has already been loaded from the
Power Query Editor, pick a cell in the data, and then go to Query >
Edit. 

2. Choose Home, then Merge Queries from the drop-down menu. An
inline merging is the default action. Select the arrow next to the
command and then Merging Queries as New to perform an interim
merge. The Merge dialog box is displayed on the screen.

3. Choose the main table from the first drop-down menu, then choose a
join column by clicking on the column heading.

4. Choose a comparable table from the next drop-down menu, then a
matching column by clicking on the column heading.

In the preview of the main and linked or secondary tables, make sure you
pick the same amount of columns to match. The order of selection in each
table is used to compare columns. The data types of the matching columns
must be the same, such as Text or Number. You may also choose to
combine several columns.



5. Power Query shows the number of matches from a top group of rows
after you choose columns from the main table and associated table.
This activity checks to see whether the Merge operation was
successful or if any adjustments are required to get the desired
outcomes. You may choose from a variety of tables and columns.

6. The default join operation is an inner join.

 However, you may choose from the following sorts of join
operations from the Join Kind drop-down list:

�        The inner connection Only rows from the main and associated
tables that are identical are imported.

�        Outer join on the left All rows from the main table are kept, and
any matching rows from the associated table are brought in.

�        Outer right join: All rows from the associated table are kept, and
any matching rows from the main table are brought in.

�        Full outer: All rows from the main and associated tables are
imported.



�        Anti-join on the left Only rows from the main table with no
matching rows from the linked table is imported.

�        Right anti join: Only rows from the linked table that don't match
any entries in the main table are imported.

�        Cross-joining By joining each row from the main table with each
row from the associated table, the Cartesian product of rows from
both tables is returned.

7. Pick Use fuzzy matching to execute the merging and choose from the
Fuzzy Matching choices if you wish to do a fuzzy match. 

8. Choose Only include matching rows to include only rows from the
main table that match the associated table. Alternatively, the resultant
query includes all entries from the main table.

9. Choose OK.

Outcome

Conclusion

Finally, merging queries is a significant transformation that improves the
performance of our queries and tables for data models. It's critical to
comprehend how we'll employ them and how we'll bring them all together
as one. We will be able to develop completely optimized queries and tables
as a result of this. We can then utilize them in our data model to improve
the efficiency of our DAX computations.



CHAPTER SEVEN

 ENHANCING POWER QUERY PRODUCTIVITY

This chapter provides helpful hints for arranging queries and getting the
most out of Power Query. In addition, the users will get a few tips for
improving query speed. Inside the Queries and Connections task pane, you
can see all of the Power Query queries in a certain worksheet. The
capability to recognize data types instantly and modify data types
strategically is one of Power Query's more recent improvements.

When fresh data is added to the query, this sort of detection is most often
used. Although Power Query performs a good job of predicting which data
types should be utilized, automated data type changes might create
problems. It's impossible to avoid the reality that the greater the data set, the
slower the queries will perform. The methods a user may take to improve
query performance are discussed in this chapter.

Implementing some Power Query Productivity Tips

Organizing queries in group
Data cleansing is required if you have a huge data collection and a
significant number of queries. Some users are unaware of the need for data
cleansing in the Query Editor. You may utilize the Transform ribbon's
options or just right-click the columns to transform them. To clean up your
data, there's no need to apply complex functions. You can quickly
comprehend and refer to your columns in your model in this manner.
Furthermore, cleansing your data might assist you in subsequently
simplifying your visualizations and reports.
Let’s work with the sample below;



To begin cleaning, you must first choose which among them will be
contained in the model. Before everything else, that's the first thing I think
of.

The setup may include a large number of queries, and not all of them must
be included in your model.

Press the Shift button and click the relevant tables to choose the numerous
data you wish to add. While picking the proper tables, you may also hold
down the Ctrl key.

Afterward, right-click and choose Move To Group, then New Group from
the menu that appears.

Working to ensure that your queries are well organized, aid in the seamless
operation of your Power Query. Maintaining your data tidy and structured
will allow your team to work together more effectively. Your data model
and reports are simple to grasp for other users.

Selecting columns in your queries faster

The SQL SELECT command is used to get data from a database table,
which is returned as a result table. Result sets are the names for these result
tables. The syntax for this is SELECT column1, column2, columnN
FROM table_name;

The sections of a table containing values you wish to get are column1,
column2, ... You may use the below syntax to get a list of all the fields
accessible in a field; SELECT * FROM table_name;



Renaming query steps

Any data modifications will appear in the Applied Steps list. For example,
if you rename the second column, it will appear as Renamed Columns in
the Applied Steps list.

Simply right-click on the step that you want to rename and click Rename.

Copying queries to save time

●      Start with the existing query in the workbook.
●       Select Data, Get & Transform. Then, pick Show Queries from the

menu.
●      Right-click the Table1 Query in Workbook Queries and select Copy.
●      Go to the workbook where this query isn't yet present.
●      Select Data > Get & Transform > Show Queries from the drop-down

menu.

●      Right-click the pane in Workbook Queries and select Paste.
●      This table's order date has also been split into Year, Month, and Day!



Setting a default load behavior

When loading data from a data source utilizing Power Query, the operator
has three options for storing the data. It may be entered into a workbook
spreadsheet, a data model, or perhaps both. When just one table is being
imported, the default behavior (and hence the one that will be used most
often) is to load into a worksheet; when many tables are specified, the
default behavior is to load into the data model.

Average users will anticipate viewing the data instantly when it is imported,
thus the load to spreadsheet default is sensible. They won't want to launch
the PowerPivot model editor. Nevertheless, uploading to the worksheet has
a number of drawbacks.

The million-row limitation in Excel, the aspect that data is kept in the
model considerably more effectively, and the data size constraints when
dealing with Power Pivot are the most common limitations.

Because the defaults are Power Query-wide, they're in the Power Query
options. Go to the Power Query tab and choose the Options option once
Excel is opened.



You may now customize your data load settings in addition to joining the
Customer Experience Program. I always import solely to the model;
therefore, I choose Custom and Load to Data Model from the drop-down
menu.

Preventing automatic data types changes

Whenever you utilize Power Query to convert data, it will typically boost
the headers (use first rows headers) and estimate the data types for each
column. You can stop it from doing so. When bringing in structured data,
the layout makes it easy to determine the headers and data kinds.



The two yellow-highlighted steps on the right have been dynamically put
into the Query. The X to the left of each stage may be used to erase it.

The headers have been promoted, which indicates that the names in the first
row of the data have been elevated to column headers.

Date, Text, Integer, and Integer have also been set as column data types 

You might not let that happen, and there is an option you can alter to
prevent it from occurring automatically - see the Settings section below for
more information.

The column headings may need to be manually entered on occasion. This
happens when the first row has a variable entry, such as a date.

The data type for each column is approximated depending on the values of
that column in the Changed Type stage.

Types of Data

The column data types might affect your transformations while conducting
more complicated work in Power Query. For example, if you're conducting
date calculations using a column, you'll require a Date data type.

In certain circumstances, explicitly setting your column data types is
preferable to relying on Power Query to estimate them properly.

Settings

You may disable the two stages marked in yellow in the figure above by
changing a global option.

After you change this parameter, it will affect any Power Queries you make.

Select the Get Data to drop down on the Data ribbon tab, then Query
Options at the base.



Choose the Never detect column... option in the Global Data Load Type
Detection menu and select OK.

The Promote Headers and Changed Type steps would no more be applied
automatically.

The Changed Type step will not be introduced if you promote the headers
manually using the Use First Row as Headers icon.



Avoiding Power Query Performance Issues

There are performance difficulties when there are too many variables or
steps. Power Query allocates RAM for each variable, resulting in a
considerable increase in memory use. It also takes a long time for the CPU
to process so many variables using the Power Query Engine. In the vast
majority of situations, your variables are databases with numerous rows and
columns of data. Therefore, even with hundreds of steps or variables, this
may occur in an actual situation for you. So, you must keep an eye on the
number of variables.

If the problem is caused by a large number of variables, the solution is to
reduce the number of variables. With fewer than a hundred variables,
performance concerns are uncommon; however, as the number exceeds that,
the problem becomes apparent. One thing to keep in mind is that combining
variables makes debugging, troubleshooting, and maintaining the code
more difficult. As a result, only utilize this approach if absolutely necessary.

Using views instead of tables

A database view is nothing more than a saved query over database data.
This saved query can be used to query tables as well as other views (you
can create a view that queries other views). Although this saved query
(view definition) is big data of the database, it does not contain any physical
data!

The first significant distinction between a "normal" table and a view is that
views do not save data. This implies that whenever you require data from a
view, the underlying stored query must be conducted against the database.
Because views are executed every time you "call" them, they always will
select the appropriate data from the fundamental tables. That implies you
don't have to worry whether the underlying table has changed
(deleted/updated rows) since you'll always obtain the real data from the
tables.

Benefits of Using Views

Views have numerous benefits over regular tables under certain
circumstances:



�        Views can (and often do) contain joins between multiple tables,
resulting in a single result set and thus reducing complexity.

�        Utilizing aggregate functions like SUM, AVG, COUNT, and others,
you may pre-aggregate data for your analytic operations using views.

�        Views may be used to restrict access to underlying data: for example,
you might construct a view that only includes sales for the United
States, and then provide appropriate people access to that view. As
you may limit access to a table while providing access to a view-only,
you're not revealing all of the data from the database.

�        Views take up no space in your database (except for a little amount of
RAM used to store query definitions) – and don't forget, views don't
store real data!

Your basic model should be concerned with data storage and retrieval
efficiency. By enabling you to isolate the complications that result from an
efficient, normalized model, views are partially a tool that negates such
difficulties.

Furthermore, comparing "what are the benefits of utilizing a view versus a
table?" is not a good contrast. It's impossible to live without tables, but it's
possible to live without vistas. They're all there for various reasons. Tables
are the actual model, whereas Views are an abstracted version of the
concrete model.

Disabling privacy settings to improve performance

To ensure that sensitive data is only accessed by authorized individuals,
privacy settings must be configured appropriately. Moreover, data sources
must be segregated from one another so that merging data has no negative
influence on data transport. If privacy settings are established improperly,
critical information may be exposed outside of a secure facility. Knowing
and understanding the privacy settings is important and ensuring that they
are set to the proper level for your requirements.

However, a stringent isolation level prevents data from being shared across
data sources, it may decrease functionality and have a negative effect on
performance.



1. Choose File. Click Options and Settings, then pick Data Source
Settings in the Power Query Editor.

2. Choose Edit Permissions from the drop-down menu. The dialog
window for Editing Permissions displays.

3. Choose an option from the drop-down list underneath Privacy
Level:
�        None: There are no privacy options available. Set this parameter

with caution. Ensure that privacy rules are followed in all other
ways. In a controlled development environment, you might utilize
this privacy option for testing and performance purposes.

�        Private: The accessibility of the data source may be limited to
authorized users if it contains sensitive or secret information. It's
absolutely separate from the rest of the data. Facebook data, a text
file detailing stock awards, or a worksheet holding an employee
evaluation are all examples.

�        Organizational: Restricts access to a data source to a certain set
of persons. It is hidden from all public data sources; however, it
may be seen by other Organizational data sources. A Microsoft
Word document on an intranet SharePoint site with permissions set
for a trusted group is a frequent example.

�        Public: Ensures that everyone has access to the data. The public
may only be applied to files, online data sources, or workbook
data. Data from a Wikipedia article or a local file containing data
taken from a public web page are two examples.

4. Choose OK.

Avoiding data transfer by negligence

Privacy Degrees may help you avoid merging data from numerous data
sources that are configured to distinct levels of privacy, such as private and
organizational. Based on the query, you can unintentionally transfer data
from the private data source to a data source that isn't in a trusted scope.
Power Query examines each data source and categorizes it as Public,
Organizational, or Private, depending on the degree of privacy specified. If
there is undesired data transmission, this analysis guarantees that data is not



merged. When a query employs a method called query folding, this data
protection mechanism might also occur.

Conclusion

The productivity of your Power Query matters a lot. When the productivity
is good, the rate of your work will be very fast and neat. So, the tips
explained here will go a long way in helping you achieve that.

 

 

 

 

 



CHAPTER EIGHT

TEN TIPS FOR WORKING WITH POWER QUERY

This chapter emphasizes the Get and Transform (Power Query) capability
in Excel. It illustrates how to use the Microsoft Office Excel Power Pivot
feature to increase productivity and incorporate knowledge in a spreadsheet.
The overall aim is to increase general accounting department efficiency.
This chapter focuses on Excel's time-saving features and approaches. In this
case study, Excel Get and Transform, Power Pivot, big data, and working
capital are all woven into one mosaics.

Select the appropriate connection.

A large variety of data connections are available in Power Query. Data
sources such as TXT, CSV, and Excel files, as well as databases like
Microsoft SQL Server and prominent SaaS services like Microsoft
Dynamics 365 and Salesforce, are all supported by these connections. If
your data source isn't shown in the Get Databox, you may always connect
to it using the ODBC or OLEDB connection.

You will have the greatest abilities and competencies if you use the right
connection for the job. When connecting to a SQL Server database, for
instance, utilizing the SQL Server connector rather than the ODBC
connector not only delivers a far better Get Data experience, but it also
enables capabilities that may enhance your experience and outcomes, such
as query folding.

Each data connection has a consistent user interface. Data Preview is a step
in this standardized experience. If the connection supports it, you'll be given
a user-friendly interface to pick the data you wish to retrieve from your data
source, as well as a rudimentary data preview of that data. You may also use
the Navigator window to choose several datasets from your data source, as
seen in the figure below.



Filtering early.

Filtering your data at the start of your query, or as soon as feasible, is
always a good idea. Some connections will use query folding to make use
of your filters. Filtering away any evidence that isn't related to your case is
also a good idea. By just displaying data that is important in the data
preview area, you will be able to concentrate on the work at hand.

You may pick the values you wish to retain or filter out using the auto filter
option, which provides a separate list of the values detected in your column.
You may also search for values in your column using the search bar.



Performing hard operations last 

Some procedures need reading the whole data source in order to produce
any results, therefore previewing them in the Power Query Editor will be
sluggish. If you sort your data, for instance, the first few sorted rows maybe
toward the end of the original data. As a consequence, before the sort
operation can produce any results, it must first read all of the rows.

Other processes, such as filters, do not need to read all of the data before
delivering any outcomes. Rather, they use a technique known as
"streaming" to work with the data. The data "streams" by, with results being
returned as it goes. Such procedures in the Power Query Editor just require
reading enough of the source data to fill the preview.

Execute such streaming activities first, and any more costly processes last,
if at all practicable. It will assist you to spend less time waiting for the
preview to render every time you create a new step to your query.

Working on a portion of your data for the time being.

If adding additional steps to your query in the Power Query Editor is taking
too long, try conducting a "Keep First Rows" action first to reduce the
number of rows you're dealing with. After that, delete the "Keep First
Rows" step after you've added all the steps you need.



Making use of the appropriate data types

Some Power Query functionalities are dependent on the data type of the
column specified. When choosing a date column, for instance, the Add
Column menu will display the possible choices under the Date and time
column group. These choices will be totally wiped out if the column does
not have a data type selected.

Because type-specific filters are particular toward certain data types, they're
in a similar scenario. These type-specific filters will not be provided if your
column does not have the relevant data type declared.

It's important that you use the right data types for your columns at all times.
When dealing with organized data sources like databases, the data type
information is pulled from the database's table schema. However, when



working with unorganized data sources like TXT and CSV files, it's critical
to use suitable data types for the columns that come from that data source.
For unstructured data sources, Power Query provides automated data type
recognition by default.

Moving or deleting columns to reorganize data.

It's possible that your data is precisely what you want it to be, except for
one little element. It has columns you don't require or the columns aren't in
the order you want to see them. Decluttering and arranging your data is a
simple thing that allows you to concentrate on the essential things. When
using Power Query to import data, this is a simple remedy.

Delete any column from the data by going to the Home tab in the query
editor ribbon and selecting the Remove Columns command, then selecting
Remove Columns from the menu. You may also remove a column by right-
clicking on it and choosing Remove.

Hint: Do the column titles you wish to delete alter from time to time?
Therefore, rather than using the Remove Other Columns command, choose
the columns you wish to maintain. The query will only refer to the columns
you wish to preserve and will not throw any problems if the names of the
columns you removed change the next time you import data.

It's also simple to move columns. Simply left-click on the column header
and drag it left or right to the new spot.

Creating a column based on examples

Making new columns related to existing columns in your data is a typical
occurrence.



In this case, you have quite a list of email addresses and want to add a new
column to each row that includes text such as "Ardeen works at Uber" and
so on.

You must extract the first name and firm from the email address and
combine them while capitalizing the names and companies. To get the
output, you'd have to use a couple of different transformation processes in
Power Query. This implies determining which sequence of actions will
result in the desired outcome. Based on a few of the samples you offer,
Power Query can really find out how to modify the data.

Utilize a modular strategy.

It is totally feasible to write a single query that incorporates all of the
necessary conversions and computations. However, if the query has a lot of
stages, it's a good idea to break it up into numerous inquiries, each of which
refers to the previous one. The purpose of this method is to isolate and
simplify transformation processes so that they are easy to comprehend.

Assume you have a question with the nine stages shown in the figure
below.



At the Merge with Prices table phase, you might separate this query into
two. In that manner, the processes that were performed to the sales query
prior to the combine are clearer to comprehend. To do so, right-click the
Merge with Prices table step and choose Extract Previous from the menu.

After that, you'll be asked to name your new query in a dialog box. Your
query will be essentially divided into two queries as a result of this. Just
before merging, all of the queries will be combined into one query. The
second query will include an essential step that references your new query,



as well as the remainder of the stages from the Merge with Prices table step
downward which you had in your initial query.

You may also take advantage of query referencing if that's what you want to
do. However, it's a great way of keeping your inquiries at a scale that
doesn't appear too complicated at first look.

Future-proofing queries

A primary concern is to make sure you build a query that won't cause any
problems at a subsequent refresh. Power Query has a number of capabilities
that make your query more resistant to modifications and able to refresh
even if certain elements of your data source change.

It's a good idea to describe the context of your query in regards to what it
should perform and what it should provide for in terms of its structure,
layout, column names, data types, and any other relevant components.

The following are some examples of modifications that might help you
to make your query more adaptable to changes:

1. Use the Remove bottom rows feature if your query includes a
variable number of rows containing data but a set number of rows
that act as the footer that should be eliminated.

2. Use the Choose columns feature if your query contains a variable
number of columns but you just need to choose a few from your
dataset.



3. You may use the unpivot just chosen columns functionality if your
query has a large number of columns and you only need to unpivot a
subset of them.

4. You might eliminate the rows that gave error values if your query
involves a step that changes the data type of a column, but certain
cells return errors because the values don't comply with the required
data type.

Making functions that may be reused.

If you often need to apply the same set of changes to various queries or
data, establishing a Power Query custom function that you can reuse as
many times as you need might be useful. A Power Query custom function is
a mapping between a collection of input values and a single output value
that is built using native M functions and operators.

Let's imagine you have a number of queries or data that all need the same
changes. You may write a custom function that you could then use against
your desired queries or data. This custom function will save you time and
allow you to manage all of your conversions in one place, which you can
change at any time.

Existing queries and parameters may be used to develop bespoke Power
Query functions. Consider a query that has numerous codes in the form of a
text string, and you want to write a function to decrypt those values.

Conclusion

So, this chapter listed and explained the tips on Power Query that you can
use to boost its productivity. Ensure that you make use of the tips here for it
will save you lots of time and energy.
 
 
 
 
 



 
 
 
 
 
 



BOOK 5

EXCEL DATA ANALYSIS



 

CHAPTER ONE

 LEARNING BASIC DATA-ANALYSIS

Excel is a sophisticated, user-friendly tool that has revolutionized the way
analysts and businesses approach data analysis in a variety of sectors. Excel
has been the most popular and commonly used data analysis tool since its
introduction.

The application can do both simple and complicated data analysis
procedures. Monetary forecasting, company development, human resource,
and external planning are just a few of the activities that analysts utilize
across a wide range of sectors and use cases.

Having a strong working grasp of Excel can only enhance your abilities.
Users may complete a broad variety of tasks using it. Its methods,
representations, and collections let the user rapidly and properly examine
data without having to do repeated labor.

What is Data Analysis Anyway?

Data analysis often referred to as data analytics, is a method for cleaning,
analyzing, changing, and modeling data. Data analysis makes it simple to
locate and comprehend new information, come up with reliable results,
update and arrange data effectively, and validate a certain statement
procedure.

Though data is critical and the universe has grown more computation, data
in its basic form is insufficient. Data must be reviewed, cleaned, and
changed before it can be used to provide actionable insight. Data analysis is
a term used to describe this kind of procedure.

There is no one-size-fits-all solution. Data analysis may be done in a
number of ways. These many approaches to data analysis are employed in a
variety of sectors, including commerce, sciences, as well as the disciplines
such as sociology. Data analysis is, in reality, something that the modern



corporate world lives on. To fuel corporate development, data analysis is
used to gain business insight.

Data mining is similar to data analysis in that it focuses on uncovering new
information for forecast instead of explanatory reasons. Data analysis may
be divided into descriptive statistics, exploratory data analysis (EDA), and
confirmatory data analysis in statistical applications (CDA).

CDA aims to validate or disprove current assumptions, while EDA focuses
on detecting new characteristics in the data.

Predictive analytics is the process of using statistical models to make
predictions or classify data. Text analytics uses statistical, linguistic, and
structural tools to collect and categorize knowledge from textual sources.

These are examples of data analysis. Due to doing data analysis, data
integration is required. Visual analytics and data distribution are both linked
to data analysis. The words data analysis and data modeling are sometimes
used alternatively.

Performing appropriate data analysis has numerous aspects. Analysts can
easily achieve all of this using Excel. Below are just a few of the many
capabilities Excel has for data analysis:

Sorting 

Excel can easily sort data based on one or more parameters. Users may sort
data in either descending or ascending order, depending on their
requirements. Users may sort lists alphabetically or have descriptive
statistics ranked from lowest to highest, or conversely.

Filtering

This is another kind of data analysis that Excel may conduct alongside
sorting. In Excel, users may divide data into sections and display just the
data points that meet their requirements. This is a fantastic option for
narrowing down data, ensuring that it meets specified criteria, or seeing just
a subset of cells. All of this is performed while the actual data is preserved.
Based on the filter used by the user, the viewable data changes. It is a
realistic method of examining a dataset.



Conditional Formatting

Conditional formatting enables the user to emphasize cells in a certain color
dependent on the value of the cell and the conditions set by the user. It's a
great technique to graphically showcase data or detect outliers and patterns
in data.

Charting

While Excel can quickly edit data sets, it can also generate charts to make
data analysis results easier to understand. Excel charts are user-friendly and
make the data easy to interpret because of their color, simplicity, and
versatility. Excel charting is a basic and straightforward approach to making
your data analysis more understandable to others. In projects and
discussions, Excel charts are useful for delivering crucial conclusions from
data research.

Tables 

The table command converts data into a structured table that may be sorted
and filtered for simple organizing and display.

Pivot Tables

This Excel function allows you to manipulate and analyze big organized
data sets interactively. Pivot tables can extract vital insight from big,
comprehensive data sets and condense it. A spreadsheet describes, sorts,
reassembles, classifies, tallies, totals, or balances the data. It allows users to
effortlessly evaluate enormous data sets in Excel, even those containing
hundreds of millions of data points.

What-If Analysis

Users may use Excel to create scenarios of theoretical events in order to see
how autonomous factors affect two variables. "What would sales be like if
the firm opened two more retail outlets next year?" for instance. Situations,
Goal Seek, and Data Tables are the three kinds of What-If Analysis tools
available in Excel. Scenarios enable you to think about a variety of
circumstances. Data Tables will reveal the influence of one or two variables
on a given calculation, while Goal Seek will assist you in achieving your



desired outcome. All of them enable the user to edit data and execute
simulations of hypothetical situations.

Solver

This is a Microsoft add-in that may also be used for What-If scenarios.
Depending on your specified restrictions or limits, it may discover the ideal
(both minimum and maximum) result for an ideal cell (one containing a
formula). Solver discovers the best solutions to decision issues, allowing
the data to be used more effectively. For instance, a company may utilize a
solver to determine the best marketing strategy for an e-commerce store
based on the market and operating margins for every product.

Analysis Toolkits

You may use this Excel add-in to assist you with difficult analytical,
commercial, and mechanical analysis. It comprises statistical tests like
ANOVA, t-Test, and z-Test, as well as regression, sampling, and Fourier
processing methods for solving complex systems issues.

Descriptive Statistics

Descriptive statistics is one of the Excel Tool Pak add-ins that permits you
to avoid doing separate statistical analyses for regularly used statistics like
mean, mode, and standard deviations. As a result, the user may get
statistical statistics for their data collection with only one click of a button.

Cooking raw data

There are different things you need to follow whenever you are working on
raw data. These steps will guide you through. Below are the steps;

Data Collection: The first stage in doing data analysis is to gather data on
the variables in an organized manner. This kind of procedure will assist us
in determining the answers to critical questions and evaluating the
outcomes. The data-gathering phase is critical because it assures the validity
of the data, allowing legitimate choices to be made based on it.

Data collecting is also beneficial since it provides a baseline against which
you can assess progress and a goal to strive towards. In terms of Excel, you



may gather and import data from a variety of different sources.

Cleaning of data

Finding and repairing flaws in a dataset is the goal of data cleaning. It also
entails replacing any components that are missing or incorrect with the
proper ones.

The approaches listed below may be used to clean data in Excel:
1. Getting rid of redundant values
2. Eliminating blank spaces
3. Combining and dividing columns
4. Joining or matching table data to reconcile it 

1. Getting rid of redundant rows:

Once you have a lot of data, it's probable that some rows may be duplicated.
Before removing duplicate values, it's a good idea to filter for distinct
values first to ensure that the results are what you want. Thankfully, Excel
has a built-in tool for removing duplicate data from a table. It allows you to
eliminate duplicate values from a table depending on the columns you
choose.

2. Eliminating Blank Spaces:

It's conceivable that your Excel data includes preceding, ending, or
numerous inserted space letters. Whenever you sort, filter, or search with
these characters, you may get surprising results. You may, however, utilize
Microsoft Excel's Trim function to eliminate all spaces from the text but
apart from singular spaces between words.

3. Combining and dividing columns

Merging or splitting two or more columns into one, or splitting one column
into two or more columns, is popular in Excel. For example, you could wish
to break an address column into distinct columns for street, city, region, and
postal code.

4. Joining or matching table data to reconcile it

When two or more tables are connected, Excel may also be used to discover
and repair matching mistakes. It's possible that you'll have to reconcile two



tables from distinct workbooks. It may be used to view all entries in both
tables or to compare tables and detect rows that don't match, for example.
The method Vlookup() will assist you in completing this operation.
Vlookup() searches the first column of a table array for a value and returns
a value from another column in the table array in the same row.

Exploration of Data Using Pivot Tables

Data Exploration is the process of using statistical information and
visualizations to undertake preliminary studies on data in order to uncover
patterns, anomalies, test hypotheses, and verify hypotheses.

Why does it worth so much? Because you can utilize data exploration to
make sense of what you have. You may then choose what queries you want
to ask and how to phrase them, and also how to effectively modify your
data sources to get the information you want.

Visualization of Data:

Given the importance of data exploration, data visualization as a tool for
doing so becomes more relevant. The presenting of data in a pictorial or
graphical style is known as data visualization. The importance of such a
graphical style is that it allows decision-makers to view analytics displayed
graphically. In other words, they have a far easier time grasping complex
topics or recognizing new patterns. The most common capabilities for data
visualization in Excel are charts and pivot charts (Charts and Pivot Charts).

Dealing with data

You may be curious about how data analysis operates. There are ways you
deal with data in the data analysis process. For your convenience, here is a
step-by-step breakdown of the process of data analysis:

Defining Requirements for Data

It is critical to identify the data needs from the start in order to do a
successful data analysis. Let's pretend the information is about the
population. If that's the case, certain factors like age, income, and so on
must be stated and retrieved. The information gathered might be numerical
or categorical.



Data Gathering

After the variables have been defined, the data for the variables must be
gathered. It may be gathered from a variety of places and made accessible
for processing. In its current state, this data may not include any useful
information. As a result, it must be treated and cleaned.

Processing of Data

The information gathered must be arranged in order to be analyzed further.
This would include reorganizing the data in a certain manner so that it can
be used by different analytic tools. For example, you may need to arrange
the data in a table with rows and columns for further analysis in a
Spreadsheet or Statistical Application. It's possible that you'll need to
construct a data model as well.

Cleaning of data

While the information may be structured, it may also be lacking. It's still
possible that some of the products are duplicates. There's a chance you'll
make a few mistakes. Data cleaning is a method of correcting these
inaccuracies and ensuring that the data is accurate. Cleaning the data may
be done in a variety of ways. If it involves financial information, totals will
almost certainly be included. These totals may then be compared to real-
world public data or other variables. The data may be cleansed in this
manner.

Analyzing the data

Data is available for analysis after it has gone through different steps such
as processing and cleansing. Data analysis may be done using a variety of
methods. Data visualization may also be used to visualize data in a visual
way. Data analysis may also be done using well-known forecasting methods
such as correlation or regression analysis.

Communication

While data analysis may seem to be the last phase in the process, the results
must be delivered to the end-users in a systematic manner. The results may
be required in a certain format by the end-users. Some data visualization



approaches, such as tables and charts, may be quite effective in this
situation since they can express the idea quickly. Color coding and other
techniques may assist you to make it easier to understand and convey your
results.

Building data models

The Data Model is used to create a model in which data from multiple
sources may be merged by establishing linkages between them. A Data
Model joins the tables together, allowing for in-depth analytics utilizing
PivotTables, Power Pivot, and Power View. By constructing connections
based on a common column, it is possible to integrate data from various
tables.

This data model enables data to be loaded into Excel's storage. It's
preserved in memory, where we can't view it immediately. Then you may
tell Excel to use a similar column to link the data together.  Even though the
information is spread across different tables, the Data Model can obtain it
all. Excel does have the data in its cache once the Data Model is built. The
data in its memory may be obtained in a variety of ways.

Whenever you load two or more tables from a database at the same time, a
Data Model is built automatically. The Data Model in Excel is built using
the existing database connections between those tables.

The first thing to do before building a table is creating  to get some data.
Simply click on Data. Pick Get and Transform Data. Then, pick Get Data.
This is done so as to import data from any external sources.

When you have done this, a table will be presented before you. If you need
multiple tables from one particular source, then you need to click on the
box next to the Enable selection of multiple table option. A data model will
be created for you by Excel whenever you choose more than a table.



So, choose one or more tables. Then, pick Load. You can edit the source
data if you want to. Simply click the Edit option there. So, you have a data
model with the tables you have loaded. They will be displayed in the Pivot
Table Field List.

Note: Whenever you import two or more tables into Excel at the same time,
models are built implicitly.

When you utilize the Power Pivot add-in to import data, models are
generated directly. The model is displayed in the add-in in a tabbed form
similar to Excel, with each tab containing tabular data.

A single table may be included in a model. Pick the table and hit Add to
Data Model in Power Pivot to construct a model based on only that table. If
you wish to leverage Power Pivot capabilities like filtered datasets,
calculated columns, calculated fields, KPIs, and hierarchies, you may do
this.

If you import linked tables with main and foreign key connections, table
connections will be generated automatically. In most cases, Excel can
utilize the imported connection data to create table connections in the Data
Model.



Performing what-if analysis

What-If Analysis is the act of altering cell values to observe how such
changes influence the results of formulae on the spreadsheet. Scenarios,
Goal Seek, and Data Tables are three types of What-If Analysis tools
included with Excel. Scenarios and data tables use a collection of inputs and
predict what could happen.

A Data Table only has one or two variables, but those variables might have
many distinct values. Although a Scenario may contain several variables, it
can only have 32 values. In contrast to Scenarios and Data Tables, Goal
Seek takes a result and finds potential input values that create that result.

When you have a data table in excel, it is easy for you to differentiate
between one or two inputs and you will perform a What-if analysis. The
two types of Data Types include; One-variable Data Tables and Two-
variable Data Tables. When your analysis problem contains more than two
variables, you will utilize the Scenario Manager Tool.

One-variable Data Tables

This type is utilized when you want to examine the difference between the
values of a variable and another variable and how the formula affects the
outcome of the calculations. You use this to see how altering one input
affects another number of outputs.

We will work with the example below;

Example: John has a loan of 5,000,000 for a tenure of thirty years. Now,
you would like to figure out the payments that are made monthly for
different interest rates. You also want to know the interest amount and its
principal that is being paid the second year.

So, to carry this out, you have to follow the three steps below;
1. Setting the background
2. Creating the Data Table
3. Performing the Analysis

First Step: Setting the Background
Let’s assume that the interest rate is twelve percent.



Then, put in all the values required
Assign a name to the cells that consist of the values. This is done so
that the formulas in the data will have names rather than having cell
references.
Put the calculations for EMI, Cumulative Interest, and Cumulative
Principal with the functions in Excel (PMT, CUMIPMT, and
CUMPRINC).

The image below is how your worksheet should be;

 

Second Step: Creating the Data Table

Here, you will put in the list of values. There are the interest rates that you
will like to replace in the input cell. In the image below, you will find out
that there is a space in the first row of the Interest Rate values. This is
because, on that row, is where you have to put in the formula which you
want to use.



Enter in the first function (PMT) in the cell one row above one cell to the
right. Enter the other functions in the cells to the right of the first function.

Third Step: Performing the Analysis
First, choose the range of cells. The cells to be chosen should contain
the formulas and the values which you wish to substitute.
Select the Data Tab and pick What-If analysis.
Pick Data Table. The dialog box will display.
Choose the icon in the column input box.
Select the Interest Rate cell. Click Ok.
The calculated results will be displayed for you.

Two-Variable Data Table



This is used to examine how varying values of two variables that are in a
formula affect the outcome of the formulas. you utilize it to see how two
input affects a single output. Let’s work with an example.

Example: JOHN has a loan of 50,000,000 and you would like to know the
combinations made for the interest rates and loan tenures and the
differences in them affects the payments made monthly. Just like the One-
Variable Data Table, we will utilize the same steps.

1. Setting the background
2. Creating the Data Table
3. Performing the Analysis

First Step: Setting the background
Let’s assume that the interest rate is twelve percent.
Then, put in all the values required
Assign a name to the cells that consist of the values. This is done so
that the formulas in the data will have names rather than having cell
references.
Put the calculations for EMI (PMT)

Second Step: Creating the Data Table

Enter =EMI in cell F2



Put in the first list for the input values. Then, enter the second list for the
input values.

Third Step: Performing the analysis
Pick the cell range that consists of the formula.
On the Data tab, pick What-If analysis.
Choose the Data Table. On the dialog box, select the icon in the Row
input cell.
Pick the NPER
Click the Row icon again and select the icon in the Column input cell.
Select the cell Interest Rate and click the Column icon again.

 



Analyzing Data with Conditional Formatting

In Excel, conditional formatting is used to emphasize data based on certain
conditions. It would be tough to see different patterns merely by looking at
your Excel worksheet. In Excel, conditional formatting allows you to
visualize data and make spreadsheets more understandable. It enables you
to add formatting to cell values such as colors, icons, and data bars based on
the cell values. For data visualization, you may utilize Conditional
Formatting. Processing for a cell range must be specified depending on the
contents of the cell range. The cells that fulfill the provided criteria will be
formatted according to your specifications.

It makes it simple to scan your data and check for vital signs graphically.
With numerical data, conditional formatting works best. Simply choose a
column of data and make sure you're on the Home tab of Excel's ribbon to
get started. From the Conditional Formatting dropdown menu, you may
choose from a variety of styles. Each of the formats your cells in a different
way, but they all adjust to the cells you've highlighted.

Instance

You may emphasize those cells in a range holding the sales statistics for the
previous quarter for a group of salespeople who have fulfilled the stated
objective, such as $2500.

You may give a color code of green and a requirement of total sales of the
individual >= $2500. Excel evaluates each cell in the range to see whether
the criterion you set, i.e. the person's total sales >= $2500, is met.

Excel uses the format you specified, i.e. the green color, to highlight any
cells that meet the requirement. The formatting of a cell stays unaltered if
the content of the cell does not meet the requirement. The outcome is as
predicted; only the salespeople that reached the goal have their cells
highlighted in green, providing a simple visual representation of the
analysis findings.

Highlighting cells that meet some criteria

You can utilize the highlight cell rules to give a format to the cells that the
contents in it meet up the following criteria;



1. Numbers within a particular numerical range-
Equal To
Less Than
Between
Greater Than

2. Text that consists of particular text strings

3. Dates that occur within a particular date ranges
Yesterday
Today
Next Month
Tomorrow
This month
In the last seven days
Last month
Last week
Next week
This week

4. Values that are duplicate or unique

With the steps below, you can conditionally format cells.

First, you pick the range that is to be conditionally formatted.
Move to the style group on the home tab and pick Conditional
Formatting.
Select Highlight Cells Rules.



From the options listed for you, you can select the ones you want to
highlight. When you click on any of the options, for instance, you select
Greater Than, you will be directed to a menu where you will be asked to
input the number which is to be greater than and the format to be used. Just
as you can see in the image below.

When you are done, click Ok. You will have the cells selected with the
color you have picked out.

Showing pesky duplicate values

Simply follow the same steps above but now you will select Highlight cell
rules and pick Duplicate Values.



Then, you follow the on-screen instructions in the dialog box where you
will put in the values and the format you want.

Highlighting the top or bottom values in a range

Simply follow the same steps above but now you will select the Top or
Bottom rules.



Then, put the values in the next dialog box and the format you want for it.

Analyzing cells values with color scales

Color Scales may be used to examine how a cell's value compares to the
values in other cells in a range. Color Scales, like Highlight Cells Rules,
employ cell shading to show the changes in cell values. To a set of cells, a
color gradient will be applied. Each cell value's color shows where it falls
within that range.

Select the column or row. Click on Conditional formatting and select
Color Scales which will display a list of different color scales for you to
select from. Select one and it will be applied to your worksheet.



Analyzing cells values with data bars

Colored Data Bars may help you see how a cell's value compares to the
values in other cells. The value in the cell is represented by the length of the
data bar. A greater value is represented by a longer bar, whereas a lesser
value is represented by a smaller bar. Blue, green, red, yellow, light blue,
and purple are the six solid colors available for the data bars.

Whenever you have a lot of data, data bars may assist you to see the higher,
lower, and intermediate numbers. Daytime temps throughout areas in a
given month, for instance. Gradient fill color bars may be used to illustrate
a cell's value in relation to the values in other cells. Blue, Green, Red,
Yellow, Light Blue, and Purple are the six Gradient Colors available for the
Data Bars.

Horizontal bars are shown directly in the cell using the data bars conditional
format. The length of the bar is determined by the cell's value in
comparison to the other values in the range. To do this, simply select the
column or row. Click on Conditional formatting and select Data bars
which will display a list of different data bars for you to select from.



Pick one and the effect will be applied to your worksheet.

Surprisingly, the colors used for data bars are not theme colors if you pick
one of the 12 data bar types. The data bar colors do not change when you
alter the document theme. However, if you use the New Formatting Rule
dialog box to add the data bars, the colors you pick are theme colors.

Analyzing cells values with icon sets

An icon set comprises three to five symbols, as you can see. To connect an
icon with each value in a cell range, you may create criteria. Small numbers
are represented by a red down arrow, high numbers by a green up arrow,
and intermediate values by a yellow horizontal arrow.

Select the column or row. Click on Conditional formatting and select Icon
Sets which will display a list of different icon sets for you to select from.



Select one and it will be applied to your worksheet.

Creating a custom conditional-formatting rule

Although Excel comes with several "presets" for conditional formatting,
they are restricted. You may, however, construct rules using your unique
formulae. You may take over the situation that activates a rule and apply
precisely the reasoning you need by creating your formula. Formulas
provide you with the greatest amount of power and versatility.

To new rules, simply choose the cells. Then, on the Home tab, click on
Styles > Conditional Formatting > New Rule. This will open up the new
formatting rule dialog box. Click on the Use a formula to determine
which cells to format option, and then type in the formula.



The formula has to be logical. It must return either TRUR or FALSE. When
it is true, the conditional formatting will apply but when it is false, it will
not apply. Note that the formula must start with an equal to (=) sign. Click
Ok.

To access the conditional formatting rule, which you have created, click on
Manage Rules on the conditional formatting menu. if the selection has
cells that have conditional formatting applied to it, the rule will display in
the Rules Manager window.

But if the current selection has no cells which have conditional formatting
applied to it, then, the rules will not display. So, to make it display, click on
the drop-down arrow on the “Show formatting rules for” option and select
“This Worksheet”. It will display all the rules and conditional formatting
you have applied to that worksheet.



Editing a conditional-formatting rule

Simply choose the rule and pick the Edit rule.  The Edit Formatting Rule
box will display. On it, you can change the Rule Type, the Rule Description,
and the Formatting. After that, click Ok.

Removing conditional-formatting rules

Use the Clear Rules option to delete all the formats you have created. You
can do so on the selected cells, the current worksheets, the selected table,
and the selected PivotTable.

Summarizing Data with Subtotals

In a list, Microsoft Excel can generate subtotal and grand total numbers
instantly. Excel highlights the list whenever you add automated subtotals so
you may show and conceal the detailed rows for every subtotal.

To add subtotals, organize your list so that the rows you wish to subtotal are
together. Subtotals may then be calculated for any column with numbers.
You may use AutoSum instead of automated subtotals if your data isn't
arranged as a list or if you simply require a single total.

How are subtotals calculated?



Subtotals: A summary function in Excel, such as Sum or Average, is used
to compute subtotal numbers. Subtotals may be shown in a list with many
types of calculations at the same time.

Grand Totals: The numbers in the subtotal rows are not used to calculate
grand totals; instead, they are obtained from detailed data. When you use
the Average sum method, for instance, the grand total row shows the
average of all detail rows in the list, not the values in the subtotal rows.

Automatic Recalculation: As you modify the detail data, Excel
immediately dynamically adjusts the subtotal and grand total figures.

You may use Excel Subtotal and Outline to show overview rows or columns
if you have a set of data that you wish to organize and summarize. You may
also use PivotTable for this, but the fastest approach to study a range of data
is to utilize Subtotal and Outline. It's worth noting that Subtotal and Outline
may only be used on a range, not a table.

You may have up to eight layers in your outline, one for each group. Lower
numbers signify outside levels, whereas higher numbers reflect inner levels.
Each inner level offers extensive information about the outer level before it.

Grouping related data

Simply select the rows or the column for the grouping. Then, click on
the Data Tab and select Group from the Outline Section.

This will show the Group dialog box. On it, you are to choose the
rows or columns. Then, click Ok when you are done.

Consolidating Data from Multiple Worksheets

You may combine data from individual worksheets into the main
spreadsheet to summarize and present findings from many spreadsheets.
The worksheets may be in the same or other workbooks as the main
spreadsheet. Whenever you consolidate data, you combine it so that you can
modify and combine it more readily as needed.

For instance, if every one of your branch headquarters has its own
expenditure spreadsheet, you may utilize consolidation to combine these
statistics into a specific enterprise expenditure spreadsheet. This main



spreadsheet might include revenues totals and averages, current inventory
levels, and the company's best-selling goods.

There are two ways you can consolidate data which are Consolidating by
position and Consolidating by category

Consolidating by position

The data inside the original area will be in the same sequence as the data in
the destination areas, and the labels are the same. This approach may be
used to combine data from a number of spreadsheets, such as a cost
estimates spreadsheet built out of the same templates.

Consolidating by category.

Whenever the data in the original area is not in the same order as the data in
the destination areas, the labels are the same. To integrate data from a
succession of spreadsheets with varied layouts but the same data labels, use
this procedure.

To combine many spreadsheets into the main spreadsheet, follow these
instructions:

1. Build up the data in each component sheet as follows if you've not:
Ascertain that each data range is in list format. In the first row,
every column should have a description (header) and
comprises comparable data. In the whole list, there should be no
empty rows or columns.

Set each range on its own spreadsheet, but leave the main
spreadsheet blank until you're ready to integrate the data. This is
something Excel will take care of for you.

Ascertain that every range has the same design.

2. In the main worksheet, pick the upper-left cell of the area i.e. the
place you want the consolidated data to display.

3. Select the Data Tab and choose to Consolidate.

4. Now, the Function box will show. Pick the summary function which
you want Excel to utilize when consolidating the data. SUM is the



default function.

5. Pick your data. In the box on the reference option, click the Collapse
button. This is to shrink the panel so that you can select the data.
Choose the worksheet that has the data. Choose the data and select
the Expand Dialog button.

In a situation whereby the worksheet that has the data you want to
consolidate is in another workbook, you have to select the Browse option.
Search for the workbook and find the file.

6. Click Add. Then, repeat the steps so that you can add the ranges for
the consolidation.

7. You can choose between automatic updates and Manual updates. If
you want it automatically, then click the box next to the Create links
to source data option. When the box is not clicked, it will update
manually.

8. Select Ok.

Conclusion

Data analysis is a key aspect of every organization, and understanding how
to utilize it flexibly when the situation calls for it is crucial. Excel and data
analysis might be a great mix for this. Understanding your way around
Excel and being comfortable doing data analysis with it can assist your



business and profession. Whilst also starting up with Excel is simple,
understanding it for data analysis will take some effort. It may, however,
open doors for you at any age or level of your work. It is not too late to
acquire or update your Excel abilities, particularly for data analysis,
whether you're just commencing out or have been in a certain sector of
work for so long.

 



CHAPTER TWO

WORKING WITH DATA-ANALYSIS TOOLS

Working with data tables

Data tables are utilized to check the comparison between variables and how
they affect the data and its outcome. It is a kind of What-If analysis tool that
is found in the data tab in the What-If analysis section. This data table is of
two types and is One Variable and Two-Variable.

Creating a basic data table

We will be working with the one variable here. The one-variable data table
is helpful in instances when an individual wishes to see how changing
interest rates affect the amount of money they have to pay on their
mortgage. Examine the graph beneath, which illustrates the mortgage
amount estimated utilizing the PMT function dependent on the interest rate.

The mortgage amount is determined depending on the interest rate,
mortgage duration, and term loan in the table provided. The monthly
mortgage payment is calculated using the PMT formula, which is
represented as =PMT (C4/12, C5,-C3).

When calculating the monthly mortgage payment for various interest rates,
the interest rate is treated as a variable. To do so, you'll need to create a data
table with just one variable.



The following are the procedures to make a one-variable data table:
1. Make a column that will contain the values of the interest values.
2. Choose an empty cell and type in the formula. Use the column for the

Monthly Mortgage as the cell reference.
3. Highlight the whole column for the different values. Also, highlight

the cell where you have inserted the formula.
4. Select the Data Tab and choose What-If analysis. Then, pick Data

Table
5. The dialog box will open. Enter the Row input cell and the Column

input cell. You can do so by clicking on the cells in your worksheet.
6. Click Ok.

Another Example using the Two-Variable data table.

Two-variable data tables are helpful in situations whenever a user wants to
see how their formula's outcome differs when two input variables are
changed at the same time. The two-variable data table is helpful in
situations when a person wants to see how varying interest rates and loan
amounts affect the amount of money needed to pay off a mortgage. We may
see them with immediate outcomes rather than calculating for different
variables individually. Examine the graph below, that illustrates the
mortgage amount estimated using the PMT function dependent on the
interest rate.

The preceding sample is identical to our earlier sample for a one-variable
data table. Cell C6 calculates the mortgage amount depending on the
interest rate, mortgage duration, and loan amount. The monthly mortgage
payment is calculated using the PMT formula, which is represented as
=PMT (C4/12, C5, -C3).



To illustrate the two-variable data table with relation to the preceding
sample, we will present the various mortgage amounts and let you select the
best one for you by looking at the various interest rates and loan amounts. It
is necessary to create a two-variable data table in order to accomplish this.

Creating a two-input data table
On a worksheet, type in your values in a range of cells. For instance,
cell B15 to B19.
In another cell range, type in another value. For instance, cells C14 to
G14
In cell B14, enter in the following formula; =A14*2+A15
Choose cell B14 to G19
Click Table in the Data Tab. Enter in A15 in the row input and enter
A14 in the column input.
Click Ok.

Analyzing data with Goal Seek

Goal Seek is a What-If Analysis tool integrated into Excel that
demonstrates how one variable in a calculation affects another. It decides
whatever value to input in an input cell in order to receive the expected
results in a formula cell.

The nicest part of Excel Goal Seek is that it does all of the work for
you, and all you have to do is provide these three parameters:

Target/desired value in a formula cell
The cell that must be changed in order to meet the goal

The Goal Seek tool is particularly effective for parameter estimation in
corporate finance, and it is commonly used by management students and
company owners. However, there are numerous additional applications that
may be beneficial to you.

Goal Seek, for instance, may inform you how many sales you need to
accomplish in a certain time to achieve a $100,000 yearly net profit
(example 1). Or, what grade do you need to get on your final test to get a 70
percent total passing grade (example 2)? Alternatively, how many votes do
you need to win the election? (example 3).



Stop making assumptions and utilize the Excel Goal Seek function if you
want a formula to deliver a certain result but aren't sure what input value
inside the calculation to alter to obtain that result.

At any one moment, Goal Seek can only process one input value. If you're
working on a complex marketing strategy with several real numbers, the
Solver add-in may help you identify the best answer. So, let’s look at how
to use this tool.

The table you are seeing above shows that when you sell 100 items at 5
dollars per item, you will get $450, with the 10% commission not included.

Below is how you analyze your data with this tool:

Set your data. It should have a formula cell as well as a changing cell
which will be dependent on the formula cell.

On the Data tab, select the Forecast Group. Choose the What-If
analysis icon and pick Goal Seek.

In the dialog box, choose the cell or values. You will find the
following in the box;

By changing cell: This is the input reference for which you will
adjust
Set cell: This is the cell reference that consists of the formula

To value: This is the result of the formula that you are trying to
get.

Click Ok.
The Goal Seek Dialog box will show. It will inform you whether
there has been a solution or not. When there is a solution, the
changing cell value will be substituted with another value.
Select Ok.



Analyzing Data with Scenarios

As a company owner, you devote much time weighing the pros and cons of
various business conditions. It could be the pricing of a particular model,
adjusting budget estimates, or evaluating alternative leases or items you're
thinking about buying.

Whatever you're computing, you'll want to evaluate various options to see
which one is perfect for you. Excel is a useful tool for examining various
situations, and its Scenario manager feature makes comparing choices side
by side a breeze.

To utilize the Scenario tool, you must first construct a spreadsheet
containing mathematical formulae that will serve as the foundation for your
study. This form of a worksheet is known as a model, and it's where you'll
put the data for each of the objects you're analyzing.

Create a Scenario

First, you have to set up your worksheet. So, on a new worksheet,
give sheet one a name. Name it Budget.

On that sheet, put in the marketing budget.

Name the following cells

B1: Dept

B3: Sales

B4: Expenses

B6: Profit

Type in the formula in cell B6: =Sales – Expenses

Below are the steps to create the scenario

Move to the Data Tab and choose What-If Analysis

Select Scenario Manager. Click the Add icon.

Enter the name for the scenario that you want to create. Here, use
Marketing.



Navigate to the Changing cells box. Choose cell B1.

Press the control key and choose cells B3 and B4. You have a limit of
32 changing cells

Navigate to the Comment box. Enter the comment which will explain
the scenario. This is optional

Select Ok.

On the Scenario Dialog box, you can adjust the values in it.

Click Ok.

Select Close.

Edit a Scenario

Move to the Data Tab and choose What-If Analysis

Select Scenario Manager. Select the scenario you want to edit by
highlighting its name.

Select the Edit button. Then, make your modifications

Select Ok.

Delete a Scenario

Move to the Data Tab and choose What-If Analysis

Select Scenario Manager.

Choose the scenario name that you want to delete and press Delete.

Optimizing Data with solver

Understanding solver

Solver is a Microsoft Excel add-in tool that may be used for what-if
analysis optimizations. Optimization analysis, according to O'Brien and
Marakas, is a more advanced expansion of goal-seeking analysis. Rather
than specifying a precisely targeted value for a parameter, the purpose is to
determine the best value for one or more target variables while keeping



certain limitations in mind. Then, according to the established limitations,
one or more additional variables are adjusted frequently until the optimal
values for the target variables are discovered.

Solver is a feature in Excel that allows you to determine an ideal value
(maximum or minimum, or a specific value) for one formula in one cell
called the objective cell, subject to particular restrictions or limitations on
the values of other formula cells on the spreadsheet. This implies that the
Solver uses a set of cells known as choice variables to compute the
formulae in the goal and limitation cells. The variables in the choice
variable cells are adjusted by Solver to fulfill the constraints on constraint
cells and generate the desired outcome for the goal cell.

The advantages of solver

Linear Algebra

Balancing equations using a single unknown parameter is a comparatively
simple operation. When there are numerous unknowns in a large number of
input equations, nevertheless, the method becomes considerably more time
demanding and difficult. Solver's capacity to analyze cases with several
unknown variables fast is an important feature. This is commonly known as
"linear algebra." While traditional Excel formulae do simple calculations,
Solver goes a step further by using Excel's math processor to conduct
complex problem-solving algorithms to get outcomes for numerous
variables at the same time. This is especially beneficial when there are a lot
of unknowns or when there are many separate sets of equations.

Optimization

Solver's main aim in the business sector is optimization. Many product
development cycles, like linear algebra, are impacted by several variables,
each of which may have a major operating margin or quality control. The
solver can swiftly discover the importance of these aspects in meeting a
company's intended objectives if the link between these factors and those
goals can be represented quantitatively. For example, if you want to start a
new vehicle service business and have half a million dollars, you may want
to figure out how many cars you can acquire as a fleet. This is your
objective, however, there are certain limitations. The amount of money you



have is obviously a constraint, but you may also need specific minimum
automobile sizes. The solver can show you how to fulfill all limitations
while still getting the most fleet for your money if you can articulate them
as mathematical assertions. Solver has streamlined your business strategy in
this manner.

Education

While Excel's solver is a wonderful foundation for the potential of "what if"
analysis, it is also a restricted product for tasks that are extremely vast.
Many businesses have their own specialized software that functions in a
similar way as Solver but can handle far bigger data sets and many
variables at the same time. These techniques, on the other hand, are out of
reach for students who need to grasp the principles of optimization and
linear programming, a related mathematical discipline. Excel's widespread
use has led to certain educational institutions including Excel Solver in their
curricula. This application is a huge help for educational institutions that
need to explain these ideas without investing in more complex tools.

Loading the Solver add-in

On the workbook, click on the File Tab and choose Options.

Click on Add-Ins and choose Manage Excel Add-ins.

On the dialog box, tick the box on the Solver Add-In option.

Click OK.

Adding constraints to Solver

Select Add on the Subject to Constraints which you will see below
the Solver Parameters Box.

Put in the cell reference for the constrain. You will use a single cell or
a range of cells. You cannot use multiple cells.

Select the relationship that you want. the relationship is what you
want to be in the middle of the constraints and the cell reference.



Enter a number in the Constraint box. It can be a formula, cell
reference, or name.

Select Add if you want to accept the constraints and put another one.
Click Ok to just close the box.

Conclusion

There are different data analysis tools that you can work with in Excel.
Some of them have been listed out here. Utilize the examples listed in this
chapter to help you know how to use them.

 



CHAPTER THREE

 INTRODUCING EXCEL TABLES

Being systematic is one of the keys to successful data analysis. I'm not
referring to your desk or workplace, but rather your data. Data processing
from a spreadsheet with hastily put numbers and text will be almost
difficult. Why? Because Excel is the software world's tidy freak. Excel
serves up its hands and cries, "I can't operate under these circumstances!" if
data is scattered around the page in any manner.

However, Excel recognizes that the rest of us aren't that organized, so it
provides the table — a powerful tool that can help you not just line up your
data like soldiers on parade, but also analyze it and extract relevant
information. In this chapter, you'll learn what tables are and why they're so
important in data analysis. You'll also learn how to create, analyze, sort, and
filter a table.

What are a Table and its importance?

Tables are utilized to arrange data that would be too extensive or complex
to be fully presented in a paragraph, enabling the viewer to see the findings
swiftly. They may be utilized to emphasize data patterns and themes, as
well as to remove numeric data from a document to make it more legible.

Tables make provision for quick and easy reading of problems shown in
rows and columns. Due to their basic form, versatility, and simplicity of
adaptation, they may be used as a standard method for advantage dialogue.

Microsoft Excel makes it simple to create tables and do computations. Its
working area consists of a series of cells that must be filled with
information. As a result, the information may be structured and utilized to
create graphs, charts, and summary reports. Working with tables in Excel
may seem hard at first look to a novice. It varies significantly from Word's
table creation concepts.

 Understanding a table’s structure



A table in excel consists of many elements which are explained below;

The header row

Every table in Excel consists of a header row. The columns in a table have
filtering enabled in the header row. This is to enable you to filter your table
as well as sort it easily.

Calculated columns

You may build a calculated column by inserting a formula in one cell in a
table column and having that formula automatically applied to all other
cells in that table column.

The total row

When you add a total row to a table, Excel provides an AutoSum drop-
down list from which you may choose among functions like SUM,
AVERAGE, and others. When you choose one of these choices, the table
will convert it to a SUBTOTAL function, which by default ignores rows
that have been concealed by a filter. You may adjust the SUBTOTAL
function parameters to include hidden rows in your computations.

Building a Table

Tables in Excel are useful for providing data collections structure. It
contains several useful features, such as data organization, headers, and
applied filters. Tables may be accessed via the Insert menu tab or the
shortcut key Control key + T. All we have to do now is choose the range of
cells we want to include in the table. The Design tab, which appears when
we pick the table, allows us to adjust table styles.

Follow the steps below to create a table.

Choose the cell or range you want to create the table on.

Click on the Home tab, then click on Format as Table. This will display a
menu that consists of some table styles. Choose any style you want.



When you click on the style you want, a dialog box will open. Check the
box on the My table as header (Checking this box makes the first row of the
range the header row) and click Ok.

Converting a range to a table

First, select the range that you want to convert. Click on the Insert
Tab and choose Table.



The dialog box for table creation will display. Click on the box next
to the My table that has headers i.e. if it has headers. Click Ok.

You can also format it as a table if you want to. Simply choose the range,
then on the home tab, choose Format as Table. Then, pick the table style
you want. Follow the on-screen instructions.

Analyzing Table Information

Choose the cell that you want to analyze. Select the Quick Analysis
button that shows at the bottom right of the data you have selected.
You can also do this by pressing the Control key + Q.

Choose the tab that you want. Select an option.

We can use a pivot tool to summarize large volumes of data. It is mostly
used to comprehend and detect patterns in the data set and is one of the
finest methods to analyze data in Excel.

Pattern recognition in a tiny dataset is straightforward. However, because of
the size of the datasets, finding patterns typically requires extra research. A
pivot table may be a tremendous help in these situations since it simply
takes a few minutes to summarize groupings of data using one.

Consider the following scenario: you have a dataset with regions and sales
numbers. You may be interested in knowing the number of sales by region,
which may be utilized to discover why a region is underperforming and
how to improve in that area. You may quickly produce a report in Excel
using a pivot table and store it for further examination.

In Excel, a Pivot Table enables you to summarize data as averages, sums, or
counts from data in another Spreadsheet or table. Because you can organize
and view data rapidly, it's ideal for swiftly creating reports.

For instance, if you're doing data analysis, you could have created a
spreadsheet that you can copy and paste into Excel, or use in Google Docs
if you prefer (simply go to File > Make a Copy).

The spreadsheet includes data from a fictitious company's client purchases.
Because firms buy at various times, we'll use a pivot table to aggregate this



data so we can view total purchases per company and compare transactions
across companies for easy analysis.

Adding a column subtotal

First, you have to choose the data range. Then, choose Data and
choose Subtotal.

A dialog box will display and that is the Subtotal dialog box. Select
the options you want from the list of options given to you.

After that, select Ok.

Sorting table records

One of the most frequent data management tools is sorting. You may sort
your table in Excel by one or more columns, ascending or descending order,
or by performing a custom sort. First, click on the cell. Then, click on Sort
& Filter.

You will have different sorting options.

Sort A to Z: This is to sort in ascending order
Sort Z to A: This is to sort in descending order
Custom Sort: This is for applying various sort criteria in multiple
columns.
Click on Custom Sort, then click Add Level.



Then, enter in how you want it to be sorted. Once you are done, click Ok.

Filtering table records

Click on cell on your worksheet. On the ribbon, click on the Data tab, then
select Filter.

Now, click on the arrow on the column header.

Then, click on Number Filters. Select any filter option.



Filtering a table with slicers

Adding Slicer filters to your tables may dramatically boost the usability of
tables by allowing you to filter table data more quickly and simply. Choose
the table for filtering. Then, click on Insert Slicer. You can find the Insert
Slicer on the Design tab on the ribbon.

When you click on Insert Slicer, it opens up a dialog box. On it, you are to
check the boxes of the field in the table in which you want to filter with a
slicer.



Then, click Ok.

Tables are among Excel's most powerful features, but when you add Slicer
filters to them, you significantly increase their use by allowing you and
your team to swiftly filter tables without having to utilize the typical drop-
down filter environment.

Changing the table’s appearance

What's the first thing you'd want to do with an Excel table once you've
generated it? Make it appear just how you want it to!

To do this, simply select the table, click on the Home tab, then click on
Format as Table. This will display a menu that consists of some table
styles. Choose a style.



Clearing a filter

You can do this with just a click. Simply select the Data Tab and choose
Sort and Filter. On the section, select Clear. This will clear all the filters you
have applied in that set of data.

You can decide to clear the filter column by column without clearing all the
filters in the table at once. You have to select the drop-down menu and
select the option “Clear Filter From”. Then, you select the column you
want to clear the filter.

Applying a predefined AutoFilter

Excel AutoFilter is a simple method of converting numbers in excel
columns into customized filters depending on cell data. Excel's auto-filter
feature allows us to filter our values in one, two, or more fields in one go

We can pulverize our data using Excel AutoFilter to meet our needs. We
may filter depending on our selections from a collection or search for the
data we're looking for. The rows that do not match the filters' requirements
will be omitted.

To put it another way, AutoFilter in Excel enables us to see selected rows in
Excel while concealing others. Whenever Excel AutoFilter is applied to the



row's heading, a drop-down menu appears in the header row. It gives us a
number of filter choices, which we'll go through in this section.

There are multiple AutoFilter options you can work with. They are
Contains, Equals to, Does not Contain, Greater Than, Ends with, Less Than,
Begin with, and Greater than or equals to. Let’s work on how you can apply
the multiple filters.

Select any row header. Click filters on the data tab.

Applying advanced filters

Advanced filter options can be found on the Sort and Filter tab on the Data
ribbon. Select the columns for the data for the filter. Then, click on the
Advanced filter option. In the dialog box, choose the Action, the List
Range, and the Criteria Range. Then press OK. The multiple columns will
be filtered.

Conclusion

Excel tables are very important in Excel. They are used in structuring,
analyzing, and organizing the data in your worksheet. Ensure that you use
the examples given here to structure your data.

 



CHAPTER FOUR

GRABBING DATA FROM EXTERNAL SOURCES

In several circumstances, the data you wish to examine is stored somewhere
other than Excel. That information might be stored in a text or Word
document, on a website, in a file or database, in a database application
(such as a company financial statements), or on a dedicated database server.
Unfortunately, you can't examine anything that would be "available on the
market" in a file, software, or website. Rather, you'll need to find out how to
get that data "in here," which means importing it into an Excel file and
presenting it as an Excel table. Importing data from other sources may be
difficult, but Excel has a number of sophisticated tools for doing it.

What is All this about External Data?

Data that is saved elsewhere, like on a server, is referred to as external data.
Utilizing one or more external data linkages, you may import or show data
from another source in a worksheet. SQL Server tables, SQL Server
Analysis Services cubes, Microsoft Azure Marketplace data, and other
external data sources are all instances of external data sources. External
data connections in a worksheet allow you to submit queries to and collect
information from the databases you choose. This allows you to access the
most up-to-date information in a worksheet by refreshing the data.

In Excel, you may utilize native data instead of dealing with external data.
Even if an external connection was utilized to load data into a worksheet,
native data is saved directly in the workbook and does not need the
retention of an external data connection. Directly entering changes or
reimporting data into Excel may be used to modify native data.

Importing External Data into Excel

Importing data from an Access Table

Press the Data Tab and choose Get Data. Then, select From Microsoft
Access Database.



Then, choose the Access File. Then, click Import.

Choose a Table and click Load.

You will have the table on your worksheet.



If you Access data modify, click on Refresh on the ribbon.

Importing data from a Word table

Open the Microsoft Word application. Copy the table in the
document. Then, close the app. Navigate to your Excel application
and open your workbook.

Click on the cursor in the first cell grid. Then, press Control key + V.
This will paste the data into the worksheet.

You can also convert Word to Excel. This is done using the From Text
option. To do this, simply open the Word app, then select File and choose
Save As. Then, choose Plain Text format from the Save As Type.

Select Save. Now, on the Excel app, click on Data and choose From Text.
Choose the Delimited option.



Modify and choose Finish. Select a worksheet. It can be a new one or an
existing one. Then, choose Import. Press Ok.

Introducing text file importing

You utilize the Excel import wizard to import text files. It goes with lots of
processes. Let’s move on to how to do so.

Simply select the Data Tab and choose to Get External Data. Pick From
Text. You will have things you have to note down when doing this. Your
data might be divided by spaces, tabs, colons, or any other characters. This
means that you will have to choose Delimited. 

You will select Fixed Width if the column in your worksheet is of the same
length. Pick a row that will be for the Start import row. On the default
option of the File Origin, you can leave it like that.  Select the data that will
separate your data i.e. if you have delimited data. The Advance button is
not really necessary.

Importing a fixed-width text file

First, choose the content for the importing. It should be in the .txt file.
Copy the files.

Navigate to your Excel sheet\ and paste it. column A should be
chosen. After that, move to the Data Tab and choose Text to Column.

Choose the Fixed Width Format. select Next. Then, make some
modifications on the next window and click Finish.

Importing data from a web page

The first thing to do is to connect to the data source. So, copy the link
address of the web page. Click on the Data Tab and choose to Get and
Transform Data. Choose From Web.

Paste the link in the box. Press Ok. The contents of the link will be shown
by the navigator window.



Click on Web View. Select the arrow on the Load option and choose Load
to. Select existing worksheets. Right-click and choose Edit.

Select Product and choose Transform. Click on the Any Column option and
pick Fill then, Down.

Choose Changed Type.

Select Product and choose Transform. Click on the Any Column option and
pick Replace Values.

Click Insert.

Importing an XML file

Select the Developers Tab and choose Import. In the dialog box, find the
XML file and choose it. then, click Import. You can choose to import in a
new worksheet or to an existing worksheet.

Querying External Databases

Defining a data source

Click the Power Pivot option and choose Manage. You will see the different
tabs in the Power Pivot Window. The hidden column will be grayed out. If
you want to see the table origin, click on the Table Properties option.

In Excel, select Data and choose Connections. Choose the connection and
select Properties. Then, pick a Definition.

Conclusion

You can work with the data stored in your file and can also work with other
data from external sources. You utilize these data when you have to. There
are different ways of importing these data and you have seen them as we
have listed them. Select the steps best for you and apply them.



CHAPTER FIVE

 ANALYZING TABLE DATA WITH FUNCTIONS

The Database functions execute fundamental operations like Sum, Average,
Count, and so on, but they also include criterion parameters that enable you
to calculate just a sample of the data in your Database. The Database's other
entries are disregarded.

Excel, on the other hand, is so much more capable. It's possible to utilize it
to make a huge database, such as an Excel database. Excel's database
features are quite strong. Excel may be used not just to construct a basic
searchable database, but also to develop a fully relational database.

Excel is made up of rows and columns that store our data, also known as
records. Because Excel is the most widely used tool, we store our data in it,
which makes it a database. Whenever we put data in excel in the form of
tables in rows and columns, it becomes a database.

The Database Functions: Some General Remarks

These database functions do standard computations like sum, average,
count, and so forth, but they mostly include criterion parameters that enable
you to limit the computation to a portion of your document's entries. The
database's remaining entries are disregarded.

To have them in a worksheet, hit the Function Wizard (fx) button on the
Formula bar, pick Database from the Select a Category drop-down list box,
and afterward hit the function to use or write the Database function straight
into the column.

All database functions in Excel have the same syntax, which includes three
parameters for data, field, and filters. All arguments must be provided. The
data is included in a range of cells. Each column is labeled in the first row
of the range.

Summing a column’s Values



This is done using the SUMIF function. The syntax for this formula is
SUMIF (range, criteria, [sum_range].

Range: This is the cell range that is to be summed up. They include
numbers or names.

Criteria: This is the criteria for the summing up. It can be in form of a
number, expressions, text, cell references, or a function.

Sum-range. This is the actual cell to include.

Counting a Column’s Values

Whether you're calculating the personnel number of a sector in your
company or the quantity of the product sold month after month, counting is
an important aspect of data analysis. You may count cells, rows, or columns
of data in Excel using a variety of methods. 

You can count them using a simple formula. It can be done by pressing a
button or using a worksheet function. So, simply choose the range of cells
in the column that you want to count. Click the formula tab and choose
Auto Sum and pick Count Function.

Averaging a Column’s Values

This is done using the Average function. The syntax of the formula is
=AVERAGE(number1, [number2],...). simply put the Average formula in
a cell, then put the values of the column that you want to calculate their
average. For example, =AVERAGE(100,56,34,566,33,56,67). Then, press
enter.

Multiplying a Column’s Values

Let’s say your data started from the B and C and you want to multiply the
columns. You will simply do =B2*C2*.



Then, use the drag and fill option to fill in the other cells in the column.

Conclusion.

Here, I have explained the different ways that you can work with functions
on your table data. The examples are well understandable. Ensure that you
utilize them.



CHAPTER SIX

CREATING AND USING PIVOT TABLES

Understanding Pivot Tables

A pivot table is a particular Excel feature that enables you to visually
analyze and study data. It is a tool that enables you to interactively study
vast amounts of data. With a pivot table, you can rapidly turn a large
number of rows and columns into a comprehensive, neatly designed report.
A PivotTable is a user-friendly tool for efficiently summarizing vast
volumes of data. A PivotTable may be used to study statistical data in-depth
and to solve unexpected queries about your information
A PivotTable is particularly useful for:

Large volumes of data may be queried in a variety of user-friendly
methods.

Numeric data subtotaling and aggregation, data summarization by
categories and subcategories, and custom computations and formulae

Extending and compressing data levels to narrow your findings, as
well as diving down to specifics from data collected for fields of
interest to you.

To view alternative representations of the original data, move rows to
columns or columns to rows (or "pivot").

Filtration, sorting, grouping, and conditionally formatting the most
relevant and intriguing subset of data, allowing you to concentrate on
just the information you need.

Reports that are succinct, beautiful, and annotated may be presented
online or in print.

In essence, Pivot Table extract value from the infinite clutter of data on your
computer. And, more particularly, it allows you to organize your data in
various ways so that you may readily make useful conclusions.



The "pivot" aspect of a pivot table refers to the ability to twist (or pivot) the
data in the worksheet to examine it from a wider viewpoint. To be clear,
when you pivot, you are not adding to, removing from, or otherwise
affecting your data. Rather, you're merely restructuring the data so that it
may be mined for important information.

Exploring Pivot Table features

There are some features that come with a Pivot Table in Excel. Those
features help it to function very well.

 

They are as follows;

Filters: A report filter is used to apply a filter to a table as a whole. Filters
are used to conceal certain data.

Columns: Column labels are used to add a filter to one or more columns in
the pivot table that must be shown. Values under various situations

Rows: Row labels are used to add a filter to one or more rows in the pivot
table that must be shown. Data that is used to specify something.

Values: This generally takes the form of a field with numerical values that
may be utilized for various sorts of computations. The total number of data
points.

Importance of Pivot Table

When working with data in Microsoft Excel, there are several tools and
features available. Pivot tables are an essential feature of Excel that allows
you to work with data in several ways. Pivot tables are useful because they
enable anybody to filter and retrieve information from the data set they're
working with.

Pivot tables enable anybody to see their data from a variety of angles. Users
may construct interactive visualizations for anybody viewing them with the
help of these pivot tables.



You may construct a pivot table after the data is in Excel. To create a pivot
table, highlight all of your data, go to the Insert tab, and choose Pivot table
from the drop-down menu. The Pivot Table option gives the user the
maximum flexibility with their data, allowing them to investigate all
conceivable combinations of their categories. If the user wishes to have
Excel present some pivot tables already built with their data, they may click
the Recommended Pivot Tables option.

The pivot table dashboard will appear in a new excel sheet once you click
OK, and the user will be able to examine all parts of the data.

When the user begins adding items to the filters, rows, columns, and values
sections on the right side of the dashboard, the numbers appear on the left
side of the dashboard. All of the data's columns appear in the box, and they
may be dragged and dropped into any of the four categories.

If you drag anything into the rows field, it will display all of the data from
that column in rows on the left side. The same is true if you drag anything
into the column field; only the data will appear in columns across the page.

The values field enables the user to get and display data linked with
categories in the rows or columns. Finally, the filter field is quite valuable
because it allows for the user to split down the data so that they may only
view the bits of it that are relevant to them. To the left is a representation of
these pivot tables' fundamental functions.

Another useful feature of pivot tables is the large number of functions that
can be applied to the data in the columns and rows in real-time.

The pivot table's values may be translated in many ways. The lists on the
left are just a few of the many methods to extract essential values from data
quickly. Users may retrieve the total amount of numbers in a category, the
count, and other statistics that can be utilized to locate crucial data.

If a user wants to make calculations from the data in a column right away,
they can do so with just one click on each cell. Instead of typing long
formulas into each cell, pivot tables allow you to perform calculations that
would otherwise necessitate a long formula in each cell.

Creating a new field calculated from a function made up of other fields is
another intriguing possibility with pivot tables. A user can manipulate



different fields in a pivot table by adding, subtracting, multiplying, and
dividing them.

Building a pivot table from an Excel Range or Table

A PivotTable may be created from a set of data or an Excel table. If you
know what you're searching for, you may start with a blank PivotTable to
add in the specifics. You may also utilize Excel Recommended PivotTables
to get an idea of which PivotTable layouts are most appropriate for
summarizing your data. It is an easy process to create a Pivot Table in your
worksheet. Follow the steps below to do so;

First, chose the cells for the pivot table.

Navigate to the Insert tab and select Pivot Table. Select where you want the
pivot table to be placed. Click Ok. It is advisable to pick New Worksheet.
You can also decide to analyze multiple tables by clicking the boxes on Add
this data to the Data Model.

The Pivot table will be created on your worksheet in relation to the data in
your new worksheet. It will consist of an empty worksheet. Name the
worksheet.



Creating a Pivot Table from External data

Analyzing all of the data may assist you in making better corporate choices.
However, it might be difficult to compile a set of ideas, particularly if you
have a large amount of data saved outside of Excel, such as in a Microsoft
Access or Microsoft SQL Server database or an OLAP cube file. In such a
situation, you'll link to the external data source before creating a PivotTable
to summarize, analyze, explore, and show the information.

Building a Pivot Table from Microsoft Query

We will work with the dataset below.

Because this dataset isn't put up in a precise format, creating a pivot table
from it would be difficult. The dataset should be organized in the manner



described below. However, executing this procedure manually would take a
long time. However, you can simplify this procedure using Power Query.

Follow the steps below to do so;

Choose the source of your data by clicking on Power Query. You must
choose "From Table" if your data is already in the Excel file. If you don't
want to use CSV files, you may choose data from other sources.

In most cases, the first row is utilized as a header. Agencies, months, and so
on should be utilized as headers in the instance above. When they're not
already being utilized as headers, just go to Transforms and choose "Use
First Row as Headers."

Afterward, you must choose the columns that will be placed below one
another. I want the months to be in that manner, so choose the columns
"Jan" through "Dec."

After that, choose to Transform and then "Unpivot Columns."

Your information has been updated. If you don't like the alteration, you may
simply reverse the steps.

This data collection must now be saved. "Close and Load To" is selected
from the File menu. Make a new spreadsheet and save the data set that has
been updated.



You may now utilize your data in a Pivot Table. You may now quickly build
a Pivot Table from the Insert menu, selecting any features you want in your
table for fast data comparison and analysis.

Building a Pivot Table from a New data connection

On the Data tab, choose From Other Sources. Then choose the connection
you want from the sources list. In the Data Connection Wizard box, enter
the server for the database and put how you wish to log on to the server.

Enter the database, table, and query that has the data you want. Then, enter
the connection file you want to create.

Refreshing Pivot Table Data

When data in the PivotTable source list is modified, the PivotTable does not
immediately recalculate.

Below are some reasons why you might need to refresh an Excel Pivot
Table:

When the data structure changes, the pivot table must be refreshed.

At a later time, a source data variable is changed or modified.

More rows are included in the basic pivot table data set.

Existing rows in the source data used as a source for the Pivot Table
are removed, or

The fresh data entering from the sources (SAP, ERP, upstream data
sources) varies as the day, week, month, or quarter changes.

So, if you create a pivot table to evaluate data and afterward the data
changes after several days or weeks, you need not recreate the Pivot Table.
You just need to refresh it. There are different ways you can refresh a pivot
table.

1. Existing Data, the values vary considerably, while the numbers of
rows of data remain constant.

The data is changed first in this approach.



Navigate to the Pivot Table. Right-click within the Pivot and select
Refresh.

The Pivot Table is instantly updated. Use this simple method
whenever the source data alters.

In the Excel Ribbon, you may also pick the Refresh All button.

2. The size of the data in Excel changes

New rows or columns are added to the data collection, but this new data is
not represented in the pivot table. In this scenario, we must change the pivot
table's data range source to include the most recent data rows and columns.
There are a few options for doing this.

A. When your pivot table is reliant on data in a variety of cells, such as cells
B1:H50, you must increase that range to cover more rows and columns.

The simplest method is to go to the Pivot Table Analyze Tab and select the
Change Data Source choice button. The current data range from the source
will be indicated (highlighted). Re-select the new data range and choose the
OK button.

After it is done, click the Refresh All option to refresh the data from the
newly chosen rows/columns and update the pivot. The pivot table
will quickly be refreshed.

B. The process is considerably simpler if your pivot table is based on a
Table, such as Pricing Table, Table1, and has been turned into a Table.

C. All you have to do is click the Refresh button under the Analyze Tab,
and the pivot table will be instantly refreshed.

To use a Table as a data source for a Pivot Table is a smart technique that
you should use more often. When generating a new pivot table, it utilizes
the whole Excel table, and any additional rows added or deleted afterward
are automatically regarded as part of the Pivot Table.

Refreshing Pivot Table Data Manually

To bring up the PivotTable Tools on the ribbon, click anywhere in the
PivotTable.



Press Alt key + F5 or select Analyze, then Refresh.

Hint: Pick Analyze and pick Refresh All to update all PivotTables in your
worksheet in one go.

Whenever refreshing takes much longer, verify the refresh progress by
going to Analyze, then, select Refresh arrow, and choose Refresh Status.

Tap Cancel Refresh to halt the refresh.

Refreshing Pivot Table data automatically

You may also choose to have your PivotTables update every time you open
the worksheet. On the Options tab, click the Options button, and then on the
Data tab, check the box next to Refresh data upon opening the file.

Adding multiple fields to a pivot table area

On your worksheet that contains the PivotTable, then, click on any of
the cells in the pivot table area to open the Pivot Table Wizard.

Choose the column label selected. Then, drag and drop it into the
Row Labels section.

Now, rearrange the field labels in the Row Labels section. You will
see some modifications on the Pivot Table. Choose how you want to
order the row labels.

Review the Page Layout for the worksheet.

Pivoting a field to a different area

You can drag multiple fields to an area in a pivot table. Here, we will work
with different fields and will be working with the image below. The fields



we will work with are Multiple Row Fields, Multiple Value Fields, and
Multiple Report Filter.

Multiple Row Fields

After inserting the Pivot table, you can drag the filed below to the different
areas;

Drag the Country field and the Category field to the Rows area

Drag the Amount Field to the Values area



You will find the multi-level pivot table.

Multiple Value Fields

After inserting the pivot table, you drag the fields below to the different
areas;

Drag the Country field to the Rows area

Drag the Amount field to the Values Area (two times).



We drag the Amount field to the Values area twice, and whenever you do
that, Excel will populate the Columns area.

Now, select any cell in the Sum of Amount2 column and right-click and
pick Value Field Settings.



Put in the percentage on the box next to Custom Name. Pick a percentage of
Grand Total in the Show Values As tab option.

Select Ok. 

Your outcome will be as seen below;



Multiple Report Filter Fields

After inserting the pivot table, then you drag the fields below to the
different areas.

Drag the Country field as well as the Product field to the Filters area
Drag the Amount field to the Values area
Drag the Order ID to the Rows area.



Now, choose on the first filter drop-down menu, pick the United Kingdom.
On the second one, pick Broccoli. The pivot table will display the order
made by Broccoli to the United Kingdom.

Grouping pivot table values



Large volumes of data may be readily summarized, analyzed, and presented
using pivot tables. To do so effectively, you must first be able to arrange the
data into suitably sized and ordered subgroups. You can easily achieve this
using Pivot Tables' grouping and ungrouping functionalities.

Understanding how to arrange data quickly in a PivotTable report may be
really beneficial. This is due to the fact that it makes it simple to organize a
large quantity of diverse data into a few categories or subcategories. Fewer
groups enable you to streamline your assessment and concentrate on the
most important (grouped) things.

You can group numeric values, date and time values, and text values. Below
is the way you can do them.

Grouping Records
1. Right-click a value in the PivotTable and choose Group.
2. Choose the Starting at and Ending at checkboxes in the Grouping

box, then modify the values as necessary.
3. Select a period of time under By. Add a number that determines the

intervals for each group in mathematical fields.
4. Choose OK.

Grouping selected data

1. Select two or more values while holding the Control Key

2. Select Group from the context menu by right-clicking.

Assigning a name to a group
1. Choose a group.
2. Select Analyze. Then, pick Field Settings from the drop-down menu.
3. Select OK after changing the Custom Name to whatever you like.

Ungrouping data

1. Any item in the group may be selected by right-clicking it.
2. Choose Ungroup.

Error troubleshooting (grouping)



Whenever you attempt to group a selection, you may get an error message
stating that you are unable to do so. This could happen for a variety of
reasons. Being that you must pick two additional entries to establish a group
if you want to group data within your own custom groups; you cannot
construct a group with just one item.

You will have an error notice if there are empty cells in a field, such as a
date or a number field. If you have a text input in a date or number field,
you will get an error. Examine the actual data and rectify the issue in each
instance, then reload the PivotTable prior to actually attempting again.

Filtering pivot table values

Applying a report filter

Select the field that is to be used as a Report Filter. Choose the field in the
Pivot Table Field List. Drag the field inside the Filters box.

Excel will put the selected field to the top of the pivot table on your
worksheet. There will be no changes to the values in the pivot table.

In my image below, I added the Region filed as the Report Filter, and you
can see that it is displayed at the top of the pivot table. You can add more
than one field as the report filter by following the same steps above.

Filtering row or column items

When you apply a filter to a Pivot Table, you may notice that rows or
columns vanish. It's because pivot tables only show items that have data by



default. A filter has already been added to the East area in the sample given.
Since there are no entries for Blue in the North or West areas, the Blue
column would typically vanish. Blue, on the other hand, is still visible since
the color field settings have been configured to "display things with no
data," as detailed below.

The image below shows three fields which are Region, Color, and Sales.

The Row field is now the Region, the Column field is the Color, and the
Value field is the Sales.



To enable the display of items that has no data, click on the box next to the
Show items with no data option.

If you want it to display zero when they are no data in it, enter zero on the
box at the right side of the For empty cells show option.

Filtering pivot table values

We will be working with the pivot table below. We are going to filter the
top values in the pivot table.



We want to make the top ten stores with the highest values in the Sum of
Sales section to display. To do this,

Simply right-click on any of the names for the stores. Select Filter and
choose Top 10.

In the next box that shows, choose the top 10 items by Sum of Sales. After
that, choose Ok.



The top 10 values will be filtered immediately

In the image above, you will figure out that the top 10 values are displayed
but it didn’t show them to be in an arranged order. So, we will sort it out.
Simply. Right-click and select Sort. Then, choose Sort Largest to Smallest.

The values will now be arranged from the largest to the smallest.



Filtering a pivot table with a slicer.

To add a slicer to a table, your data must be organized in an Excel table.
Select a cell within your data and navigate to the Insert menu and
choose Table to build an Excel table.

When your data is now in a table, a tab will be shown. On the Table Design
tab, select Insert Slicer.

It will bring up the Insert Slicer box, where you can choose whatever fields
in your data you wish to add a slicer to.

To generate many slicer objects at once, pick one or much more fields out
from the list. You'll be capable of utilizing them both at the same time to
sort data depending on different fields.

If you press OK, Excel will automatically construct the slicer objects.

Adding a Slicer to a Pivot Table

1. Simply, choose the pivot table for the slicer. Navigate to the Pivot
Table Analyze tab and select Insert Slicers.

2. Then, choose the fields to add. Click Ok.

Conclusion



This chapter simply explained what a pivot table is all about. As you were
reading through, you got to know about the meaning, parts, and importance
of a pivot table. With pivot table. You can efficiently carry out several tasks.
The examples you have understood in this chapter on how to use the pivot
table effectively will guide you through for you to avoid errors.



CHAPTER SEVEN

PERFORMING PIVOT TABLE CALCULATIONS

When using pivot tables to analyze data, you'll often have to extend your
analysis to incorporate data from computations that weren't included in your
initial data set. Calculated fields and calculated items in Excel allow you to
do calculations inside a pivot table.

Messing around with Pivot Table summary calculations

Excel provides several techniques for summarizing your data in the Pivot
table. Sum, Count, and Average are some of its summary capabilities.

If you insert a field in the Values section of the field list pane, the value in
the column is instantly summed. The Sum function is the standard summary
function for the PivotTable's arithmetic value fields, but you may change it.

In the PivotTable, on the Grand Total field, right-click on it and select
Summarize Values By.

Choose the function that you want to use from the drop-down menu.

Below are the summarized options that you can use alongside the
function:

SUM: The standard adding function. It adds up the details in the
column. It is the basic function for numerical value fields in value
fields. When the sum method is used, all empty or non-numeric
variables in the PivotTable are set to 0 so that they may be totaled.
COUNT: It shows the total number of non-empty values. It is the
standard value for value fields that include non-numeric data or
spaces.
AVERAGE: With this, the average of the provided data is shown.
MAX: With this, the highest value is shown.
MIN: With this, the lowest value is shown.
PRODUCT: With this, the composite of the values is shown.



StDev: An estimation of a population's standard deviation, when the
sample represents a portion of the total population.
StDevp: The population standard deviation, in which the population
is all the other data to be summed.
VAR: It provides an estimation of a population's variation, where the
sampling is a portion of the full population.
VARP: It shows the variation of a population, in which the
population is the total amount of data to be evaluated.
Distinct Count: It shows the number of distinct values. This
summary feature is only available in Excel when you utilize the Data
Model.

Changing the Pivot table summary calculations

The values in the Values box in the PivotChart report describe the actual
source data (not the value that is shown) in the usual sequence: The SUM
function is used for numeric data, whereas the COUNT function is used for
text values. You may, however, alter the summary function. You may also
make a custom computation if you want to. Follow the steps below to do so:

Pick a field in the Values area. This is where you would want to
modify the function in the Pivot Table report.
Navigate to the Analyze tab and pick Active Field from the Active
Field group. Then, hit Field Settings.
This opens the Value Field Settings box. The field name in the data
source will be the Source name. The Custom name shows the present
name in the report. It will show the source name when there is no
custom name.
To modify the Custom name, simply hit the box and change the
name.
Now, select the Summarize Values By tab, and on the box, pick the
summary function that you wish to utilize.
You can decide to utilize a custom calculation by clicking the Show
Values As tab and choosing the calculation you want.
If the Base Field option is shown in the calculation you picked,
choose the Base item.
To modify the numbers, pick the Number Format from the Number
Tab. Choose a format type and press Ok.



When your report has more than one/two value fields, just repeat the steps
above for each of them.

Trying out the difference summary calculation

We will be working with the sample below;

To show the differences, simply right-click and choose Show Value As,
then click Difference From.

Then, choose the Basic Field and Item. Press Ok.

Applying a percentage summary calculation

Several designed percentage calculations are available in the Pivot Table's
“Show Values As” option. We would like to understand how to evaluate
quantities in calculations using Pivot Table percentages rather than Totals in
a sales collection of various cigarette brands in various locations.

Percentage of Grand Total

To evaluate each number to the grand total value in Pivot Table
percentages, we utilize the percent of Grand Totals computation. Branding
is put in the Row area, Areas in the Column area, and Sales Amounts in the
Value area of our Pivot Table. We wish to compare the proportion of each



brand's sales in each location to the total sales of all brands across all
regions.

To alter the sales amount of each brand as a percentage of the Grand
Total, we perform the following:

1. Click the right mouse button on any of the brand's sales amount cells.

2. Select Show Values as 
3. Choose Percentage of Grand Total

Percentage of Column total

The percentage of Column Total calculation compares every value to
the total of a column value and displays the result in Pivot Table
percentages as a percentage of column total.

To display the proportion of sales for each brand inside each area, just
do the following steps in your Pivot table:

1. Select any of the brand's sales amount cells using the right mouse
button.

2. Pick Show Values As
3. Choose the percentage of Column Total from the Show Values As

drop-down menu.

Use this same method to display the percentage of the row total as well.

Adding a running total summary calculation

In a pivot table, a running total is a total sum that also includes the previous
total. If we have month-by-month data from January to December, for
instance, a running total will display you the YTD total every month.



We can utilize a running total to calculate the full development against the
target. Follow the steps below to add a running total.

After creating the Pivot Table, choose a cell from any column.

Then, you right-click and pick Value Field Settings. the window will
display.

Navigate to the Show Value As tab. Then, pick Running Total In.

Select Ok. You will have the running total in your pivot table.



Ensure that the pivot table is sorted correctly before adding the running
total. If we wish to add it from January to December, the data must be in
that order.

Creating an index summary calculation

One amazing feature of Excel is the ability to display data as the Index in a
Pivot Table. The Index describes the comparative relevance of a cell, i.e.,
the comparative significance of each number in relation to its row, column,
and grand total.

It may assist you in making choices if, for instance, you would want to raise
the cost of the goods and want to know which areas would be most affected
(based on the Index).

Simply right-click and select Show Value As. Then, choose Index. The
Index summary calculation will display in your pivot table.

Working with Pivot Table Subtotals

Subtotals are included in your pivot table automatically. It is done whenever
you put more fields beneath them. One of the fields does not display
subtotals and that is the innermost field. It is not a big deal because you can
make them display if you want. You can do this by generating a pivot table
custom subtotals.

Follow the steps below to do so;



1. Simply right-click on any item in the pivot field (probably the one
you want to change).

2. Select Field Settings and on the next box that appears, move to the
Subtotals and Filters Tab and pick Custom.

3. Select one or more summary functions. Do so from the list of
functions displayed for you.

4. After that, pick Ok.

Turning off subtotals for a field

To disable Subtotals in a pivot table, follow these steps:

1. Within the pivot table, choose a cell.

2. Inside the ribbon, go to the Design tab.

3. Choose "Do not show subtotals” from the Subtotals drop-down
option.

Displaying multiple subtotals for a field

Subtotals for the outer fields show automatically when numerous fields are
added to the Row Labels section of a pivot table. Region and City fields are
in the Row Labels portion of the pivot table below. The Values section has
two fields: Sum of Quantity, which displays the total quantity for each city,
and Sum of Total Price, which displays the entire sales amount.



1. Simply right-click and select Field Settings. Pick the Subtotals and
Filters Tab.

2. Choose Custom and choose the functions for the subtotals. Click Ok.

3. You will see the subtotals beneath the group. This is done whenever
you pick multiple Custom subtotals. It will not change even when you
decide to let it show at the top of the group.

Introducing Custom Calculations

A custom calculation is a formula you create to generate PivotTable values
that would not show in the report if you simply utilized the source data
fields and Excel's built-in summary calculations. Custom calculations allow
you to expand your data analysis to include outcomes that are tailored to
your individual requirements. You can also call it a Calculated Field.

Calculated Fields are most often used to add a new Field to your Pivot
Table. The newly introduced Field performs computations depending on the
values of other fields, in most cases.

Calculated Fields, in more specific terms, employ the sum of the original
data of the Field(s) that the Calculated Field calculation
uses. Furthermore, when you interact with Calculated Fields, you're dealing
with all of the relevant Field's underlying data (rather than individual
Item(s). Calculated Fields are handy when you wish to utilize all of the data
from a specific Field(s) in your computations for the reasons stated above.

Assuming you need to calculate the Cost of Goods Sold for every retailer
and item using a simple technique. The computation is quite basic to make



the instances as easy as possible and to concentrate on the concept of
Calculated Fields. For each item and shop, we'll believe you can compute
the Cost of Goods Sold as a percentage of the Sales Amount.
Arithmetically:

COGS = Total Sales multiplied by a percentage

It's worth noting that the Pivot Table's source data lacks a column for Cost
of Goods Sold.

In certain cases, you may be able to add such a column by going back to the
source data. In other circumstances, however, making a new column to the
data sources may not be feasible or practical. Using a Calculated Field
instead of adding a new column to the source data is an option.

This isn't to say that Calculated Fields aren't useful in certain situations. I'll
go through a few typical Calculated Fields issues and restrictions further
down. That overview should aid you in identifying situations when
Calculated Fields are not the best option.

Checking out the custom calculation types

There are two types of custom calculation. They are Calculated fields and
Calculated Items. Calculated Fields are most often used to add a new Field
to your Pivot Table. The newly introduced Field performs computations
depending on the values of other fields, in most cases.

Calculated Fields, in more specific terms, employ the sum of the original
data of the Field(s) that the Calculated Field calculation uses. Calculated
Fields are not to be confused with Calculated Items. These names pertain to
separate constructions, despite the fact that they have certain characteristics.

Calculated Items vary from other types of items in that they function with
individual data. Calculated Items, in other words, enable you to operate
with Item(s) from inside a Field.

As previously stated, Calculated Fields employ all of the original data of the
Field(s) that the Calculated Field formula uses.

To put it another way, you typically do the following:



1. When you wish to deal with all of a Field's underlying data, use
Calculated Fields (s).

2. As previously said, adding a column to your source data is an
approximate approximation of Calculated Fields.

3. If you want to interact with particular Item(s) inside a Field, use
Calculated Items.

Calculated Items are essentially comparable to increasing row(s) to your
source data, just as Calculated Fields are approximately comparable to extra
columns in the source data.

Inserting a custom calculation field

You're probably aware that Excel is a calculating engine, as well as the
ability to construct a calculated field, is a feature you'll want in your
toolbox when dealing with pivot tables.

A calculated field lets you maintain a computation operating across a pivot
table, just as you would with a formula in a worksheet.

Ryan desires to know how much money he makes on each style of beer he
sells: Pilsners, Stouts, Ambers, and IPAs. It's a pain to make the income
computation outside the pivot table since he has to remove the Q1 expense
from the Q1 revenues and do the exact thing for Q2, and so forth.

He can create a calculated field that will calculate the figures for him and
tell him how much money he'll make on each sort of beer.

And here is how you do it:

1. While within a pivot table cell, move to the "Pivot Table Analyze"
tab, choose the "Fields, Items, and Sets" button, and then pick
"Calculated Field."

2. Then, Ryan has to enter the name of the field.



3. Ryan must now input the formula he is attempting to compute. To
calculate profit, he understands he must deduct his costs from his
sales.

4. So he'd go to "sales" and press "Insert Field," enter in the negative
sign, and then go to "Cost" and press "Insert Field."

5. Ryan can readily view his income for each kind of beer—as well as
his overall profit—on the lower part row of his pivot table now that
the computed field is in position.

Inserting a custom calculation item

Calculated items are similar to all other things in your pivot table, except
that they don't appear in your data sources. They are simply made following



a formula. According to your needs, you may update, alter, or remove
computed Items.

1. Simply choose the Pivot Table.

2. Click on Analyze on the ribbon. Pick Fields, Items, and Sets. Then,
choose Calculated Item.

3. Enter the formula and the name. then, choose the fields and the items
and click Ok.

Editing a custom calculation

1. Simply navigate to the Insert Calculated Field box. To do this, simply
click on any cell in the Pivot Table and select Analyze Tab. Pick
Fields, Items, and Sets. Then, you pick Calculated Field.

2. Choose the field that you want to modify. You can modify the
formula and name.

Deleting a custom calculation

Simply click the Delete button on the Insert Calculated Field box after
selecting the field you want to remove.

Conclusion

We have gone through the different ways you can perform the Pivot Table
calculations. There are lots of calculations you can do and you have



mastered how to do them with the steps you have gone through here. So,
use them to work more on Pivot Table calculations.



CHAPTER EIGHT

BUILDING PIVOT CHARTS

Introducing the Pivot Chart

Have you ever had the opportunity to reflect on an excel sheet that is so
jam-packed with information that you can't tend to construct the meaning of
it all? That merely combing through the data makes you feel like your head
is about to burst when you look at it? If that's the case, you're not alone.

For companies today, data does everything. From inventories to client
purchasing patterns, we've got you covered. Having data is similar to being
given a plan for achieving a sustainable competitive advantage. Raw data,
on the other hand, won't assist you nearly as much. What you want and
need to do now is examine the data for patterns and use what you've learned
to make better judgments in the future.

This is where things become complicated; data analysis is a time-
consuming operation that needs the assistance of a professional. But it
doesn't have to be that way all of the time. You can always rely on
technology to assist you with this.

Pivot charts are a great way to get that support.

Whenever data is raw and unstructured, it may be incredibly hard for an
individual to summarize and comprehend the information completely. This
is not only exhausting and mentally taxing, but it's also uncomfortable and
tough to picture. Pivot Tables and Pivot Charts come to the rescue in these
situations, allowing you to summarize, display, and analyze data in a
structured and organized style that is both simple to understand and well-
presented. In a word, Pivot Charts are a fantastic method to view data
quickly and effectively. A Pivot Chart is a graphical depiction of a Pivot
Table that is also a built-in feature of MS Excel.

Whenever working with large volumes of data, a pivot chart is very handy.
For example, a company with a big number of workers may use Excel to
track each student's operating time, so that at the end of each month, the



employee with the most working hours would be given a bonus for their
dedication and sincerity to the company. Whilst working with the whole list
of people would be time-consuming and perhaps inaccurate, a pivot table,
or, for that matter, a pivot chart, would allow for speedy reorganization and
visualization of data in a comprehensible way, easing the full procedure.

Understanding Pivot Chart pros and cons

There are advantages and disadvantages of the Pivot Chart/Pivot Table and
they are listed below.

Advantages are:

Pivot tables show you how your data works — Pivot tables are one of
several tools available to assist individuals to have a better understanding of
their data. From one set of data, you may produce various reports on
multiple data sets.

Works nicely with SQL exports - SQL queries create a lot of the data we
have in our company. SQL exports (data downloaded/exported from SQL
databases) and SQL servers are both supported by pivot tables. This makes
data collection and transmission into a format that can be readily analyzed
much simpler.

Large volumes of data may be separated - One issue with data analysis is
that it becomes more difficult as the quantity of data grows. You can simply
separate data using pivot tables, regardless of how large the entire data
collection is. This enables data analysis to be simpler and might even help
you detect patterns.

It's useful to generate immediate data - Once data is put into a pivot
table, you may utilize it however you want. You may also utilize formulae
to produce quick data or put formulas right into the pivot table.

Disadvantages are:

Pivot tables demand enough time to learn – While generating a pivot
table in Excel just takes a few clicks, fully understanding the tool takes
effort. Pivot tables may be difficult and daunting for first-time users. Only
once you've "tamed the beast" will you be able to utilize it correctly for data
analysis.



It might take a long time to learn how to utilize it – Based on how you
want to utilize your data in the pivot table, it may require some time to do
so. This is due to the fact that the tool itself lacks a comprehensive set of
computation choices. This implies the user will have to manually compute
the data or enter equations, which will take time.

There are no updates that happen automatically – You're effectively
depending on outdated data for your metrics and analytics unless you
routinely update your pivot table with fresh data. This implies that using
pivot tables for real-time analytics will be difficult.

Desktop computers (old ones) may not be capable of handling big data
sets; Nevertheless, when dealing with a few thousand pieces of data, any
computer will suffice. However, as you reach the tens of thousands, aging
machines may fail to afford the data you want. It's also fairly uncommon for
computers to fail simply because the quantity of data they're processing is
too much for them to manage.

Understanding Pivot Chart Limitations

You can't use Pivot Charts to produce reports using Multi-select / Checkbox
field types. When you add a new field to a pivot table that is already
existing for which a Pivot Chart has already been produced, Excel adds the
new field to the last column automatically. This order cannot be changed,
nor can the extra field (column) be placed in the midst of the other columns.

Creating a Pivot Chart

A normal chart makes use of a variety of cells, but a pivot chart is formed
based on the data summarized in a pivot table. A pivot chart is essentially a
dynamic chart, however, converting a regular chart to a dynamic chart
requires data adjustments.

To create the chart, simply choose the cells in your worksheet. Navigate to
the Insert tab, then pick Chart before choosing Pivot Charts.



A menu will appear which will contain the cells you have selected. Choose
where you want the chart to be placed. You can Use an External Source if
you want to create the Pivot Chart from another source.

Pick Ok.

Pivot Chart has four elements just like a pivot table which are Axis,
Legend, Values, Report Filter.

Creating a Pivot Chart from a Pivot Table

After opening the Excel worksheet, look for the file that contains the pivot
table and the data source from which you want to create the pivot chart.

Choose the way the pivot chart will be and what it is to represent. Such as
the columns, style, the chart type, and so on.

Then, click the Insert Tab and select Pivot Chart.

Choose the chart type and press Ok.



Working with Pivot Chart

Moving a Pivot Chart to another sheet

You may want to rearrange your dashboard or modify it. but before you
achieve this, you will like to move your Pivot Chart to another sheet in the
same workbook or another one. People do work on a Pivot Chart in another
sheet before they move it into the main worksheet.

Follow the steps below to do so;

Select the pivot chart. Then, move to the Options tab and navigate to
the Action section.

Then, choose Move Pivot Chart. The dialog box of the Move Pivot
Chart will show.

Select where you want to move the pivot chart. You can select a new
worksheet or within the current worksheet.

Click Ok after choosing an option.

Filtering a Pivot Chart

Filtering a Pivot Chart is the practice of developing it easier to create a
Pivot Chart dependent on a set of criteria. A customized Pivot Chart may be
generated, for instance, if a Pivot Chart is generated that shows the sales of



various things or commodities in different nations depending on a given
condition or, conversely, a filter. This is used for data display and analysis.
Simply follow the steps to do so.

So, I will utilize the standard filters which is the triangle next to the Product
and Country. So, I will use the Country filter to display the overall amount
of each product that is exported to the United States.

Remove the Country Filter

Due to the fact that we included the Category filter in the Filters area. So,
we will filter the chart by category.

So utilize the Category filter to only display the vegetables exported to each
country.



Changing the Pivot Chart type

Choose the Chart that you want to modify its type.

Go to the Type group on the Design Tab and select Change Chart Type

Then, select the chart you want.

Then, select Ok.

Adding data labels to your Pivot Chart

Right-click on the data series in the chart. then, choose Add Data
Labels.

Hit any of the data labels to choose all data labels. Then, choose the
specific data label for the chart.

You can repeat these steps to add more data labels.

Sorting the Pivot Chart



Sorting makes it easier for you to understand your data. It is very helpful
when you have lots of data in your pivot table or chart. There are different
ways you can sort your data in the pivot chart. You can sort your data from
the highest values to the lowest, alphabetically, and so on.

Click the Pivot Table and select the small arrow next to the heading
of your column

Then, choose the sort option that you want.

Adding Pivot Chart Titles

Adding titles to your chart helps you to understand the chart and what it is
meant for. Simply click on the chart and choose the Chart Title box. Click
on the plus (+) sign at the right-hand side of the chart. Click the arrow
beside the Chart Title. Choose Centered Overlay. This is to make the title be
over the chart. To remove the title, simply uncheck the checkbox of the
Chart Title.

Displaying a data table with Pivot Chart.

Select anywhere on the chart. navigate to the Chart Tools section in
the ribbon and select Labels.

Choose Data Table. You will have a list of options. Choose a Data
Table and select Show Data Table.

Then, choose Ok.

Conclusion

Pivot Charts are very useful in Excel when organizing your data. This
chapter has explained the ways you can work with it somas to have a good
structure of your data.

 

 



CHAPTER NINE

UNDERSTANDING EXCEL DATA MODELS

In Excel, a data model is a sort of data table wherein two or more tables are
linked by a common or many data series. In a data model, tables and data
from several other sheets or sources come together to produce a single table
that can acquire files from all the tables.

Elaboration

By constructing connections based on a common column, it is possible to
integrate data from various tables.

Data models are applied openly, resulting in tabular data that can be utilized
in Excel Pivot Tables and Pivot Charts. It combines the tables, allowing for
in-depth analysis in Excel utilizing Pivot Tables, Power Pivot, and Power
View.

The data model enables data to be loaded into Excel's storage.

It's preserved in memory, where we can't view it immediately. Then you
may tell Excel to use a common column to link the data together. The Data
Model's 'Model' section describes how all tables relate to one another.

Even if the information is spread across different tables, the Data Model can
access it all. Excel has the data in its memory once the Data Model is built.
The data in its memory may be accessed in a variety of ways.

Dealing with Data Models

We'll teach you how to create a tiny data model using tables and
PowerPivot in this segment. You may also obtain an insight into the Quick
Explore tool with only a few taps. If you want to delve down into the
specifics in Excel, Quick Explore is the way to go. It's important to note
that this feature requires Excel 2013 or later.

On the Tables worksheet, we have sales-related datasets.



Let's start by establishing table connections.

Insert the specified table first from the Worksheet to the Data Model after
selecting the range.

In PowerPivot, choose the Manage option. That's a sandstone Excel add-in
for data analysis. We'll construct a Data Model that includes the following
connections between the sales tables:



Build a pivot table using the data from the source tables. Select the
PivotTable symbol in the PowerPivot pane. A new Worksheet will be
created to describe and organize the design.

Select a data-filled cell on the new worksheet! The symbol for Quick
Explore now shows.

Select the icon. The Explore area will appear on the screen. The Pivot
Table's tables are shown in the pop-up pane. You may drill down deep using
any of the available choices.



Select the symbol for Quick Exploration. A pop-up panel called Explore
emerges. This panel displays all of our Pivot Table sales tables.

To drill down deeper into the information, choose one of the available
fields. We wish to select the required product names from cell C8 in this
case.

Customers of BlueTechnology in the Midwest will get a value of $25630.
On the Explorer window, select this option.

Excel will construct and alter the Pivot table. Check out the filters in the
top-left area. The pivot table has been reorganized to display information
about the chosen cell.

Is it necessary to reorganize the layout? To restore your default table
structure, use Control key + Z on your keyboard.

It is beneficial for anyone to look beyond the exterior. In circumstances
when we need to dig down to the base of the data sets and inspect the
specifics, it is achievable. The drill-down approach is our ally in this
approach. When dealing with enormous data tables, utilize this function
with caution since there's a lot to learn with little investigation.



Creating a relationship between tables

Have you ever tried using VLOOKUP to copy a column from one table to
another? VLOOKUP is no longer needed now that Excel includes a built-in
Data Model. Depending on matching data in each table, you may construct
a connection between two tables of data. Then, even if the tables are from
separate sources, you may generate Power View sheets and construct
PivotTables as well as other reports using fields from each table. If you
have client sales data, for instance, you could wish to import and link
temporal intelligence data to examine sales trends by year and month.

Excel may frequently construct such associations in the Data Model it's
developing behind the scenes whenever you import related tables from a
relational database. In all other circumstances, you'll have to manually
construct connections.

Make that there are at least two tables in the workbook and that each
table includes a column that can be mapped to another table's column.

Choose one of the following options: Make a table out of the
information, or make a graph out of it. In a new spreadsheet, import
external data as a table.

Assign a relevant name to each table: Select Design. Pick Table
Name and then input a name in Table Tools.

Check that the data values in a column in one of the tables are unique
and there are no duplicates. Only if one column has unique values can
Excel build the connection.

Select Data and then, choose Relationships.

Your worksheet will consist of just a table if the relationship is grayed out.

Move to the Manage Relationship box and select New.

Select the arrow for Table in the Create a Relationship box. Choose
a table.

Choose the column that consists of the data which is related to the
Related Column (Primary) for the Column (Foreign).



Choose a table that consists of at least one column of data that is
related to the table you have chosen for Table for the Related Table

Pick a column that consists of unique values which match the values
in the column you have chosen for Column for Related Column
(Primary)

Choose Ok.

Importing related external data tables

There are different ways you can get data in Excel. You can get external
data from Access, Web, Text, and Other Sources. Here, I will show you
how you can import data from all of them.

Import Access Data

Move to the Data Tab and navigate to the Get External Data Group.
Then, Select From Access.

Choose the Access File

Select Open.

Pick a Table and pick Ok.

Choose how you want the data to be viewed and where you want to
place it. choose Ok.

You will get the result on your worksheet. You can refresh it anytime
you want to.

Import Web Data



Move to the Data Tab and navigate to the Get External Data Group.
Then, Select From the Web.

A dialog box will open and it will show you the homepage of your
browser with the URL of the page being highlighted.

Paste the web address. Search for the data table and click on it. Then,
select Import.

Import Text Data

Move to the Data Tab and navigate to the Get External Data Group.
Then, Select From Text.

Choose the file you want to import

Select Import.

Import Data from Other Sources

Move to the Data Tab and navigate to the Get External Data Group.
Then, Select From Other Sources.

Select the source you want to import from the list of sources
displayed for you. Here, I go with SQL Server

Put in the name of the server and the log-on credentials in the Data
Connection Wizard.

Then, select Next.

Pick the database and the tables that you will want to work with.
Choose Next.

Then, click Finish.

Basing a Pivot Table on multiple related tables

Select the Insert tab and choose the Pivot table button.

Choose the first table you want to add.

Click on the box next to the Add this data to the Data Model option.
Select Ok.



In the Pivot Table window, select All. This is to show all the tables.
Select the boxes of the tables that you want to include in the Pivot
Table.

Managing a Data Model with Power Pivot

You may develop a Data Model, which is a grouping of tables with
connections, in both Excel and Power Pivot. The data model in an Excel
worksheet is the same as the data model in the Power Pivot interface. Every
dataset you upload into Excel is also accessible in Power Pivot.

Power Pivot is a SQL Server Analysis Services engine that is made
accessible via an in-memory procedure that operates inside Excel. Internal
Data Model is the term used to describe it. The Power Pivot Ribbon
interface is the most efficient method to deal with the Internal Data Model.

You may construct a Data Model, which is a group of tables with
relationships after the Power Pivot add-in is installed and accessible. Any
data you bring into Excel or already have in Excel becomes accessible in
the Power Pivot window after it has been added to the data model. Over and
beyond the conventional Excel Data tab, the Power Pivot Ribbon provides
extra functionality.

Now let us take a glance at how Power Pivot fits into the entire Business
Intelligence workflow and how it interacts with the other BI tools in Excel
to get a sense of where it fits in when utilizing Excel for analysis of data or
presentation.

Because Power Pivot is a data model, the first step is to import some data.
You'll need a tool or connector to connect to various sorts of data sources
and get your data unless it's already in your Excel sheet. Depending on your
data source, this may be a complicated issue that is beyond the scope of this
essay.

After you've got the data, you'll have to clean it up and modify it. Another
Excel add-in called Power Query does both of these capabilities. The Power
Pivot data model is created as the last stage. This is where we make the
connections between the various data tables.



Lastly, once you've calculated all of the required metrics, you can use Pivot
Tables and/or Pivot Charts to summarize the data in your Power Pivot data
model. A dashboard can be created by combining multiple Pivot Tables /
Pivot Charts with slicers.

Enabling the Power Pivot Add-in

1. To activate Power Pivot in Excel, access the backstage view by
clicking the "File" button inside the Ribbon.

2. Secondly, on the bottom left of the backstage view, choose the
"Options" section to access the "Excel Options" box.

3. Choose the "Add-Ins" option on the left flank of this window.

4. Pick "COM Add-ins" out from the "Manage" drop-down just at
the bottom right-hand side of this window.

5. Next, to access the "COM Add-Ins" panel, select the adjoining
"Go..." button.

6. Tick the box on the "Microsoft Power Pivot for Excel" add-in in this
window.

7. Now, on the right, press the "OK" button to activate the add-in.



Adding a table to the Data Model

In Excel, a PivotTable may only be created from a single table or range.
You may use the Data Model to add new tables to the PivotTable if
necessary.

Assume your workbook has two worksheets.

The first is a table that contains the data of salespeople and the
territories they represent.

The second contains sales data by area and month

The sales may be summarized per salesperson as shown below.

Sales may be accessed by clicking the table.

Choose the INSERT tab.

Inside the Tables category, choose PivotTable.

A blank PivotTable will be constructed using the variables from the
Sales data – Region, Month, and Order Amount. Underneath the
PivotTable Fields list is a MORE TABLES command.

Selecting more tables.

The dialog box Create a New PivotTable opens. To leverage several tables
in your analysis, a new PivotTable must be built using the Data Model,



according to the information provided. Select Yes. A new Pivot Table will
be created.

You'll see that there are two tabs under PivotTable Fields: ACTIVE and
ALL.

Click the ALL tab.

In the PivotTable Fields list, there are two tables: Sales and
Salesperson, each with its own set of fields.

Drag the Salesperson field from the Salesperson table to the ROWS
area.

Drag the Month field from the Sales table to the ROWS area.

Drag the Order Amount field from the Sales table to the VALUES
box.

The PivotTable is now ready to use. A notification occurs in the PivotTable
Fields stating that table relationships may be required. Besides the message,
select the CREATE button. The dialog box for creating a relationship
displays.



Choose Sales from the Table drop-down menu.
Choose Region from the Column (Foreign) box.
Choose Salesperson from the Related Table drop-down menu.
Choose Region from the Related Column (Primary) box.
Choose the OK button.

The PivotTable has been created from two tables on separate spreadsheets.

Creating a relationship between tables with Power Pivot

Dealing with several tables adds intrigue and relevance to the data in the
PivotTables and reports that utilize it. When you're utilizing the Power
Pivot add-in to deal with your data, you can utilize Diagram View to
establish and manage relationships between the tables you loaded.

In order to create table connections, each table must have a column with
corresponding values. If you're linking Customers and Orders, for instance,



each Order record should include a Customer Code or ID that points to a
specific customer.

1. Click Diagram View in the Power Pivot window. The tables are
immediately sorted based on their connections, and the Data View
worksheet style switches to a visual diagram structure.

2. Build a relationship by right-clicking a table diagram and selecting
Create Relationship. The dialog box for creating a relationship
appears.

3. A column is preselected if the table comes from a relational database.
Pick a column from the database that includes the data which will be
utilized to connect the rows in each table when no column is pre-
selected.

4. Pick a table with at least 1 column of data that is connected to the
table you just chose for Table for Related Lookup Table.

5. Choose the column that holds the data that is associated with the
Related Lookup Column from the Column drop-down menu.

6. Select Create from the drop-down menu.

When you've created or imported a table for each topic in your Data Model,
you'll have to allow the coming together of related data in Excel whenever
you need it again. This is accomplished by guaranteeing that linked tables
have similar fields and by creating connections among tables. It allows
Excel analysis tools like Pivot Tables to pull data from multiple tables.

NB: Despite the fact that Excel verifies if the data categories in each
column correspond, it doesn't validate that the columns comprise
corresponding data and will build the connection even though the values do
not match. Construct a PivotTable that includes fields from both tables to
see if the connection is genuine. If the data seems to be incorrect (for
instance, blank cells or a similar value repeated down each row), you'll
choose alternative fields and maybe different tables.

Creating a Pivot Table or Pivot Chart from your Data Model



The data model is a method of organizing tables and calculations for usage
in PivotTables. The data model was once accessible as a Power Pivot add-in
and is now included with Excel 2016+ for Windows. Excel 2016 for
Windows is used to provide the rest of this article.

There are various benefits to creating a Pivot Table from the data model
instead of a single Excel table.

To get us started, here are a few examples.

1. We can create a PivotTable that combines data from different tables.

2. We can build formulae that vastly outnumber those accessible in a
standard PivotTable.

3. The formulae are written in a language called DAX, which has a lot
of sophisticated features.

4. Using named sets, we may select and pick rows and columns.

5. We can utilize a Get & Transform query (to clean the data before it
comes) and link to several data sources (e.g., a CSV file, a database
table, and an Excel workbook) in a single model rather than
copying/pasting data into a worksheet.

6. We may just Refresh the report in the following times after it has
been produced (instead of going through the whole export, clean,
import, and merge into a single data table process).

This is only a sampling of the highlights.

So, below are the steps that we are going to follow in doing so.

1. Activate the data model.

2. Importing the data model.

3. Define the relationships.

4. Construct the PivotTable

Activating the data model



To enable the data model, simply click the Data tab and select Manage Data
Model.

If it is your first time doing this, you will be asked to enable the add-ins.

After you have enabled it, you will see the Pivot table tab on the ribbon.

Importing the data models

The data tables are then imported. We have certain transactions in a Data
Table workbook in our situation. The bank account is included in the
transactions, but not the user id. Thankfully, we have a chart of accounts,
that is kept in the Lookup Table worksheet.

The procedure for importing data tables varies based on the location of your
source data. Click the Power Pivot, then select the Manage ribbon
command to get started. The Power Pivot window will appear, as illustrated
below.

To access the underlying data source, run the Get External Data command.



Because the data is stored in a few Excel files in our situation, we utilize the
Get External Data > From Other Sources option and then pick Excel File
from the subsequent box. We open the appropriate worksheet and choose
the option to use the first row as column headings. After we complete the
process, the data is imported into our data model, as seen below.

Note: You should use the Power Pivot > Add to Data Model command if
you're constructing a data model within the workbook with the tables.

Then we repeat the process using the data from the Lookup Table Excel file.
Below is a screenshot of the new Power Pivot window.



After we've put our data into the data model, we'll need to define the
relationships to inform Excel how the tables are connected (which fields are
shared between them).

Defining the Relationship

Relationships may be defined in a variety of ways; however, my personal
preference is to utilize the visual diagram approach. Just tap the Home >
Diagram View command to switch between Data View (shown above) and
Diagram View (shown below). Instead of viewing the data transactions,
we'll see the tables with the column names, as seen below.

To define the relation, drag the column name from the Data Table to the
Lookup Table’s associated column. In this scenario, the AcctNum column
of the Data Table is linked to the AcctNum column of the Lookup Table.
The relationships are shown in Excel as seen below.



Now, we can create our pivot table.

Construct the Pivot Table

You simply pick a New Worksheet or an Existing Worksheet in the resultant
Create PivotTable dialog in the Power Pivot pane by clicking the PivotTable
> PivotTable command. When we hit OK, the typical PivotTable field panel
appears.

But hold on a second... It seems to be distinct from the usual field panel
upon closer study. In most cases, we'll get a list of fields that we may use in
the report. But now we can see the tables and expand them to see the fields
inside them, as seen below.



Yes, we may choose fields for our report from any or both tables. For
instance, we would like the Lookup Table’s AcctName in Rows and the
Data Table’s Amount column in Values. And that's it!

So, assuming your initial thought is that it would have been simpler to build
a single table using VLOOKUP, I completely understand. Well, here is the
point: there's a catch. Because there is just one lookup table in this case, it is
pretty straightforward. A chart of accounts, a calendar table, a department
list, and other lookup tables are supported by the data model. You may also
have numerous data tables in your data model, in addition to multiple
lookup tables.

There's also the difficulty of always amending our report. We don't need to
supervise several lookup formulae each month since we aren't utilizing



VLOOKUP to obtain related data. We may simply Refresh and the new
data flows into the report when the external data source is updated, whether
for a new account or new transactions. As you may see, this offers up a lot
of intriguing options and can help us save time in our workbooks that we
use often.



CHAPTER TEN

TRACKING TRENDS AND MAKING FORECASTS

Whenever you're examining data, utilizing Excel's database functions, or,
even better, creating a PivotTable or PivotChart, you can do simple
calculations like the sum and average, as well as represent the information.
Everything is fine. Nevertheless, as important as all these technologies are,
they are unable to respond to one very basic question: What really is the
general direction of certain past data – it might be earnings, sales, costs,
defects, or complaints — given some previous data?

Are profits increasing? Is the number of flaws decreasing? Are sales
seasonal (e.g., lower in the cold season, higher in the summer)? Solving
these sorts of queries is known as summary statistics because, in this
chapter, you'll learn about the sophisticated Excel tools that can help you
not only detect the patterns in your data but also anticipate future values. As
you'll see, it's all really smooth.

Plotting a Best-Fit Trend Lines

The simplest approach to gain a feel of the general trend represented by a
collection of data is to plot a best-fit trend line on a chart. This is a straight
line drawn across the data points of the chart, with the discrepancies
between the chart points above and below the line canceling each other out.

Regression analysis is a statistical method for studying the connection
between two events, one of which is dependent on the other. A best-fit trend
line is an example of regression analysis. Housing sales, for example, are
influenced by borrowing rates:

Housing sales increase as interest rates fall.

When interest rates rise, home sales fall.

Housing sales are referred to as the dependent variable in regression
analysis, while interest rates are referred to as the independent variable.



When dealing with historical data, such as sales over time, the independent
variable is time, and the dependent variable is the object you're measuring
(such as sales).

You must plot your data series as an XY (Scatter) chart to include a best-fit
trend line.

Here are the steps to plot a best-fit trend line on an Excel chart if
you've previously created one for your data:

To pick a chart, click on it.

If your chart includes more than one data series, choose the one you
wish to study.

Select Design and then Add Chart Element.

Trendline Additional Trendline Options

The Trendline Format pane displays.

Select the Trendline Options tab from the drop-down menu.

Select Linear from the drop-down menu.

The best-fit trend line is plotted using Excel.

(Optional) Check the option that says "Display Equation on Chart."

Steps 6 and 7, which add a little arithmetic to the trend analysis, may
be skipped if you simply want to view the trend line. However, if
you're interested, do Steps 6 and 7, then read my explanation of what
these numbers signify, which follows these steps.

(Optional) Check the option that says "Display R-Squared Value on
Chart."

Close the window.

Calculating Best-Fit Values

If your study needs precise trend values, you may draw the best-fit trend
line and then compute the values using the regression equation. You must,
however, recalculate the values if the data values change. Using the



TREND feature is a better option. TREND may handle up to four
arguments at once:

TREND(known_ys, known_xs, new_xs, const)

The solely needed parameter is known ys, which is a reference to a range of
dependent values or an array of them. The range reference or array of
independent values is known xs (the default is the array 1,2, 3,...],n, where n
is the number of known ys). Because the new xs option is only used for
predicting, it isn't needed here. (I go into more detail about this in the
section "Calculating Forecasted Linear Values.") The y-intercept is
determined by the const argument: TRUE (the default) calculates the y-
intercept based on the known ys, whereas FALSE sets it to 0. (At the point
where the trend line crosses the y-axis, the y-intercept is the value of y.)

The following is the technique for calculating best-fit values using the
TREND function:

Choose which cells you want the best-fit values to show in.

=trend (is a kind of trend.

To indicate the dependent values, type a reference or an array.

After that, enter a comma, and then a reference or array to represent
the independent values.

Type two commas and then FALSE if you want to use a trend
beginning point of 0.

(Select).

Hold Ctrl + Shift and then hit Enter or click the Enter button.

The best-fit trend values are calculated and entered as an array in
Excel.

Plotting Forecasted Values

So far, I've discussed two methods for calculating the R2 value (coefficient
of determination), which indicates how strongly the dependent and
independent variables are related:



Select the Display R-Squared Value on the Chart check box after plotting
the best-fit trend line.

Read the R2 value in the first column of the third row using the LINEST
function with the stats parameter set to TRUE.

Give yourself a high-five if you discover that both methods show that the
dependent and independent variables are highly linked (that is, the R2 value
is 0.7 or above), and then use that correlation to anticipate future values.

This may seem to be magic, but it's only statistics. The assumption that the
principal variables underpinning the available data will stay relatively
consistent throughout the number of periods in your projection is critical.
Any projection you make based on your previous data is likely to be
worthless if you're planning to buy another firm or drop product lines.

With that caution in mind, using a chart to extend the best-fit trend line into
one or more future periods is the easiest technique to generate predicted
values. However, you must display your data series as an XY (Scatter) chart
to work with a best-fit trend line and utilize it to depict anticipated values.

The steps are as follows:

To pick a chart, click on it.

If your chart includes more than one data series, choose the one you
wish to study.

Select Design and then Add Chart Element.

Trendline Additional Trendline Options

The Trendline Format pane displays.

Select the Trendline Options tab from the drop-down menu.

Select Linear from the drop-down menu.

The best-fit trend line is plotted using Excel.

In the Forecast section, type the number of units you want to project
the trend line into in the future in the Forward text box.

(Optional) Check the option that says "Display Equation on Chart."



(Optional) Check the option that says "Display R-Squared Value on
Chart."

Close the window.

Along with the expanded trend line, Excel shows the regression equation
and the R2 value.

Extending a Linear Trend

With a linear trend, the dependent variable is proportionally connected to
the independent variable. For example, you could observe that anytime
interest rates (the independent variable) fall by 1%, home sales (the
dependent variable) rise by 100,000 units. Similarly, you can discover that
every $50,000 spent on advertising boosts firm sales (the dependent
variable) by $250,000. (the independent variable).

You may use a linear connection to anticipate future periods if forecasting is
part of your data analysis. The fill handle and the Series command are two
tools Excel provides to help you stretch a linear trend into one or more
future periods.

Calculating Linear Forecasted Values

If your analysis needs precise forecast values, you may either use the fill
handle or the Series command to extend the linear trend and then use the
regression equation to get the values, or you can use the best-fit trend line
and then use the regression equation to calculate the values. These are
simple approaches, but if the historical numbers change, you must
recalculate the anticipated values. Using the TREND function is a more
efficient option. Here's a quick rundown of TREND syntax:

TREND(known_ys, known_xs, new_xs, const)

TREND must be used not just with the known ys argument (a reference to
the dependent values) and optionally with the known xs argument (a
reference to the independent values) in this circumstance, but also with the
new xs argument. The new xs parameter is a range reference or array that
specifies the new independent values for which dependent values should be
projected.



The following is the technique for utilizing the TREND function to
compute anticipated linear trend values:

Choose the cells where the anticipated values should appear.

=trend( is a kind of trend.

To indicate the dependent values, type a reference or an array.

After that, enter a comma, and then a reference or array to represent
the independent values.

After that, type a comma, followed by a reference or array that
represents the new independent values.

Type a comma and then FALSE if you choose to use a trend
beginning point of 0.

(Select).

Hold Ctrl+Shift and then hit Enter or click the Enter button.

The anticipated trend values are calculated and entered as an array in
Excel.

Plotting an Exponential Trend Line

I've only covered regression analysis on linear data that evolves at a steady
pace up until now. However, regression analysis may be used on nonlinear
data when the trend line isn't straight.

An exponential trend, which rises or declines at an increasing pace, is a
frequent example of nonlinear data. The trend line mimics the graph of a
number being increased to ever greater exponent values, thus the name
exponential. The series 21, 22, 23 begins slowly (2, 4, 8, and so on), but by
the time you reach 220, the series value has risen to 1,048,576, and 2100 is
a 31-digit figure!

An exponential trend line may be used to depict such a pattern. This is a
curved line that runs across the data points and cancels out the
discrepancies between the ones on one side of the line and those on the
other.



The steps for drawing an exponential trend line are as follows:

To pick a chart, click on it.

If your chart includes more than one data series, choose the one you
wish to study.

Select Design and then Add Chart Element.

Trendline Additional Trendline Options

The Trendline Format pane displays.

Select the Trendline Options tab from the drop-down menu.

Choose the Exponential option from the drop-down menu.

The exponential trend line is shown in Excel.

(Optional) Check the option that says "Display Equation on Chart."

Steps 6 and 7 may be skipped if you just want to view the trend line.

(Optional) Check the option that says "Display R-Squared Value on
Chart."

Close the window.

Exponential Trend Values Calculation

As I said in the last section, looking at an exponential trend line is a nice
way to spend time. The trend line is an excellent visual aid, but it is useless
when you need accurate exponential trend values. Yes, you could display
the trend line and then compute the precise numbers using the exponential
form of the regression equation:

BMX = y

If the data values change, you must recalculate the trend values and replot
the trend line. There's just too much work!

Using the GROWTH function, which accepts up to four parameters, is
a better option:

GROWTH(known_ys, known_xs, new_xs, const)



The dependent values are referenced by the known ys parameter, which is
necessary. The independent values are referenced by the known xs
parameter (the default is the array 1,2,3,...],n, where n is the number of
known ys). The new xs input specifies the new independent values for
which you want dependent values projected. The value of b in the
exponential regression equation is determined by the const argument:
FALSE sets it to 1, while TRUE (the default) uses the known ys to compute
b.

Here are the steps to utilizing the GROWTH function to compute
exponential trend values:

Choose which cells you want the exponential values to display in.

=growth( is a type.

To indicate the dependent values, type a reference or an array.

After that, enter a comma, and then a reference or array to represent
the independent values.

After that, enter a comma, then a reference or array to represent the
new independent values.

Type a comma and then FALSE if you choose to use a trend
beginning point of 1.

(Select).

Hold Ctrl+Shift and then hit Enter or click the Enter button.

Excel calculates and saves the exponential trend data as an array.

Plotting a Logarithmic Trend Line

A logarithmic trend occurs when data increases or decreases rapidly at first,
then gradually slows and levels out over time. The sales pattern of a highly
anticipated new product, which normally sells in big volumes for a brief
period before leveling off, is an example of a logarithmic trend.

A logarithmic trend line may be used to depict such a pattern. This is a
curved line that runs across the data points and cancels out the



discrepancies between the ones on one side of the line and those on the
other.

The steps for drawing a logarithmic trend line are as follows:

To pick a chart, click on it.
If your chart includes more than one data series, choose the one you
wish to study.
Select Design and then Add Chart Element.
Trendline Additional Trendline Options
The Trendline Format pane displays.
Select the Trendline Options tab from the drop-down menu.
The Logarithmic radio option should be selected.
The logarithmic trend line is plotted in Excel.
(Optional) Check the option that says "Display Equation on Chart."
Steps 6 and 7 may be skipped if you just want to view the trend line.
(Optional) Check the option that says "Display R-Squared Value on
Chart."
Close the window.

Plotting a Power Trend Line



A power trend, in which the data grows or declines continuously, provides
the greatest fit in many applications of regression analysis. Such a trend is
certainly neither exponential nor logarithmic, which both entail severe
behavior at the trend's conclusion (in the case of exponential) or at the
trend's beginning (in the case of logarithmic) (in the case of logarithmic).
Revenues, earnings, and margins in successful organizations are examples
of power trends, all of which demonstrate consistent rises in the pace of
growth year after year.

Although a power trend seems to be linear, charting it reveals a curved best-
fit line between the data points. When analyzing such data, it's typically
better to start with a linear trend line. If it doesn't work, try a power trend
line instead.

To draw a power trend line, follow these steps:
To pick a chart, click on it.
If your chart includes more than one data series, choose the one you
wish to study.
Select Design and then Add Chart Element.
Trendline Additional Trendline Options
The Trendline Format pane displays.
Select the Trendline Options tab from the drop-down menu.
The Power radio button should be selected.
The power trend line is plotted in Excel.
(Optional) Check the option that says "Display Equation on Chart."
Steps 6 and 7 may be skipped if you just want to view the trend line.
(Optional) Check the option that says "Display R-Squared Value on
Chart."
Close the window.



Plotting a Polynomial Trend Line

The connection between the dependent and independent variables does not
always move in the same direction in real-world circumstances. That would
be much too simple. Data such as unit sales, profits, and expenses, for
example, may go up and down rather than growing continuously –
consistently, as in a linear trend, rapidly, as in an exponential or logarithmic
trend, or slowly, as in a powerful trend.

A polynomial trend line, which is a best-fit line of many curves obtained
using an equation that employs multiple powers of x, maybe plotted to
depict such a trend. The order of the polynomial equation is the number of
powers of x. The greater the order, the more closely the curve matches your
current data, but the more unexpected your anticipated numbers are.

If you already have a chart, you may add a polynomial trend line by
following these steps:

To pick a chart, click on it.
If your chart includes more than one data series, choose the one you
wish to study.
Select Design and then Add Chart Element.
Trendline Additional Trendline Options
The Trendline Format pane displays.
Select the Trendline Options tab from the drop-down menu.



Choose Polynomial from the drop-down menu.
To change the order of the polynomial equation, use the Order spin
button arrows.
The polynomial trend line is shown in Excel.
(Optional) Check the option that says "Display Equation on Chart."
Steps 7 and 8 may be skipped if you just want to view the trend line.
(Optional) Check the option that says "Display R-Squared Value on
Chart."
Close the window.

Creating a Forecast Sheet.

The forecast function is the most basic forecasting function you can have. It
forecasts the chosen repetition series, but we should first get all of the other
known sequences and known outcomes. To anticipate the upcoming
demand, the forecast function just employs the Moving Average Forecast
technique. If we don't know X, we've input the number manually, starting
with 1 for the initial value and working our way up.

Now, on the formula tab, pick Insert. On the dialog box, click the down
arrow and choose Statistical. Pick Forecast function.



The formula for this is

Example;

Here, this function will help us predict next month's sales data. Let’s say a
company has monthly sales data. Then, the board wants to figure out the
sales forecasting so that they can have an idea of their future month sales. In
my table below, we are to predict that of 2009.



On the empty cell, type in the FORECAST function.
=FORECAST(D12,C3:C11,D3:D11).

Press ENTER.

You can modify your work by adding a graph to it.



CHAPTER ELEVEN

 ANALYZING DATA USING STATISTICS

Counting Things

You count the number of values that match a certain range. Counting values
in a range is done with the use of the SUMPRODUCT and COUNTIFS
functions. It counts how many cells match one or more
conditions/requirements. The COUNTIFS function uses this formula
=COUNTIFS(criteria_range1, criteria1, [criteria_range2, criteria2]…)

Explanation:
�        Criteria_range 1 is the data range that will be calculated with the use

of criteria1.
�        Criteria1 is the condition that defines which cells are to be counted.
�        Criteria_2 & Criteria2 are voluntary; they are applied when there is

an existence of over one criterion.

In the image below, the formula in F6 is
=SUMPRODUCT(1/COUNTIF(B5:B14, B5:B14))

Explanation:

COUNTIF is used from B5:B15 which uses the same values as criteria
COUNTIF(B5:B14, B5:B14). We have ten values for criteria, so we are to
bring back an array that has ten results such as {3;3;3;2;2;3;3;3;2;2}. These



numbers signify counts. For instance, Jim displayed three times, Mark
displayed three times, etc.

The array will be configured as a divisor. The number 1 will be the
numerator. When you are done dividing, you will have another array as
seen below;

{0.333333333333333;0.333333333333333;0.333333333333333;0.5;0.5;0.
333333333333333;0.333333333333333;0.333333333333333;0.5;0.5}

Every value that is displayed once in that range will be displayed as 1s
while values that are displayed more than once will be displayed as
fractional values.

Counting Numbers

The COUNT function counts the number of cells having numeric values in
a given range. COUNT, on the other hand, excludes cells that contain text
(including numbers represented as text), the logical values TRUE or
FALSE, and cells that are empty. (It's worth mentioning that COUNT
includes cells with dates or times since Excel regards those forms of data as
numbers.)

The syntax is as follows:

=COUNT(value1[, value2, …])

Cell or range references are represented by value1, value2, and so on. Use
the following formula to find out how many numeric values are in the range
B3:B12 in the worksheet displayed in the image using the COUNT function

=COUNT(B3:B12)

COUNT delivers a count of the numeric values in a range.

COUNT yields 6 as indicated in cell E3.



Counting Nonempty cells

The COUNTA function counts the number of nonempty cells inside a given
range. It makes no difference what data types the cells contain: integers,
dates, times, logical values, or text. A cell is included in the COUNT A
total as long as it includes anything. The COUNTA syntax is as follows:

=COUNTA(value1[, value2, …])

Cell or range references are represented by value1, value2, and so on. For
example, in the spreadsheet given earlier in the image, apply the following
formula to compute how many non-empty values are in the range B3:B12.

=COUNTA(B3:B12)

COUNTA yields the number 9 as seen in cell E4 in the image.

Counting empty cells

The COUNTBLANK function counts the number of empty cells within a
given range, which is the polar opposite of COUNTA. The
COUNTBLANK syntax is as follows:

=COUNTBLANK(value1[, value2, …])

Cell or range references are represented by value1, value2, and so on. Use
the following calculation to find out how many empty values are in the



range B3:B12 in the worksheet shown previously in the image using
COUNTBLANK:

=COUNTBLANK(B3:B12)

Counting cells that match criteria

The COUNTIF function in Excel is used to enumerate cells that fulfill
given criteria or conditions inside a defined range.

For instance, a COUNTIF formula may be used to determine the number
of cells in your worksheet that consists of a

number that is higher than or lesser than the value you give. COUNTIF is
also often used in Excel to count cells that contain a given word or begin
with a specific letter (s).

The COUNTIF function has a very basic syntax: =COUNTIF(range,
criteria)

It has just two arguments which are Range and Criteria. The range here
defines one or multiple cells for counting while the Criteria here defines the
condition which lets the function of the cell that is needed for counting. You
write in the range as you do normally such as B1:B15. You can put in the
criteria as "10", B2, ">=10", "some text"

Counting cells that match multiple criteria

The COUNTIFS function may be used to display the number of cells that
satisfy a specified condition. COUNTIF may be used to count items based
on dates, numbers, text, and other parameters.

COUNTIFS additionally requires the use of logical expressions (>,>,=).

COUNTIFS is a function that counts cells that satisfy several criteria. Since
we provide the same range for two criteria in this situation, each cell in the
range must fulfill both requirements to be tallied. The formula is
=COUNTIFS(range,">=X",range,"<=Y").

�        For greater than or equal to, use >=.

�        For less than or equal to, use =.



So, if we wish to count depending on conditions in our dataset, we use
the following formula: =COUNTIFS(B2:B9,">=80",B2:B9,"<=90")

Counting Permutations

Calculating the permutations, which is the number of ways a subset of data
may be organized in any sequence, without repetitions, given a data set, is a
common approach to count things. Let's say your data collection contains
the letters A, B, C, and D.

Here are all the possible combinations of any two of these letters that
do not repeat:

AB, AC, AD, BA, BC, BD, CA, CB, CD, DA, DB, DC

The following are the two most important qualities of a permutation:

Because the order is critical, AB and BA are considered separate groups.

The groups' AA, BB, CC, and DD aren't included in the permutations since
repeats aren't permitted.

When picking a subset from a data collection, Excel's PERMUT function
counts the number of permutations possible (or a sample from a
population). The PERMUT syntax is as follows:

=PERMUT(number, number_chosen)

The number of items in the set is the number, and the number of things in
each subset is the number chosen. For example, if you have a population of
four items and two items in each subgroup, you may use the formula to get
the number of permutations.



=PERMUT(4, 2)

The method returns the number 12, indicating that there are 12 possible
ways to choose two things from a group of four.

Allowing repeats in the subset is a variant on the permutation theme (such
as AA, BB, CC, and DD from the ABCD set). In such a situation, utilize the
PERMUTATIONA function in Excel, which has the same syntax as
PERMUT.

=PERMUTATIONA(number, number chosen)
=PERMUTATIONA(number, number chosen) =PERMUTATIONA(

To compute the number of permutations in which two things are chosen
from a population of four items with duplicates permitted, for example, use
the formula:

PERMUTATIONA PERMUTATIONA PERMUTATIONA (4, 2)

The final score is 16.

Counting combinations

When the order isn't crucial, it's frequently beneficial to count items by
computing the combinations, which is the number of ways a subset of that
data may be organized without repetitions given a data set (that is, each
subset is unique). Let's say your data collection contains the letters A, B, C,
and D. Without repeating everything, here are all the many ways you may
group any two of these letters:

AB, AC, AD, BC, BD, CD

There are two main qualities of a combination:

The subsets must be distinct, which means that the order of the subsets is
irrelevant. The subsets AB and BA, for example, are regarded to be the
same subset.

The groups AA, BB, CC, and DD aren't included in the combinations since
repeats aren't permitted.

When picking unique subsets from a data source, Excel's COMBIN
function counts the number of available combinations (or a sample from a



population). The COMBIN syntax is as follows:

=COMBIN(number, number_chosen)

The number of items in the set is the number, and the number of things in
each subset is the number chosen. For example, if you have a population of
four items and two items in each subgroup, you may use the formula to get
the number of combinations.

=COMBINATION (4, 2

The method returns the number 6, indicating that there are six possible
ways to choose two things from a group of four.

If you wish to add repetitions (such as the ABCD set's AA, BB, CC, and
DD), use Excel's COMBINA function, which has the same syntax as
COMBIN:

=COMBINA(number, number chosen) =COMBINA(number, number
chosen) =COMBINA(number

To compute the number of unique combinations in which two things are
chosen from a population of four items with repetitions permitted, for
example, use the formula:

=COMBINATIVE (4, 2)

The final score is ten.

Averaging Things

The sum of two or more numeric values divided by the count of the
numeric values yields an average. You can compute the average by writing
a custom formula if you like, but this is only feasible for a limited number
of elements. Calculating averages using Excel worksheet functions is
quicker and more efficient for bigger datasets.

The mean is how statisticians refer to an average. A typical value in a
distribution or a value that reflects the majority of instances is referred to as
the central tendency. The mean, median, and mode are the most widely used
metrics of central tendency.

Calculating an average



The AVERAGE function, which utilizes the following syntax to calculate
the average (or mean) of a group of data, is the go-to worksheet function.

AVERAGE(number1[, number2,...]) is a function that computes the average
of two numbers.

Up to 255 parameters may be entered, each of which can be a number, a
cell, a range, a range name, or an array (a collection of values wrapped in
curly braces, such as 20, 25, 25, 30). If a cell contains zero, Excel includes
it in the calculation; however, if a cell is blank, Excel excludes it from the
computation

To calculate the average of the values in the range D3:D19, for example,
use the formula.

=AVERAGE(D3:D19)

Calculating a conditional average

You may need to average the values in a range in your data analysis, but
only those values that meet a certain requirement. This may be done using
the AVERAGEIF function, which is a combination of AVERAGE and IF,
and averages just those cells in a range that fulfill the criterion you provide.

AVERAGEIF is a function that accepts up to three arguments:

=AVERAGEIF(range, criteria[, average_range])

The range argument specifies the range of cells to be used to test the
condition; the criteria argument specifies which cells are in the range to
average using a logical expression surrounded by double quotation marks,
and the optional average range argument specifies the range from which the
average values should be taken. If you don't provide an average range,
Excel will use range to calculate the average.

Excel only adds the average range cells that match the cells in range and fit
the requirements.

Calculating an average based on multiple conditions

Getting the average of all numbers that meet a certain condition



Excel's AVERAGEIF function computes the average (arithmetic aggregate)
of all cells that fulfill a set of conditions. The formula is:
AVERAGEIF(range, criteria, [average_range]). The first two parameters
to the AVERAGEIFS function are necessary, while the final one is
optional:

�        Range - the number of cells that will be compared to the supplied
criteria.

�        The criterion used to choose which cells to average is known as the
criteria. The criterion may be specified as a number, a logical
expression, a text value, or a cell reference, for example, 5, ">5",
"cat," or A2.

�        Average range - the range of cells to average (optional). If the range
parameter is omitted, the formula will compute an average of the
values in it.

EXAMPLE;

The AVERAGEIF function in Excel is most often used to obtain an average
of cells that perfectly fit a specific requirement. Let's average just the sales
(B2:B8) for the Banana orders (A2:A8) in this illustration:

=AVERAGEIF(A2:A8, "banana", B2:B8). You can put the formula in an
empty cell. =AVERAGEIF(A2:A8, E1, B2:B8)

Getting the average of all numbers that meet two or more conditions.



The AVERAGEIFS function is the plural version of the AVERAGEIF
function. It takes many factors into account and provides the average
(arithmetic average) of units that match all of the requirements.

The formula is; AVERAGEIFS(average_range, criteria_range1,
criteria1, [criteria_range2, criteria2], …)

The following are the parameters to the AVERAGEIFS function:

�        The average range parameter specifies the range of cells to average.

�        Criteria range1, Criteria range2, Criteria range3, Criteria range4,
Criteria range5, Criteria range - 1 to 127 ranges to be compared to the
set of criteria The first criteria range is necessary; the others are
optional.

�        Criteria1, criteria2…. means the cell that is to be averaged. It can be
provided in a number form, logical expression, cell reference, or text
value.

The Excel AVERAGEIFS function, as previously stated, finds the average
of cells that fulfill all of the conditions you give (AND logic). In principle,
it works similarly to AVERAGEIF, with the exception that you may use it
in formulas with multiple criteria ranges and criteria.

Calculating the median, mode, variance, standard deviation

With every piece of data, descriptive statistics are among the core "should
learn" concepts. It offers us an overall picture of data patterns, such as
learning about the range, the mean, mode, and median, as well as the
variance and standard deviation, , Count, maximum, and minimum are all
used.

Descriptive statistics are helpful because they enable you to describe a vast
quantity of data. Let's imagine you have information on one thousand
people's earnings. Nobody wants to read a thousand bits of data, and even if
they did, they will not be capable of extracting any relevant information.
When you condense it, though, it does become useful: an average pays or
median income is a lot simpler to comprehend than lots of data. Below is an
image of its features;



How do you calculate this?

First: Enter your information into Excel in a single column. For
instance, if your data collection has ten items, enter them into fields
A1 through A10.
Second: Go to the "Data" tab, then to the "Analysis" group, and
finally to "Data Analysis."
Third: On the pop-up Data Analysis box, choose "Descriptive
Statistics."



Fourth: In the "Input Range" text box, enter an input range. In the
box, enter "A1:A10" for example.
Fifth: Once you have named the column in row 1, click the "Labels
in the first row" check box; otherwise, leave it unmarked.
Sixth: In the "Output Range" box, enter a cell location. Type "C1" as
an example. Make sure there are no data in two neighboring columns.
Seventh: To show Excel descriptive statistics, tick the "Summary
Statistics" option and then click "OK." In the column you chose as the
Output Range, a set of descriptive statistics will be supplied.

Let’s, work with an example.

So, follow the steps above to the third three. With my data above, I will
select the input range as $C$2:$C$13. I have named my first row, so I will
check the Labels in the First-row box. My output range will be $D$2. Click
the box on Summary Statistics. Select OK.



You will see the descriptive statistics on your worksheet. You will see the
mean, median, mode, and other useful stats of your data.

Finding the Rank



One of the most frequent methods for assessing data is to rank it.
Comparing categories and items may be made easier by ranking them. The
nice aspect about ranking is that you can see what's at the upper and
lower part. You could save a huge amount of time and work by using
ranking in a pivot table, and it will aid us in your evaluation.

The excel rank function is used to determine the optimum sequence position
of any chosen cell within a particular hierarchy or range, and it is only
relevant to numbers. That's because Rank can only be quantified in terms of
numbers. If we have five numbers and wish to know the rank (or position)
of any of them, we merely select the range and then the order in which we
want them to appear.

There are different rank functions in Excel which are RANK.AVG,
RANK.EQ, and RANK. Let me work with an example.

I have a dataset that consists of twelve teams that joined in the Kabaddi
tournament. It includes the team names and their total points. So, I want to
rank each of the teams as I compared it to the rest of the teams.

Here, we will use the RANK.EQ function. Put the function rank function in
cell C2. Then, input the cells that you want to rank.



Then, press Enter and use the drag and fill feature to fill in other cells.

This also works for a Pivot Table.

1. In the pivot table that you intend to measure the ranking, add the
value field two times.

2. Right-click on any of the cells in the second data column to choose
them.

3. Select "Show Values As" from the drop-down menu.



4. You have two choices for adding ranking: "Rank Smallest To
Largest" or "Rank Largest To Smallest." Choose whichever one you
like.

5. The column values will be converted to rankings, and then you may
sort the data to see how it ranks.

Note that the rank will be modified when you filter the pivot table.

In Source Data, Using RANK.EQ and RANK.AVG

This approach is a little more difficult, but it works perfectly. The advantage
of utilizing RANK.EQ and RANK.AVG is that you don't have to modify
your pivot table in any way. Simply take these few instructions below.

1. Add this formula
=IF(COUNTIF(C$2:C2,C2)>1,””,SUMIFS($E$2:$E$1507,$C$2:
$C$1507,C2)) in the formula bar after inserting your raw data. For
each category in the column, the formula will add a single total. You
may then use that sum to determine where each category ranks.

2. Below your data, include two extra columns. Then, enter this
formulas =IF(H2=””,0,RANK.EQ(H2,$H$2:$H$1507,1))

=IF(H=””,0,RANK.AVG(H2,$H$2:$H$1507,1)).  The rating for the
category in your data dump will be calculated using AVG. Both of these
routines were used to generate various ranking kinds.

3. Then, using this data dump, generate a pivot table similar to the one
below. To determine the ranking, you can use either of the columns.



With this method, the filter you use on the data will not affect the ranking.

In a Pivot Table, create a separate Rank Column:

You may create a manual distinct column for ranking rather than using
formulae or any other way. This function may be used to add ranks to a
specific instance.

Simply take these few instructions below;

1. Select a pivot table and organize the data as desired, ascending or
descending.

2. Add the formulae below to the next two columns beyond the pivot
table.

=RANK.EQ(E4,$E$4:$E$15,1)

=RANK.AVG(E4,$E$4:$E$15,1)

3. Drag them. You will see the ranking along with the pivot table.

Determining the Nth Largest and Smallest Value

With these steps used above, you will find the largest and smallest value
within the descriptive statistics column. This time, you will have to tick the
box on the Kth Largest and Kth Lowest boxes.



Creating a Frequency Distribution using Groups

When you organize a vast quantity of data into a grouped frequency
distribution, you may detect patterns in the data more easily. For instance,
with student test results, the first category may score less than or equal to
50, the second 51 to 60, and so on, up to scores between 91 and 100. To get
the number of occurrences in each category, use the Excel FREQUENCY
function:

FREQUENCY(data_array, bins_array)

FREQUENCY accepts two arguments: data array and bins array. the data
array is the list of values to the group, and the bins array is the list of
groupings (also known as bins) to utilize. FREQUENCY is entered as an
array formula in the same number of cells as the number of groups. If you
had six groups, for instance, you would put the formula into six cells. The
steps are as follows:

Choose the cells where the aggregated frequency distribution should be
shown.

=frequency( is a frequency type.

You may either type in or choose the things you'd want to group.

Enter or pick the list of groups behind a comma.



Keep the number of groups in your frequency distribution to a minimum,
five to ten is a decent amount. You may lose your capacity to easily
communicate information if you have too few or too many groups. Trends
may be hidden by using too few intervals, while details can be hidden by
using too many intervals. It's also a good idea to keep your intervals simple.
Five, ten, or twenty-minute intervals are appropriate since they are simple
to comprehend. Start your interval with a number that is divisible by the
interval size, making it easier to interpret your frequency distribution.
Finally, the number of values in each period should be the same. This, once
again, makes your frequency distribution simple to comprehend.

(Select).

Hold down Ctrl+Shift and then click the Enter button or press
Ctrl+Shift+Enter.

Finding the correlation

Correlation is a measure of how closely two sets of data are related.
Whether you have monthly numbers for advertising costs and sales, for
example, you could ask if more advertising expenses result in more sales, or
if the two values are connected.

It's important to remember that a connection does not imply that one item
causes the other. You can only claim that one number differs from the other.

The CORREL function in Excel is used to discover a correlation:

CORREL CORREL CORREL (array1, array2)

CORREL has two arguments: array1 and array2, which are two numeric
lists. The correlation coefficient, which is a value between –1 and 1, is
returned by CORREL. Whether the connection is positive (+) or negative
(–) is indicated by the sign.

 

 

 



CHAPTER TWELVE

ANALYZING DATA USING DESCRIPTIVE STATISTICS

Loading the Analysis ToolPak

Click on File and select Options. In the dialog box that displays, click Add-
Ins choose Excel Add-Ins, and click GO.

The Add-Ins dialog box will open. Click on Analysis ToolPak. Click Ok.



The tool will be added to the Data Analysis group under the Data Tab.

Calculating a Moving Average

By using the AVERAGE function in several iterations, the Moving Average
function in Excel is used to provide the average of moving iteration data.
The dataset, which may include several ebbs and flows, is smoothed out
using a moving average.

We may utilize an integrated program for Moving Average, which can be
found under the Data menu ribbon's Data Analysis option. Pick the input
range and output cell for this, and the smoothed moving average data will
be returned instantly.

Pick at most the latest three iteration data if we wish to utilize the
AVERAGE function. In several disciplines, the moving average approach is
commonly utilized in Sales Forecasts and Estimation of the Next Quantity.

Where to find this tool;

The tool is in-built, yes, but you have to unleash it from where it is. You can
find it under the ANALYSIS TOOLPAK option in Excel. You get it on the



Data Analysis tab as explained above.

When you click on it, you will find the Moving Average option. Now, let’s
have an example. We will do this with the help of the average formula. So,
below I have some data on my worksheet.

So, I click on the Data Tab and pick Data Analysis. The Data Analysis box
will display. Search for Moving Average and choose it. select Ok.

In the next box that displays, choose the sales data from B2 to B13 for the
Input Range option. On the interval option, you are to put in how many
months that is needed to be removed by the average.

Here, I used 3. Then, choose the output range. I chose cell C2. Choose the
Chart Output. This is optional. If you want to show a chart, then pick it.
choose Ok when you are done.



You will find the Moving Average chart and the output in your worksheet.

Determining Rank and Percentile

Calculating where one item ranks in relation to the other things in a group is
a typical kind of data analysis. For example, you could want to see how one
group's overall number of defects compares to the other groups in a data set
that indicates the number of product defects by the workgroup. You may
also wish to compute the percentile, which is the proportion of items in the
sample that are at the same or lower level than a particular value.

You may compute the rank using Excel's RANK.EQ and RANK.AVG
functions and you can calculate the percentile using the
PERCENTILE.EXC and PERCENTILE.INC functions, as I discuss in
Chapter 11, "Analyzing Data with Statistics." These are fine worksheet
functions, but if you don't mind utilizing static results, the Analysis
ToolPak's Rank and Percentile tool can generate these numbers quickly and
with less effort.

The following is how it works:
Select Data Analysis from the drop-down menu.
The Data Analysis dialog box appears in Excel.



Select Rank and Percentile from the Analysis Tools section, then
click OK.
The Rank and Percentile dialog box appear in Excel.
To define the range of cells to analyze, use the Input Range box.
If your data is in rows, make sure the Rows radio option is selected.
Select the Labels in the First Row check box if your data range
contains labels (or the Labels in the First Column check box, if your
data is in rows).
Enter or click the upper-left corner of the range where you wish the
results to show in the Output Range box.
You may also choose New Worksheet Ply to dump the numbers into a
new worksheet, or New Workbook to create a new file to save the
information.
The Rank and Percentile dialog box is seen in its finished state in the
picture.
Click the OK button.

As seen in the image, Excel calculates the rank and percentile values and
displays them in the place you defined in Step 4. The example data in this
instance is the worksheet's Defects column (D3: D:22).



Generating Random Numbers

When you're constructing a data analysis model in Excel, it won't be worth
a damn if it doesn't have any data in it so you can put it through its paces.
You can add some placeholder test values by hand if you don't have any
data, but it seems like a lot of effort. Fortunately, you may avoid that time-
consuming task by using the Analysis ToolPak's Random Number
Generation tool, which will happily produce a set of random values for your
model.

True, Excel has tools for generating random integers in the spreadsheet, but
these functions, although helpful, are restricted. The RAND function, for
example, creates random numbers between 0 and 1, whereas the
RANDBETWEEN function generates random numbers between two
values. Go ahead and use either function if it meets your data needs.

RAND and RANDBETWEEN's figures, on the other hand, aren't always
relevant since they aren't practical. If your data model is based on student
test scores, for example, random values between 40 and 100 are unrealistic
since student test scores are nearly usually distributed as a bell curve, with
most of the results clustered in the center and just a few outcomes on the
high and low ends.



The Random Number Generation tool allows you to produce random values
using different distributions that determine the pattern of the data to assist
you achieve more realistic random numbers.

Here's a basic overview:

Uniform: From the range of values you specify, generates numbers
with an equal probability (which makes the Uniform distribution
similar to the RANDBETWEEN worksheet function).
Normal: Generates numbers based on a mean and standard deviation
in a bell curve distribution.
Bernoulli: Generates a random succession of 1s and 0s depending on
the likelihood of a single trial being successful.
Binomial: Generates random numbers based on the likelihood of
success across a set of trials.
Poisson: Produces random numbers depending on the likelihood of a
certain number of events happening within a given time period.
Patterned: Produces random numbers based on a pattern defined by
a lower and upper limit, step value, and repetition rate.
Discrete: Generates random numbers based on a set of variables and
their probability.

Don't be concerned if you don't grasp all of these distributions or even how
to pronounce any of them. Feel free to play about with each one to see what
you come up with. The procedures for using the Random Number
Generator tool are as follows:

Select Data Analysis from the drop-down menu.
The Data Analysis dialog box appears in Excel.
Select Random Number Generation from the Analysis Tools box,
then click OK.
The dialog window for Random Number Generation appears.
Choose the number of random numbers you wish to produce.
Enter the desired number of random number sets in the Number of
the Variables text box. This is the number of columns in the output
that will be created.
Enter the number of random numbers you want in each batch in the
Number of Random Numbers text box. This is the number of rows in
the output that will be created.



Select the sort of distribution you wish to employ from the
Distribution list.
To define the distribution parameters, use the controls in the
Parameters group.
The choices you see are determined by the distribution you choose in
Step 4. The Normal distribution is chosen in the Random Number
Generation dialog box displayed in the figure, thus the parameters are
a mean value and a standard deviation.
(Optional) Enter a starting point for the random number generation in
the Random Seed text box.
You may start the production of random numbers by providing a
value that Excel will utilize. The advantage of employing a Random
Seed value, as Excel refers to it, is that you may use the same "seed"
to generate the same collection of random numbers in the future.
Enter or click the upper-left corner of the range where you wish the
random numbers to appear in the Output Range box.
You may also choose New Worksheet Ply to add the random numbers
to a new worksheet, or New Workbook to create a new file for the
output.
Click the OK button.

As illustrated in the figure, Excel creates random numbers and then displays
them in the area you defined in Step 7.

Creating a Frequency Distribution



We will do this by using the frequency function. The frequency formula is
=FREQUENCY (data_array, bins_array).

Data array: The frequencies are counted using a set of array values.
The frequency function outputs an array of value 0 if the data array
values are zero.
Bins array: A collection of array values that are used to organize the
input array's contents. It will yield the array items from the data
sequence if the bin array values are zero. you will find this function in
the formula tab.

Steps in doing this;

Here is my table here, I have a dataset that consists of twenty values.

So, the first thing to do is to let Excel know the upper limits for our bins in
the frequency distribution. Here, I used 10, 20, and 30 i.e. 0-10, 11-20, 21-
30, and 30+.



Now, to calculate the frequency of each bin, I will apply the Function
formula. =Frequency (A2:A21,C2:C4).



Only 6 values are in the range of 0-10, only 7 values are in the range of 11-
20, only 5 values are in the range of 21-30, and only two values are bigger
than 30. Now, with the steps below, we will visualize the distribution.

First, highlight D2:D5. Select Insert from the ribbon and click on the 2-D
Column. A chart will be displayed on your worksheet which shows the
frequencies for each bin.



CHAPTER THIRTEEN

ANALYZING DATA USING INFERENTIAL STATISTICS

In this chapter, I discuss the Excel Analysis ToolPak add-more in's
advanced features, such as sampling, t-test, z-test, scatter plot, regression,
correlation, ANOVA, and f-test. Inferential statistics are used to look at a
set of sample data selected from a population and then draw conclusions —
that is, make inferences — about the population's features using these other
methods. (Skip back to Chapter 12 to learn about the basic descriptive
statistical tools that Excel provides with the Analysis ToolPak add-in.) If
you haven't previously done so, go back to Chapter 12 to discover how to
install the Analysis ToolPak add-in.)

It's important to note straight away that in order to utilize these tools, you'll
need a solid understanding of statistics. A solid fundamental statistics
course in college or graduate school, and maybe a follow-up course, is what
I'm talking about. All of these technologies may be put to good use if you
have a fair understanding of statistics and a little patience.

Data Sampling

You may choose items from a data collection either randomly or frequently
using the Analysis ToolPak's Sampling tool, with "regular" implying that
you select every nth item. Why would you want to do anything like that?
The most typical explanation is that your whole data collection (the
population) is too large to analyze in a reasonable amount of time. So,
instead of extracting a sample, you apply the inferential statistical methods
described in this chapter on the sample to derive inferences about the
population.

As an example, assume you wish to choose 20 orders at random from a
table of invoices as part of an internal audit. That's an ideal job for the
Sampling tool!



Select Data Analysis from the drop-down menu.
The dialog window for data analysis appears.
Select Sampling from the Analysis Tools section then clicks OK.
The Dialog Box for Sampling displays.
Specify the range of cells from which you wish to extract your
sample in the Input Range box.
Only numeric values are allowed in the range you choose. Select the
Labels check box if your data range has a label.
Select a sampling technique.

For retrieving items from your data collection, Excel supports two
sampling methods:

Periodic: Extracts the data set's every nth item, such as every fifth or
tenth item. Select the Periodic radio button and then type the period
you wish to use in the Period text box to utilize this approach.

Random: Takes elements from the data collection at random. Select the
Random radio button and then enter the number of items you wish to
extract in the Number of the Samples text box to utilize this approach.

Select the Output Range radio button and type or click the upper-left corner
of the output range to pick a place for the output data.

Alternatively, you may choose New Worksheet Ply to insert the sample into
a new worksheet, or New Workbook to save the results to a new file.



The picture depicts the Sampling dialog box in its finished state. In this
scenario, I want a random sample of 20 items from the Quantity column in
the Invoices database, which is Q2:Q1060.

Click the OK button.

The sample is extracted and displayed in the place you chose in Step 5. An
example may be seen in the picture. The example data in this instance is the
table's Defects column (D3:D22).

Using t-Testing Tools

When you wish to draw conclusions about relatively tiny data sets, the
Excel Analysis ToolPak add-in includes three tools for dealing with t-
values and t-tests:

paired t-test Means are calculated using two samples.

Two-Sample t-Test Assuming Equal Variances

Two-Sample t-Test Assuming Unequal Variances

Here's how these three tools function in a nutshell. Assume you're dealing
with the values displayed in the figure for the purpose of example. The first
set of values may be found in the worksheet range A1:A21. The second set
of numbers may be found in the worksheet range B1:B21.

Follow these procedures to do a t-test calculation:



Select Data Analysis from the drop-down menu.

The dialog window for data analysis appears.

Select the t-test tool you wish to use from the Analysis Tools list, then
click OK.

Paired Two-Sample t-Test for Means: When you need to do a paired two-
sample t-test, use this tool.

Two-Sample t-Test Assuming Equal Variances: When you need to do a two-
sample test and have reason to believe that the variances of both samples
are equal, use this tool.

Two-Sample t-Test Assuming Unequal Variances: When you need to do a
two-sample test but know that the two-sample variances are uneven, use
this tool.



The matching t-test dialog box appears in Excel. The t-Test: Two-Sample
Assuming Equal Variances dialog box is shown in the picture. The other t-
test dialog windows have a similar appearance.

Identify the sample values in the Variable 1 Range and Variable 2 Range
input text fields by informing Excel which worksheet ranges you've saved
the two samples in.

These text fields allow you to input a range of addresses. Alternatively, you
may click in the text box and then drag to pick a range. Select the Labels
check box if the first cell in the variable range has a label and you want to
incorporate the label in your range selection.

Indicate whether you believe the means are equal in the Hypothesized Mean
Difference text box.

If you believe the samples' means are equal, write 0 (zero) or leave the text
field blank. Enter the mean difference if you believe the means are not
equal.

Put the confidence level for your t-test calculation in the Alpha text box.

The degree of confidence ranges from 0 to 1. The confidence level is set to
0.05 by default, which is comparable to a 5-percent confidence level.

Indicate where the t-test tool results should be saved in the Output Options
section.

Select one of the radio options and type information into the text fields to
tell Excel where the t-test analysis results should go. Select the Output
Range radio option, then enter the range address in the Output Range text
box to insert the t-test results into an existing worksheet range. Select one
of the other alternative radio buttons if you wish to put the t-test findings
somewhere else.

Click the OK button.



   

Determining the Regression

I discuss adding trend lines to scatter charts in Chapter 10, "Tracking
Trends and Making Forecasts," to help you see the overall trend of your
data. By utilizing the Analysis ToolPak's Regression tool, you may go
beyond the visual regression analysis provided by the scatter plot approach.
Let's imagine you started looking at a basic data set using the scatter
charting approach I described before. And, following that first inspection,



say you want to dig further into the data by utilizing full-fledged, no-holds-
barred regression.

To use the Regression tool to do regression analysis, follow these steps:

Select Data Analysis from the drop-down menu.

The dialog window for data analysis appears.

Choose the Regression tool from the Analysis Tools section, then
click OK.

The Regression dialog box appears in Excel.

Find out what your Y and X values are.

Specify the worksheet range containing your dependent variables using the
Input Y Range text box. Then, using the Input X Range text box, find the
worksheet range reference where your independent variables are stored.

Choose a place where the regression analysis findings will be saved.

Use the Output Options radio buttons and text boxes to tell Excel where to
save the regression analysis findings. Select the Output Range radio button
and then enter the range address in the Output Range text box to insert the
regression results into a range in an existing worksheet, for example. Select
one of the other alternative radio boxes to put the regression findings
somewhere else.

Determine what information you want to be returned.

To define the residual findings, you want to be returned as part of the
regression analysis, use the Residuals checkboxes.

To add residuals and normal probability information to the regression
analysis results, use the Normal Probability Plots check box.

The picture depicts the dialog box in its finished state.

Click the OK button.

The graphic displays three stacked visual plots of data from the regression
analysis, as well as a part of the regression analysis findings. The R-square
value, the standard error, and the number of observations are all part of a



range that provides some fundamental regression statistics. The Regression
tool provides analysis of variance (or ANOVA) data below that, including
information on degrees of freedom, sum-of-squares value, mean square
value, f-value, and F significance. The Regression tool, which appears
beneath the ANOVA information, provides information about the regression
line calculated from the data, including the coefficient, standard error, t-stat,
and probability values for the intercept — as well as the same information
for the independent variable, which in this example is the number of ads.
Excel also uses basic scatter charts to depict some of the regression results.
Excel plots residuals, predicted dependent values, and probabilities in the
image, for example.

Correlation Calculation

The Correlation analysis tool (also included in the Analysis ToolPak)
calculates the relationship between two sets of data. This tool could be used
to investigate the impact of advertising on sales, for example. Follow these
steps to utilize the Correlation Analysis tool:

Select Data Analysis from the drop-down menu.
The dialog window for data analysis appears.
Select the Correlation tool from the Analysis Tools list, then click
OK.
The Correlation dialog box appears in Excel.
Determine the range of X and Y values you want to look at.
Use the Input Range box to find the worksheet range where your data
is stored.



Excel believes that your data is in columns, so it automatically picks the
Columns radio option in the Grouped By section. Select the Rows radio
choice instead if your data is in rows. Select the Labels in First Row (or
Labels in First Column) check box if the input range contains labels in the
first row (or first column).

Choose a destination for the output.

Use the Output Options radio buttons and text boxes to tell Excel where the
correlation analysis findings should go. Select the Output Range radio
option and then type the range address in the Output Range text box to
insert the correlation results into an existing worksheet range. Select one of
the other radio buttons if you wish to save the correlation findings
somewhere else.

Click the OK button.

Excel calculates the correlation coefficient for the data you entered and
saves it in the location you chose. This graph depicts the link between list
price and units sold. Cell E3 contains the key value. The value –0.96666
indicates that list price and units sold have a strong negative correlation.
That is, when the list price rises, the number of units sold decreases.

Calculating the Covariance

The Covariance tool, which is also part of the Analysis ToolPak add-in,
measures the connection between two sets of data. The average of the
product of value deviations from the data set means is calculated using the
Covariance tool.

Follow these instructions to utilize this tool:

Select Data Analysis from the drop-down menu.

The dialog window for data analysis appears.

Select the Covariance tool from the Analysis Tools list, then click
OK.

The Covariance dialog box appears in Excel.

Determine the range of X and Y values you wish to look at.



Use the Input Range box to find the worksheet range where your data
is stored.

Because Excel believes your data is in columns, the Columns radio option
in the Grouped By section is automatically selected. Select the Rows radio
choice instead if your data is in rows. Select the Labels in First Row (or
Labels in First Column) check box if the input range contains labels in the
first row (or first column).

Choose a destination for the output.

Use the Output Options radio buttons and text boxes to tell Excel where the
covariance analysis findings should go. Select the Output Range radio
option and then type the range address in the Output Range text box to
insert the results into an existing worksheet range. Select one of the other
Output Options radio buttons if you wish to save the results somewhere
else.

The picture depicts the dialog box in its finished state.

After you've chosen your export settings, click OK.

Excel generates the covariance information for the data you selected and
saves it in the location you chose. The correlation findings for the list price
and units sold data are shown in the image.

Using Anova Tools

ANOVA: Single Factor, Anova: Two-Factor With Replication, and Anova:
Two-Factor Without Replication are three Anova (analysis of variance)



tools included in the Analysis ToolPak add-in. You may compare sets of
data using the Anova tools by looking at the variation of values in each set.

The following are the steps to using an Anova tool:

Select Data Analysis from the drop-down menu.

The dialog window for data analysis appears.

Select the Anova tool you wish to use from the Analysis Tools list,
then click OK.

The corresponding ANOVA dialog box appears in Excel.

Describe the information that will be analyzed.

Use the Input Range box to find the worksheet range where your data
is stored.

Because Excel believes your data is in columns, the Columns radio option
in the Grouped By section is automatically selected. Select the Rows radio
choice instead if your data is in rows. Select the Labels in First Row (or
Labels in First Column) check box if the input range contains labels in the
first row (or first column).

Describe where the Anova results will be stored.

Use the Output Options buttons and boxes to tell Excel where the Anova
analysis findings should go. Select the Output Range radio option and then
enter the range address in the Output Range text box if you wish to insert
the Anova results into a range in an existing spreadsheet, for example.
Select one of the other Output Options radio buttons to place the Anova
findings somewhere else.

The picture depicts the Anova: Single Factor dialog box in its finished
state.

Click the OK button.

The Anova calculation results are returned by Excel.



Performing an f-test

An f-test is a test that is used to determine whether or not something is true.
A tool for calculating two-sample f-test calculations is included in the Excel
Analysis ToolPak add-in. You can compare variances between two
populations using an f-test analysis.

The following are the steps to using the f-test tool:

Select Data Analysis from the drop-down menu.

The dialog window for data analysis appears.

Select the F-Test Two-Sample for Variances tool from the Analysis
Tools list, then click OK.

The F-Test Two-Sample for Variances dialog box appears in Excel.

Identify the sample values in the Variable 1 Range and Variable 2
Range input text fields by informing Excel which worksheet ranges
you've saved the two samples in.

These text fields allow you to input a range of addresses. Alternatively, you
may click in the text box and then drag to pick a range. Select the Labels
check box if the first cell in the variable range has a label and you want to
incorporate the label in your range selection.

Put the confidence level for your t-test calculation in the Alpha text box.



The degree of confidence ranges from 0 to 1. The confidence level is set to
0.05 by default, which is comparable to a 5-percent confidence level.

Describe where the f-test results will be stored.

Use the Output Options buttons and boxes to tell Excel where the f-test
analysis findings should go. Select the Output Range radio button and then
enter the range address in the Output Range text box, for example, if you
wish to insert the results into a range in an existing worksheet. Select one of
the other Output Options radio buttons to save the results somewhere else.

The image depicts the F-Test Two-Sample for Variances dialog box in its
completed state.

Click the OK button.

The results of the f-test computation are returned by Excel.

 

 



CHAPTER FOURTEEN

TEN THINGS YOU OUGHT TO KNOW ABOUT STATISTICS

Counting, averaging, adding, and standard deviation the data are all part of
the "analysis" aspect of "data analysis." In a nutshell, statistics play a big
role in data analysis. However, here's the problem with statistics: It's a topic
that quickly becomes difficult once you get beyond the fundamentals.
Fortunately, you can jump over many of these early statistics stumbling
blocks like a gazelle by understanding a few fundamentals, which is what
this chapter is all about.

When I say "basics," I mean just that. There will be no discussion of
statistical jargon like chi-squared distributions or Fourier analysis in the
paragraphs that follow. This chapter has no Greek letters.

If you've never been exposed to statistics in school or it's been a decade or
two since you were, you'll find some important background information
here to help you utilize some of Excel's statistical capabilities.

Descriptive statistics are simple to understand.

The first thing you should know about statistics is that certain statistical
analyses and statistical measurements are rather simple. Even for someone
who isn't very quantitative, descriptive statistics, which include things like
pivot table cross-tabulations (covered in Chapters 7–9) and basic statistical
functions, make sense. When you add up a series of numbers, you obtain a
total. Isn't that simple? Finding the largest or lowest value in a group of
numbers is also rather basic.

This argument regarding descriptive statistics is important since many
individuals become nervous when they hear the term statistics. That's a
shame since descriptive statistics is among the most valuable statistical
tools you have at your disposal.

Deviation from the mean Explains the concept of dispersion.

If you've ever taken a statistics class, you may recall this oddity. When
someone says "average," she typically means the most frequent average



measurement, which is the mean. However, you should be aware that there
are numerous other widely recognized average measures, such as mode,
median, and other special mean measurements, such as the geometric mean
and harmonic mean.

I'd want to briefly go through a few of them... Not because you need to
know everything, but because knowing that the word average is inaccurate
helps you appreciate some of the book's talks and much of Excel's statistical
features.

Assume you're looking at a limited collection of numbers: 1, 2, 3, 4, 5, to
make this topic more specific. The mean of this tiny group of numbers is 3,
which you can get by adding all of the numbers in the set (1+2+3+4+5) and
then dividing the total (15) by the total number of values in the set (5).

The mode and median are two more frequent average metrics. I'll start with
the median measurement since it's easy to understand given the data set I
introduced in the previous paragraph. In the sense that there are as many
values bigger than the median as there are values less than the median, the
median is the halfway value. The median is the data set 1, 2, 3, 4, 5 is 3.
Why? Because there are two bigger values (4 and 5) and two lower values
in this data set (1 and 2).

When your data collection has an even number of values, the median is
calculated by averaging the two middle values. The data sets 1, 2, 3, and 4
have no middle value, for example. Divide by 2 after adding the two middle
numbers (2 and 3). The median number obtained from this computation is
2.5. Half of the data set's values are above the median value of 2.5, while
half of the data set's values are below the median value of 2.5.

A third common average is used to calculate the mode. The most frequent
value in the data set is the mode. Consider the following data set: 1, 2, 2, 2,
3, 5, 5. The numbers 1 and 3 appear just once, whereas 5 appears twice and
2 appears three times. As a result, the most frequent value is 2, and the data
set's mode is 2.

Other popular statistical metrics of the average exist, as I mentioned
previously. Because the numbers in the data set are joined together
arithmetically as part of the calculation, the mean measurement I mentioned
previously in this article is really arithmetic mean. However, you may mix



and match the values in numerous ways. A geometric mean, for example, is
sometimes used by financial analysts and scientists. There's also a concept
known as a harmonic mean.

You don't need to know (much less comprehend) these additional average
metrics, but keep in mind that since there are so many different methods to
compute an average, just using the word average is inaccurate. Make sure
everyone understands what kind of average you're utilizing. What if
someone else uses the word average without indicating the sort of average?
That individual is most likely talking about the mean, but you can't be sure,
and uncertainty is harmful when it comes to statistics.

Standard Deviations Describe Dispersion

In most statistical reports, the standard deviation or its near sibling, the
variance, is mentioned in some ambiguous or frightening way. Although the
standard deviation formula is intimidating to look at — at least if you're not
familiar with the Greek letters — the formula and rationale are intuitively
simple to grasp.

The standard deviation describes the dispersion of values in a data
collection around the mean. In general, a low standard deviation indicates
that the values are grouped around the mean; a large standard deviation
indicates that the values are spread out away from the mean.

For example, later in this chapter, I discuss the normal distribution, which is
a set of items in a data set that, when plotted, produces the classic bell
curve: low at the start for the smallest values, curving up to a peak at the
mean value, curving down from the mean, and then low again for the
largest values. That's all a little hazy, but standard deviation may help you
become a lot more specific. That's because the standard deviation reveals
something about how the items in the normal distribution are clustered:

The data set has 68 percent of values that are within one standard deviation
of the mean. If the mean is 50 and the standard deviation is 10, then 68
percent of the values are in the range of 40 to 60.

The data set's 95 percent of the values are within two standard deviations of
the mean. 95 percent of the results with a mean of 50 and a standard
deviation of 10 are between 30 and 70.



The data set contains 99.7% of values that are within three standard
deviations of the mean. With a mean of 50 and a standard deviation of 10,
99.7% of the values fall between 20 and 80 percent of the time.

An Observation is an Observation

If you read anything about statistics in this book or in the Excel online
Help, you'll come across the phrase observation. An observation is nothing
more than that. Please bear with me if this seems cyclical. Assume you're
putting together a data collection of daily high temperatures in your area.
When you step outside and see that the temperature is 87° F on a beautiful
July day, that is your first observation. The second observation is when you
step outside and see that the high temperature the following day is 88° F.

Another way to define observation is as follows: You make an observation
whenever you give a value to one of your random variables. When you
walk out and give a new temperature value (87° one day, 88° the next, and
so on) to a data collection of daily high temperatures in your area, for
example, you're producing an observation.

A Sample is a Subset of Values

A sample is a subset of a population's observations. Your little collection of
observations, for example, is a sample if you establish a data set that
records the daily high temperature in your area.

A sample, on the other hand, is not the same as a population. All available
observations are included in a population. When collecting daily high
temperatures in your area, the population includes all daily high
temperatures from the community's inception.

Inferential Statistics Are Interesting, but They're Also Complicated

Some numbers, as I said previously in this chapter, are simple to
comprehend. Calculating the biggest value in a collection of integers, for
example, is unmistakably a statistical measurement, but there's no mystery
involved. Descriptive statistics, for example, determine the greatest value in
a data set, and for the most part, we mere mathematical mortals can grasp
such statistics.



The same cannot be stated for inferential statistics, the second major
discipline of statistics. Inferential statistics are based on a highly valuable
concept that isn't immediately apparent. You may make inferences about the
whole population based on the features of a sample of values from a
population if the sample is representative and big enough.

For example, in every presidential election in the United States, the main
television networks predict the victor when just a tiny number of votes have
been tallied or counted (typically counter to their prior assurances). What
are their methods for doing this? They do, after all, take a sample of the
population. They specifically stand outside polling stations and inquire
about how individuals voted. You may deduce how all the voters voted if
you ask a significant sample of voters whether they voted for one candidate
or the other. After that, you can forecast who will win the election.

 

Although incredibly effective, inferential statistics have two
characteristics that I want to highlight:

Issues with accuracy: When making a statistical inference, you may never
be completely certain that your conclusion is true. It's always possible that
your sample isn't representative or that the accuracy of your sample isn't
high enough to estimate the population value.

This is largely what transpired in the United States during the presidential
election of 2000. On the basis of exit surveys, several of the major news
networks projected that Al Gore would win. They then anticipated that
George W. Bush would win based on previous exit surveys. They then
ceased forecasting the race, either understanding that their statistics weren't
good enough given the closeness of the race, or just because of their
personal shame at bobbling the ball. In hindsight, their difficulty in
predicting the contest was unsurprising given the razor-thin margin of
victory between the two contenders.

A steep learning curve: Inferential statistics may get rather sophisticated
very rapidly. When working with inferential statistics, you'll come across
phrases like probability distribution functions, insane (in some
circumstances) parameters, and a lot of Greek symbols right away.



In practice, if you haven't taken at least one statistics class — and most
likely more than one statistics class — it will be difficult to move into
inferential statistics in a significant way. With a single statistics class and
possibly the information in this book, you should be able to work with
inferential statistics based on normal and uniform distributions. Working
with inferential statistics and applying them to different probability
distributions, on the other hand, maybe difficult. At least, that's what I've
noticed.

Probability Distributions aren't always difficult to understand.

A probability distribution is one of the statistical concepts you'll come
across a few times in this book — and a lot more if you go into the Excel
Help file. This sentence seems to be difficult, and in some circumstances, it
is. With a few good examples, you can genuinely comprehend what a
probability distribution is.

A T distribution is a popular distribution that you may have heard about in
statistics lectures. A T distribution is similar to a normal distribution, except
that the tails are longer and fatter. There are also skewed distributions (those
with the hump inclined in one direction or the other). The probability
distribution function for each of these probability distributions, on the other
hand, specifies the probability distribution chart.

I'll look at two probability distributions in the following two sections:
uniform distribution and normal distribution.

Uniform Distribution

A uniform distribution is a common probability distribution function. Every
event has the same chance of occurring in a uniform distribution. As an
example, imagine you're rolling a six-sided die. If the die is fair, you have
an equal chance of rolling one of the following numbers: 1, 2, 3, 4, 5, or 6.
Given the enormous amount of observations, you might anticipate rolling a
1 roughly 10,000 times if you roll the dice 60,000 times. Similarly, you'll
very certainly roll a 2, 3, 4, 5, or 6 10,000 times. Sure, there will be some
variation between what you anticipate (10,000 occurrences of each side of
the six-sided die) and what you get. Your actual observations, on the other
hand, would closely match your assumptions.



The thing that makes this distribution stand out is that everything is rather
level. The probability or likelihood of rolling any of the six sides of the die
is even, or uniform. This is where the term "uniform distribution" comes
from. Every event has the same chance of happening. I constructed a
uniform distribution by simulating 60,000 dice rolls, as seen in the figure.
(Can you tell me how I made those rolls? By first inserting the formula
=RANDBETWEEN(1,6) and then copying and pasting it into 60,000 cells.)
The uniform distribution is simply a horizontal line, as you can see.

Normal Distribution

The normal distribution, often known as a bell curve or a Gaussian
distribution, is another frequent kind of probability distribution.

In many instances, a normal distribution happens spontaneously.
Intelligence quotients (IQs), for example, are normally distributed. A
normal distribution is created by taking a large group of individuals, testing
their IQs, and then plotting their IQs on a graph. The fact that the majority
of the population's values are centered around the mean is one of the
characteristics of a normal distribution. Another feature of a normal
distribution is that the mean, mode, and median all have the same value.



A probability distribution function is nothing more than a function, or
equation, that describes the distribution's line. Not every probability
distribution resembles a normal or uniform distribution, as you would
expect.

Parameters aren't as complicated as they seem.

You're ready to comprehend that a parameter is an input to the probability
distribution after you realize that a probability distribution is simply an
equation or formula that represents the line in a probability distribution
chart. To put it another way, the formula, function, or equation that
represents a probability distribution curve requires inputs, which are known
as parameters.

Only one parameter is required for certain probability distribution
functions. For example, all you truly need to work with a uniform
distribution is the number of values in the data collection. There are only
six choices on six-sided dice, for example. You can calculate that every
option has a 1 in 6 probability of occurring since you know there are only
six choices. The mean and standard deviation are the two parameters that
make up a normal distribution. Other parameters are used in other
probability distribution functions.

Skewness and Kurtosis Describing a Probability

Skewness and Kurtosis are terms used to describe the skewness and kurtosis
of a probability distribution. Skewness and kurtosis are two further
statistical words to be familiar with. Skewness is a measure of a probability
distribution's lack of symmetry. The skewness of a completely symmetrical
distribution, such as the normal distribution, is zero. However, if a
probability distribution leans to the right or left, the skewness equals a
number other than zero, and the number represents the absence of
symmetry.

The heaviness of the tails in distribution is measured by kurtosis. Kurtosis
equals 0 in a normal distribution. To put it another way, zero is the
measurement for a tail that resembles a normal distribution tail. The thing
that stretches out to the left or right is the tail. The kurtosis is a positive
value if a tail in distribution is heavier than in a normal distribution. The



kurtosis of a distribution is a negative value if the tails are thinner than in a
normal distribution.

Confidence Intervals May Appear Difficult at First, but They Are
Beneficial.

People are often perplexed by probabilities, and this is likely most evident
during presidential elections in the United States. Pundits speak about a
candidate's prospects of winning in a variety of misleading ways (often in
ways confusing to even the pundits themselves).

"According to the findings of a recent survey, candidate Stem Winder
would earn 51 percent of the vote if the election were conducted today; the
margin of error was +/- 3 percent with a confidence level of 95 percent,"
claims some TV pundit.

Okay, that was a lot, but if you break it down, things get a bit clearer. The
survey's true meaning is as follows: The pollsters questioned a random
sample of the US public who they would vote for today, and 51 percent of
the people answered they would vote for Mr. Winder.

This is when things start to get interesting. Because of the sample size,
pollsters can perform some clever arithmetic and deduce that the true
proportion of persons who would vote "Winder" in the overall population is
between 48 and 54 percent (more on this later). It's worth noting that
"margin of error" is essentially the same thing as "confidence interval."

It's crucial to understand the relationship between confidence levels and the
margin of error. The margin of error calculated by the pollsters in the
preceding example would be larger if they wanted a range of values with a
confidence level of 99 percent.

To put it another way, there's a 95 percent chance (sort of) that the real
percentage of people who would vote "Winder" in the entire population is
between 48 and 54 percent, but a 99 percent chance (again, sort of) that the
real percentage is between 45 and 57 percent. The greater the range of
probable values, the more certain you may be that the actual data point will
fall inside it. The greater your range, on the other hand, the surer you want
to be that the true data point is contained in it.



This is why one of my pet peeves is that when news organizations report on
polls, they often just mention the margin of error and not the confidence
level. The information on the margin of error is rather pointless without
knowing the confidence level that the pollster used to compute it.

Another key point to remember regarding confidence levels is that for the
same confidence level, the larger your sample size, the narrower your
margin of error will be. If you poll two individuals on the street and ask
them who they expect to vote for, and one answers "the challenger" and the
other says "the incumbent," you can't declare with certainty that the nation
will vote in a 50-50 split. Unless you select a very low confidence level for
your computations, data from this sample would have a huge margin of
error.

If you take a random sample of 5,000 individuals and ask them who they're
voting for, you'll have some fairly strong footing to stand on when
predicting who will win the presidential election. To put it another way, a
sample of 5,000 individuals has a lot lower margin of error than a sample of
two, assuming you desire the same degree of confidence for both samples.

Making a minor adjustment at a point: Although it was simpler to use as
an explanation when initially introducing the fundamental notion of a
confidence interval, I wasn't exactly right when I claimed that the
confidence interval meant that there is a 95% probability that the true value
falls inside this range. Technically, a confidence interval with 95 percent
confidence means that if you took different samples from the same
population over and over again, and then calculated the confidence interval
for those samples in the exact same way for each new sample, the
confidence intervals you calculated from the samples would include the real
number about 95 percent of the time (because your data from each sample
will be slightly different each time, and therefore the interval you calculate
will be slightly different as well). So when I say "95 percent chance" or "99
percent chance," I mean exactly what I say. (I need to offer this explanation
so that if my old statistics instructors read this book, they don't shake their
heads in shame.)

My last argument is that using confidence intervals for election prediction is
far from the only thing you can do with them.



Considering the following scenario: you have Google Analytics data on
two separate online advertising you're running to market your small
company, and you want to know which one is more successful. You may
use the confidence interval calculation to determine how long your
advertisements should run until Google has gathered enough data to
determine which ad is really superior. (In other words, the formula
determines the sample size required to overcome the margin of error.)



CHAPTER FIFTEEN

TEN WAYS TO ANALYZE FINANCIAL DATA

Scientists, engineers, mathematicians, statisticians, and pollsters are among
those who utilize Excel. However, if you could poll all of the world's Excel
users, I'm sure the majority of them work in the financial business.
Financial types depend on Excel every day to examine budgets, loans,
investments, and other monetary details, whether they're accountants or
adjusters, bankers or borrowers, money managers or money lenders.

Excel is used by more than just financial professionals (sometimes
literally). Excel may also be used to assess mortgages, auto payments,
education funds, savings accounts, and other day-to-day finances by
financial novices.

Whether you work for money or for money, this chapter will teach you 10
helpful Excel strategies for evaluating financial data.

Calculating Future Value

Excel has lots of financial functions. People use these functions to calculate
their day-to-day activities in their company or firm. Some of the functions
are Future Value (FV), FVSCHEDULE, Present Value (PV), XNPV, PPMT,
and lots more. Below are some of the ways you can utilize these functions
in Excel.

The Function Value (FV) is used to discover the future value of an
investment. It contains the interest rate that doesn’t change and the payment
made periodically.

To do this, the formula below is used;

Rate here means the interest rate or the period. Nper means the number of
periods.



[Pmt] means the payment period. PV means the Present Value. [Type]
means when the payment is made. In this [type] option, when something is
attached to it, it means that the payment was made at the period end.

Example: Apple invested the US $100 in 2017 and this payment has been
made yearly. They have an interest of 10% per annum. What would be their
future value in 2021?

You will get the US $129.79

Calculating Present Value

This is done using the Present Value function. It is easier to calculate the
present value if you can calculate the future value.

Example: The FV of investment in Canada is $100 in 2017. They make the
payment yearly with an interest rate of 10% per annum. Calculate the
present value?



You will have $72.64

Calculating the positive and negative cash flows

This is done using the Net Present Value (NPV). It is the total sum of the
positive and negative cash flows over years.

Rate means the discount rate for some time. The Values mean the positive
or negative cash flows. Negative values are seen as payments while positive
values are seen as inflows.

Example:

 
You will get $240.87.

Calculating non-periodic future cash flows



This is done with the XIRR function. The syntax for this formula is XIRR
(values, dates, [guess]). Values here mean the range of cells or arrays that
represent a series of income and expenditures. Dates mean the dates for the
cash flows. It can be in any order. The date of the first investment has to
come first. Guess means the expected IRR is given as a percentage or a
decimal.

For example;

Things to note down when using these functions

�        The Excel formula XIRR is used to calculate the internal rate of
return for cash flows with mismatched scheduling. The IRR function
may be used to model periodic cash flows with unpredictable
payment dates.

�        At most 1 good (income) and 1 bad (extrovert expenditure) value
must be present in the range of outcomes.

�        The initial value must be expressed by a negative integer if it is an
expenditure (initial investment). The original investment is not
amortized; future payments are rolled back to the first cash flow date
and marked down on a 365-day basis.

�        The proportional component of a date that reflects time is deleted, and
all dates are shortened to integers.

�        The dates should be correct. Dates are input as hyperlinks to cells
with dates or as the output of formulae like the DATE function. Issues
may arise if dates are entered in text format.

�        Also when computing monthly or weekly cash flows, XIRR in Excel
always produces an annualized IRR.



Calculating Loan Payments

When taking out a loan, whether it's for a home, a vehicle, a school loan, or
anything else, the first step is to figure out how much you'll have to pay
back each month. To calculate the payment, you utilize the Excel PMT
function.

Three parameters are mandatory and two are optional for the PMT
function:

PMT (Project Management Techniques) (rate, nper, pv[, fv][, type])

The needed arguments are rate, which is the fixed rate of interest during the
loan's tenure; nper, which is the number of payments made over the loan's
term; and pv, which is the loan principle. The two optional inputs are fv, the
loan's future value, which is normally a balloon payment at the conclusion
of the loan, and type, the payment type, which is either 0 (the default) for
end-of-period payments or 1 for beginning-of-period payments.

Any outstanding principal at the conclusion of a loan is covered by a
balloon payment.

The monthly payment on a 3-percentage-point, 25-year $200,000 mortgage
is calculated as follows:

=PMT(0.03 / 12, 25 * 12, 200000) =PMT(0.03 / 12, 25 * 12, 200000)
=PMT(0.03

The output of this calculation is –948.42, as you can see. What is the
significance of the negative sign? Because a loan payment is a money that
your payout, the PMT function produces a negative result.

If the interest rate is annual, divide it by 12 to obtain the monthly rate; if the
period is represented in years, multiply it by 12 to get the number of months
in the term, as indicated in the previous calculation.

Many loans only cover a part of the principle, with the remaining payable
as a balloon payment at the conclusion of the loan. Because this payment
represents the loan's future value, you provide it as the fv parameter to the
PMT function. Because the loan period is supposed to pay down just the
partial principle, you would believe the PV argument should be the partial
principle — that is, the initial loan principal minus the balloon amount.



Nope. You pay interest on the balloon portion of the principle in a balloon
loan. As a result, the PV parameter of the PMT function must be the full
principal, whereas the (negative) fv argument must be the balloon
component.

Calculating the Principal and Interest on a Loan Payment

It's one thing to know the overall amount of a monthly loan payment; it's
another to break it down into principal and interest components. The
primary component of the loan payment is the portion of the payment that
goes toward paying down the initial loan amount, while the remainder is the
interest you're paying to the lender.

The PPMT and IPMT functions may be used to compute loan payment
principal and interest, respectively. The value of PPMT rises as the loan
advances, while the value of IPMT drops, but the total of the two remains
constant over time and is equivalent to the loan payment.

The six parameters are the same for both functions:

PPMT PPMT PPMT PPMT (rate, per, nper, pv[, fv][, type])

IPMT is an acronym for Intellectual Property Management Technology
(rate, per, nper, pv[, fv][, type])

The four needed arguments are rate, which is the fixed interest rate
throughout the loan duration; per, which is the number of payment periods;
nper, which is the number of payments made during the loan term; and pv,
which is the loan principle. The two optional inputs are fv, which is the
loan's future value, and type, which is the payment type: 0 at the end of the
period of 1 for the beginning of the period.

The principle and interest components of the first monthly payment on a —
percent, 25-year $200,000 mortgage, for example, are calculated using the
following two formulas:

Cumulative Loan Principal and Interest Calculation

Use the CUMPRINC or CUMIPMT functions to compute how much
principal or interest has accrued between two periods of a loan.

The same six parameters are required by both functions:



CUMPRINC(rate, nper, pv, start period, end period, type])
CUMPRINC(rate, nper, pv, start period, end period, type])

CUMIPMT(rate, per, PV, start period, end period, type]) CUMIPMT(rate,
nper, PV, start period, end period, type]) CUMIPMT(rate,

Here, rate denotes the fixed rate of interest throughout the loan's period;
nper is the number of payments made during the loan's tenure, and pv
denotes the loan principle. The initial period to include in the computation
is the start period, and the latest period to include in the calculation is the
end period. where type is the payment type: 0 at the end of the period of 1
for the start of the period.

Set start period to 1 and end period to 12 to calculate the cumulative
principal or interest in the first year of a loan, for example:

CUMPRINC(0.03 / 12, 25 * 12, 200000, 1, 12, 0) CUMPRINC(0.03 / 12,
25 * 12, 200000, 1, 12, 0) CUMPRINC(0.03

CUMIPMT(0.03 / 12, 25 * 12, 200000, 1, 12, 0) CUMIPMT(0.03 / 12, 25 *
12, 200000, 1, 12, 0) CUMIPMT(0.03

You'd set the start period to 13 and the end period to 24, and so on, for the
second year.

Identifying the Minimum Interest Rate

You may use the Excel RATE Function to compute what interest rate will
meet these conditions if you know how much you want to borrow, how long
you want to borrow for, and what payments you can afford. For example, if
current interest rates are greater than the figure you compute, you may use
this computation to postpone borrowing money.

The following parameters are sent to the RATE function:

RATING (nper, pmt, pv[, fv][, type][, guess])

The three needed arguments are nper, which represents the number of
payments made during the loan's duration; pmt, which represents the
periodic payment; and pv, which represents the loan principle. RATE also
accepts three optional arguments: fv, the loan's future value (the loan's end-
of-term balloon payment); type, the payment type (0 for end of period, 1 for



beginning of period); and guess, a percentage number that Excel considers
as a starting point for computing the interest rate.

If the duration is presently represented in months, divide it by 12 to get an
annual interest rate. In contrast, if you have a monthly payment and want an
annual interest rate, you must divide that by 12.

RATE uses an iterative approach in which Excel begins with a guess value
and strives to improve each consecutive result in order to get at the correct
answer. If you leave guess blank, Excel uses a default value of 10%. Excel
gives a #NUM! error if it can't come up with a value after 20 attempts. If
this occurs, you should try again with a guess value.

On a related point, the NPER function may be used to compute the duration
of a loan if you know the principal, interest rate, and payment:

NPER is a non-profit organization dedicated to (rate, pmt, pv[, fv][, type])

The three needed inputs for the NPER function are rate, which is the fixed
rate of interest; pmt, which is the loan payment; and pv, which is the loan
principal. The two optional inputs are fv, which is the loan's future value,
and type, which is the payment method (0 or 1).

Determining the Internal Rate of Return

Internal Rate of Return (IRR) is an abbreviation for Internal Rate Of
Return. The concept NPV, or Net Present Value, is used to describe it. This
IRR is defined as the depreciation rate that brings the net present value
(NPV) among all working capital (both positive and negative) out of a
business or operation to 0.

It's a crucial financial instrument for determining the viability of a new
project or venture. A greater IRR than that of the firm's own appropriate
pace suggests that the particular investment will likely pay off in the future.
The lower IRR, on the other hand, implies a bad return on investment.

The formula for the internal rate of return is IRR (value1, value2...). Value
one means the initial payment. Now, let’s solve some problems. Below is a
table that consists of different cash flows for many periods that differ. The
main investment for this business was $5000. This means that the cash flow



from day 0 is -5000. Because of this, it is seen as negative cash flow. With
the data in this table, we will compute the Internal Rate of Return.

Now, input your data in your Excel worksheet.

Now, put in this formula =IRR(B1:B7). Press Enter.

Here is your result.



 

 

 



CHAPTER 16

HOW TO IMPROVE YOUR PIVOT TABLE GAME

You may be asking why you need to learn another tool: The PivotTable
when Excel already has so many excellent data-analysis tools and functions.
In a nutshell, the PivotTable is a helpful tool to have in your data-analysis
arsenal. The lengthy answer is that pivot tables are worth understanding
because they provide a broad list of advantages, not just one or two.

Let me provide a few examples: PivotTables are simple to create and
maintain; they execute huge and sophisticated computations rapidly, and
they can be updated quickly and simply to accommodate for new data.
PivotTables are dynamic, so you can quickly move, filter, and add to them;
and, lastly, you can apply most of the formatting choices that you do to
standard Excel ranges and cells to them.

Oh, and there's one more: PivotTables are completely customizable,
allowing you to create whatever report you wish. This chapter, which
covers 10 approaches that will make you become a PivotTable expert,
highlights customizability.

Activating and deactivating the Pivot Table Fields Task Pane

When you click within the PivotTable report, Excel shows the PivotTable
Fields task pane by default, and when you click outside the PivotTable
report, Excel conceals the PivotTable Fields work pane.

On the surface, there's nothing wrong with it. However, you must have at
least one cell in the PivotTable report selected to use the instructions in
Ribbon's PivotTable Tools contextual tab. When you pick any PivotTable
cell, the PivotTable Fields task window appears, taking up valuable screen
real space.

Fortunately, Excel allows you to manually toggle the PivotTable Fields task
pane off and on, allowing you to present your PivotTable report with more
space. When you need to add, move, or remove fields, you may return to
the PivotTable Fields task pane.



Follow these procedures (all two of them!) to turn off and on the
PivotTable Fields task pane:

Inside the PivotTable, click.
Select Analyze Show Field List from the drop-down menu.
The Close button in the upper-right corner of the PivotTable Fields
task pane may be used to quickly conceal the window.

Change the Pivot Table Fields Task Pane Layout

The PivotTable Fields task pane is split into two pieces by default: the
Fields section displays the available fields for the data source and appears at
the top of the pane, and the Areas section contains the PivotTable areas —
Filters, Columns, Rows, and Values — and appears at the bottom. This
layout may be customized to fit your working style. Here are a few options:

Stacked Fields and Areas Sections: This is the default arrangement.

Sections on Fields and Areas Side-by-Side: Positions the Fields and
Areas sections on the left and right, respectively. If your source data has a
significant number of fields, choose this layout.

Hides the Areas section and only shows the Fields section. By right-
clicking the field name and then selecting the area where you want the field
inserted, you may use this layout to add fields to the PivotTable (instead of
dragging fields to the Areas section). You may make extra areas for the
fields by concealing the Areas section.

Only the Areas Section (2 by 2) is shown, and the areas are arranged in two
rows and two columns. If you've done adding fields to the PivotTable and
want to focus on moving fields between regions and filtering the data,
choose this layout.

Only Shows the Areas Section (1 by 4): Hides the Fields section and
shows the areas in a single column. If you don't need the Fields section
anymore, use this layout. This structure also allows each section to have a
larger display, which is beneficial if some of your fields have extremely
lengthy names.

To modify the layout of the PivotTable Fields task pane, take these
steps:



Within the PivotTable, click any cell.

Select Tools from the drop-down menu.

The gear symbol represents the Tools button.

The PivotTable Fields task pane tools are shown in Excel.

Select the layout you wish to use by clicking on it.

Your option affects the appearance of the PivotTable Fields task pane
in Excel.

Note that you may sort the field list while the PivotTable Fields task pane
tools are open. Sort in Data Source Order is the default setting, which
means Excel shows the fields in the same order as they appear in the data
source. Click Order A to Z if you want to sort the fields alphabetically.

Showing the Details Behind the Data in Pivot Tables

The key benefit of utilizing pivot tables is that they make it simple to
summarize massive amounts of data into a concise report for data analysis.
PivotTables, in other words, show you the forest rather than the trees.
However, you may need to view some of those trees on occasion. If you're
looking at the outcomes of a marketing campaign, your PivotTable may
show you how many earbuds were sold as a consequence of a 1 Free with
10 deal. But what if you want to know more about the numbers that make
up that number? If your source data has hundreds or thousands of entries,
you'll need to filter it in some manner to view just the ones you’re interested
in.

Fortunately, Excel makes it easy to access the records you want by allowing
you to examine the information that lies behind a given data value directly.
This is referred to as "drilling down to the specifics." When you drill down
into a PivotTable data value, Excel goes back to the source data, extracts the
records that make up the data value, and then displays the records in a new
worksheet. This extraction takes just a second or two for a PivotTable based
on a range or table, depending on how many entries the original data
includes.



Use one of the following ways to dig down into the information
underlying a PivotTable data point:

Click Show Information after right-clicking the data value for which
you wish to see the underlying details.

Select the data value by double-clicking it.

When you try to dig down to the underlying details of a data value, Excel
may give you an error message. This section of a PivotTable report cannot
be changed. This error indicates that the functionality that allows you to dig
down has been disabled. To reactivate this function, choose any cell in the
PivotTable and then select Analyze PivotTable Options from the PivotTable
Options dialog box. Select the Enable Show Details check box on the Data
tab, then click OK.

When you share the workbook containing the PivotTable and you don't
want other users diving down and cluttering the workbook with detailed
worksheets, the issue is the inverse. In this instance, go to Analyze
PivotTable Options, choose the Data tab, uncheck Enable Show Details, and
click OK.

You may wish to access all of a PivotTable's underlying source data at
times. If the source data is a range or table on another worksheet, showing
that worksheet will reveal the underlying data. However, if the source data
isn't easily accessible, Excel provides a rapid method to see all of the
underlying data. Show Details by right-clicking the Grand Total column in
the PivotTable (that is, the cell in the bottom-right corner of the PivotTable).
(Alternatively, you may double-click that cell.) Excel creates a new
worksheet with all of the PivotTable's underlying data.

Use the Pivot Table Style

One of the advantages of a PivotTable is that it is contained within a regular
Excel worksheet, allowing you to apply formatting options such as
alignments and fonts to specific areas of the table. This works nicely,
especially if you have certain formatting needs. You may, for example, have
in-house style requirements that must be followed. Unfortunately, the
formatting might take a long time, especially if you're using many distinct
formatting choices. And if you need to apply multiple formatting choices to



different portions of the PivotTable, the overall formatting time might add
up quickly. If you use a style instead of formatting your PivotTables, you
may save a lot of time. A style is a set of formatting choices for distinct
regions of a Pivot Table that Excel specifies, such as typefaces, borders, and
background colors. For labels and grand totals, for example, a style may
employ bold, white writing on a black background, and white text on dark
blue background for objects and data. Manually defining all of these
formats might take anything from half an hour to an hour. However, with
the style feature, you can choose which one you want to use for the entire
PivotTable, and Excel will automatically apply the individual formatting
options.

More than 80 styles are defined in Excel, which is split into three
categories: light, medium, and dark. Pivot Style Light 16, the default
styling for PivotTable reports you produce, is in the Light category, as is
None, which eliminates any formatting from the PivotTable.

To add a style to a PivotTable, follow these steps:
To format a cell in the PivotTable, right-click it.
Toggle to the Design tab.
Click the More button in the PivotTable Styles group.
The collection of styles displayed.
Select the style you'd want to use.
The style is applied by Excel.

Making Your Own Pivot Table Style

It's possible that none of the default PivotTable styles will give you the
precise appearance you're looking for. In that case, you can create a custom
PivotTable style from scratch to achieve that look.

When creating custom PivotTable styles in Excel, you have a lot of options.
You have a total of 25 PivotTable elements to format. The entire table, the
page field labels and values, the first column, the header row, the Grand
Total row, and the Grand Total column are among these elements. Stripes,
which are different formats applied to alternate rows or columns, may also
be defined. The First Row Stripe, for example, formats row 1, 3, 5, and so
on; the Second Row Stripe, on the other hand, formats rows 2, 4, 6, and so
on. Stripes may help you read a lengthy or broad report more easily.



You may develop a personalized look to fit your requirements since you
have control over so many components. For example, your PivotTable
might need to match your company's colors. Similarly, if the PivotTable
will be part of a bigger report, the PivotTable formatting may need to match
the larger report's theme.

The main disadvantage of customizing a PivotTable style is that you must
start from scratch since Excel does not allow you to modify an existing
design. Excel, boo! Creating a custom style might be time-consuming if you
need to provide formatting for all 25 PivotTable components.

However, if you're still up for it, here are the steps to follow to make
your own PivotTable style:

Toggle to the Design tab.
Click More in the PivotTable Styles category.
The collection of styles displayed.
Select New PivotTable Style from the drop-down menu.
The New PivotTable Style dialog box displays.
Give your unique style a name
Select the PivotTable feature you wish to format from the Table
Element list.
Then choose Format.
A dialog box called Format Cells appears.
To format the element's text, use the Font tab's options.
You have the option of selecting a font, a font style (bold or italic),
and a font size. You may also pick a strikethrough effect, underlining,
and color.
To format the element's border, use the Border tab's settings.
You have the option of selecting a border style, color, and location
(such as the left edge, top edge, or both).
To format the element's background color, use the Fill tab's options.
You have the option of either a plain color or a pattern. You can also
use the Fill Effects buttons to create a gradient that alternates between
colors.
Click the OK button.
You'll be taken back to the New PivotTable Style dialog box in Excel.

To format other table elements, repeat Steps 5 through 10.



The Preview part of the New PivotTable Style dialog box is very useful
since it displays how the style will appear when applied to a PivotTable.
You might want to use your new style for all of your PivotTables if you're
particularly pleased with it. What's to stop you? Select the Set as Default
PivotTable Style for This Document check box to tell Excel to use your new
style as the default for any future PivotTables you create.

Finally, when you're finished, click OK.

The custom PivotTable style is saved in Excel.

Surprisingly, Excel does not apply the new style to the existing PivotTable
when you exit the New PivotTable Style dialog box. Dumb! Select any cell
in the PivotTable, click Design, click the More button in the PivotTable
Styles group to open the style gallery, and then click your style in the
Custom section that now shows at the top of the gallery to apply it.

If you need to change something about your custom style, go to the style
gallery, right-click it, and then Modify. Make your changes in the Modify
PivotTable Style dialog box, then click OK.

If you discover that you need to develop a new custom style that is identical
to an existing custom style, don't bother starting from scratch. Instead, open
the style gallery, right-click an existing custom style, and then choose
Duplicate from the drop-down menu. Adjust the style name and formatting
in the Modify PivotTable Style dialog box, then click OK.

If you no longer need a custom style, you should remove it from the style
gallery to save up space. Open the PivotTable Styles gallery by clicking the
Design tab, right-clicking the custom style you no longer require, and then
click Delete. Click OK when Excel asks you to confirm.

Preserve a Pivot Table

When you reload or rebuild the PivotTable, Excel has a bad tendency of not
keeping your particular formatting. If you used a strong font on certain
labels, for example, after a refresh, the labels may return to ordinary text.
Preserve Formatting is a function in Excel that allows you to save custom
formatting after a refresh; you may activate it to keep your own formatting.



In default PivotTables, the Preserve Formatting functionality is always on.
This functionality might, however, have been disabled by another user. For
example, you may be dealing with a PivotTable that was built by someone
else and the Preserve Formatting function has been disabled.

When you refresh or rebuild a PivotTable, Excel, on the other hand,
reapplies the report's existing style formatting. Excel reverts to the default
PivotTable style if you don't provide one.

The steps to set up a PivotTable to retain formatting are as follows:
You may operate with any cell in the PivotTable by clicking it.
Select Analyze PivotTable Options.
The Layout & Format tab is shown in the PivotTable Options dialog
box.
Uncheck the box that says "Autofit Column Widths on Update."
When you deselect this option, Excel will not automatically format
things like column widths when you pivot fields.
Check the box that says "Preserve Cell Formatting on Update."
Click the OK button.
When you reload the PivotTable, Excel remembers your modified
formatting.

Renaming a PivotTable.

Excel assigns the unimaginative name PivotTable1 to the first PivotTable
you create in a workbook. PivotTable2, PivotTable3, and so on are the
names of subsequent PivotTables, which are also uninteresting. However,
when you create new PivotTables based on other data sources, Excel
duplicates these names. If you have a lot of PivotTables in your worksheet,
you can make them stand out by giving each one a distinct and descriptive
name.

Here's how to do it:

You may operate with any cell in the PivotTable by clicking it.

Select Analyze PivotTable from the drop-down menu.

Type a new name for the PivotTable in the PivotTable Name text box.

A PivotTable name can be up to 255 characters long.



Outside the text box, click.

The PivotTable is renamed in Excel.

Disable Grand Totals

There is an additional row at the bottom of a default PivotTable with at least
one-row field. The sum of the values associated with the row field items is
included in this row, which is designated Grand Total. The amount in the
Grand Total row, on the other hand, could not be a total. The Grand Total
row, for example, comprises the average of the values associated with the
row field items if the summary calculation is Average.

A PivotTable with at least one column field, on the other hand, has an
additional column at the far right of the table. The sum of the values
associated with the column field items is included in this column, which is
also designated "Grand Total." The Grand Total row has the sums for each
column item, and the Grand Total column has the sums for each row item if
the PivotTable has both a row and a column field.

These grand totals are typically unnecessary for data analysis and take up
space in the Pivot Table. For example, assume you want to look at your
salespeople's quarterly sales to determine which quantities exceed a specific
threshold for incentive reasons. The grand totals are pointless since your
sole focus is the individual summary figures for each employee. You can
tell Excel not to show the grand totals in this case by following these
steps:

You may operate with any cell in the PivotTable by clicking it.
Select Design Grand Totals from the drop-down menu.
For presenting the grand totals, Excel provides a range of
possibilities.
Select your preferred option.
The menu contains four items:
Off for Rows and Columns: This option disables the grand totals for
both rows and columns.
On for Rows and Columns: Enables grand totals in both the rows and
columns.
Turns off the grand totals for just the columns when set to On for
Rows Only.



On for Columns Only: Turns off the grand totals for just the rows.
Excel applies the grand total option that you've chosen.

Another annoying PivotTable feature is the field headers that display in the
report. The field headers include Sort & Filter buttons, but if you don't use
them, the PivotTable will become cluttered. To disable the field headers,
select Analyze Show Field Headers from within the PivotTable.

Workbooks with Pivot Tables Can Be Resized.

Because Excel needs to keep track of a lot of additional information to
maintain the PivotTable performance acceptable, PivotTables often result in
huge workbooks. Excel, for example, keeps a duplicate of the source data in
a dedicated memory space called the pivot cache to guarantee that the
pivoting recalculation occurs fast and efficiently.

Excel keeps the source data in the pivot cache if you create a PivotTable
from data in a separate workbook or from an external data source. The time
it takes Excel to refresh and update the PivotTable is considerably reduced
as a result. The disadvantage is that it might increase the size of the
workbook as well as the time it takes Excel to save it.

Follow these procedures to notify Excel not to store the source data in
the pivot cache if your workbook has become too big or is taking too
long to save:

In the PivotTable, click any cell.
Select Analyze PivotTable Options from the drop-down menu.
A dialog window called PivotTable Options displays.
Toggle to the Data tab.
Deselect the Save Source Data with the File check box.
Click the OK button.
The external source data is no longer saved in the pivot cache by
Excel.

Using a Pivot Table Value in a Formula

In a worksheet formula, you might need to use a PivotTable value. In most
cases, the address of a cell is used to refer to it in a calculation. This won't



work with PivotTables because when you pivot, filter, group, and refresh
the PivotTable, the addresses of the report data change.

To guarantee precise PivotTable references, utilize Excel’s
GETPIVOTDATA function. The data field, PivotTable location, and one or
more (row or column) field/item pairs that specify the exact value you want
to use are all used in this function. Your formula reference will stay correct
regardless of the PivotTable arrangement, as long as the value is shown in
the report.

The GETPIVOTDATA function has the following syntax:

GETPIVOTDATA (data field, pivot table, [, field1, item1. The two required
fields are the data field, which is the name of the field in the Values area of
the PivotTable, and pivot table, which is the cell address of the PivotTable's
upper-left corner. The remaining parameters are made up of two parts: a
field name and a field item.

For example, here's a GETPIVOTDATA formula that returns the PivotTable
value for Earbuds in the Product field and 1 Free with 10 in the Promotion
field:

=GETPIVOTDATA ("Quantity", $A$3, "Product", "Earbuds",
"Promotion", "1 Free with 10"). GETPIVOTDATA is a little difficult, so
let me set your mind at rest right away by stating you’ll virtually never have
to peck out this function and all its parameters by hand. Instead, when you
click the PivotTable value you want to use in your formula, Excel takes care
of everything for you. Phew!

Conclusion

PivotTable helps a lot in Excel when working with your data. Here, the
various ways you can utilize to improve your PivotTable game have been
listed for you. With the steps here, you are to understand more about pivot
tables.
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Data Analysis box, 325, 328
Data Analysis Expressions, 458, 505
data analysis tool, 532
data analytics, 532
data bars, 543, 548, 549
Data bars, 99
data cleaning, 535
Data cleansing, 515
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Excel charting, 533
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exploratory data analysis (EDA),, 532
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formula in a cell, 222, 226, 282
Formula tab, 218, 226, 227, 239, 250, 356, 362
Formula Tab, 360
Formula tab., 239, 356, 362
formula writing, 382
formulas by pointing, 217
Formulas returning an error, 357
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Mac OS and Windows, 2
Manage Rules, 109
Manage Versions, 117
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Map charts, 169
Marakas, 559
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Marketplace data, 571
mastering Excel, 260
MATCH formula, 302
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mathematical equation, 33
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median, 646, 648, 650, 676, 677, 680
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Merge Feature, 511
Merge Queries, 476, 512
Merge tool, 476
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Microsoft Access database, 441
Microsoft add-in, 534
Microsoft apps, 2
Microsoft Excel, 226, 264, 304, 306, 348, 349, 368, 393
Microsoft Excel 2022, 2, 3



Microsoft Excel File, 441
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Microsoft Excel's, 535
Microsoft Excel's tools, 209
Microsoft Office application, 2
Microsoft Office Excel, 524
Microsoft Office suite, 2, 3
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Microsoft SQL Azure, 441
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MS Excel spreadsheet, 2
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multi-column table, 497
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Multiple Sheets, 120
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One-variable Data, 539
open workbook, 222
Operands, 212
operating margins, 534
Operation Traverse, 351
operator precedence, 211, 215
Operator Precedence problems, 359
Oracle, 441, 449
Organizational account, 486
Orientation" button, 30
Output Range, 649, 660, 662, 667, 669, 670, 671, 672, 673, 675
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Power Pivot Window, 574
Power Query, 582, 620
POWER QUERY, 469, 487, 515, 524
Power Query Basics, 469
Power Query Editor's graphical interface, 469
Power Query experiences, 469
Power Query joins, 511
Power Query Productivity, 515
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Power Query's Unpivot tool., 488
Power radio button, 637
Power View, 537, 614, 617
Power View,, 430
PowerPivot, 614, 615
PowerPivot Data, 432, 451
PowerPivot model editor, 517
PowerPivot panel,, 444, 465
PowerPivot tab, 444
PowerPivot worksheet, 441, 442
PowerPivot's capabilities, 441
Pre-1900 dates, 264
precedence number, 359
predefined AutoFilter, 569
Predictive analytics, 532
Present Value., 310
prevalent technique., 331
Pricing Table, 584
principal part of the payment., 311
Print Active Sheets, 132
Print Entire Workbook, 129, 131
Print in Excel, 129
printable characters, 256, 292
Printing charts, 163
printing the data, 129
prior data value, 327
Privacy Degrees, 523
Privacy Levels, 509
problematic data, 419
Product Category Name, 458
Product field, 589, 698
ProductNumber, 490, 491
Project Management Techniques, 686
prominent local engine, 430
propagate formulae, 39
Protect Workbook, 119
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Range intersections, 228
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Rank Smallest, 384
Raw data, 607
real-world, 536, 638
real-world public data, 536
Recommended Charts, 26, 150, 156
recursive computations, 455
redundant rows, 535
redundant values, 535
Region column, 488
Region filed, 591
Regional and Language Settings Properties, 265
regression, 534, 537, 630, 631, 633, 634, 635, 637, 666, 670
Regression, 630, 670, 671
regression analysis, 537, 630, 634, 637, 670
regular chart, 377, 608
relational database, 436, 441, 483, 576, 617, 624
relevant Field's underlying data, 410
Renaming a chart, 161



repairing flaws, 535
Report Filter, 378, 389, 412, 585, 589, 591, 609
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Result vector, 299
ribbon, 543, 566, 567, 570, 572, 584, 602, 606, 613, 625, 626, 658, 665
Ribbon interface, 430, 452
ribbon tab, 14
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ROUNDDOWN, 242, 243
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Row icon, 543
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Row Labels, 377, 412
Row Labels section, 377, 585, 602
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Rows, 579, 585, 587, 589, 629, 660, 671, 672, 673, 691, 697
rudimentary data, 524
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Rules Manager window, 109
Rules Manager window., 550
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Sales Amounts, 379
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Sales Report., 22
Sales table, 434, 464, 466
salespeople, 433, 461, 543, 544, 621, 697
Sampling, 666, 667
Scaling, 135
Scenario Manager, 539, 558, 559



Scenario Manager Tool, 539
Scenarios, 538, 558
Scroll Bar, 45
second data column, 384
sectors, 532
Select Data, 162, 176, 177, 179
Server Analysis Services, 430, 441, 482
Server Database page, 442
shareholding pool, 33
SharePoint environment, 430
SharePoint server, 430
shortcut pastes data, 13
Shrinking text, 94, 96
Significant numbers, 242
single-cell array formula, 347
single-column table, 497, 498
Skewness, 681
Skip Blanks, 76
Slicer, 567, 568, 596
Slicer filters, 88, 89, 567, 568
Slicers displays, 440
smart calendar sheet, 4
SmartArt basics, 205
SmartArt graphics, 205
Smoothing Data, 323
sociology., 532
software, 560, 562, 571
solver, 534, 559, 560
Solver, 534, 557, 559, 560, 561
sophisticated procedures, 36
Sort & Filter function, 432
Sorting, 533
Sorting Data, 120
source data, 374, 390, 403, 408, 410, 411, 415, 419, 428
Sparkline Tools Design tab,, 187
Special Skip Blanks, 76
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spreadsheet system, 2
SQL Server, 571, 581, 619
SQL Server Analysis, 430, 441, 482
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